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1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following sections.

Intended use

The product is intended for the development, production and verification of electronic
components and devices. It generates radio frequency (RF) signals for test setups in
industrial, administrative, and laboratory environments. Use the product only for its
designated purpose. Observe the operating conditions and performance limits stated in
the specifications document.

Target audience

The target audience of this document includes developers, technicians, operators,
administrators and maintenance personnel. The required skills and experience of the
users depend on the test setup and application of the product.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Section 1.1, "Safety instructions", on page 13. The same information is provi-

ded in many languages in printed format. The printed "Safety Instructions" for
"Mains-Powered Products, Not Heavy" (document number 1171.1771.99) are deliv-
ered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the specifications
document, manuals and the printed "Safety Instructions" document. If you are unsure
about the appropriate use, contact Rohde & Schwarz customer support.

Using the product requires skilled persons or specially trained personnel. These users
also need sound knowledge of at least one of the languages in which the user interfa-
ces and the product documentation are available.

Safety instructions
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Reconfigure or adjust the product only as described in the product documentation or
the specifications document. Any other modifications can affect safety and are not per-
mitted.

Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer support at
https://www.rohde-schwarz.com/support.

Lifting and carrying the product

The maximum weight of the product is provided in the specifications document. You
can lift or carry the product by yourself, if you can manage the weight on your own.
Alternatively, you can use lifting or transporting equipment. Follow the instructions pro-
vided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing.

If Rohde & Schwarz provides accessories designed for outdoor use of your product,
e.g. a protective cover, you can use the product outdoors.

You can operate the product up to an altitude of 2000 m above sea level. If a higher
altitude is permissible, the value is provided in the specifications document. The prod-
uct is suitable for pollution degree 2 environments where nonconductive contamination
can occur. For more information on environmental conditions such as ambient temper-
ature and humidity, see the specifications document.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting the product

Before connecting the interfaces or measuring inputs of the product to other products
or electrical circuits, make sure that the other products or electrical circuits provide

Safety instructions
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special protection against electric shock. This protection principle is referred to as
SELV (safety extra-low voltage) and is based on a low voltage level and increased
insulation. Exceptions are indicated by a measurement category on the product and
given in the specifications document.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● Only connect the product to a power source with a fuse protection of maximum
20 A.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product and its accessories warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Safety instructions
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Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2  Labels on R&S SMB100B

Labels on the casing inform about:
● Personal safety, see "Connecting to power" on page 15.
● Product and environment safety, see "Labels regarding product and environment

safety" on page 16.
● Identification of the product, see the serial number on the rear panel.

Labels regarding product and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its life.

1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

DANGER

Imminently hazardous situation. Will result in death or serious injury if not avoided.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

Warning messages in the documentation
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1.4  CE declaration of conformity

The CE declaration of conformity of the base unit is delivered with the product. Keep
the document for further reference. The current version of this CE declaration of con-
formity is available at:

www.rohde-schwarz.com/company-documents/smb100b

1.5  Where to find key documents on Rohde & Schwarz

Certificates issued to Rohde & Schwarz that are relevant for your country are provided
at www.rohde-schwarz.com/key-documents, e.g. concerning:
● Quality management
● Environmental management
● Information security management
● Accreditations

1.6  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A

https://www.rohde-schwarz.com/company-documents/smb100b
https://www.rohde-schwarz.com/key-documents
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2  Welcome
The R&S SMB100B is a high-performance signal generator developed to meet
demanding customer requirements. Offering excellent signal characteristic and
straightforward and intuitive operation, the signal generator makes signal generation
fast and easy.

2.1  Key features

Outstanding key features of the R&S SMB100B are:
● Frequency range from 8 kHz up to 40 GHz
● Excellent SSB phase noise
● Low wideband noise
● High output power
● Closed loop power control
● User correction
● Pulse train generation
● SCPI macro recorder and code generator for generating executable remote control

code from manual operating steps (for MATLAB®, CVI, etc.)
● Compact racks with a height of 2 U and different widths and depths
● 5" Graphical user interface with touchscreen

For more information, refer to the specifications document.

2.2  What's new

This manual describes firmware version FW 5.40.102.xx and later of the
R&S®SMB100B.

Compared to the previous version, it provides the new features listed below:
● Connecting a frequency multiplier with option R&S SMBB-K554, see Section 6,

"Multiplying RF output frequencies", on page 114.
● Editorial changes

2.3  Documentation overview

This section provides an overview of the R&S SMB100B user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smb100b

Documentation overview

https://www.rohde-schwarz.com/manual/smb100b
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2.3.1  Getting started manual

Introduces the R&S SMB100B and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

2.3.2  User manuals and help

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance, instrument interfaces
and error messages. Includes the contents of the getting started manual.

The contents of the user manuals are available as help in the R&S SMB100B. The
help offers quick, context-sensitive access to the complete information.

All user manuals are also available for download or for immediate display on the inter-
net.

2.3.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

2.3.4  Instrument security procedures

Deals with security issues when working with the R&S SMB100B in secure areas. It is
available for download on the internet.

2.3.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

2.3.6  Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMB100B. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

Documentation overview

https://gloris.rohde-schwarz.com
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See www.rohde-schwarz.com/brochure-datasheet/smb100b

2.3.7  Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

2.3.8  Release notes and open source acknowledgment

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smb100b

2.3.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

For some application sheets, see also:

www.rohde-schwarz.com/application/smb100b

2.3.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@Rohde-Schwarz

Documentation overview

https://www.rohde-schwarz.com/brochure-datasheet/smb100b
https://gloris.rohde-schwarz.com/calcert
https://www.rohde-schwarz.com/firmware/smb100b
https://www.rohde-schwarz.com/application/smb100b
https://www.youtube.com/@Rohde-Schwarz
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3  Getting started

3.1  Preparing for use

Here, you can find basic information about setting up the product for the first time.

3.1.1  Lifting and carrying

For safety information, see "Lifting and carrying the product" on page 14.

Use the handles for lifting and carrying the R&S SMB100B.

Figure 3-1: Instrument side view with front handles (1) and side handles (2)

3.1.2  Unpacking and checking

1. Unpack the R&S SMB100B carefully.

2. Retain the original packing material. Use it to protect the control elements and con-
nectors when transporting or shipping the R&S SMB100B later.
See also Section 15, "Transporting", on page 632.

3. Using the delivery notes, check the equipment for completeness.

4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

3.1.3  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the specifications document.

For safety information, see "Choosing the operating site" on page 14.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the specifications document.
● Class B equipment is suitable for use in:

Preparing for use
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– Residential environments
– Environments that are directly connected to a low-voltage supply network that

supplies residential buildings
● Class A equipment is intended for use in industrial environments. It can cause

radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4  Setting up the R&S SMB100B

See also:
● "Setting up the product" on page 14
● "Intended use" on page 13

3.1.4.1  Placing the R&S SMB100B on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the specifica-
tions document.

2. CAUTION! Foldable feet can collapse. For safety information, see "Setting up the
product" on page 14.
Always fold the feet completely in or out. With folded-out feet, do not place any-
thing on top or underneath the product.

3. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.
Stack as follows:

● If the products have foldable feet, fold them in completely.
● It is best if all products have the same dimensions (width and length). If the

products have different dimensions, stack according to size and place the
smallest product on top.

● Do not exceed the permissible total load placed on the product at the bottom of
the stack:
– 50 kg when stacking products of identical dimensions (left figure).
– 25 kg when stacking smaller products on top (middle figure).

Preparing for use
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Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products

4. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2  Mounting the product in a rack

To prepare the rack

1. Observe the requirements and instructions in "Setting up the product" on page 14.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the product in a rack

1. Use an adapter kit that fits the dimensions of the R&S SMB100B to prepare the
instrument for rack mounting.

a) Order the rack adapter kit designed for the R&S SMB100B.

For more information, refer to the specifications document.
b) Mount the adapter kit. Follow the assembly instructions provided with the

adapter kit.

2. Lift the product to shelf height.
If the rack is high, use a safe climbing aid when placing on upper shelves.

3. Grab the handles at the front.

4. Push the R&S SMB100B onto the shelf until the rack brackets fit closely to the
rack.

Preparing for use
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5. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S SMB100B in the rack.

To unmount the product from a rack

1. Loosen the screws at the rack brackets.

2. WARNING! The product is heavy. For safety information, see "Lifting and carrying
the product" on page 14.
Bring the lifting equipment to shelf height.

3. Remove the R&S SMB100B from the rack.

4. If placing the R&S SMB100B on a bench top again, unmount the adapter kit from
the R&S SMB100B. Follow the instructions provided with the adapter kit.

3.1.5  Considerations for test setup

For safety information, see "Connecting the product" on page 14.

Cable selection to minimize electromagnetic interference

Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, for example, double-shielded RF, LAN and USB

cables.
● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.

Signal input and output levels

Keep the signal levels within the specified ranges to avoid damage to the
R&S SMB100B and connected devices.

For more information, refer to the specifications document.

Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

► NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).
Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

3.1.6  Connecting to power

For safety information, see "Connecting to power" on page 15.

Preparing for use
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1. Plug the AC power cable into the AC power connector on the rear panel. Only use
the AC power cable delivered with the R&S SMB100B.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector.

For more information, refer to the specifications document.

3.1.7  Connecting to LAN

Network environment

Before connecting the product to a local area network (LAN), consider the following:
● Install the latest firmware to reduce security risks.
● For internet or remote access, use secured connections if applicable.
● Ensure that the network settings comply with the security policies of your company.

Contact your local system administrator or IT department before connecting your
product to your company LAN.

● When connected to the LAN, the product may potentially be accessed from the
internet, which may be a security risk. For example, attackers might misuse or
damage the product.

To connect to LAN

► Connect the LAN socket on the rear panel via an RJ-45 cable to the LAN.

Using DHCP (dynamic host configuration protocol), the R&S SMB100B assigns the
IP address automatically.

If connected to the LAN, the R&S SMB100B displays the IP address and the host
name at the left bottom of the home screen.

2
1

1 = Hostname
2 = IP address

If disconnected from the LAN, the R&S SMB100B displays the IP address 0.0.0.0.

See also Section 12.8, "Setting up remote control", on page 340.

3.1.8  Connecting USB devices

You can connect or disconnect all USB devices from the R&S SMB100B during opera-
tion.

Preparing for use
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To connect USB storage devices

USB storage devices, such as memory sticks, allow data transfer from or to the
R&S SMB100B. You can also use them for firmware updates.

► Connect the USB storage device to any of the USB connectors.

To connect USB devices with an external power supply

1. NOTICE! Connected devices with external power supply can feed back current into
the 5 V power supply of the USB interface and thus damage the R&S SMB100B.
Ensure that there is no connection between the positive pole of the power supply
and the +5 V power pin of the USB interface (VBUS).

2. Connect the USB device to any of the USB connectors.

To connect a keyboard

► Connect the keyboard to any of the USB connectors.

When connected, the R&S SMB100B detects the keyboard automatically. A detected
keyboard has the default layout English – US.

To connect a mouse

► Connect the mouse to any of the USB connectors.

When connected, the R&S SMB100B detects the mouse automatically.

To connect power sensors

Connect the power sensors of the R&S NRP families to any of the USB connectors.

See Section 8.4, "Using power sensors", on page 189.

To connect a frequency multiplier

► Connect the frequency multiplier for control connection to the "USB" connector on
the front panel or rear panel.

3.1.9  Connecting to RF coaxial connectors

Here, you find information on how to prepare and to connect to RF coaxial connectors
of the R&S SMB100B. Use these RF connectors, for example, for output of the RF sig-
nal or for input of an external reference signal.

To prepare for connecting

1. NOTICE! Damaged or not clean connections can lead to RF insertion loss and mis-
match, and even premature wear of the connectors.
Before connecting to the port, inspect the RF connector visually. Check that it is
clean, undamaged and mechanically compatible.

Preparing for use
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2. NOTICE! DC voltage at the RF connector can damage the instrument. Never apply
DC voltage to the RF input connectors.
Make sure that the values are within the DC limits given in the specifications docu-
ment.

3. If your test setup has a DC component at the RF input, insert a DC blocker.

4. Use a high-quality RF cable that matches the RF connector type. See also "Cable
selection to minimize electromagnetic interference" on page 24.

5. You can connect to two kinds of connectors:
● "To connect to screwable connectors" on page 27
● "To connect to pluggable connectors" on page 27

To connect to screwable connectors

To connect the cable with the connector, proceed as follows:

1. Carefully align the connector of the cable and the connector along a common axis.

2. Mate the connectors along the common axis until the male pin of the inner connec-
tor engages with the female socket of the outer connector.

3. Turn the nut of the outer connector until you couple the connectors firmly.

4. NOTICE! Excessive tightening can damage the connectors.
Using a calibrated torque wrench torque the nut to the limit as in the table below.
Hold the opposite connector part stationary with a spanner.

The R&S SMB100B provides screwable RF connectors as in Table 3-1.

Table 3-1: Connector name, type, size, torque limit and nut opening

Connector  Torque limit  Nut opening  

Type Name lb-Inch Nm Inch mm

N RF 50 Ω*) 13.3 1.5 3/4 20

SMA Ref In 1 GHz

Ref Out 1 GHz

5 0.56 5/16 8

2.92 mm RF 50 Ω*) 8 0.9 5/16 8

*) maximum frequency fmax depends on the connector type: fmax(N) ≤ 7 GHz, fmax(2.92
mm) ≤ 40 GHz

To connect to pluggable connectors

The R&S SMB100B provides pluggable Bayonet Neill-Concelman (BNC) connectors.

To connect the RF cable with the BNC connector, proceed as follows:

1. Carefully align the connector of the cable and the BNC connector along a common
axis.

Preparing for use
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2. Mate the connectors along the common axis until the male pin of the connector of
the cable engages with the female socket of the BNC connector.

For more information on handling and maintaining coaxial RF connectors, see the
application note 1MA99.

For information on mounting test port adapters onto the RF connector, see the applica-
tion note 1MA100.

3.1.10  Connecting to RF 50 Ω

1. Before connecting, disable the RF output:
In the home screen, switch off the RF block.

2. For connection, use the connector "RF 50 Ω" on the front panel.
See "To connect to screwable connectors" on page 27.

To prevent RF output switch-off

► NOTICE! High reflected powers can force the R&S SMB100B to switch off the RF
output.
Connect a load with sufficient return loss.
For more information, refer to the specifications document.

3.1.11  Connecting to Ref In/Ref Out

For connection, the R&S SMB100B provides BNC connectors or SMA connectors on
the rear panel. See "To connect to pluggable connectors" on page 27 and "To connect
to screwable connectors" on page 27.

3.1.12  Switching on or off

The following table provides an overview of power states, LEDs and positions of the
power switch.
Table 3-2: Overview of power states

State LED Position of power switch

Off  gray [0]

Standby  orange

 orange

[I]

Ready  yellow [I]

Preparing for use
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To switch on the R&S SMB100B

The R&S SMB100B is off but connected to power. See Section 3.1.6, "Connecting to
power", on page 24.

1. Set the switch on the power supply to position [I] on the rear panel.

The LED of the [On/Standby] key on the front panel is orange.

2. Wait until the oven-controlled oscillator (OCXO) warms up.
For more information, refer to the specifications document.

3. Press the [On/Standby] key on the front panel.

The LED changes to green. The R&S SMB100B boots.

After booting, the R&S SMB100B starts up displaying the home screen on the
screen on the front panel.

To check startup functions

When starting for the first time, the R&S SMB100B starts with the default settings.
When restarting, the R&S SMB100B recalls the instrument configuration before shut-
down.

See Section 10.5.2, "Saving and recalling instrument settings", on page 233.

When switched on, the R&S SMB100B monitors the main functions and logs errone-
ous functions. See the following:

See Section 14.4, "Querying notifications", on page 620.

To shut down the product

The product is in the ready state.

► Press the [On/Standby] key.

The operating system shuts down. The LED changes to orange. The product
changes to standby state.

In the standby state, the power switch circuits and the OCXO are active. To deactivate
them, disconnect the instrument from the power supply.

To disconnect from power

The R&S SMB100B is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the toggle switch on the power supply to position [0].

The LED of the [On/Standby] key is switched off.

2. Disconnect the R&S SMB100B from the power source.

Preparing for use
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3.2  Instrument tour

This section explains the control elements and the connectors of the R&S SMB100B.
The views of the front panel and the rear panel help you to get familiar with the instru-
ment and to perform the first steps. For specifications of the interfaces, see the specifi-
cations document.

The meanings of the labels on the R&S SMB100B are described in Section 1.2,
"Labels on R&S SMB100B", on page 16.

3.2.1  Front panel tour

This section provides an overview of the control elements at the front panel of the
R&S SMB100B. Most of the connectors are at the rear panel and are described in Sec-
tion 3.2.2, "Rear panel tour", on page 36.

Figure 3-2: Front panel view of the R&S SMB100B RF signal generator

1 = Utility keys
2 = Touchscreen
3 = Function keys
4 = Navigation controls
5 = Display keys
6 = USB connector
7 = RF 50 Ω
8 = Keypad
9 = On/Standby

Instrument tour
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Figure 3-3: Front panel view of the R&S SMB100B Microwave signal generator

1 = Utility keys
2 = Touchscreen
3 = Function keys
4 = Navigation controls
5 = Display keys
6 = USB connector
7 = SD card slot
8 = RF 50 Ω
9 = Keypad
10 = On/Standby

3.2.1.1  Utility keys

The utility keys set the R&S SMB100B to a defined state, and provide access to basic
settings and information on assistance.
Table 3-3: Utility keys

Utility Key Assigned functions

[Preset] Sets the instrument to a defined state

[Local] Switches from remote control to local (manual) control

[Setup] Accesses the general instrument settings

[Help] Displays context-sensitive help text

3.2.1.2  Touchscreen

The screen display on the front panel is the graphical user interface. It shows the most
important settings, the current configuration at a glance and provides access to the set-
tings dialogs.

Instrument tour
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Figure 3-4: Touchscreen

The screen is touch-sensitive, offering an alternative means of user interaction for
quick and easy handling of the instrument.

See also:
● Section 3.4.2, "Understanding the display information", on page 48.
● Section 3.4, "Operating the instrument", on page 46, for operating the touch-

screen.
● Section 16.1, "Cleaning", on page 633, for cleaning the screen.

3.2.1.3  Function keys

Function keys provide access to the most common generator settings and functions.
You can find a detailed description of the corresponding functions in the user manual.
Table 3-4: Function keys

Function key Assigned functions

[Freq] Activates frequency entry.

[Level] Activates level entry.

[Mod on/off] Switches the modulation on and off.

[RF on/off] Switches the RF output on and off.

3.2.1.4  Navigation controls

The navigation controls include a rotary knob, navigation keys, and the display keys.
They allow you to navigate within the display or within dialog boxes.

Instrument tour
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Rotary knob

The rotary knob has several functions:

● Increments (clockwise direction) or decrements (counterclockwise direction)
numeric instrument parameters at a defined step width.

● Moves the selection, e.g. to a function block in the block diagram
● Shifts the selection bar within focused areas (e.g. lists).
● Acts like the [Enter] key, when it is pressed.
● Opens a context-sensitive menu, when it is pressed and held.

Editing keys

Editing keys enable you to confirm an entry, delete individual characters, or exit the
current operation.
Table 3-5: Editing keys

Type of key Description

[Esc] key Closes all kinds of dialog boxes, if the edit mode is not active. Quits the
edit mode, if the edit mode is active. Equals selecting the "Cancel" but-
ton in dialogs, if provided.
For "Edit" dialog boxes, the following applies:
● If data entry has been started, it retains the original value and

closes the dialog box.
● If data entry has not been started or has been completed, it closes

the dialog box.

[Enter] key Has the same effect as pressing the rotary knob
● Concludes the entry of dimensionless entries. The new value is

accepted.
● With other entries, this key can be used instead of the default unit

key.
● In a dialog box, selects the default or focused element.
● Calls the next dialog level.
● Confirms and closes open input windows.

[Backspace] key Deletes the character to the left of the cursor in editing mode.

Navigation keys

As an alternative to the rotary knob or the touchscreen, you can use the navigation
keys to navigate through dialog boxes, diagrams, or tables.

Instrument tour
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Table 3-6: Navigation keys

Type of key Description

[Up/Down] Key The [Up] and the [Down] key does the following:
● In a numeric edit dialog box, increase or decrease the instrument

parameter.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar vertically.
● In windows or dialog boxes with vertical scrollbar, move the scroll-

bar.

[Left/Right] Key The [Left] and the [Right] key does the following:
● In an alphanumeric edit dialog box, move the cursor.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar horizontally.
● In windows or dialog boxes with horizontal scrollbar, move the

scrollbar.

3.2.1.5  Display keys

The display keys arrange different windows on the display.
Table 3-7: Display keys

Display key Assigned functions

[Home] Returns to the initial feature screen.

[Next window] Toggles between the entry fields in the taskbar.

[On/Off] ● Switches highlighted elements or a function block on and off.
● Switches between two or more settings, e.g. items of selection lists.

At the end of a list, the cursor is set on the first entry again.

[Undo] Reverts the last operation.

[★ (User)] Adds a parameter to the user menu for quick access.

3.2.1.6  USB connector

Female USB type A connector, to connect devices like a keyboard, a mouse, a mem-
ory stick, or the R&S NRP-Z3/Z4 cable for the R&S NRP power sensors.

How to: Section 3.1.8, "Connecting USB devices", on page 25

3.2.1.7  SD card slot

Option: R&S SMBB-B85 (R&S SMB100B microwave instruments only)

Slot for removable mass storage.

To prevent from unauthorized removal, the SD card holder includes wholes that pro-
vide the opportunity of sealing the SD card. We recommend that you seal the SD card
crosswise.
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3.2.1.8  RF 50 Ω

The connector type depends on the installed frequency option.
Table 3-8: RF connector types of the frequency options

Installed RF fre-
quency option

Connector type Frequency
range

R&S SMBB-B101 N female fmax ≤ 6 GHz

R&S SMBB-B103

R&S SMBB-B106

R&S SMBB-B112 PC 2.92 mm female

Instrument equipped with interchangeable PC 2.92 mm test port
adapter.

fmax ≤ 40 GHz

R&S SMBB-B120

R&S SMBB-B131

R&S SMBB-
B140(N)

How to: Section 3.1.10, "Connecting to RF 50 Ω", on page 28

3.2.1.9  Keypad

The keypad enables you to enter alphanumeric parameters, including the correspond-
ing units. It contains the following keys:
Table 3-9: Keys on the keypad

Type of key Description

Alphanumeric keys Enter numbers and (special) characters in edit dialog boxes.

Decimal point Inserts a decimal point "." at the cursor position.

Sign key Changes the sign of a numeric parameter. For an alphanumeric parame-
ter, inserts a "-" at the cursor position.

Unit keys

(G/n dBμV, M/μ μV, k/m mV and
x1 dB(m))

These keys add the selected unit to the entered numeric value and com-
plete the entry.

For level entries (e.g. in dB) or dimensionless values, all units have the
value "1" as multiplying factor. Thus, they have the same function as an
[Enter] key.

3.2.1.10  On/Standby

The [On/Standby] key switches the instrument from the standby to the ready state or
vice versa.

The LED above the [On/Standby] key indicates the instrument state, see Sec-
tion 3.1.12, "Switching on or off", on page 28.
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3.2.2  Rear panel tour

This section provides an overview of the connectors at the rear panel of the instrument.
For technical data of the connectors, refer to the data sheet.

Figure 3-5: Rear panel view R&S SMB100B RF signal generator

1 = Serial number (six digits in the string 1400.1000.02-<serial number>-<checksum>)
2 = IEC 625/IEEE 488
3, 5 = USB/USB In
4 = LAN
6 = AC power supply connector and switch
7 = S/P Dif
8 = Stereo L/R
9, 10 = Ref In/Ref Out
11 = LF
12 = Mod. Ext.
13 = Pulse Video
14 = Pulse Ext.
15 = Signal Valid
16 = Inst Trig

Figure 3-6: Rear panel view R&S SMB100B Microwave signal generator

1 = Serial number (six digits in the string 1400.1000.02-<serial number>-<checksum>)
2 = IEC 625/IEEE 488 (option R&S SMBB-K986)
3 = LAN
4 = USB/USB In (option R&S SMBB-K986)
5, 6 = Ref In/Ref Out
7 = Inst Trig

Instrument tour
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8 = Signal Valid
9 = Pulse Ext.
10 = Pulse Video
11 = Mod. Ext.
12 = LF
13 = AC power supply connector and switch

3.2.2.1  Connectors

IEC 625/IEEE 488
Option: R&S SMBB-B86/-K986
General purpose interface bus (GPIB) interface for remote control of the instrument.
The interface complies with the standards IEC 625, IEEE 488 and SCPI.
Use this interface to connect a computer for remote control of the R&S SMB100B. See
also the following sections:
● Section 12.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 302
● Section 12.5.3, "GPIB address settings", on page 314
● Section C, "GPIB interface", on page 656

USB/USB In
● Female USB (universal serial bus) 3.0 connector of type A (host USB), to connect

devices like a keyboard, a mouse, a memory stick, or the R&S NRP-Z3/Z4 cable
for the R&S NRP power sensors

● Option: R&S SMBB-B86/-K986
Female USB 2.0 connector of type Micro-B (USB In), for example, for remote con-
trol.

How to: Section 3.1.8, "Connecting USB devices", on page 25

LAN
RJ-45 connector to connect the R&S SMB100B to a LAN for remote control, remote
operation, and data transfer.
How to: Section 3.1.7, "Connecting to LAN", on page 25

AC power supply connector and switch
Mains power switch for performing the following tasks:
● Connecting the internal power supply to the power source
● Disconnecting the internal power supply from the power source
How to: Section 3.1.6, "Connecting to power", on page 24.

S/P Dif
Option: R&S SMBB-B5
BNC input connector for digital stereo signals.
See also Section 5.4.3, "Stereo modulation", on page 78.

Stereo L/R
Option: R&S SMBB-B5

Instrument tour
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BNC input connectors for analog stereo modulation signals. External modulation sour-
ces or the internal LF generator can be used.
See also Section 5.4.3, "Stereo modulation", on page 78.

Ref In/Ref Out
Input/output for external reference signal.
BNC connectors for reference signals from 1 MHz to 100 MHz.
SMA connectors for 1 GHz reference signals.
How to: Section 3.1.11, "Connecting to Ref In/Ref Out", on page 28

LF
BNC connector for output of the internal LF generator signal.
For more information, refer to the specifications document.

Mod. Ext.
BNC connector for input of external analog modulation signals.
See Section 5, "Analog modulations", on page 68.

Pulse Video
BNC connector for output of the internal pulse generator signal or the looped through
pulse signal from Pulse Ext. connector (video signal).
See Section 5.4.1, "Pulse modulation settings", on page 71.

Pulse Ext.
BNC connector for input of an external pulse modulation signal or an external trigger/
gate signal for the pulse generator.

Signal Valid
BNC connector for output of a signal that determines the valid signal times (valid level
and frequency) for all analog modulations.
Alternatively, you can use this connector to synchronize pulse signals by activating the
"Pulse Sync" in the dialog Section 5.4.4, "Pulse generator", on page 87.

Inst Trig
BNC connector for input of external trigger signals. The signals trigger sweeps and list
mode.
See Section 7.1, "Signal generation and triggering in the sweep and list modes",
on page 135.

3.3  Trying out the instrument

This section introduces the first steps with the R&S SMB100B. It shows how to operate
and configure the instrument using simple examples. The complete description of the
functionality and its usage is given in the R&S SMB100B user manual. Basic instru-
ment operation is described in Section 3.4, "Operating the instrument", on page 46.

Trying out the instrument
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Prerequisites

The instrument is set up, connected to the power supply, and started up as described
in Section 3.1, "Preparing for use", on page 21.

The first signal generation tasks explain how to generate an unmodulated signal, to
configure the RF signal output, and how you can vary the RF frequency and level in
sweep mode.

The instrument is manually operated via the touchscreen. Try out the following:

● Generating an unmodulated carrier........................................................................ 39
● Generating an RF frequency sweep signal.............................................................41
● Saving and recalling settings.................................................................................. 43

3.3.1  Generating an unmodulated carrier

We start to generate a simple unmodulated signal. In this example, the R&S SMB100B
can be in its minimal configuration.

1. On the R&S SMB100B front panel, press the [Preset] key to set a defined initial
instrument state.

2. Set the frequency:

a) In the "Status Bar", tap the "Frequency" field.
b) On the on-screen keypad, enter "6" and press the "GHz" key.

The on-screen key pad closes and the frequency value is displayed.

3. To set the signal level, tap the "Level" field and enter the level in the same way.

4. To activate RF signal output, select "Level" > "RF On" in the tile diagram.

Trying out the instrument
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The blue colored "RF On" icon indicates that the RF output is activated.

The R&S SMB100B provides the 6 GHz signal at the RF connector at the front
panel.

Figure 3-7: Generating an unmodulated signal

Alternative ways to access the instrument functions

To fulfill the same task, you can also use the front panel keys or the setting parameters
provided in the frequency and level dialogs.

Trying out the instrument
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Try out the settings dialogs

1. In the "Frequency" tile, select "Frequency...".

a) In the "RF Frequency" tab, tap the "Frequency" field.
b) Set the frequency via the on-screen keypad.

2. Access the "RF Level" dialog via the "Level" tile.

a) In the "RF Level" tab, select "Amplitude".
b) Set the amplitude (level) via the on-screen keypad.

3. Select "RF State > On" to activate the RF signal generation.

See Section 4, "RF signal configuration", on page 56.

Try out the front panel keys

► Use the [Freq], [Level], and [RF on/off] key on the front panel.

Connect RF 50 Ω of the R&S SMB100B to a signal analyzer, for example R&S®FSW,
to display the generated signal.
For the required settings of the signal analyzer, refer to its user manual or its online
help.

3.3.2  Generating an RF frequency sweep signal

The "Sweep" operating mode allows you to generate an RF signal with periodically
varying frequencies or amplitudes.

This example deals with an RF signal with varying frequency and constant level. To
configure the sweep, you need to determine a defined start and end frequency with
constant time intervals between the frequency steps.

The sweep function does not require specific options.

1. On the front panel, press the [Preset] key to set a defined initial instrument state.

2. Set the signal output level, if required, e.g. set "Level > -25 dBm".

3. In the tile diagram, select "Sweep" > "Frequency Sweep".

4. In the "General" tab:

Trying out the instrument
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a) Select "Mode > Auto" to run the sweep continuously.
b) Select "Shape > Sawtooth" to set the waveform shape of the sweep signal.
c) Select "Spacing > Linear", to determine the calculation method for the fre-

quency shift of a step.
d) Set "Dwell Time > 15.0 ms", to determine the time interval of the sweep steps.

5. Select the "Frequency Range" tab.

a) Set "Start Freq > 200 MHz" and "Stop Freq > 600 MHz" to determine the fre-
quency sweep range.

b) Set the step width "Step Lin > 10.0 MHz" to determine the width for a frequency
step.

6. In the "General" tab, activate the frequency sweep with "State > On".

7. Close the sweep dialog.
(Alternatively, tap the "Home" button to minimize the dialog. The R&S SMB100B
indicates the "Sweep" dialog as active dialog in the task bar.)

Trying out the instrument
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8. To activate the RF signal output, select "Level" > "RF On".

Figure 3-8: Generating a frequency sweep signal

The frequency field in the status bar indicates the continuously changing frequency,
i.e. the running sweep.

3.3.3  Saving and recalling settings

To restore the results of our measurements later, we save the instrument settings in a
file.

To save the instrument settings in a file

We assume, a test configuration as described in Section 3.3.2, "Generating an RF fre-
quency sweep signal", on page 41.

1. Press the [Setup] key on the front panel.

2. In the "Setup" menu, select "Settings > Save/Recall".

3. In the "Save/Recall" dialog, select "Operation Mode > Save".

Trying out the instrument
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4. Tap the "Filename", use the on-screen keyboard, and enter MyTestSignal.

5. Tap the "Save" button.

The file MyTestSignal.savrcltxt is stored in the default direc-
tory /var/user/.

To load saved instrument settings

You can restore the settings to the instrument at any time using the settings file.

1. Press the [Preset] button to restore the default instrument settings so you can
check that the stored user settings are restored afterwards.

2. Press the [Setup] key on the front panel.

3. In the "Setup" menu, select "Settings > Save/Recall".

4. In the "Save/Recall" dialog, select "Operation Mode > Recall".
Navigate to the directory the file is saved in and select the MyTestSignal file.

Trying out the instrument
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5. Tap the "Recall" button.

All instrument settings are restored and the display resembles Section 3.3.2, "Gen-
erating an RF frequency sweep signal", on page 41, which shows the instrument
display right before the settings were saved.

How to display all parameters with values different to their preset values
When you load a file to your instrument, you do not have enough information on the
changed settings. In such case, it is useful to visualize all parameters that have been
changed from their default state.

Try out the following:
● Touch and hold a spot in the tile diagram for at least 1 second to access the con-

text-sensitive menu.
● Select "Mark All Parameters Changed from Preset".

Trying out the instrument
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● All changed parameters are highlighted.

See also Section 10, "File and data management", on page 220.

3.4  Operating the instrument

This section provides an overview on basic operating tasks. There are three ways to
operate the R&S SMB100B.

Operating the instrument
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Manual operation

Use the touchscreen, keys and rotary knobs, or an optional mouse and/or keyboard.
The principles of manual operation are explained in this section.

Remote control

Create programs to automatize repeating settings, tests, and measurements. The
instrument is connected to a computer that runs the program.

This way of operation is described in Section 12.1, "Overview of remote access
modes", on page 297.

Remote operation

For remote monitoring and operation of the instrument, a VNC server is installed on the
R&S SMB100B. You need a LAN connection to the computer, and a VNC client or
browser to connect to the instrument.

This way of operation is described in Section 12.1, "Overview of remote access
modes", on page 297.

The following sections show how to operate the instrument manually.

● Means of manual interaction...................................................................................47
● Understanding the display information....................................................................48
● Accessing the functionality......................................................................................51
● Entering data...........................................................................................................52
● Undo and redo actions............................................................................................53
● Getting information and help...................................................................................54

3.4.1  Means of manual interaction

For the manual interaction with the R&S SMB100B, you have several methods that you
can use as an alternative to perform a task:
● Touchscreen:

Touchscreen operation is the most direct way to interact. Almost all control ele-
ments and actions on the screen are based on the standard operating system con-
cept. You can tap any user interface element to set parameters in dialog boxes,
enter data, scroll within a dialog etc., as if you work with a mouse pointer.
Tapping the screen works like clicking mouse buttons:
– Touch quickly = click: Selects a parameter or provokes an action.
– Touch and hold = right-click: Opens a context-sensitive menu.
– Touch and swipe = drag: Scrolls through the contents of a display element

larger than the screen, e.g. a list or a table.
● Function keys and rotary knob:

The front panel provides nearly all functions and controls to operate the instrument
in the classic way, without touchscreen.

● Optional mouse and/or keyboard:

Operating the instrument
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These devices work like known from PCs. The navigation keys on the front panel
correspond to the keys on the keyboard.

This manual describes the manual interaction with the instrument via the touchscreen.
It mentions the alternative methods using the keys on the instrument or the on-screen
keypads if it deviates from the standard operating procedures. The usage of the touch-
screen and navigation keys is described in Section 3.4.3, "Accessing the functionality",
on page 51.

Throughout the manual, the term "select" refers to any of the following methods:
● Using a finger on the touchscreen
● Using a mouse pointer in the display
● Using a key on the instrument or on a keyboard

3.4.2  Understanding the display information

The home screen of the R&S SMB100B displays all main settings and generator
states, divided into main operation areas.

3

1 2

Figure 3-9: Home screen

1 = Taskbar/softkey bar with "Home" and "Info" key
2 = Status bar
3 = Tile diagram

Operating the instrument



Getting startedR&S®SMB100B

49User Manual 1178.3711.02 ─ 11

● Status bar................................................................................................................49
● Tile diagram............................................................................................................ 49
● Taskbar....................................................................................................................49
● Additional display characteristics............................................................................ 50

3.4.2.1  Status bar

The status bar at the top of the screen indicates the RF frequency and the level of the
output signal provided to the DUT. You can set both parameters directly here.

3.4.2.2  Tile diagram

The tile diagram is the main entry to the settings of the R&S SMB100B.

Tile Access to:

"Modulation" ● Analog and stereo1), and pulse1) modulation settings
● Built-in LF generator

"System Config" ● "Save/Recall": settings for saving and loading instrument configurations
● "Remote access": Network and emulation settings.
● "Setup": general system configuration

"Sweep" ● Frequency and level sweeps
● List mode

"Frequency" ● RF frequency and phase
● Reference frequency

"Level" ● RF level
● Attenuator
● Automatic level control
● User correction

"Power sensors" ● Power sensors

1) requires additional options

3.4.2.3  Taskbar

The "Taskbar" shows a home and an info button, and assigns a labeled button when-
ever you open a dialog. If more dialogs are open than the taskbar can display, touch
and swipe the taskbar to scroll up and down.

The buttons shown in the following example represent the variants.
Table 3-10: Example of buttons in the taskbar

"Home" button

Returns to the home screen.

 

"Busy" indicator

Indicates a running process.
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"User Menu"

Lists parameters that can be defined for quick access.

Shows the current remote access connections when the instrument is remotely con-
trolled.

Tip: An indicator in the "System Config" tile shows the current remote control status.

R&S NRP power sensors

Shows a connected external power sensor. The button displays the current readings
when the sensor is active.

Active dialogs

Indicates the dialog name of each active dialog in a separate button.

"Info" key

Provides access to status and error messages.

Note: The warning symbol signifies a permanent error message.

3.4.2.4  Additional display characteristics

The following section provides a short insight on the indication of the screen in general,
and significant elements that you see under specific modes, in dialogs or settings.

● Appearance of active elements
– Active elements like On/Off switches, state buttons have a blue background.
– Selected elements are framed or highlighted orange.
– Inactive elements are gray.

● On-screen keypads
Either a numerical or alphanumerical on-screen keypad appears when you enable
an entry field, see Section 3.4.4, "Entering data", on page 52.

● Info line
The "Info line" shows brief status information and error messages. It appears when
an event generates a message. If selected, the R&S SMB100B shows information
on static errors and the error history.

● Key parameters indicated in tab labels
● Scrollbar handle

An arrow icon that appears when you touch a scrollbar helps you to scroll in a dia-
log or list.
If no scrollbar handle appears, you can touch and swipe an element to scroll up
and down.

● Progress indicators
A busy icon indicates a currently running process. If a process takes some time, a
progress bar shows the current state.
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● Context-sensitive menus
Within the entire screen display, including single parameters, you can access con-
text-sensitive menus that provide some additional functions.

3.4.3  Accessing the functionality

All functionalities are provided in dialog boxes as known from computer programs. You
can control the instrument intuitively with the touchscreen. This section provides an
overview of the accessing methods.

The instrument's functions and settings can be accessed by selecting one of the follow-
ing elements:
● System and function keys on the front panel of the instrument
● Taskbar/softkeys on the touchscreen
● Context-sensitive menus for specific elements on the touchscreen, or with the

rotary knob (press and hold).
● Elements on the status bar in the touchscreen
● Displayed setting on the touchscreen that means block diagram and all settings

available in dialogs.
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To open a dialog box

► Perform one of the following actions:

● Select the required tile, and then the menu entry.
● Select the minimized view (button) on the taskbar.

Some of the utility keys access a dedicated dialog, too.

To minimize a dialog box

1. To return to the home screen, select the "Home" button.

2. To switch to another dialog, select the [Next Window] button.

To close a dialog box

To close a dialog box, you have the same controls as you know from computers or
devices with touchscreen.

► Perform one of the following actions:

● Select the "Close" icon in the upper right corner.
● Select the [Esc] key on the front panel.
● Drag and drop a minimized dialog from the taskbar to the tile diagram.

To select an option in a dialog box

► Select the required option.

3.4.4  Entering data

Some parameters have their own key on the front panel. For data input in dialog
boxes, the instrument provides on-screen keypads for entering numeric and alphanu-
meric values. You can always set the parameters via the touchscreen, the front panel
or an external keyboard.

To enter numeric values with the on-screen keypad

For numeric settings, the instrument displays the numeric keypad. The units specified
correspond to the units of the parameter.

1. Enter the numeric value.

Tip: For a quick entry, you can enter a value in an exponential representation, for
example 1e7 for 10000000.

2. Tap the unit button to complete the entry.

The unit is added to the entry.

Tip: For a quick unit change, you can enter shortcuts, for example for a frequency
value 1e8h for 100 MHz.
For an overview of shortcuts supported by the R&S SMB100B, see Section B, "Unit
shortcuts", on page 654.
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3. If the parameter does not require a unit, confirm the entered value by pressing
"Enter".

To enter numeric values with the front panel controls

1. Change the currently used parameter value by using the rotary knob or the [Up/
Down] keys.

2. If the parameter does not require a unit, confirm the entered value by pressing the
[Enter] key or any of the unit keys.
The instrument highlights the editing line to confirm the entry.

If you edit numeric data in tables, enable edit mode first. Press [Enter] or press the
rotary knob.

To enter alphanumeric values

If a field requires alphanumeric input, you can use the on-screen keyboard to enter let-
ters and characters including special characters.

To complete an entry

► Press the [Enter] key or the rotary knob.

To correct an entry

1. Using the arrow keys, move the cursor to the right of the entry you want to delete.

2. Press the [Backspace] key.

3. Deletes the entry to the left of the cursor.

4. Enter your correction.

To abort an entry

► Press the [Esc] key.
The dialog box closes without changing the settings.

3.4.5  Undo and redo actions

Accessed via the context-sensitive menus, "Undo" allows you to restore one or more
actions on the instrument. Depending on the available memory, the "Undo" steps can
restore all actions.

"Redo" restores a previously undone action.
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3.4.6  Getting information and help

In some dialog boxes, graphics are included to explain the way a setting works.

For further information, you can use the following sources:
● Tooltips give the value range of the parameter.
● The context help provides a functional description on a setting.
● The general help explains a dialog box, provides instructions, and general informa-

tion.

To display context help

► To access a help topic, perform one of the following:

a) Tap and hold the parameter for which you need information.
b) In the opening context menu, tap "Help".
c) Tap the parameter.
d) Press the [Help] key.

The "Help" dialog opens. You can browse the help for further information.

Contents of the help dialog box

The help dialog box covers two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system also provides an "Index" and a "Find" area, and "Zoom" functions that
are accessed via the corresponding buttons.

To open general help

► Press the yellow [Help] key on the front panel.
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If a dialog box is opened, the help topic for the current tab is shown. Otherwise the
"Contents" page appears.

Navigating in the table of contents and in the help topics

1. To move through the displayed content entries, tap on an entry.
Entries with a plus sign contain further entries.

2. To display a help topic, tap on the topic name.

3. To follow a cross-reference, tap on the link text.

4. To return to the previous page, select "Back".
This function scrolls back all steps that you have performed before.

5. Use the "scroll bars" to shift the visible section of content shown.

6. To maximize the "Topics" area, tap the "Hide Contents Tree" button to hide the con-
tents tree.

Using the index

1. Select the "Index" button.

2. Enter the first characters of the topic that you are interested in.

The entries starting with these characters are displayed.

3. Tap on the index entry.

The corresponding help topic is displayed.

Operating the instrument
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4  RF signal configuration
The R&S SMB100B signal generator generates RF signals with outstanding spectral
purity within the frequency range from 8 kHz up to 40 GHz and with adjustable signal
level over a wide range.

In addition to these real-time CW signals, you can generate RF signals from predefined
lists and sweep signals that vary according to the frequency or amplitude curves.

You can also apply versatile analog modulation types with definable characteristics.

The variably adjustable output level due to the built-in attenuator, allows you to vary the
RF signal level over the full level range. Several methods enable you to improve the
signal performance and to optimize the signal quality for the particular application, or to
increase the accuracy and reliability of the generated RF signal.

The R&S SMB100B supports R&S NRP power sensors, e.g. to monitor the output level
of the generator or to determine the level correction values for user correction lists.

Signal modes and characteristics

The R&S SMB100B generates unmodulated or analog modulated RF signals. You can
output the signal in fixed mode or as a signal with periodically varying frequencies or
amplitudes.

Signal modes for RF signal generation:
● Unmodulated signal

Generates an unmodulated continuous wave (CW) of constant frequency and
amplitude.
For information on the signal frequency and level settings and an example on how
to configure a simple CW signal, see:
– Section 4.3, "RF frequency settings", on page 59
– Section 4.4, "RF level settings", on page 61
– Section 3.3.1, "Generating an unmodulated carrier", on page 39

● Analog modulated signal
Modulates the signal with an analog signal and generates amplitude, phase, fre-
quency and pulse modulation.
See Section 5, "Analog modulations", on page 68.

The R&S SMB100B allows you to provide the RF signal with constant or varying fre-
quencies and/or amplitudes at the output:
● Constant frequency and level (CW/Fixed mode)

The RF output signal has the set frequency and level.
● Varying frequency and/or level

– Sweep mode
An RF or LF frequency and RF level sweep signal, processed continuously,
step-by-step or individually and with selectable trigger modes. You can only run
one sweep at a time.

– List mode



RF signal configurationR&S®SMB100B

57User Manual 1178.3711.02 ─ 11

The RF signal is based on a list of predefined frequency and level values pairs
and step widths.

See Section 7, "List and sweep mode", on page 133.

4.1  Activating RF signal output

By default, the RF output signal is deactivated.

To activate the RF output signal

1. Configure the RF signal as required.
Set, for example, the frequency and level values.

2. Activate the RF output in one of the following ways:

a) Select "Level" > "RF ON" > "On"
b) Press the [RF on/off] key at the front panel.

When activated, the "RF On" icon in the "Level" tile turns blue.

RF State/RF ON............................................................................................................57
RF output impedance....................................................................................................57

RF State/RF ON
Activates or deactivates the RF output.
Acts as the [RF on/off] key.
Remote command: 
:OUTPut<hw>[:STATe] on page 419

RF output impedance
You can query the impedance of the RF output.
Remote command: 
:OUTPut<hw>:IMPedance? on page 420

4.2  How to set the frequency and level

The simplest form of the RF signal is a continuous wave (CW) of constant frequency
and amplitude. The RF signal is defined by its frequency, level and phase.

To configure the RF signal.

1. Use one of the following:

How to set the frequency and level
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a) In the home screen select:

● "Frequency" and "Level" in the status bar
● "Frequency" in the "Frequency" tile
● "Level" in the "Level" tile
● "Phase" in the "Frequency" tile

b) On the front panel:

● Press the [Freq] key
● Press the [Level] key

2. Enter the values as required.

The R&S SMB100B indicates the frequency and level settings in the status bar of the
home screen, and shows active functions and parameters of the RF signal in the "Fre-
quency" and "Level" tiles.

See "RF frequency and level display with a downstream instrument" on page 58.

RF frequency and level display with a downstream instrument

If your test setup includes a downstream instrument, you can enter the parameter of
the downstream instrument in the frequency or level settings dialog of the
R&S SMB100B. Examples of downstream instruments are mixers, frequency multipli-
ers, amplifiers or attenuators and of their corresponding major parameters offset, multi-
plier, amplitude. The R&S SMB100B generates the signal without the downstream
parameters, but considers all additional parameters concerning the frequency and
level.

Example parameters that affect the frequency and level:
● Frequency offset
● Multiplication factor
● User correction

Any of these cases are indicated by a dedicated icon, displayed in the "Frequency" or
"Level" tile, depending on the affected parameter.

Figure 4-1 illustrates the calculation of the "Frequency" and "Level" values, displayed
in the status bar.

Figure 4-1: Frequency and Level display vs frequency and level at the RF output

How to set the frequency and level
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fRF, LevelRF = Frequency and level ("Status bar > Frequency and Level") at the output of the downstream
instrument, see also Calculation of fRF and LevelRF)

fRF Out, LevelRF

Out

= Frequency and level at the output connector [RF 50 Ω] ("RF > RF Frequency > Fre-
quency" and "RF > RF Level > Amplitude")

n*f = Multiplication factor ("RF > RF Frequency > Multiplier")
Δf = Frequency offset ("RF > RF Frequency > Offset")
ΔLevel = Power offset ("RF > RF Level > Offset")

Calculation of fRF and LevelRF

● fRF =n*fRF Out + Δf
● LevelRF = LevelRF Out + ΔLevel

4.3  RF frequency settings

Access:

1. Select "Frequency" > "RF Frequency".

2. Observe the information on the home screen, "Frequency" tile.

RF frequency settings
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The "Frequency" tile indicates the reference frequency, current frequency offset
and multiplier values, and phase offset value.

In the "RF Frequency" dialog, you can configure:
● RF frequency, incl. an offset or multiplication factor of a downstream instrument
● The step size for varying the frequency with the rotary knob.
The remote commands required to define the settings are described in Sec-
tion 13.16.4, "SOURce:FREQuency subsystem", on page 487.

Settings

Frequency..................................................................................................................... 60
Offset.............................................................................................................................60
Multiplier........................................................................................................................61
User Variation................................................................................................................61

└ Variation Active............................................................................................... 61
└ Variation Step..................................................................................................61

Frequency
Sets the RF frequency.
This frequency is output at the RF 50 Ω connector.
It does not consider any parameter that affect the frequency, as e.g., a frequency off-
set.
See "RF frequency and level display with a downstream instrument" on page 58.
Note: Suppressed values in the status bar
For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.
●

The display has been disabled for security reasons.
See:
– Annotation Frequency
– Annotation Amplitude

●

The display is disabled when list mode is running, see Section 7, "List and sweep
mode", on page 133.

Remote command: 
[:SOURce<hw>]:FREQuency[:CW|FIXed] on page 489

Offset
Sets the frequency offset.
This value represents the frequency shift of a downstream instrument, like for example
a mixer.
The "Frequency" value displayed in the status bar is the resulting frequency, as it is at
the output of the downstream instrument. The frequency at the R&S SMB100B RF out-
put is not changed.

RF frequency settings
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See "RF frequency and level display with a downstream instrument" on page 58.
Remote command: 
[:SOURce<hw>]:FREQuency:OFFSet on page 491

Multiplier
Sets the multiplication factor for the RF frequency.
This value represents the multiplication factor of a downstream instrument, as for
example a multiplier. You can also assign a negative multiplication factor, for example
-1.0 to support frequency converters working in the reverse frequency position.
The "Frequency" value displayed in the status bar is the resulting frequency, as it is at
the output of the downstream instrument. The frequency at the R&S SMB100B RF out-
put is not changed.
See "RF frequency and level display with a downstream instrument" on page 58.
Remote command: 
[:SOURce<hw>]:FREQuency:MULTiplier on page 490

User Variation
Defines and activates a user-defined step width for varying the RF frequency or RF
level with the rotary knob.
If disabled, the step width varies in steps of one unit at the cursor position.

Variation Active ← User Variation
Activates the set user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP:MODE on page 493
[:SOURce<hw>]:POWer:STEP:MODE on page 534

Variation Step ← User Variation
Sets the user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP[:INCRement] on page 493
[:SOURce<hw>]:POWer:STEP[:INCRement] on page 534

4.4  RF level settings

Access:

1. Select "Level" > "RF Level".

RF level settings
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In the "RF Level" dialog, you can configure the offset-free level, the level limit, and
the step width for varying the level with the rotary knob.

2. Select "User Variation" to set the step width to be used when .setting the RF level
using the rotary knob.

3. Observe the information on the home screen, "Level" tile.

The "Level" tile indicates the level limit, the user correction status and current cor-
rection value, current setting characteristics incl. mode.

The remote commands required to define the settings are described in Sec-
tion 13.16.11, "SOURce:POWer subsystem", on page 524.

RF level settings
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Settings

RF State/RF ON............................................................................................................63
Amplitude...................................................................................................................... 63
Limit...............................................................................................................................63
Offset.............................................................................................................................64
Setting Characteristics.................................................................................................. 64
Level Range.................................................................................................................. 65
Readjust........................................................................................................................ 65
User Variation................................................................................................................65

└ Variation Active............................................................................................... 65
└ Variation Step..................................................................................................65

RF State/RF ON
Activates or deactivates the RF output.
Acts as the [RF on/off] key.
Remote command: 
:OUTPut<hw>[:STATe] on page 419

Amplitude
Sets the level of the RF signal.
The value is offset-free and corresponds to the level at the RF 50 Ω connector.
See "RF frequency and level display with a downstream instrument" on page 58.
Note: Suppressed values in the status bar
For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.
●

The display has been disabled for security reasons.
See:
– Annotation Frequency
– Annotation Amplitude

●

The display is disabled when list mode is running, see Section 7, "List and sweep
mode", on page 133.

Remote command: 
[:SOURce<hw>]:POWer:POWer on page 530
Note: The SCPI command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:
AMPLitude] sets the level of the "Level" display.
This means, the level containing offset.

Limit
Sets an upper limit for the output power.
Note: The parameter "RF level" > "Limit" and "NRP power control" > "RF Amplitude
Limit" are identical.

RF level settings
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You can use this value to protect your DUT from damage due to high input power. If
you enter an RF level above this value, the instrument limits the output power to this
specified value, and generates the warning message:
"Pep value greater than the defined limit." However, the level indication in the status
bar is not affected.
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce<hw>]:POWer:LIMit[:AMPLitude] on page 529

Offset
Sets a level offset.
This value represents the level shift of a downstream instrument, like, for example, an
attenuator or an amplifier.
The "Level" value displayed in the status bar is the resulting level, as it is at the output
of the downstream instrument. The level at the R&S SMB100B RF output is not
changed.
See "RF frequency and level display with a downstream instrument" on page 58.
Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet on page 535

Setting Characteristics
Selects additional quality characteristics to optimize the behavior of the RF signal level
for the specific application.
"Auto" Sets the RF output level automatically according to the selected

mode.
In this mode, the instrument provides the highest dynamic range and
fastest setting times.
The RF signal is shortly blanked when the step attenuator is switch-
ing.
For more information, refer to the specifications document.

"Uninterrupted"
Suppresses blanking at level transitions. Frequency transitions can
lead to an RF level blanking due to hardware-specific switching
points.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Executes signal level changes monotonically increasing or decreas-
ing.
The setting makes sure that increasing the level value exclusively
results in an increased output level, and vice versa.
All electronic switches, which can affect the monotonicity are fixed.
The operation mode is useful for applications using level searching
algorithms which rely on a strictly monotonous behavior.

RF level settings
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"Constant-VSWR"
Suppresses output impedance variations at the RF 50 Ω output con-
nector, due to changed level settings.

"User" Selects this entry automatically when you change one of the following
parameters from the default setting:
● "Attenuator" > Mode
● "ALC" > State or Detector Sensitivity
Note: If you select another setting characteristic, the R&S SMB100B
presets the modified attenuator and ALC parameters.

Remote command: 
[:SOURce<hw>]:POWer:LBEHaviour on page 529

Level Range
Shows the interruption-free range of the level that you can use in the currently selected
mode.
Remote command: 
[:SOURce<hw>]:POWer:RANGe:LOWer? on page 536
[:SOURce<hw>]:POWer:RANGe:UPPer? on page 536

Readjust
Recalculates and adjusts the internal switch positions of the RF chain according to the
current level.
The R&S SMB100B provides the "Readjust" function when you change one of the fol-
lowing parameters from the default setting:
● "RF Level" > Setting Characteristics
● "Attenuator" > Mode > FixedSetting Characteristics
Remote command: 
[:SOURce<hw>]:POWer:ALC:SONCe on page 528

User Variation
Defines and activates a user-defined step width for varying the RF frequency or RF
level with the rotary knob.
If disabled, the step width varies in steps of one unit at the cursor position.

Variation Active ← User Variation
Activates the set user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP:MODE on page 493
[:SOURce<hw>]:POWer:STEP:MODE on page 534

Variation Step ← User Variation
Sets the user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP[:INCRement] on page 493
[:SOURce<hw>]:POWer:STEP[:INCRement] on page 534

RF level settings
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4.5  RF phase settings

The phase in sinusoidal signals defines the initial angle at its origin.

Access:

1. Select "Frequency" > "Phase".

In the "Phase" tab, you can determine the delta phase value and reset the phase to
this reference.

2. Switch to the home screen, "Frequency" tile.

The R&S SMB100B indicates the configured settings.

The remote commands required to define the settings are described in Sec-
tion 13.16.10, "SOURce:PHASe subsystem", on page 523.

Settings

Delta Phase...................................................................................................................66
Reset Delta Phase Display........................................................................................... 66

Delta Phase
Sets the phase of the RF signal.
The current phase of the signal is used as the reference.
Remote command: 
[:SOURce<hw>]:PHASe on page 524

Reset Delta Phase Display
Adopts the selected "Delta Phase" value as the current value, and resets delta phase
to 0 degrees.

RF phase settings
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Remote command: 
[:SOURce<hw>]:PHASe:REFerence on page 524

RF phase settings
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5  Analog modulations
The R&S SMB100B supports AM (amplitude modulation), FM (frequency modulation),
ΦM (phase modulation (PhiM)), and also PULM (pulse modulation). It generates low
frequency signals (LF) as sine, triangle, trapezoidal or square (pulse) waveform, that
can be output and further processed by a downstream instrument.

Option: R&S SMBB-K22, enables generation of pulse modulated RF signals.

Option: R&S SMBB-B5, Stereo/RDS-Coder enables generation of stereo-modulated
RF signals (R&S SMB100B RF instruments only).

5.1  Required options

R&S SMB100B base unit equipped with the following options:
● Option frequency (R&S SMBB-B10x)
● Option Stereo/RDS-Coder (R&S SMBB-B5, R&S SMB100B analog RF instruments

only)
● Option pulse modulator (R&S SMBB-K22)
● Option pulse generator (R&S SMBB-K23)

(supports generation of single and double pulse signals)
● Option multi-function generator (R&S SMBB-K24)
● Option pulse train generator (R&S SMBB-K27)

(requires R&S SMBB-K23)
● Option AM/FM/PhiM (R&S SMBB-K720)

For more information, refer to the specifications document.

5.2  Modulation types and signal sources

Radio transmitters do not transmit an audio signal directly. Instead, they modulate the
audio signal onto a continuous wave (CW) carrier with much higher frequency.

A CW carrier has a sinusoidal waveform with constant amplitude and constant fre-
quency. Modulating a signal onto the carrier means varying a property of the carrier
according to the modulating signal. The three basic modulation types FM, AM and
PhiM for example, vary one property of the carrier proportional to the instantaneous
amplitude of the modulating signal.

Signal sources

If fully equipped, the R&S SMB100B modulates signals from the following sources:
● Internal modulation source

– Two LF generators

Modulation types and signal sources



Analog modulationsR&S®SMB100B

69User Manual 1178.3711.02 ─ 11

Each of the LF generators provides a modulation signal with sine, pulse, trian-
gle or trapezoid shape.

– Noise generator
The noise generator supplies white noise with selectable bandwidth and distri-
bution.

– High-performance pulse generator
Generates single and double pulse, or pulse train signals.

● External modulation source
– Amplitude, frequency or phase modulation signals are input at the Mod. Ext.

connector.
– Pulse modulation signals, at the Pulse Ext. connector.
– Stereo modulation signals, at the Stereo L/R and S/P Dif connector.

Signal output

You can perform AM, FM and PhiM with the signal of any of the provided sources.
Moreover, you can combine two modulation signals and generate a two-tone signal.
Regardless of the signal source, the generated signal can be output for further pro-
cessing in a downstream instrument.

Current configuration is indicated in the "Analog Modulations > Overview" dialog; the
output signal routing can be changed, too.

Input and output connectors

Direction Modulation Connector Required option

Output Pulse modulation from internal signal

Loop through of pulse signal from Pulse Ext.

Pulse Video R&S SMBB-K22/-K23

 All analog modulations

Marks the valid level and frequency

Signal Valid  

 LF generator LF  

Input AM, FM, PhiM Mod. Ext. **) R&S SMBB-K720

 Stereo modulation from external source Stereo L/R R&S SMBB-B5

 Pulse modulation from external source*)

Or

External trigger or gate signal*)

Pulse Ext.**) R&S SMBB-K22

● *) External trigger signal and external signal for the pulse modulation cannot be
used simultaneously, because these signals are expected at the same connector
Pulse Ext.. Signal polarity and impedance are the same for both signals.

● **) The external modulation signal must have a voltage of US = 1 V (UEFF = 0.707
V) to achieve the displayed modulation depth and range.
Note that the input voltage does not exceed 1 V, otherwise modulation distortions
can occur.

For more information, refer to the specifications document.

Modulation types and signal sources
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Interactions and characteristics

● FM and PhiM modulations exclude each other and cannot be performed simultane-
ously.

● In sweep mode, LF frequency sweep is possible.
● The settings of the modulation signal affect all analog modulations that use an

internal modulation source.
● You can feed an external LF signal in each of the two paths.
● Considerations to AM when using an external modulation signal:

If external modulation is enabled, the RFoutput amplitude follows the external mod-
ulation signal with a scaling factor defined by the modulation sensitivity setting.
With Coupling (AC/DC) > DC, the RF output signal behaves according to:
– input signal = 0 V: the RF output amplitude corresponds to the level value set in

the R&S SMB100B
– input signal = +1 V: the output level increases up to the maximum value given

by the set modulation sensitivity
– input signal = -1 V: the output level decreases down to the minimum value

given by the set modulation sensitivity
With Coupling (AC/DC) > AC, the modulation input signal is internally highpass fil-
tered. Therefore, the DC content of the input signal is removed before it reaches
the amplitude modulator.

For more information, refer to the specifications document.

5.3  Activating analog modulations

► Use one of the following:

● Select "Modulation > Amplitude Modulation/Frequency Modulation/Phase Mod-
ulation > State > ON".

● Select "Modulation > MOD ON".
● Press the [Mod on/off] key.

[Mod on/off]
Activate one or more analog modulations and press the [Mod on/off] key to toggle the
state of them all.
Pressing the key again restores the status that was active before the last switch-off.
Remote command: 
[:SOURce<hw>]:MODulation[:ALL][:STATe] on page 442

Activating analog modulations
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5.4  Modulation settings

Access:

► Select "Modulation" > "Modulation Sources".

The "Modulation" dialog contains all functions and settings to configure the analog
modulations, the LF signal sources for performing a modulation, and the LF signal
output.

5.4.1  Pulse modulation settings

Option: see Section 5.1, "Required options", on page 68.

Access:

► Select "Modulation" > "Pulse Modulation".

The "Pulse Modulation" dialog contains all parameters required to configure the
pulse modulator and the pulse generator.
It also displays the pulse signal graphically.

For an overview of the supported signals sources and related connectors, see Sec-
tion 5.2, "Modulation types and signal sources", on page 68.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.5, "SOURce:PULM subsystem", on page 457.

Settings

State..............................................................................................................................71
Source...........................................................................................................................72
Transition Type..............................................................................................................72

State
Activates pulse modulation and triggers the following automatic settings:
● Pulse generator is activated.

Modulation settings
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The signal is output at the Pulse Video connector.
To deactivate the signal output, set "Pulse Generator" > Pulse Output State > "Off".

Remote command: 
[:SOURce<hw>]:PULM:STATe on page 461

Source
Selects between the internal "Pulse Generator" or an "External" pulse signal for the
modulation.
"Pulse Generator"

Selects the internal generator.
See Pulse generator.

"External" Modulation source is fed to the input connector.
See "Signal sources" on page 68.

Remote command: 
[:SOURce<hw>]:PULM:SOURce on page 461

Transition Type
Selects between "Fast" or "Smoothed" slew rate (slope).
"Fast" Enables fast transitions with shortest rise and fall times.
"Smoothed" Flattens the slew rate, resulting in longer rise / fall times. Use this

mode if you are working with devices that are sensitive to steep
slopes.
For more information, refer to the specifications document.
For more information, refer to the specifications document.
For more information, refer to the specifications document.

Remote command: 
[:SOURce<hw>]:PULM:TTYPe on page 462

5.4.2  FM, PhiM and AM modulation settings

Option: R&S SMBB-K720

Modulation settings
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Access:

► Select "Modulation" > "Amplitude Modulation/Frequency Modulation/Phase Modu-
lation".

The "FM", "ΦM" and "AM" tabs contain the parameters per modulation type.

The remote commands required to define these settings are described in:
● Section 13.16.1.2, "SOURce:AM subsystem", on page 443
● Section 13.16.1.3, "SOURce:FM subsystem", on page 448
● Section 13.16.1.4, "SOURce:PM subsystem", on page 453

Settings

State..............................................................................................................................74
Source...........................................................................................................................74
FM settings....................................................................................................................74

└ Deviation.........................................................................................................74
└ Deviation Mode...............................................................................................75
└ Total Deviation................................................................................................ 75
└ Ratio Path2/Path1...........................................................................................75
└ Mode...............................................................................................................75

PhiM settings.................................................................................................................76
└ Deviation.........................................................................................................76
└ Deviation Mode...............................................................................................76
└ Total Deviation................................................................................................ 76
└ Ratio Path2/Path1...........................................................................................76
└ Mode...............................................................................................................77

Modulation settings
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AM settings................................................................................................................... 77
└ Depth.............................................................................................................. 77
└ Sensitivity........................................................................................................77
└ Deviation Mode...............................................................................................77
└ Total Depth......................................................................................................78
└ Ratio Path2/Path1...........................................................................................78

State
Activates a modulation.
Note: Some modulations exclude each other and cannot be performed simultaneously.
For more information, refer to the specifications document.
Remote command: 
[:SOURce<hw>]:AM<ch>:STATe on page 445
[:SOURce<hw>]:FM<ch>:STATe on page 450
[:SOURce<hw>]:PM<ch>:STATe on page 454

Source
Selects the LF signal source.
You can vary the signal sources for each of the modulations.
"LF Generator 1/2"

Selects one or both of the internally generated LF signals.
See Section 5.4.7.1, "Source > LF generator settings", on page 100.

"External" Selects an externally supplied LF signal.
"Noise Generator"

Selects the internally generated noise signal.
See Section 5.4.7.3, "Source > noise generator settings",
on page 105.

Remote command: 
[:SOURce<hw>]:AM<ch>:SOURce on page 446
[:SOURce<hw>]:FM<ch>:SOURce on page 450
[:SOURce<hw>]:PM<ch>:SOURce on page 455

FM settings
The following settings are dedicated to FM.

Deviation ← FM settings
Sets the frequency modulation deviation in Hz.
The maximal deviation depends on the RF frequency and the selected modulation
mode.
Maximal possible deviation is selected automatically, if one of the following applies:
● The selected deviation is too high for the particular frequency
● The selected frequency is outside of the range where deviation is possible.
A warning message indicates this situation, too.
For more information, refer to the specifications document.

Modulation settings
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Remote command: 
[:SOURce<hw>]:FM<ch>[:DEViation] on page 450

Deviation Mode ← FM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The total deviation is the sum of both paths. When the sum is exceeded, the
R&S SMB100B reports a settings conflict, but does not change the settings.

"Uncoupled" Enables you to adjust the deviation for each path independently.
"Fixed Total" Couples the deviation of both paths in per Hz. If you change the devi-

ation of any path, the R&S SMB100B automatically adjusts the value
of the other path. The sum always results in the set Total Deviation.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the deviation
of any path, the R&S SMB100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:FM:DEViation:MODE on page 451

Total Deviation ← FM settings
Sets the sum of the signal deviation for path 1 and path 2 in Hz when using combined
sources in Deviation Mode > Fixed Total.
Deviation of both paths always sum up to the value of the total deviation.
Behavior when changing any depth settings:
● Changing the total deviation adjusts the deviation of both paths proportionally.
● Changing the deviation of one path adjusts the deviation of the other path. The

sum always results in the set total deviation.
Remote command: 
[:SOURce<hw>]:FM:DEViation:SUM on page 451

Ratio Path2/Path1 ← FM settings
Sets the deviation ratio (path2 to path1) in percent.

Example: 
If the deviation in path1 is 10 kHz and the ratio is 50%, the deviation in path 2 is auto-
matically set to 5 kHz.

Remote command: 
[:SOURce<hw>]:FM:RATio on page 452

Mode ← FM settings
Selects the mode of the frequency modulation.
"High Bandwidth"

The maximum range for modulation bandwidth is available.
"Low Noise" Phase modulation with phase noise and spurious characteristics

close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced.
For more information, refer to the specifications document.

Modulation settings
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Remote command: 
[:SOURce<hw>]:FM:MODE on page 452

PhiM settings
The following settings are dedicated to PhiM.

Deviation ← PhiM settings
Sets the phase modulation deviation in radians or degrees.
The maximal deviation depends on the RF frequency and the selected modulation
mode.
For more information, refer to the specifications document.
Maximal possible deviation is selected automatically, if one of the following applies:
● The selected deviation is too high for the particular frequency
● The selected frequency is outside of the range where deviation is possible.
A warning message indicates this situation, too.
Remote command: 
[:SOURce]:PM<ch>[:DEViation] on page 457

Deviation Mode ← PhiM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The deviation sum 2 rad at a maximum. When the sum is exceeded, the
R&S SMB100B adjusts the settings automatically.

"Uncoupled" Enables you to adjust the deviation for each path independently.
"Fixed Total" Couples the deviation of both paths. If you change the deviation of

any path, the R&S SMB100B automatically adjusts the value of the
other path. The sum always results in the setTotal Deviation.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the deviation
of any path, the R&S SMB100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:PM:DEViation:MODE on page 456

Total Deviation ← PhiM settings
In Deviation Mode = Fixed Total, sets the sum of the signal deviation for path 1 and
path 2.
Deviation of both paths always sum up to the value of the total deviation.
Behavior when changing any depth settings:
● Changing the total deviation adjusts the deviations of both paths proportionally.
● Changing the deviation of one path adjusts the deviation of the other path. The

sum always results in the set total deviation.
Remote command: 
[:SOURce<hw>]:PM:DEViation:SUM on page 456

Ratio Path2/Path1 ← PhiM settings
Sets the deviation ratio (path2 to path1) in per cent.

Modulation settings



Analog modulationsR&S®SMB100B

77User Manual 1178.3711.02 ─ 11

Example: 
If the deviation in path1 is 10 rad and the ratio is 50%, the deviation in path 2 is auto-
matically set to 5 rad.

Remote command: 
[:SOURce<hw>]:PM:RATio on page 456

Mode ← PhiM settings
Selects the mode of the phase modulation.
"High Bandwidth"

The maximum range for modulation bandwidth and PhiM deviation is
available.
However, phase noise increases at low frequencies, and the range of
PhiM deviation is limited. This mode is suitable if you process high
frequencies.

"High Deviation"
The maximum range for PhiM deviation is available.
Phase noise is improved for low frequencies compared to the default
mode. The range for modulation frequency is limited.
This mode is suitable for low modulation frequencies and/or high
PhiM deviation.

"Low Noise" Frequency modulation with phase noise and spurious characteristics
close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced.
For more information, refer to the specifications document.

Remote command: 
[:SOURce<hw>]:PM:MODE on page 455

AM settings
The following settings are dedicated to AM.

Depth ← AM settings
Determines the depth of the modulation signal in percent.
The depth is limited by the maximum peak envelope power (PEP).
Remote command: 
[:SOURce<hw>]:AM<ch>[:DEPTh] on page 446

Sensitivity ← AM settings
Sets the input sensitivity of the external modulation signal.
Remote command: 
[:SOURce<hw>]:AM<ch>:SENSitivity on page 448

Deviation Mode ← AM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The deviation sum of both paths is 100% in total. When the sum is exceeded, the
R&S SMB100B reports a settings conflict, but does not change the settings.
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"Uncoupled" Enables you to adjust the deviation depth for each path independ-
ently.

"Fixed Total" Couples the deviation depth of both paths in per cent. If you change
the depth of any path, the R&S SMB100B automatically adjusts the
value of the other path. The sum always results in the set Total
Depth.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the depth of
any path, the R&S SMB100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:AM:DEViation:MODE on page 447

Total Depth ← AM settings
Sets the sum of the signal Depth for path 1 and path 2 in per cent when using com-
bined sources and Deviation Mode > Fixed Total.
Using external LF signals, the R&S SMB100B indicates the Sensitivity per Volts for the
input signal.
Provided both signal paths are turned on, the depth of both paths always sum up to the
value of the total depth.
Behavior when changing any depth settings:
● Changing the total depth adjusts the depths of both paths proportionally.
● Changing the depth of one path adjusts the depth of the other path. The sum

always results in the set total depth.
Remote command: 
[:SOURce<hw>]:AM:DEPTh:SUM on page 447

Ratio Path2/Path1 ← AM settings
Sets the deviaton ratio of the signal depth for path 2 to path 1 in per cent when using
combined sources.
Using external LF signals, the R&S SMB100B indicates the Sensitivity per Volts for the
input signal.
Remote command: 
[:SOURce<hw>]:AM:RATio on page 447

5.4.3  Stereo modulation

R&S SMB100B RF instruments only

Option: see Section 5.1, "Required options", on page 68.

Access:

► Select "Modulation" > "Stereo Modulation".

Option R&S SMBB-B5, Stereo/RDS Coder enables generation of stereo-modulated
RF signals according to the standard. Beside the MPX (FM stereo multiplex) signal,
also the radio traffic service ARI (Automotive Radio Information) and Radio Data
System (RDS) are supported by the option.
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Select an internal or external signal source. The analog [Stereo L/R] connections
and the digital [S/P Dif] connection supply the signal of an external source. The LF
generator acts as internal signal source.

DUT

1 2 3

4

5

6

Figure 5-1: Example setup

1 = R&S SMB100B with Stereo/RDS Coder R&S SMBB-B5
2 = RF modulated test signal including ARI and RDS
3 = FM stereo tuner
4 = Analog audio signals
5 = Signal generation and analysis, for example with R&S®UPV Audio Analyzer
6 = Analog or digital audio signals

● General settings......................................................................................................79
● Pilot tone................................................................................................................. 82
● ARI.......................................................................................................................... 83
● RDS.........................................................................................................................85

5.4.3.1  General settings

Access:

► Select "Modulation" > "Stereo Modulation".

The "General" tab contains the settings for creating a stereo modulation signal.
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The remote commands required to define these settings are described in Sec-
tion 13.16.1.6, "SOURce:STEReo subsystem", on page 468.

Settings

State..............................................................................................................................80
FM Deviation................................................................................................................. 80
Mode............................................................................................................................. 80
Audio Source.................................................................................................................81
LF Gen Frequency........................................................................................................ 81
LF Gen Shape...............................................................................................................81
External R/L Impedance................................................................................................81
Preemphasis................................................................................................................. 81
Max Modulation Frequency...........................................................................................82

State
Activates stereo modulation.
Remote command: 
[:SOURce]:STEReo:STATe on page 470

FM Deviation
Sets the MPX (FM stereo multiplex) deviation.
Remote command: 
[:SOURce]:STEReo[:DEViation] on page 470

Mode
Selects the mode for the audio signal.
"Mono Left" A mono signal containing the left channel is generated/fed in.
"Mono Right" A mono signal containing the right channel is generated/fed in.
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"Stereo R = L" A stereo signal with right and left chanel is generated/fed in. The
channels have the same frequency and phase.

"Stereo R = -L" The signal on the left external audio input is used for both channels.
The right channel is inverted.

"Stereo R != L" (External source only)
A stereo signal containing different, independent right and left chan-
nels is fed in.

Remote command: 
[:SOURce]:STEReo:AUDio:MODE on page 471

Audio Source
Selects the source for the audio signal.
"Off" No audio signal is provided, ARI and RDS signal can be generated

separately.
"Ext L,R" The external audio stereo signal is feed in via the analog [L] and [R]

inputs.
"Ext S/P Diff" The external audio signal is feed in via the digital [S/P Dif] input.
"LF Gen" The audio stereo signal is generated by the internal LF1 generator.
Remote command: 
[:SOURce]:STEReo:SOURce on page 471

LF Gen Frequency
If "Audio Source = LF Gen", sets the frequency of the LF generator signal.
This setting affects all analog modulations which use the LF1 generator as the internal
modulation source.
Remote command: 
[:SOURce]:LFOutput<ch>:FREQuency on page 497

LF Gen Shape
If "Audio Source = LF Gen", selects the shape of the LF generator signal.
This setting affects all analog modulations which use the LF1 generator as the internal
modulation source.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe on page 501

External R/L Impedance
(External analog audio signal input only)
Selects the input impedance for the external analog audio signal inputs [L] and [R].
Remote command: 
[:SOURce]:STEReo:EXTernal:IMPedance on page 472

Preemphasis
Activates and sets the preemphasis used for signal generation.
Preemphasis increases the high-frequency portions of the signal in the level before the
FM modulator is reached.
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Remote command: 
[:SOURce]:STEReo:AUDio:PREemphasis:STATe on page 472
[:SOURce]:STEReo:AUDio:PREemphasis on page 472

Max Modulation Frequency
Sets the maximum modulation frequency.
This parameter is valid/required only when preemphasis has been activated and an
external modulation source is used.
For sinewave signals with full modulation, preemphasis can lead to an internal over-
load of the modulator. The MMF parameter reduces the internal full modulation, so that
sinewave signals with nominal voltage can be transmitted with low distortion, even with
active preemphasis up to the set frequency. This procedure reduces the S/N ratio at
the set MMF, based on the level increase of the preemphasis.
The default value of this parameter works for normal modulation signals, such as voice
or music, because the amplitude of the high-frequency portions of these signals nor-
mally decreases substantially.
Remote command: 
[:SOURce]:STEReo:MMF on page 472

5.4.3.2  Pilot tone

Access:

► Select "Modulation" > "Stereo Modulation > Pilot Tone".

The pilot tone supports the transmission of a signal to the receiver through adding a
constant single-frequency signal. The signal receiver accepts the incoming signal only
after the pilot tone is confirmed.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.6, "SOURce:STEReo subsystem", on page 468.
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Settings

Pilot State......................................................................................................................83
Pilot Deviation............................................................................................................... 83
Pilot Phase.................................................................................................................... 83

Pilot State
Activates the pilot tone generation.
Remote command: 
[:SOURce]:STEReo:PILot:STATe on page 473

Pilot Deviation
Sets the deviation of the pilot tone.
Remote command: 
[:SOURce]:STEReo:PILot[:DEViation] on page 473

Pilot Phase
Sets the phase of the pilot tone in relation to the 38 kHz carrier signal of the receiver.
For a correct demodulation, the pilot tone must be in phase with the 38 kHz carrier.
Remote command: 
[:SOURce]:STEReo:PILot:PHASe on page 473

5.4.3.3  ARI

Access:

► Select "Modulation" > "Stereo Modulation > ARI".

ARI (Automotive Radio Information) indicates the presence of traffic information in FM
radio broadcasts.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.6, "SOURce:STEReo subsystem", on page 468.
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Settings

ARI State.......................................................................................................................84
ARI Deviation................................................................................................................ 84
ARI Identification........................................................................................................... 84
ARI BK.......................................................................................................................... 84

ARI State
Activates the ARI signal generation. ARI signals can be generated simultaneously with
MPX (FM stereo multiplex) and RDS signals.
Remote command: 
[:SOURce]:STEReo:ARI:STATe on page 473

ARI Deviation
Sets the frequency deviation of the ARI subcarrier signal.
Remote command: 
[:SOURce]:STEReo:ARI[:DEViation] on page 474

ARI Identification
Selects the generated identifiers of the ARI signal.
DK and BK are abbreviations of the German words Durchsagekennung and Bereich-
skennung.
"Off" Only the 57 kHz subcarrier is generated. It marks the stations which

broadcast traffic programs and enables the receiver to recognize the
frequency as being ARI-capable.

"DK" The message identification is generated in addition (low-frequency
30% AM). It signalizes that a traffic message is broadcasted.

"BK" The area identification is generated in addition (60% AM). This code
is used to identify the geographical region covered by the radio sta-
tion. The specific code is selected below.

"DK+BK" The area and message identification are generated in addition to the
subcarrier.

Remote command: 
[:SOURce]:STEReo:ARI:TYPE:STATe on page 474
[:SOURce]:STEReo:ARI:TYPE on page 474

ARI BK
Selects the specific area identification (BK) code of the ARI signal. The six letters (six
different frequencies) identify a specific region in each country.
Remote command: 
[:SOURce]:STEReo:ARI:BK[:CODE] on page 475
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5.4.3.4  RDS

Access:

► Select "Modulation" > "Stereo Modulation > RDS".

The RDS (Radio Data System) is configured in the RDS settings section. RDS is a
communication protocol standard from the European Broadcasting Union for sending
digital information embedded in conventional FM radio broadcasts. The RDS system
standardizes several types of transmitted information, including time, track/artist info
and station identification.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.6, "SOURce:STEReo subsystem", on page 468.

Settings

RDS State..................................................................................................................... 85
RDS Deviation...............................................................................................................86
RDS Data Set................................................................................................................86
Program Service Name.................................................................................................86
Program Identification................................................................................................... 86
Traffic Program..............................................................................................................86
Traffic Announcement................................................................................................... 87

RDS State
Activates the RDS signal generation. RDS signals can be generated simultaneously
with MPX (FM stereo multiplex) and ARI signals.
Remote command: 
[:SOURce]:STEReo:RDS:STATe on page 475
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RDS Deviation
Sets the deviation of the RDS subcarrier.
Remote command: 
[:SOURce]:STEReo:RDS[:DEViation] on page 475

RDS Data Set
Selects the data set used in the RDS signal. Five data sets are provided on the instru-
ment. The values of the data sets can be defined via remote control (command
SOURce:STEReo:DIRect).

Each of these data sets contains predefined values for:
● PI (program identification, identifies the broadcast station )
● PS or scrolling PS (program service name, represents the station identity name)
● TP (traffic program, mark stations with regular traffic programs )
● TA (traffic announcement, marks the start of a traffic program)
● PTY (program type, predefined genres of broadcasting programs, e.g. news)
● PTYN (program type name)
● DI (decoder information)
● MS (music/speech)
● CT (clock time, used for synchronization)
The following values are empty:
● RT (radio text, two text blocks with 64 symbols each)
● AF (alternative frequencies, maximum of five lists with 25 frequencies each, ena-

bles the receiver to retune to a different frequency providing the same station when
the first signal becomes too weak)

● TMC (traffic message channel)
● EON (enhanced other networks, eight PS with five EON AF lists each, enables the

receiver to tune into these stations automatically if traffic programs are broadcas-
ted)

The program identification and the program service name of the selected data set are
indicated in the menu.
Remote command: 
[:SOURce]:STEReo:RDS:DATaset on page 476

Program Service Name
Indicates the RDS program service name.
Remote command: 
[:SOURce]:STEReo:DIRect on page 470

Program Identification
Indicates the RDS program identification.
Remote command: 
[:SOURce]:STEReo:DIRect on page 470

Traffic Program
Activates the RDS traffic program (TP function). The receiver can recognize a fre-
quency as being capable of traffic information only if the TP function is active.
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Remote command: 
[:SOURce]:STEReo:RDS:TRAFfic:PROGram[:STATe] on page 476

Traffic Announcement
Activates the RDS traffic announcement (TA function). If activated, the receiver
switches from the current status, e.g. playing a CD, to the receive mode and enables
the broadcast of a traffic announcement. The TP state has to be on.
Remote command: 
[:SOURce]:STEReo:RDS:TRAFfic:ANNouncement[:STATe] on page 476

5.4.4  Pulse generator

Option: see Section 5.1, "Required options", on page 68.

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Generator".

The "Pulse Generator" tab contains the settings for creating the pulse modulation
signal internally.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.5, "SOURce:PULM subsystem", on page 457.

● Pulse generator > general settings......................................................................... 88
● Pulse generator > pulse train settings.....................................................................91
● Import/export list files.............................................................................................. 95
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5.4.4.1  Pulse generator > general settings

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Generator".

Settings

Pulse Mode................................................................................................................... 88
Trigger Mode.................................................................................................................89
Pulse Period..................................................................................................................90
Pulse Width................................................................................................................... 90
Double Pulse Width.......................................................................................................90
Pulse Delay................................................................................................................... 90
Double Pulse Delay.......................................................................................................90
Pulse Output State........................................................................................................ 90
Show/Show Connector..................................................................................................91
Pulse Output Polarity.................................................................................................... 91
Execute Single Trigger..................................................................................................91
Pulse Sync Out............................................................................................................. 91

Pulse Mode
Sets the operating mode of the pulse generator. Depending on the selection, the instru-
ment displays the associated parameters.
"Single" Generates a single pulse in one pulse period.

1 = Pulse delay
2 = Pulse width
3 = Pulse period
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"Double" Generates two pulses in one pulse period.

1 = Pulse width
2 = Double pulse delay
3 = Double pulse width
4 = Pulse period

"Train" Option: R&S SMBB-K27
Generates a user-defined pulse train.

1 = 1st pulse: On-time
2 = 1st pulse: Off-time
3 = 1st pulse: pulse period
4 = 2nd pulse: repeated 3 times
5 = 3rd pulse
6 = 4th pulse

See Section 5.4.4.2, "Pulse generator > pulse train settings",
on page 91.

Remote command: 
[:SOURce<hw>]:PULM:MODE on page 459

Trigger Mode
Selects between continuous triggering or triggering initiated by a trigger event from an
external signal.
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See also "Input and output connectors" on page 69.
"Auto" Generates the internal modulation signal continuously.
"Single" The pulse generator is triggered by an internal trigger event, initiated

with Execute Single Trigger.
The pulse signal is generated once.

"Ext Single" Generates a single pulse signal, triggered by an external signal.
"Ext Triggered" Generates the pulse signal each time an external trigger event

occurs.
"Ext Gated" Generates the signal triggered by an external gate signal.

For more information, refer to the specifications document.
Remote command: 
[:SOURce<hw>]:PULM:TRIGger:MODE on page 459

Pulse Period
Sets the repetition rate of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:PULM:PERiod on page 460

Pulse Width
Sets the pulse duration of the generated pulse signal.
Note: The pulse width must be at least 20 ns less than the set pulse period.
Remote command: 
[:SOURce<hw>]:PULM:WIDTh on page 460

Double Pulse Width
Sets the width of the second pulse.
Remote command: 
[:SOURce<hw>]:PULM:DOUBle:WIDTh on page 461

Pulse Delay
Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts. The pulse delay is not effective for double pulse
generation.
Remote command: 
[:SOURce<hw>]:PULM:DELay on page 460

Double Pulse Delay
Sets the delay from the start of the first pulse to the start of the second pulse.
Remote command: 
[:SOURce<hw>]:PULM:DOUBle:DELay on page 461

Pulse Output State
Activates the output of the pulse modulation signal.
Remote command: 
[:SOURce<hw>]:PGENerator:OUTPut[:STATe] on page 523
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Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

Pulse Output Polarity
Sets the polarity of the pulse output signal.
Remote command: 
[:SOURce<hw>]:PGENerator:OUTPut:POLarity on page 522

Execute Single Trigger
If "Trigger Mode = Single", initiates a single pulse sequence manually.
Remote command: 
[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate on page 460

Pulse Sync Out
Assigns the pulse synchronization signal to the [Signal Valid] connector at the rear
panel.
"checked" Sets the validity of the RF signal at the output:

● high: while the signal settles.
● low: when it is stable (valid).

"cleared" Generates a single pulse at the beginning of a pulse sequence, e.g.
to synchronize pulse modulation.

Remote command: 
[:SOURce<hw>]:PULM:OUTPut:SYNC[:STATe] on page 462

5.4.4.2  Pulse generator > pulse train settings

Option: see Section 5.1, "Required options", on page 68.

Access:

1. Select "Modulation" > "Pulse Modulation > Pulse Generator" > "Pulse Mode =
Train".
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2. Select "Pulse Train Data".

3. Select an existing file or select "New" to create one.

4. Define the filename.
Select "Edit Pulse Train Data", if the file is empty or to control and change the val-
ues.

5. In the "Edit Pulse Train Data" dialog, enter the pulse on/off times and pulse repeti-
tion values.

6. Select "Save".

A pulse train is a sequence of pulses with user-defined repetition, and pulse on and
off times. Once defined, pulse train settings can be saved in a file. The filename is
user-definable; the file extension (*.pulstrn) is assigned automatically.
When a file is selected, the filename is indicated.

Possible ways to configure a pulse train

You can configure a pulse train in the following ways:
● Internally

– Use the built-in editor table editor, see in the "Pulse Generator > Pulse Train"
dialog.
Once defined, pulse train settings can be saved in a file. For example, to
exchange configuration between instruments or to modify the file content with
an external program and reload them again.
The filename is user-definable; the file extension is *.pulstrn.

– Using the corresponding remote-control commands.
Note that you have to create a pulse train file first.

● Externally
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Create a pulse train sequence as a CSV file with Microsoft Excel, with a Notepad
or a similar tool, save it with the predefined extension. Transfer the file to and load
it into the instrument.

Pulse train ASCII file format

Files describing pulse trains are simple files in text or comma-separated value (CSV)
file format. The filename is user-definable; the file extension is *.csv or *.txt.

The file contains a list of pulse definition values, one row per pulse; a new line indicator
separates the pulses. Pulses are defined with their pulse on time, pulse off time given
in us and number of repetitions.

Example: Pulse train file content (*.txt file)
0.0001,0.0005,2
0.00025,0.0005,1
0.0001,0.0003,3

For file handling, use the standard functions in the "File Manager", see Section 10.9,
"Using the file manager", on page 237.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.5, "SOURce:PULM subsystem", on page 457.

Settings

Pulse Train Data............................................................................................................93
Edit Pulse Train Data.................................................................................................... 94
Data handling keys........................................................................................................94

└ Go To.............................................................................................................. 94
└ Edit..................................................................................................................94
└ Save As/Save................................................................................................. 94

Fill..................................................................................................................................94

Pulse Train Data
Accesses the standard "File Select" function of the instrument. The provided navigation
possibilities in the dialog are self-explanatory.
Pulse train files are files with predefined file extension *.pulstrn. When a file is
selected, the dialog indicates the filename.
You can create the file internally in the table editor or externally.
● To select an existing file, select "Select List > navigate to the file *.pulstrn > Select"
● Use the general editor function to create internally new file or to edit an existing

one.
● Use the standard file manager function to load externally created files to the instru-

ment.
Remote command: 
[:SOURce<hw>]:PULM:TRAin:CATalog? on page 464
[:SOURce<hw>]:PULM:TRAin:SELect on page 466
[:SOURce<hw>]:PULM:TRAin:DELete on page 464
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Edit Pulse Train Data
Accesses the build-in table editor to define a new pulse train file or edit an existing one.
"On-Time, µs/Off-Time,µs"

Sets the pulse on and pulse off time.
"Count" Sets the number of repetitions of an "On-/ Off-Time" value pair.

Pulses with "Count = 0" are ignored.
Use this method to skip value pairs temporarily, without deleting them
from the table.

Remote command: 
[:SOURce<hw>]:PULM:TRAin:ONTime on page 465
[:SOURce<hw>]:PULM:TRAin:OFFTime on page 465
[:SOURce<hw>]:PULM:TRAin:REPetition on page 465
[:SOURce<hw>]:PULM:TRAin:DELete on page 464

Data handling keys
Standard functions for file and data handling.

Note: Save a list only after filling both columns (frequency and level), otherwise the
entries are lost.

Go To ← Data handling keys
Selects a row for editing.

Edit ← Data handling keys
Enables you to insert, or delete a row or ranges within a list, and provides access to a
dialog for automatic filling.
See "Fill..." on page 94.

Save As/Save ← Data handling keys
Saves the list in a file with user-defined name and predefined file extension. To save a
copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.
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To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".

5.4.4.3  Import/export list files

Access:

1. Select one of the following:

● "Sweep" > "List mode".
● "Level" > "User Correction".
● "Modulation > Pulse Modulation > Pulse Generator > Pulse Mode = Train".
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2. Select "Import/Export".

Figure 5-2: Im-/Export dialog (example with UCOR settings)

The "Import/Export" dialog contains all functions and settings to import externally
created list data or to export it accordingly. You can process and store a list in the
formats *.txt (ASCII), or *.csv (plain text with identical sequence of fields). The
table separators and the decimal floating point numbers are customizable.

Settings:

Mode............................................................................................................................. 96
ASCII File Settings........................................................................................................ 96
Select (ASCII) Source/Select (ASCII) Destination........................................................ 97
Select Source/Select ASCII Destination....................................................................... 97
Import / Export...............................................................................................................97

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 520
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 466

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".

Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 519
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[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 483
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 467

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 468

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 520
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 484
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 468

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 519
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 468
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5.4.5  Pulse graph

Option: see Section 5.1, "Required options", on page 68.

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Graph".

The pulse graph is the graphical representation of the current pulse signal.

The height of the bars corresponds to the selected amplitude of the pulse signal.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.5, "SOURce:PULM subsystem", on page 457.

File Name
Indicates the name of the pulse train data file.
To create or select a file, see "Pulse Train Data" on page 93.
Remote command: 
[:SOURce<hw>]:PULM:TRAin:SELect on page 466

Zooming
You can zoom into the diagram to visualize the graph in more detail:
● "Zoom Position": Sets the focus on the time axis where to enlarge the graph.
● "Zoom In": Enlarges the graph at the selected position.
● "Zoom Out" for the reverse operation.

Modulation settings
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5.4.6  Pulse external / trigger settings

Access:

► Select "Modulation" > "Pulse Modulation > Pulse External / Trigger".

The dialog specifies some characteristics of the Pulse Ext. connector.
This connector is common for the pulse generator and the pulse modulator. For an
overview, see "Input and output connectors" on page 69.

The remote commands required to define these settings are described in Sec-
tion 13.16.1.5, "SOURce:PULM subsystem", on page 457.

Settings

Polarity.......................................................................................................................... 99
Impedance.................................................................................................................... 99
Show/Show Connector..................................................................................................99

Polarity
Sets the polarity of the active slope of a pulse input signal, that is the external pulse
modulation signal.
Remote command: 
[:SOURce<hw>]:PULM:POLarity on page 462

Impedance
Sets the input impedance.
Remote command: 
[:SOURce<hw>]:PULM:IMPedance on page 463

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

Modulation settings
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5.4.7  FM, PhiM and AM modulation sources

Access:

► Select "Modulation > Modulation Sources".

In the "Sources" tab, you can configure an LF modulation signal for performing
analog modulations. It includes the setting parameters of the internal LF-and multi-
function generators, the noise generator, and an external signal source.

● Source > LF generator settings.............................................................................100
● Source > external settings.................................................................................... 104
● Source > noise generator settings........................................................................ 105

5.4.7.1  Source > LF generator settings

Access:

► Select "Modulation" > "Modulation Sources > LF Generator".

The internal LF signal can the modulation signal source for any of the analog mod-
ulations. The LF signal applies to all modulations which use the internal modulation
signal. Therefore, any modification of the LF signal immediately affects all currently
active modulations.

The remote commands required to define these settings are described in Sec-
tion 13.16.6, "SOURce:LFOutput subsystem", on page 495.

Modulation settings
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Settings

State (LF frequency sweep)........................................................................................ 101
Shape..........................................................................................................................101
Frequency................................................................................................................... 103
Period..........................................................................................................................103
Pulse Width................................................................................................................. 103
Pulse Duty Cycle.........................................................................................................103
Triangle Rise............................................................................................................... 104
Trapezoid Rise / Fall................................................................................................... 104
Trapezoid High............................................................................................................104

State (LF frequency sweep)
Status of the LF frequency sweep signal.
You find this parameter in two dialogs:
● "LF Frequency Sweep" turns on/off the signal generation.

See Sweep mode settings for access.
● "Analog Modulation Sources" displays the current state (read-only). If it is turned

on, this dialog provides the varying sweep frequency, see Current Frequency.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput:FREQuency:MODE on page 499

Shape
Option: R&S SMBB-K24.
Selects the waveform shape of the LF generator signal.
"Sine"

1 = Period

Modulation settings



Analog modulationsR&S®SMB100B

102User Manual 1178.3711.02 ─ 11

"Square"

1 = Period

"Pulse"

1 = Pulse width
2 = Pulse period

"Triangle"

1 = Triangle rise
2 = Triangle period

Modulation settings
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"Trapezoid"

1 = Trapezoid rise
2 = Trapezoid high
3 = Trapezoid fall
4 = Trapezoid period

Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe on page 501

Frequency
Sets the frequency of the LF generator for sine signals.
Set the signal shape with the parameter Shape.
Remote command: 
[:SOURce]:LFOutput<ch>:FREQuency on page 497

Period
Sets the repetition rate of the generated LF signal for triangle, trapezoid or pulse
shapes, see Shape.
The period of sine signals is calculated from the selected Frequency
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod on page 503
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod on page 504
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod on page 502

Pulse Width
Sets the pulse duration of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh on page 502

Pulse Duty Cycle
Sets the ratio between the pulse duration and the pulse period in percent.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle on page 502
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Triangle Rise
Sets the time required for the triangle signal to change from low level to high level.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE on page 504

Trapezoid Rise / Fall
Sets the time required for the trapezoid signal to change from low level to high level,
and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE on page 503
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL on page 502

Trapezoid High
Sets how long the trapezoid signal is at high level.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH on page 503

5.4.7.2  Source > external settings

Access:

► Select "Modulation" > "Modulation Sources > External".

The "External" settings section contains all parameters required to configure the
signal of an externally supplied LF signal.

The remote commands required to define these settings are described in Sec-
tion 13.16.5, "SOURce:INPut subsystem", on page 493.
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Settings

Coupling (AC/DC)....................................................................................................... 105
Impedance.................................................................................................................. 105
Bandwidth................................................................................................................... 105
Show/Show Connector................................................................................................105

Coupling (AC/DC)
Selects the coupling mode (AC or DC) for the external signal.
"AC" Disconnects the DC voltage component and uses only the AC com-

ponent of the modulation signal.
"DC" Uses the modulation signal with both components, AC and DC.
Remote command: 
[:SOURce<hw>]:INPut:MODext:COUPling on page 494

Impedance
Sets the impedance for the externally supplied signal.
Remote command: 
[:SOURce<hw>]:INPut:MODext:IMPedance<ch> on page 494

Bandwidth
Displays the maximum bandwidth of the external LF signal.
Remote command: 
[:SOURce]:LFOutput<ch>:BANDwidth? on page 497

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

5.4.7.3  Source > noise generator settings

Access:

► Select "Modulation" > "Modulation Sources > Noise Generator".

Modulation settings
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The "Noise Generator" settings contain all parameters to configure the signal of the
internal noise generator.

The remote commands required to define these settings are described in Sec-
tion 13.16.8, "SOURce:NOISe subsystem", on page 520.

Settings

Distribution.................................................................................................................. 106
Bandwidth................................................................................................................... 106

Distribution
Selects the distribution of the noise power density.
"Gauss" Generates the noise power according to a Gaussian distribution.
"Equal" Generates an evenly distributed noise.
Remote command: 
[:SOURce<hw>]:NOISe:DISTribution on page 521

Bandwidth
Sets the noise bandwidth as distinct value.
You can set the bandwidth between 100 kHz and 10 MHz in 100 KHz steps.
Remote command: 
[:SOURce<hw>]:NOISe:BANDwidth|BWIDth on page 521

Modulation settings



Analog modulationsR&S®SMB100B

107User Manual 1178.3711.02 ─ 11

5.4.8  LF signal output settings

Access:

► Select "Modulation" > "LF Output".

In the "LF Output" tab, you can configure the signal at the LF outputs, determine
the output voltage or add a DC offset. Activate both paths to output the sum signal
of the two sources.

Settings

State............................................................................................................................107
Source.........................................................................................................................108
Show/Show Connector................................................................................................108
Output Voltage............................................................................................................ 108
DC-Offset.................................................................................................................... 108
Source Impedance...................................................................................................... 108
Load Impedance......................................................................................................... 108
Noise Level................................................................................................................. 109

└ Noise Density................................................................................................109
└ Noise Level................................................................................................... 109

State
Activates the output of the LF signal.
Remote command: 
[:SOURce]:LFOutput<ch>[:STATe] on page 499

Modulation settings
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Source
Select the sources for the signal output at the LF connector. If you activate path 1 and
2, those sources are added.
Use the "Show Connector" function to find out where this connector is located.
"LF Generator 1/2"

Selects one of internally generated LF signals.
"AM" Option: R&S SMBB-K720

Selects the AM signal.
"FM/PhiM" Option: R&S SMBB-K720

Selects the signal also used by the frequency or phase modulations.
"Noise Generator"

Selects the internally generated noise signal.
"External" Selects an externally supplied LF signal.
Remote command: 
[:SOURce]:LFOutput<ch>:SOURce on page 500

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

Output Voltage
Sets the peak to peak voltage of the selected LF output source.
This value, e.g. +1 V to -1 V refers to 50 Ohm at the RF output with high termination
impedance at the LF output.
Remote command: 
[:SOURce]:LFOutput<ch>:INTernal:VOLTage on page 500

DC-Offset
Adds a DC offset to the LF output signal.
Remote command: 
[:SOURce]:LFOutput:OFFSet on page 500

Source Impedance
Selects the output impedance of the LF generator.
"50 Ω"

Selects an output impedance of 50 Ω.

"600 Ω" Selects an output impedance of 600 Ω.

Remote command: 
[:SOURce]:LFOutput:SIMPedance on page 501

Load Impedance
Sets the specification of the load impedance interconnected to the LF generator output.
This parameter is available in case of activated R&S SMB100A or R&S SML0x emula-
tions only, see "Remote Access Settings" > "Instrument Emulations" > "Language"
on page 317.

Modulation settings



Analog modulationsR&S®SMB100B

109User Manual 1178.3711.02 ─ 11

These signal generators come with an LF generator source impedance of 10 Ohm
which is not available with the R&S SMB100B.
The set LF generator load impedance enables the R&S SMB100B to emulate the
10 Ohm LF generator source impedance of these generators by a corresponding
increase of the open circuit LF generator output voltage.
The load impedance setting is not affected by an instrument preset ([Preset] key or
*RST), restart or the "Save/Recall" function. It is reset to the default value of 1 MOhm
by a factory preset only.
Remote command: 
n.a.

Noise Level
Access:
● Select "Modulation" > "Output > Noise Level".

Noise Density ← Noise Level
Indicates the level of the noise signal for a bandwidth of 1 Hz (relative).
Remote command: 
[:SOURce<hw>]:NOISe:LEVel:RELative? on page 521

Noise Level ← Noise Level
Indicates the level of the noise signal per Hz within the total bandwidth (absolute).
Remote command: 
[:SOURce<hw>]:NOISe:LEVel[:ABSolute]? on page 521

5.4.9  Overview

Option: AM and FM/PM require R&S SMBB-K720

Modulation settings
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Access:

► Select "Modulation" > "Modulation Sources > Overview".

Blue color = Active output signal (AM and FM)
Gray color = Inactive output signal (LF Out)
Miniature graph = Indicates an active source
Connectors = Indicate a connector (e.g. external signal) is involved in the path of the signal

The "Overview" tab is an interactive diagram that indicates the active modulations
and the signal being output.
Here you can:
● Select the output signal ("LF Out") in one or two paths; the setting acts as the

parameter "LF Output Source"
● Select the source for each modulation and modulation path; the setting acts as

the parameter "Source"
● Activate modulation in one or two paths; the setting acts as the parameter

"State"
To generate a two-tone signal composed from the two paths of the same modu-
lation type, activate both paths.

● The "FM" box allows switching to "PhiM", but those modulations are mutually
exclusive.

LFOut
Label for the LF output settings in the overview.
Remote command: 
n.a.

Modulation settings
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AM
Label for the amplitude modulation settings in the overview.
Remote command: 
n.a.

FM/PhiM
Selects the modulation signal to be assigned to the output. You can assign the fre-
quency or phase modulated signal.
Remote command: 
n.a.

5.5  How to generate an amplitude modulated signal

The following examples use the internal LF generator.

To set the frequency and level of the RF signal

1. Press [Preset] to start from a defined state.

2. In the status bar, set "Frequency = 2 GHz".

3. Set "Level = -20 dBm".

To configure the modulation signal (LF generator)

1. Select "Modulation" > "Modulation Source".

2. In the "Sources" tab, select "Shape > Sine".

3. Set "Frequency = 20 kHz".

The period is calculated automatically and indicates "Period = 50.00 µs".

To configure the amplitude modulation settings

1. In "Modulation" dialog, select the "AM" tab.

2. Set "Source = LF Generator1"

3. Set "Depth = 30%"

4. Select "State = I" to activate the modulation.

5. Set "Level > RF ON" to enable signal output.

5.6  How to generate a pulse modulated signal

The following example uses the internal pulse generator.

How to generate a pulse modulated signal
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To set the frequency and level of the RF signal

1. Press [Preset].

2. In the status bar, set "Frequency = 4 GHz".

3. Set "Level = -25 dBm".

To configure the pulse generator

1. Select "Modulation" > "Pulse Generator".

2. Select "Pulse Mode = Double".

3. Set "Pulse Period = 10 us".

4. Set "Pulse Width = 2 us".

5. Set "Double Pulse Width = 1.2 us".

6. Set "Double Pulse Delay = 4.5 us".

7. Activate "Pulse Output State".

8. Set "Trigger Mode = Auto".

In the "Pulse Graph" tab, you can view the generated pulse signal graphically.

To enable pulse modulation

1. Select the "Pulse Modulation" tab.

2. Set "State = I" to activate pulse modulation.

3. Set "Level > RF ON" to enable signal output.

5.7  How to generate a pulse train modulated signal

The following example uses the internal pulse generator.

To set the frequency and level of the RF signal

1. Press [Preset].

2. In the status bar, set "Frequency = 6 GHz".

3. Set "Level = -25 dBm".

To configure the pulse generator

1. Select "Modulation" > "Pulse Generator".

2. Select "Pulse Mode = Train".

3. Select "Pulse Train Data".
Accesses the standard function for file handling.

How to generate a pulse train modulated signal
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4. Select an existing file or select "New" to create one.

5. Define the filename.
Select "Edit Pulse Train Data", if the file is empty or to control and change the val-
ues.

6. In the "Edit Pulse Train Data" dialog, enter the pulse on/off times and pulse repeti-
tion values.

For example:
● "On-Time = 500 us", "OFF-Time = 2 ms", "Count = 2"
● "On-Time = 100 us", "OFF-Time = 2.5 ms", "Count = 1"
● "On-Time = 10 us", "OFF-Time = 50 us", "Count = 10"

7. "Save" the file and close the dialog.
The instrument returns to the /var/user/ where it has saved the file.

8. Select the file in the directory.

9. Confirm with "Select".

10. In the "Pulse Generator" dialog, select "Pulse Output State = On".

11. Set "Trigger Mode = Auto".

In the "Pulse Graph" tab, you can view the generated pulse signal graphically.

To enable pulse train modulation

1. Select the "Pulse Modulation" tab.

2. Set "State = I".

3. Set "Level > RF ON" to enable signal output.

How to generate a pulse train modulated signal
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6  Multiplying RF output frequencies

6.1  About frequency multipliers

The R&S SZM multiplies the input frequency by its multiplication factor. Depending on
the R&S SZM base unit, you can optionally install high output power, an attenuator or
an isolator. All three options are integrated in the same housing as the frequency multi-
plier, which simplifies setups and the operation compared to conventional setups.

In addition, you can connect an optional external test port adapter (TPA) which is a
straight waveguide and simplifies connection of the DUT. The TPA protects internal
assemblies and their flange and if damaged, you can replace it.

The R&S SMB100B signal generator can communicate with an R&S SZM via USB. For
the USB communication between the R&S SMB100B and the frequency multiplier
R&S SZM, the R&S SMBB-K554 key must be installed on the R&S SMB100B. In case
a mechanically or electronically controlled attenuator is installed, the pre-calibrated fre-
quency response values of the multiplier are read out via USB by the R&S SMB100B.
Also the multiplication factor is automatically set in the R&S SMB100B and the correct
incident power of +7 dBm to the R&S SZM. Therefore, the instruments are able to pro-
vide a precise R&S SZM output signal for the DUT for a specific frequency.

Required options

● For operation of the R&S SZM with the R&S SMB100B via USB the R&S SMBB-
K554 option Multiplier Control must be installed on the R&S SMB100B.

● Depending on the frequency multiplier used and its multiplication factor, different
input frequency ranges are required. The R&S SMB100B must at least cover this
input frequency range.
For details on the R&S SZM input frequency ranges, see the R&S SZM specifica-
tions document.

Control of the R&S SZM via USB

If the control connection between R&S SMB100B and R&S SZM is established, the fol-
lowing features are available:
● The right multiplication factor and incident power on the R&S SMB100B is auto-

matically set in accordance to the connected R&S SZM.
● The connected R&S SZM is shown in the R&S SMB100B taskbar. If the mechani-

cally controlled attenuator option is installed on the R&S SZM, the value of the
micrometer screw for the correct R&S SZM output power is shown in the taskbar.

● Read out of the frequency response of the connected R&S SZM without internal
attenuator option.

● Read out the calibration data of the R&S SZM if an internal attenuator option is
installed

● You can correct cable losses of the connecting cable between the frequency multi-
plier and the R&S SMB100B.

About frequency multipliers
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Impact of operating modes and functions

The output level of the RF signal is determined by the operation mode that the instru-
ment generates the signal and also by the level correction functions the generator pro-
vides to optimize the accuracy of the level.

Some of these functions affect the operation with an R&S SZM. To avoid impact, the
generator automatically switches off the associated operating modes once an
R&S SZM is connected via USB.

Interactions and special characteristics to the operating modes of the R&S SMB100B
when an R&S SZM is connected:
● AM (amplitude modulation): blocked
● List mode: blocked
● Sweep mode: It is recommended that you use an R&S SZM with electronically con-

trolled attenuator to generate an RF signal in frequency or level sweep mode. Also
note the response times of the dwell time in the specifications document of the
R&S SZM.

6.2  Operating frequency multipliers

This section provides an overview on step-by-step instructions related to connecting
and configuring frequency multipliers.

It includes the following:

● Test setup..............................................................................................................115
● Connecting a frequency multiplier.........................................................................116
● Controlling the frequency multiplier.......................................................................117
● Generating RF output signals............................................................................... 121

6.2.1  Test setup

The R&S SMB100B supports the following frequency multiplier types:
● R&S SZM

For details, see the specifications document of the R&S SMB100B.

OTA microwave test setup

Typically, mmWave signals are transmitted and received over-the-air (OTA) inside an
RF shield box. The figure below illustrates a test setup with a frequency multiplier con-
nected to a signal generator and an antenna that is mounted inside an RF shield box.

The signal generator provides the IF signal to the frequency multiplier. The frequency
multiplier multiplies the IF signal from the signal generator and transmits the RF signal
to the DUT.

Operating frequency multipliers
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Signal 
Generator

RF

USB
DUT

RF shield box

control

RF input

SZM

RF

Figure 6-1: Typical setup using a frequency multiplier

Frequency multiplier connection

You can control a frequency multiplier via USB by one R&S SMB100B that exclusively
controls the frequency multiplier.

The R&S SMB100B
● Reads out the frequency multiplication factor of the R&S SZM
● Reads out the serial number of the R&S SZM
● Sets the R&S SZM incident power on the R&S SMB100B RF output

6.2.2  Connecting a frequency multiplier

This section provides step-by-step descriptions for connecting a frequency multiplier.
Connecting procedures for relevant connector types are described for the R&S SZM as
an example.

To connect an R&S SZM

The following procedure describes how to connect the R&S SMB100B to an R&S SZM
using the "RF 50 Ω" connector as IF signal output. The R&S SZM and R&S SMB100B
are connected to power and switched on.

1. Use all cables delivered with the R&S SZM. Other connections can require addi-
tional cables.
For the control connection, use the high-quality USB cable provided with the deliv-
ery.
For the IF connection, we recommend using a coaxial cable with K connectors,
50 Ω, length 1.0 m. The cable is available under order number 1348.3850.00 (see
recommended extras in the R&S SZM specifications document).
See "Cable selection to minimize electromagnetic interference" on page 24.

2. NOTICE! Risk of SMA connector damage and cable damage. Excessive tightening
can damage the connecting cable, the SMA connectors and components inside the
R&S SMB100B.
Connect the "RF 50 Ω" connector of the R&S SMB100B with the "RF In" connector
of the R&S SZM.
See also Section 3.1.9, "Connecting to RF coaxial connectors", on page 26.

3. Connect the "USB" connector with the "USB" connector of the R&S SZM.

Operating frequency multipliers
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See also "To connect a frequency multiplier" on page 26.

Table 6-1 and Figure 6-2 provide an overview on connections and a test setup.
Table 6-1: Signals and connections

Signal R&S SMB100B R&S SZM

Control USB connector "USB"

RF "RF 50Ω" "RF In"

Signal 
Generator

RF

USB
DUT

RF shield box

control

RF input

SZM

RF

Figure 6-2: Test setup with R&S SMB100B, R&S SZM and RF shield box

Signal generator = R&S SMB100B

6.2.3  Controlling the frequency multiplier

This section provides step-by-step descriptions for controlling, updating and operating
a frequency multiplier with the R&S SMB100B. For controlling the frequency multiplier
R&S SZM via USB, the R&S SMBB-K554 key must be installed on the R&S SMB100B.

The descriptions cover the following topics:

● "To configure the R&S SMB100B" on page 117
● "To configure for R&S SZM with no attenuator option installed" on page 119
● "To configure for R&S SZM with electronically attenuator option installed"

on page 120
● "To configure for R&S SZM with mechanically attenuator option installed"

on page 120

To configure the R&S SMB100B

The following procedure describes how to configure the R&S SMB100B to establish a
control connection between R&S SMB100B and a frequency multiplier.

The R&S SMB100B is connected to the R&S SZM, see "To connect an R&S SZM"
on page 116.

1. Select "System Configuration" tile > "System Configuration".

The "External RF" dialog opens.

2. Click "External Instrument > Config".

The "Remote Instrument" dialog for configuration of the external instrument opens.

3. Select the R&S SZM from the "External Instrument" list.

Operating frequency multipliers
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4. Select "Apply and Connect".

A message displays if the remote connection to the external frontend is success-
fully established.

Figure 6-3: Message displaying an established remote connection

5. Configure the connection mode between R&S SZM frequency multiplier and
R&S SMB100B:

a) Click "Frontend Configuration".

b) Check the "Settings".
See Section 6.3.3.1, "General settings", on page 127.

c) Check the "Versions/Options".
See Section 6.3.3.2, "Versions and options information", on page 128.

d) If necessary, activate "Cable Correction".
See Section 6.3.3.3, "Cable correction settings", on page 130.

6. In the "System Config > System Configuration > External RF" dialog, check the
control connection state.

Operating frequency multipliers
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The "RF" > "Rem Conn" field displays an active control connection: 

7. Optionally, specify connection characteristics:

a) Select "Auto Connect > On".
If you select this setting, you do not need to execute steps 1 to 6 each time you
reconnect the R&S SZM to the R&S SMB100B via USB.

b) Select "Preset behavior: Keep connections to external instruments > On".

To configure for R&S SZM with no attenuator option installed

When using a base instrument without the attenuator option R&S SZM-BxxE or
R&S SZM-BxxM installed:

1. Enter the "Frequency" value in the "Frequency" field on the home screen.

Note: The "Level" field is grayed out and shows the output power of the R&S SZM.
The R&S SMB100B reads out this number from a calibration table internally stored
on the R&S SZM.

2. Switch on the RF on the front panel of the R&S SMB100B.

Operating frequency multipliers
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To configure for R&S SZM with electronically attenuator option installed

When using a base instrument with the attenuator option R&S SZM-BxxE installed:

1. Enter the "Frequency" value in the "Frequency" field on the home screen.

2. Enter the "Level" value in the "Level" field on the home screen.

3. Switch on the RF on the front panel of the R&S SMB100B.

To configure for R&S SZM with mechanically attenuator option installed

When using a base instrument with the attenuator option R&S SZM-BxxM installed:

1. Enter the "Frequency" value in the "Frequency" field on the home screen.

Operating frequency multipliers
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2. Enter the "Level" value in the "Level" field on the home screen.

3. Set the micrometer screw to the value displayed in the taskbar on the left.
After setting the micrometer screw to the displayed value, the previously set level
and the corresponding frequency is output at the R&S SZM.

Note: Position 0 µm is equivalent with maximum attenuation that means minimum
signal level according to the set frequency.

6.2.4  Generating RF output signals

To multiply the RF output signal frequency

This manual operation is only necessary if there is no USB connection between
R&S SMB100B and R&S SZM.

To multiply the input frequency by individual factor due to the frequency range:

1. Select the "Frequency" tile.

2. Select "Frequency".

3. Enter the "Multiplier" value.

To output the external frontend RF signal

The procedure assumes, that a remote control connection between R&S SMB100B
and R&S SZM is established.

See "To configure the R&S SMB100B" on page 117.

► Activate the RF output.

Operating frequency multipliers
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See "To activate the RF output signal" on page 57.

6.3  External RF configuration and settings

● External RF settings..............................................................................................122
● Remote instrument settings.................................................................................. 124
● RF frontend settings..............................................................................................126

6.3.1  External RF settings

Access:

► Select "System config" tile > "System Configuration" > "External RF" tab.

In the "External RF" tab you can connect the frequency multiplier with the
R&S SMB100B, see "To configure the R&S SMB100B" on page 117.

Settings:

Connect/Disconnect.................................................................................................... 122
Auto Connect.............................................................................................................. 123
Preset behavior: Keep connections to external instruments....................................... 123
Direction...................................................................................................................... 123
External Instrument..................................................................................................... 124
Remote Connection Status......................................................................................... 124
Instrument Name.........................................................................................................124

Connect/Disconnect
Triggers the instrument to:
● Establish the remote connections to all configured external instruments.

External RF configuration and settings
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● Terminate all existing remote connections. The external instruments are not
removed from the list of external instruments. Only the remote connection status
changes.

Remote connection status can be toggled with the parameter Remote Connection Sta-
tus.
To ensure that the remote connections to the external instruments will be automatically
established after the instrument's startup or a reboot, set Auto Connect > "On".
Remote command: 
:SCONfiguration:EXTernal:REMote:CONNect[:ALL] on page 438
:SCONfiguration:EXTernal:REMote:DISConnect[:ALL] on page 438

Auto Connect
With enabled auto connect function, the instrument automatically detects connected
external instruments and establishes the required connection.
If the "Auto Connect > Off", however, after a R&S SMB100B startup you have to revise
the test setup and perform the following:
● Check whether the necessary connections between the R&S SMB100B and the

external instruments are still existing.
● Prove that the remote control of the particular instruments is required.
● Trigger the Connect function.
Remote command: 
:SCONfiguration:EXTernal:ACONnect on page 438

Preset behavior: Keep connections to external instruments
Sets the effect of R&S SMB100B preset ([Preset] or *RST) on the following:
● The connection status between the instrument and the connected external instru-

ments.
● The R&S SMB100B itself and the preset values.
● The connected instruments.

"Preset behavior..." Off On

R&S SMB100B and preset
values

Standard R&S SMB100B preset

See Table 10-1.

● RF = max. frequency of the connected fre-
quency multiplier

● RF > Off

Connection status Terminated ("Disconnect All Remote") Unchanged

Connected instruments External instrument preset (:DEVice:PRESet) External instrument preset

Remote command: 
:SCONfiguration:EXTernal:PBEHaviour on page 438

Direction
Displays the connector direction as a color coded field.
"Out" The RF connector is used as output.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:DIRection? on page 439

External RF configuration and settings
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External Instrument
Accesses a dialog with settings that help you to establish the connection to the exter-
nal instruments, see Section 6.3.2, "Remote instrument settings", on page 124.

Remote Connection Status
Indicates the status of the remote connection. Click the status indicator to toggle the
remote connection status.
To connect/disconnect all external instruments, use the functions Connect/Disconnect.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:RCONnection:STATe? on page 439

Instrument Name
Displays useful information on the connected external instrument, like the instrument
designation.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:INAMe? on page 439

6.3.2  Remote instrument settings

Access:

► Select the "System Configuration" tile > "System Configuration" > "External Instru-
ment" > "Config".

The "Remote Instrument" tab provides settings to connect the frequency multiplier.

External RF configuration and settings
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Settings:

Clean All......................................................................................................................125
External Instrument..................................................................................................... 125
Set Symbolic Name.....................................................................................................125
Remote Channel......................................................................................................... 125
Hostname or IP Address............................................................................................. 125
Device ID.....................................................................................................................125
Apply........................................................................................................................... 126
Apply and Connect......................................................................................................126
Frontend Configuration............................................................................................... 126

Clean All
The "Clean All" function unselects the external instrument, disables the connection and
removes all configured settings of the external instrument in the system configuration.
It also removes all instruments not connected via USB cable to the R&S SMB100B
from the "External Instrument" list.
Remote command: 
:SCONfiguration:EXTernal:REMote:CLEan on page 441

External Instrument
Lists all available instruments.
● Select the external instrument from the list of available instruments. The required

settings are retrieved and updated automatically.
● "None": Unselects the external instrument and disables the connection.
Remote command: 
:SCONfiguration:EXTernal:REMote:LIST? on page 439

Set Symbolic Name
Sets the alias name of the instrument.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:INFO? on page 440

Remote Channel
Displays the hardware channel used by the remote channel to the external instrument.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:INFO? on page 440

Hostname or IP Address
Displays the hostname or IP address of the connected external instrument.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:INFO? on page 440

Device ID
Displays the device identifier that is a unique string with the following structure:
<frontend type>-<serial number>
For a defined "External Instrument", the information is read out automatically.

External RF configuration and settings
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Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:INFO? on page 440

Apply
Confirms the settings and displays the external instrument in the "External RF" dialog.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:ISELect on page 440

Apply and Connect
Confirms the settings and triggers the connection establishment. In the connected
instruments, the status of this active remote connection is displayed by the "Remote"
indication.
Remote command: 
:SCONfiguration:EXTernal:RF<ch>:REMote:ICONnect on page 440

Frontend Configuration
Requires R&S SMBB-K554.
Accesses the "RF Frontend" dialog to configure settings of the connected external
instrument.
See Section 6.3.3, "RF frontend settings", on page 126.

6.3.3  RF frontend settings

Access:

► Select one of the following in the home screen:
● Select "Clk Syn / FE / Pow Sens" tile > "RF Frontend" > "Frontend Device".

External RF configuration and settings
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● Select "System Config" tile > "System Configuration" > "External RF > External
Instrument > Config" > "Remote Instrument > Frontend Config".

The "RF Frontend" dialog provides tabs for settings and information about the
external instrument.

The remote commands required to define the settings are described in Sec-
tion 13.16.3, "SOURce:EFRontend subsystem", on page 484.

To operate an external frontend with the R&S SMB100B

See Section 6.2, "Operating frequency multipliers", on page 115.

Settings:

● General settings....................................................................................................127
● Versions and options information..........................................................................128
● Cable correction settings.......................................................................................130

6.3.3.1  General settings

Access:

1. Select "Clk Syn / FE / Pow Sens" tile > "RF Frontend" > "Frontend Device".

External RF configuration and settings
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2. Select "Settings".

The "Settings" tab provides information about the intermediate frequency for the
connected external frontend, e.g., R&S SZM.

Settings:

Intermediate Frequency
Displays the frequency of the IF signal that is the frequency at the RF 50 Ω connector.
Remote command: 
[:SOURce<hw>]:EFRontend[:FREQuency]:IFRequency[:VALue]?
on page 485

6.3.3.2  Versions and options information

Access:

1. Select "Clk Syn / FE / Pow Sens" tile > "RF Frontend" > "Frontend Device".

External RF configuration and settings
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2. Select "Version / Options".

The "Versions / Options" tab displays information on the firmware and hardware of
the connected external frontend.

Settings:

Firmware..................................................................................................................... 129
Hardware Config......................................................................................................... 129
Options........................................................................................................................130

Firmware
Displays firmware information on the control server and control library of the external
frontend. The information is displayed in a table and consists of installed packages and
versions.
"Package" Comprises the frontend control server and frontend control library.
"Version" Denotes the version of the installed package.
Remote command: 
n.a.

Hardware Config
Displays hardware information of the hardware components of the external frontend.
The information is displayed in a table and consists of component name, its part num-
ber and serial number, and revision version.
"Assembly" Displays the assembly part name for hardware component.
"Part Number" Displays the part number for each hardware component.
"Serial Number"

Displays the serial number for each hardware component.
"Revision" Displays the revision version for each hardware component.

External RF configuration and settings
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Remote command: 
[:SOURce<hw>]:EFRontend:IDN? on page 485

Options
Displays the frontend options installed on the frequency multiplier.
"Option" Displays the name of the frontend option.
"Designation" Displays a short description of the frontend option.
Remote command: 
[:SOURce<hw>]:EFRontend:OPT? on page 486

6.3.3.3  Cable correction settings

Access:

1. Select "Clk Syn / FE / Pow Sens" tile > "RF Frontend" > "Frontend Device".

2. Select "Cable Correction".

The "Cable Correction" tab provides settings necessary to configure the frequency
response correction of the IF signal path.

You can load correction data to compensate for signal losses in the cable occurring at
different IF signal frequencies. Files containing correction data have the extension
*.s2p or *.uco. The following descriptions are exemplary with *.s2p files. Working
with *.uco files is analogous.

External RF configuration and settings
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Settings:

State............................................................................................................................131
Load Cable Correction File......................................................................................... 131
Recommended Frequency Range.............................................................................. 132

State
Activates correction of the IF signal for different IF signal frequencies.
Activation requires loading of a valid cable correction file, see "Load Cable Correction
File" on page 131.
Remote command: 
[:SOURce<hw>]:EFRontend:ALIGnment[:STATe] on page 487

Load Cable Correction File
Accesses a standard file-select dialog to load correction data to compensate for signal
losses in the cable occurring at different IF signal frequencies.
If a correction file is loaded, the button also displays the filename.
You can load predefined cable correction files from frontend-specific folders. The pre-
defined cable correction files stored on the R&S SMB100B contain correction data for
the recommended standard R&S IF cable, using the S-parameter S21.

Example: Displaying file correction data
The example for the *.s2p file below comprises correction data for frequencies from
0 GHz to 7.5 GHz.
# HZ S DB R 50.00
! Date: 2020-06-12;11:48:28
! freq[Hz] db:S11 ang:S11 db:S21 ang:S21 db:S12 ang:S12 db:S22 ang:S22
100000.0 0.001 0 -0.018267469344920073 0 -0.018267469344920073 0 0.001 0
50000000.0 0.001 0 -0.10438567392872056 0 -0.10438567392872056 0 0.001 0
100000000.0 0.001 0 -0.1402532552881901 0 -0.1402532552881901 0 0.001 0
500000000.0 0.001 0 -0.37850173705964973 0 -0.37850173705964973 0 0.001 0
1000000000.0 0.001 0 -0.5387899823157998 0 -0.5387899823157998 0 0.001 0
2500000000.0 0.001 0 -0.8994010660064706 0 -0.8994010660064706 0 0.001 0
5000000000.0 0.001 0 -1.3888357992535698 0 -1.3888357992535698 0 0.001 0
7500000000.0 0.001 0 -1.8624967962088599 0 -1.8624967962088599 0 0.001 0

External RF configuration and settings
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Remote command: 
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:CATalog? on page 486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE[:SELect] on page 486

Recommended Frequency Range
Displays the recommended frequency range of the IF signal that the external frontend
requires.
We recommend that you cover this range in the cable correction file. See Example
"Displaying file correction data" on page 131.
Remote command: 
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:LOWer?
on page 486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:UPPer?
on page 486

External RF configuration and settings



List and sweep modeR&S®SMB100B

133User Manual 1178.3711.02 ─ 11

7  List and sweep mode
The operating modes "List" and "Sweep" allow you to generate an RF signal having
periodically varying frequencies or amplitudes.

A signal generated with varying parameters scans a certain range of varying values of
a parameter, with defined start and end points, and can be repeated cyclically.

The R&S SMB100B supports two basic methods:
● Sweep mode

The instrument generates an RF signal which varies its frequency or level values in
discrete steps between the start and end values. The values change according to a
specific shape like sawtooth or triangle. The spacing is linear or logarithmmic.

Figure 7-1: Schematic representation of a signal generated in sweep mode

The main application field of the "Sweep" mode is to determine the frequency
response a DUT.

● List mode
The instrument generates a varying output signal, based on a previously saved list
with frequency, amplitude and step width values. While in sweep mode the fre-
quency or the level values change, in list mode you can vary both parameters
simultaneously. The frequency and level values do not need to have ascending or
descending order, they can vary arbitrarily.
You can use a global dwell time, which means that the time interval is constant for
all steps of the list, or different dwell times for each value pair.
Figure 7-2 represents the frequency and power value pairs, in this case with the
dwell time set the same for all steps (global dwell time).
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Figure 7-2: Schematic representation of a signal generated in list mode (global dwell time)

1 = RF frequency
2 = RF Level
3 = Dwell time (global)
4 = List index

The list mode is especially useful in high-speed measurements with fast changing
frequency and level settings.

Note that the shown diagrams represent the behaviour in theory. In real signal genera-
tion, the instruments usually have a blank time when the frequency or level changes.

Interactions and characteristics of list and sweep mode

● Activating the list mode automatically deactivates all RF and LF sweeps and vice
versa.

● In list processing mode, the frequency and level display in the status bar is dis-
abled.

● The sweep modes only work with a global dwell time, that means the time intervals
are constant during signal generation.

● If you want to hold a running sweep at a specific frequency or level value, enter the
value in the status bar. The sweep stops immediately.

● We recommend that you switch off the display update for optimum sweep perfor-
mance, especially with short dwell times
See Section 11.1.2, "Display update settings", on page 257.
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7.1  Signal generation and triggering in the sweep and list
modes

In both operating modes "List" and "Sweep", triggering and signal generation follow the
same principle. The instrument generates the signal continuously (that means trig-
gered automatically) or in individual steps (controlled manually by an internal or exter-
nal trigger signal).

The instrument expects the trigger signal at the Inst Trig connector.

If the dwell time in sweep or list mode is too short or external trigger signals come too
fast, the signal generation delays. As the delay increases, the R&S SMB100B signals
an overrun, or even stops sweep or list mode signal generation, if the delay gets too
long.
The instrument diplays corresponding error messages.

The figures in this section give an overview on the signal generation in the sweep and
list modes and the appropriate triggering. The figures show the signal state after acti-
vating the mode and the generation of the signal when a trigger event occurs. For each
mode, the relevant parameters and settings are briefly explained.

Each "Sweep" and "List" mode dialog provides also a "Reset" function that sets the sig-
nal to the initial value or the beginning of the list. Depending on the selected trigger
mode, the signal generation proceeds accordingly.

The naming of the selection parameters in manual control (GUI) sometimes deviates
from the naming in the remote-control commands. In addition, the value names of the
selection parameters used in the signal generator partly differ from the SCPI syntax.
The instrument accepts all value names.
The correlation between the manual control and the corresponding remote control
commands, including the SCPI conform syntax are explained for each mode (see the
cross-reference tables).
See also the following programming examples on the sweep and list modes in remote
control:
● Example "Setting up an RF frequency or power sweep" on page 544
● Example "Setting up an LF sweep" on page 495
● Example "Create an RF list and activate the list mode" on page 508

Signal generation and triggering in the sweep and list modes
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Auto mode (Sweep/List)

Figure 7-3: Auto mode (Sweep/List)

● The instrument generates the signal continuously.
● Trigger mode "Auto" is prerequisite (default). It causes the continuous generation

of the sweep signal.
● Starts signal generation immediately with "State = On".
● Switches automatically to the next step when the Dwell time has elapsed.
● Stops signal generation with "State = Off".
Table 7-1: Cross-reference between manual and remote control in Auto mode (Sweep/List)

Manual control mode:
"Auto"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce AUTO [IMMediate]
:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce AUTO [IMMediate]
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce AUTO [IMMediate]
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

List :SOURce<hw>:LIST:MODE AUTO
:SOURce<hw>:LIST:TRIGger:SOURce AUTO

Signal generation and triggering in the sweep and list modes
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Single / Extern Single mode (Sweep/List)

Figure 7-4: Single / Extern Single mode (sweep / list )

In single mode, you can specify, that the signal returns to the start value when a sweep
cycle has been completed.
See "The Retrace function" on page 142 for details.

● The instrument generates a single sweep cycle.
● Trigger mode "Manual". A trigger event initiates one sweep from the start value to

the end value.
● "State = On" sets the signal to the start value: the sweep start frequency, the

sweep start power or the frequency-power value pair of the selected index in the
list.

● Starts signal generation with a trigger event.
● Switches automatically to the next step when the Dwell time has elapsed.
● Stops signal generation at the set end value and waits for the subsequent trigger

event.
● Trigger sources:

– The "Execute Single Sweep" function.
– The corresponding remote control command.
– An externally applied trigger signal.

● "State = Off" stops the signal generation in sweep or list mode.

Signal generation and triggering in the sweep and list modes
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Table 7-2: Cross-reference between manual and remote control in Single / Extern Single modes
(Sweep/List)

Manual control mode:
"Single / Extern Single"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce SINGle [BUS] "Single" or

:TRIGger<hw>:FSWeep:SOURce EXTernal [EXTernal] "Extern Single"

:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce SINGle [BUS] for "Single" or

:TRIGger<hw>:PSWeep:SOURce EXTernal [EXTernal] for "Extern Sin-
gle"
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce SINGle [BUS] "Single" or

:TRIGger<hw>:LFFSweep:SOURce EXTernal [EXTernal] "Extern Sin-
gle"
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

List :SOURce<hw>:LIST:TRIGger:SOURce SINGle "Single" or

:SOURce<hw>:LIST:TRIGger:SOURce EXTernal "Extern Single"

:SOURce<hw>:LIST:MODE AUTO

Step / Extern Step mode (Sweep/List)

Figure 7-5: Step / Extern Step mode (sweep / list )

● The instrument generates the signal step-by-step.
● Starts signal generation with "State = On".
● Switches to the next step with a manual action.

If the end value is reached, signal generation starts again from the beginning.
● Stops signal generation with "State = Off".

Signal generation and triggering in the sweep and list modes
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● Trigger sources:
– The rotary knob at the front panel.
– The [Arrow] keys at the front panel.
– The corresponding remote control commands.
– An externally applied trigger signal.

To step through the sweep frequencies or levels:
● In manual mode:

– Set the Current Frequency or Current Level values
– Use the [Up] and [Down] keys or the rotary knob

● In remote control mode:
– Use the commands [:SOURce<hw>]:FREQuency:MANual or

[:SOURce<hw>]:POWer:MANual with the UP or DOWN parameter

Steps that would exceed the sweep range are ignored.

Table 7-3: Cross-reference between manual and remote control in Step / Extern Step modes (Sweep/
List)

Manual control mode:
"Step / Extern Step"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:FSWeep:SOURce EXTernal [EXTernal] for "Extern
Step"
:SOURce<hw>:SWEep:FREQuency:MODE STEP

RF level sweep :TRIGger<hw>:PSWeep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:PSWeep:SOURce EXTernal [EXTenal] "Extern Step"

:SOURce<hw>:SWEep:POWer:MODE STEP

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:LFFSweep:SOURce EXTernal [EXTenal] "Extern Step"

:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE STEP

List :SOURce<hw>:LIST:TRIGger:SOURce SINGle "Step" or

:SOURce<hw>:LIST:TRIGger:SOURce EXTernal "Extern Step"

:SOURce<hw>:LIST:MODE STEP

Signal generation and triggering in the sweep and list modes
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Extern Start/Stop mode (sweep)

Figure 7-6: Extern Start/Stop mode (sweep)

● The instrument generates the signal continuously.
● Trigger mode "Auto" and "Sweep > State = On" are prerequisite.
● State "On" sets the signal to the start value, that is one of the following:

– Sweep start frequency
– Sweep start power
– Frequency-power value pair of the selected index in the list

● Starts signal generation with a trigger event.
● Switches automatically to the next sweep step when the Dwell time has elapsed.

If the end value is reached, signal generation continues with the next sweep cycle.
● Stops signal generation with the next external trigger event.
● Starts the signal generation again with the next trigger event, beginning at the start

value.
● "State = Off" stops the signal generation in sweep or list mode.
● Trigger source: An externally applied trigger signal.
Table 7-4: Cross-reference between manual and remote control in Extern Start/Stop modes (sweep)

Manual control mode:
"Extern Start/Stop"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce EAUTo [-]
:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce EAUTo [-]
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce EAUTo [-]
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

Signal generation and triggering in the sweep and list modes
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Manual mode (Sweep/List)

The manual mode only applies to remote control. It is not visible in the graphical user
interface of the instrument and is described here for completeness.

Figure 7-7: Manual mode in remote control (sweep / list )

● The instrument generates the signal in steps.
● Starts signal generation with "State = On".
● Switches to the next step with a user defined setting via remote control.

You can arbitrarily select a value within the range of the start and stop values by
setting the frequency, power or index using the corresponding remote control com-
mand. There is no ascending or descending order.

● Stops signal generation with "State = Off".
Table 7-5: Remote control commands in manual mode (Sweep/List)

Remote control mode:
Manual

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :SOURce<hw>:FREQuency:MANUal <Manual>

RF level sweep :SOURce<hw>:POWer:MANual <Manual>

LF frequency sweep :SOURce<hw>:LFOUTput:FREQuency:MANual <Manual>

List :SOURce<hw>:LIST:INDex <Index>

Signal generation and triggering in the sweep and list modes
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The Retrace function

Retrace is a function especially designed for "Single" sweep modes, when the sweep
signal follows a sawtooth shape. Working in this mode, the instrument performs a sin-
gle sweep cycle when a trigger event occurs. The signal generation stops at the set
end point (stop frequency or stop level), and waits for the next trigger event.

In this state, the upper value of the signal remains at the output until the next cycle
starts. In particular, if you generate a level sweep signal, the high amplitude of the sig-
nal is output for a certain time. To protect the DUT from overload, the retrace function
immediately resets the signal value to the start value at the end of a sweep cycle. It
returns to the start level or start frequency until the next trigger is applied.

You can use the "Retrace" function if "Sweep > Mode = Single/External Single" and
"Shape = Sawtooth", see:
● "Shape" on page 152
● "Mode" on page 151

7.2  About sweep mode

In sweep mode, the signal generator scans the sweep range gradually from one point
to another, using a defined step size and following a triangle or sawtooth shape. This
mode also enables you to change direction, that means, it is possible to step back-
wards.

See Section 7.2.2, "Sweep signal shapes", on page 145.

About sweep mode
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Configuration and operation of sweep mode signals

● The R&S SMB100B generates a sweep signal by varying the following parameters:
either the RF frequency, the RF level or both, the RF frequency and the RF level in
combined RF sweep mode, or the LF frequency.

● In all sweep modes, you can perform a complete sweep cycle once, repeat the
cycle continuously or step through it gradually.

● The instrument generates the sweep signal according to the sweep settings.
● The "Reset Sweep" function, provided in the sweep settings dialogs enables you to

reset the sweep to its initial value and restart it.

Impact of changing the sweep mode during performance
If you change the sweep mode during the execution, the signal generator stops the
sweep and starts with the next trigger event at the initial value.

Combined RF frequency / level sweep processing mode

The combined RF sweep functionality processes the signal similar to the Live list
mode. The R&S SMB100B sets the frequency and level values simultaneously in the
hardware. The difference to the list mode is that the values are not taken from a previ-
ously created list, but are calculated using the selected frequency and level ranges, the
dwell time and the number of steps.

7.2.1  Correlating parameters in sweep mode

A sweep signal is a periodic signal that changes its frequency or level, or both, from a
starting value to an ending value in a defined time.

The R&S SMB100B provides various possibilities to configure a sweep signal. For
example, you can determine the sweep range by the start and end values, or based on
the start value and span. In any case, related parameters are adjusted accordingly.

The formulas below show how the sweep parameters correlate and the corresponding
calculation basis, by the frequency and offset settings. Apart from "Center Frequency",
"Span" and "Step_lin", the values apply accordingly to the level settings.
Table 7-6: Variables that are used in the following formulas

Variable Description

Sweep range Defined frequency or level value range

fCENTer Defined center frequency

fSPAN Defined extend of the sweep range

fOFFSet Frequency offset

fSTARt Start frequency of the sweep range

fSTOP End frequency of the sweep range

f1 Current sweep frequency

About sweep mode



List and sweep modeR&S®SMB100B

144User Manual 1178.3711.02 ─ 11

Variable Description

f2 Next, subsequent sweep frequency

step_lin Step size in linear scaling

step_log Step size in logarithmic scaling

POINts Number of steps within the sweep range

Sweep range

The sweep range is defined by a start and an end value. How the remaining parame-
ters correlate is shown below.

Offset = 0

Sweep Range = fSTARt to fSTOP

fCENTer = (fSTARt + fSTOP)/2

fSPAN = (fSTOP - fSTARt)

Where:

fSTARt = fCENTer - (fSPAN/2)

fSTOP = fCENTer + (fSPAN/2)

Offset≠0

A defined offset also affects the sweep range and the center frequency. Therefore, the
set frequencies are only absolute values, if the Offset = 0. Offset ≠ 0 shifts the frequen-
cies with the offset value:

Sweep Range = fSTARt + fOFFSet to fSTOP + fOFFSet

fCENTer = fCENTer+ fOFFSet

fSPAN = fSPAN + fOFFSet

The value range of the instrument is calculated as follows:

RFmin + fOFFSet to RFmax + fOFFSet

It is possible to set fSTARt > fSTOP and fSTARt < fSTOP, so that even a negative value is per-
mitted for the "Span".
If you change the start and/or stop frequency, the span and center frequency change
accordingly, and vice versa.

Sweep steps

In the following, you see how the sweep steps are calculated depending on the defined
spacing mode. The formulas show a frequency sweep, but apply to the level settings in
the same way.

The step size is added to the current value, to get the subsequent sweep step.

About sweep mode
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With linear scaling, the next frequency is calculated according to:

f2 = f1 + step_lin

In the logarithmic scaling, the step size is determined in per cent, as a constant frac-
tion of the current frequency.

Successive frequencies are calculated as follows:
● For fSTARt < fSTOP

f2 = f1*(1 + step_log/100)
If f2 > fSTOP, then f2 = fSTOP

● For fSTARt > fSTOP

f2 = f1/(1 + step_log/100)
If f2 < fSTOP, then f2 = fSTOP

With "Shape = Triangle", the frequency values on the slope from fSTOP to fSTARt are the
same as on the slope from fSTARt to fSTOP.

If you specify the number of steps within the sweep range, the step size is adjusted
according to the following correlation:
● For linear sweeps and fSTARt < fSTOP

POINtsfrequency = ((fSTARt - fSTOP)/step_lin) +1 = (fSPAN/step_lin) + 1
● For logarithmic sweeps and fSTARt < fSTOP

POINtsfrequency = ((log fSTOP - log fSTARt)/log step_log) +1

If step_log changes, the value of POINts is adjusted. The fSTARt and fSTOP values are
retained.

7.2.2  Sweep signal shapes

The R&S SMB100B supports the following sweep shapes:
● Sawtooth

The sweep sequence resembles a sawtooth. One sweep runs from start to stop
frequency, or level value respectively. Each subsequent sweep starts again at the
start value.

Figure 7-8: Sweep signal sawtooth shape
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1 = Start value
2 = Stop value
3 = Step size

● Triangle
The sweep sequence resembles a triangle. One sweep runs from start to stop
value frequency and back. Each subsequent sweep starts at the start value.

Figure 7-9: Sweep signal triangle shape

1 = Start value
2 = Stop value
3 = Step size

The current frequency or level of an RF frequency, level or LF frequency sweep is
determined by the shape (e.g. sawtooth or triangle) and the spacing (linear or logarith-
mic), and the step size.

7.3  About list mode

The list mode is used to generate the RF signal based on a set of predefined fre-
quency and amplitude value pairs, with individual step times. You can define the values
arbitrarily, in any order and varying step sizes, within the entire configurable value
range of the instrument.

Configuration and operation of list mode signals

The parameters configuring the RF signal are defined in a list (table) and stored in a
file.

Creating and handling lists

List files can be created in the following ways:
● Internally

Use the build-in table editor with columns for the frequency-level values pairs and
the dwell time.
Define the values manually (row by row) or automatically, based on value range
and step size.
See Section 7.7, "List data editor", on page 166.
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Lists are saved as files with user-definable filename and the predefined file exten-
sion *.lsw. To load a saved file, use the "File Manager".
See Section 10.9, "Using the file manager", on page 237.

● Lists can be exported, too. For example, to exchange configuration between instru-
ments or to modify the file content with an external program and reload them again.

● Externally
Create a list file as a CSV file with Microsoft Excel, with a Notepad or a similar tool
and save it with the predefined extension. Transfer the file to and load it into the
instrument.

Dwell time mode

You can choose whether you want to use different dwell times or a fixed value for all
steps in the list mode:
● "From List"

This mode uses the values from the data table.
See Section 7.7, "List data editor", on page 166.

● "Global"
This mode processes the list with a fixed time interval you can set with Global
Dwell Time.

List processing mode

See:
● "Live list processing mode" on page 149

7.4  Significant parameters and functions

This section provides some basic parameters, settings and functions that affect the
operating modes CW, list and sweep, that means at all frequency and level transitions
of the RF signal.

Dwell time

Dwell time is the length of time that elapses from the beginning until the end of a step
in list or sweep mode.

Significant parameters and functions
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Figure 7-10: Dwell Time vs. settling time

1 = "Dwell Time" (as set with the parameter)
2 = Settling time
3 = Dwell time (effective)

However, the time the instrument requires for the signal to settle reduces the set dwell
time:

tdwell(effective) = tdwell - tsetlting

If the dwell time in sweep or list mode is too short or external trigger signals come too
fast, the signal generation delays. As the delay increases, the R&S SMB100B signals
an overrun, or even stops sweep or list mode signal generation, if the delay gets too
long.
The instrument diplays corresponding error messages.

Hardware adjustments

The first time a list (new or modified) is processed, the instrument automatically calcu-
lates the necessary hardware settings. It can be performed during list processing, but
delays the first cycle, especially with short dwell times.

With long dwell times, you can perform this calculation while the list is being pro-
cessed; the entered dwell times are observed. With short dwell times, calculation of the
hardware settings increases the dwell time for the initial processing cycle; the entered
value is only observed from the second processing cycle onwards. In this case, a mes-
sage indicates that there is a deviation between the current and set dwell times. After
the first cycle, you do not need to perform additional calculations. The current dwell
times do not deviate from the set dwell times.

Blanking

The instrument applies blanking, which temporarily turns off the RF signal when the
frequency or level changes, until the signal has settled to a stable state.

Temporary blanking applies to all operating modes.

Significant parameters and functions
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Live list processing mode

The R&S SMB100B generates the signal directly from the value pairs in the database,
and adjusts the hardware settings accordingly. The current instrument state and thus
any change during the signal generation directly affects the RF signal. The temporary
memory is not used.

You can conveniently modify parameters like modulation settings during run-time.
Learning list mode data is not required. Impacts like temperature drift are also consid-
ered immediately.

This mode is optimized for maximum signal quality, and is useful if dwell times higher
than 2 ms are sufficient.

7.5  Sweep mode settings

This section lists the settings of all available sweep modes.

Access:

1. Select "Sweep" > "RF Frequency Sweep"

2. Select "Sweep" > "RF Level Sweep"

3. Select "Sweep" > "RF Combined Sweep"

4. Select "Sweep" > "LF Frequency Sweep"

The remote commands required to define these settings are described in:
● Section 13.16.13, "SOURce:SWEep subsystem", on page 543
● Section 13.16.4, "SOURce:FREQuency subsystem", on page 487
● Section 13.16.11, "SOURce:POWer subsystem", on page 524
● Section 13.16.6, "SOURce:LFOutput subsystem", on page 495

Settings

● General sweep settings.........................................................................................149
● Frequency range settings......................................................................................155
● Level range settings..............................................................................................157

7.5.1  General sweep settings

Access:

► Select for example "Sweep" > "RF Frequency Sweep".

Sweep mode settings
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Table 7-7: General settings dialog: Examples of RF Frequency and RF Combined Sweep dialogs

> "RF Frequency Sweep" > "RF Combined Sweep"

Settings

State (RF frequency sweep)....................................................................................... 150
State (RF level sweep)................................................................................................150
State (RF frequency / level sweep)............................................................................. 151
State (LF frequency sweep)........................................................................................ 151
Current Frequency...................................................................................................... 151
Current Level...............................................................................................................151
Mode........................................................................................................................... 151
Retrace........................................................................................................................152
Shape..........................................................................................................................152
Spacing....................................................................................................................... 154
Dwell Time...................................................................................................................154
Trigger Slope...............................................................................................................154
Show/Show Connector................................................................................................154
Reset Sweep...............................................................................................................155
Execute Single Sweep................................................................................................ 155

State (RF frequency sweep)
Activates RF frequency sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 488

State (RF level sweep)
Activates RF level sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:POWer:MODE on page 530

Sweep mode settings
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State (RF frequency / level sweep)
Activates the RF frequency / level sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 488
[:SOURce<hw>]:POWer:MODE on page 530

State (LF frequency sweep)
Status of the LF frequency sweep signal.
You find this parameter in two dialogs:
● "LF Frequency Sweep" turns on/off the signal generation.

See Sweep mode settings for access.
● "Analog Modulation Sources" displays the current state (read-only). If it is turned

on, this dialog provides the varying sweep frequency, see Current Frequency.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput:FREQuency:MODE on page 499

Current Frequency
Displays the current frequency sweep value for all sweep Modes, except of Mode >
Step. In this mode, you can enter the next frequency setting manually.
Remote command: 
[:SOURce<hw>]:FREQuency:MANual on page 490
[:SOURce<hw>]:LFOutput:FREQuency:MANual on page 498

Current Level
Displays the current level sweep value for all sweep Modes, except of Mode > Step. In
this mode, you can enter the next level setting manually.
Remote command: 
[:SOURce<hw>]:POWer:MANual on page 529

Mode
Selects the sweep mode.
See Section 7.1, "Signal generation and triggering in the sweep and list modes",
on page 135.
"Auto" Generates a continuously repeating sweep signal directly after acti-

vating the sweep mode.
The sweep steps are performed automatically, controlled by the dwell
time.

"Single / Extern Single"
Generates a single sweep cycle after a trigger event.
The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.

Sweep mode settings
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"Step / Extern Step"
Generates the sweep signal step-by-step, manually triggered.

"Extern Start/Stop"
Generates a continuously repeating sweep signal that is started,
stopped, and restarted by subsequent external trigger events.
The sweep steps are performed automatically, controlled by the dwell
time.

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:MODE on page 549
:TRIGger<hw>:FSWeep:SOURce on page 593
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:MODE on page 547
:TRIGger<hw>:PSWeep:SOURce on page 593
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:MODE on page 554
:TRIGger<hw>:FPSWeep:SOURce on page 594
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE on page 505
:TRIGger<hw>:LFFSweep:SOURce on page 593

Retrace
For "Shape = Sawtooth" and "Mode = Single/External Single", enables changing the
signal to the start value while it is waiting for the next trigger event. It returns to the
start level or start frequency until the next trigger is applied.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace on page 550
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:RETRace on page 550
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:RETRace on page 554
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace on page 506

Shape
Selects the waveform shape of the sweep signal.
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"Sawtooth" The sweep runs from start to stop frequency. The subsequent sweep
starts at the start value, i.e. the shape of the sweep sequence resem-
bles a sawtooth.

Figure 7-11: Sweep signal sawtooth shape

1 = Start value
2 = Stop value
3 = Step width

"Triangle" The sweep runs from start to stop value and back, i.e. the shape of
the sweep resembles a triangle. Each subsequent sweep starts at the
start frequency.

Figure 7-12: Sweep signal triangle shape

1 = Start value
2 = Stop value
3 = Step width

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe on page 550
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:SHAPe on page 550
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:SHAPe on page 555
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe on page 506
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Spacing
In "RF and LF Frequency Sweep" mode, "Spacing" selects the mode for calculating the
frequency interval, which increases or decreases the current frequency at each step.
To determine the step size, select the parameter Step Linear/Step Logarithmic.
In "RF Combined Sweep" mode, the parameter indicates that the step intervals are lin-
early (straight proportional) distributed, i.e. the intervals have the same size. The fre-
quency / level range and the Dwell Time time determine the calculated step size.
"Linear" Takes the frequency value entered as absolute value in Hz.
"Logarithmic" Takes the value entered as a logarithmic value, i.e. as a constant

fraction of the current frequency in %.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing on page 549
RF combined sweep: n.a.
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing on page 507

Dwell Time
Defines the duration of the individual sweep steps.
Note: In case of considerable overrun conditions, the R&S SMB100B turns off the
sweep mode.
See also Section 7.4, "Significant parameters and functions", on page 147.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:DWELl on page 548
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:DWELl on page 546
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:DWELl on page 553
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl on page 504

Trigger Slope
For "Mode = Extern Step/Single", selects the polarity of the active slope of an applied
instrument trigger.
Trigger signal is expected at the Inst Trig connector.
"Positive" The rising edge of the trigger signal triggers the instrument.
"Negative" The falling edge of the trigger signal triggers the instrument.
Remote command: 
[:SOURce]:INPut:TRIGger:SLOPe on page 494

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.
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Reset Sweep
Resets a sweep.
With the next trigger event, the sweep starts at the initial value.
Remote command: 
[:SOURce<hw>]:SWEep:RESet[:ALL] on page 555

Execute Single Sweep
In "Mode = Single", starts a sweep manually.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute on page 550
:TRIGger<hw>:FSWeep[:IMMediate] on page 595
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:EXECute on page 550
:TRIGger<hw>:PSWeep[:IMMediate] on page 595
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:EXECute on page 553
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute on page 505
:TRIGger<hw>:LFFSweep:IMMediate on page 595
General:
:TRIGger<hw>[:SWEep][:IMMediate] on page 595

7.5.2  Frequency range settings

Access:

1. Select for example "Sweep" > "RF Frequency Sweep"

2. Select for example "Frequency Range".

> "Frequency Range" > "Frequency / Level Range"
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Settings

Start Frequency/Stop Frequency................................................................................ 156
Center Frequency....................................................................................................... 156
Span............................................................................................................................156
Spacing....................................................................................................................... 156
Step Linear/Step Logarithmic......................................................................................157

Start Frequency/Stop Frequency
Defines the frequency sweep range by setting the start and end values.
See Section 7.2.1, "Correlating parameters in sweep mode", on page 143.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:FREQuency:STARt on page 492
[:SOURce<hw>]:FREQuency:STOP on page 492
RF combined sweep:
[:SOURce<hw>]:COMBined:FREQuency:STARt on page 552
[:SOURce<hw>]:COMBined:FREQuency:STOP on page 552
LF frequency sweep:
[:SOURce<hw>]:LFOutput:FREQuency:STARt on page 499
[:SOURce<hw>]:LFOutput:FREQuency:STOP on page 499

Center Frequency
In "RF Frequency Sweep" mode, sets the RF center frequency.
See Section 7.2.1, "Correlating parameters in sweep mode", on page 143.
Remote command: 
[:SOURce<hw>]:FREQuency:CENTer on page 491

Span
In "RF Frequency Sweep" mode, sets the span of the frequency sweep range.
See Section 7.2.1, "Correlating parameters in sweep mode", on page 143.
Remote command: 
[:SOURce<hw>]:FREQuency:SPAN on page 492

Spacing
In "RF and LF Frequency Sweep" mode, "Spacing" selects the mode for calculating the
frequency interval, which increases or decreases the current frequency at each step.
To determine the step size, select the parameter Step Linear/Step Logarithmic.
In "RF Combined Sweep" mode, the parameter indicates that the step intervals are lin-
early (straight proportional) distributed, i.e. the intervals have the same size. The fre-
quency / level range and the Dwell Time time determine the calculated step size.
"Linear" Takes the frequency value entered as absolute value in Hz.
"Logarithmic" Takes the value entered as a logarithmic value, i.e. as a constant

fraction of the current frequency in %.
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Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing on page 549
RF combined sweep: n.a.
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing on page 507

Step Linear/Step Logarithmic
In "RF/LF Frequency Sweep" mode, sets the step width for the individual frequency
sweep steps. The value is added at each sweep step to the current frequency.
Depending on the current Spacing, you can enter either an absolute or logarithmic step
width.
See Section 7.2.1, "Correlating parameters in sweep mode", on page 143.
"Step Linear" The step width is a constant value in Hz.
"Step Logarithmic"

The step width is determined logarithmically in %, i.e. as a constant
fraction of the current frequency.
Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear]
on page 551
[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic
on page 551
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:
LINear] on page 507
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:
LOGarithmic on page 507

7.5.3  Level range settings

Access:

1. Select "Sweep" > "RF Level Sweep"

2. Select for example "Level Range".
Table 7-8: Range settings dialog: Examples of RF Level and RF Combined Sweep dialogs

> "Level Range" > "Frequency / Level Range"
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Settings

Start Level / Stop Level............................................................................................... 158
Step Count.................................................................................................................. 158
Spacing....................................................................................................................... 158
Step.............................................................................................................................158
Setting Characteristics................................................................................................ 158
Level Range................................................................................................................ 159

Start Level / Stop Level
Defines the RF level sweep range by setting the start and end values.
See Section 7.2.1, "Correlating parameters in sweep mode", on page 143.
Remote command: 
RF level sweep:
[:SOURce<hw>]:POWer:STARt on page 531
[:SOURce<hw>]:POWer:STOP on page 531
RF combined sweep:
[:SOURce<hw>]:COMBined:POWer:STARt on page 552
[:SOURce<hw>]:COMBined:POWer:STOP on page 553

Step Count
In "RF Combined Mode", defines the number of sweeps to be executed in Mode > Sin-
gle.
To start the sweep cycles, select Execute Single.
Remote command: 
[:SOURce<hw>]:SWEep:COMBined:COUNt on page 553

Spacing
Indicates that the instrument distributes the level steps linearly (straight proportional),
i.e. the level steps have the same size.
To determine the step size, use the parameter Step.
Remote command: 
n.a.

Step
Sets the step width for the RF level sweep in dB.
The "RF level sweep" mode increases or decreases the level value linearly by the set
value.
Remote command: 
[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic] on page 548

Setting Characteristics
Selects additional quality characteristics to optimize the behavior of the RF signal level
for the specific application.
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"Auto" Sets the RF output level automatically according to the selected
mode.
In this mode, the instrument provides the highest dynamic range and
fastest setting times.
The RF signal is shortly blanked when the step attenuator is switch-
ing.
For more information, refer to the specifications document.

"Uninterrupted"
Suppresses blanking at level transitions. Frequency transitions can
lead to an RF level blanking due to hardware-specific switching
points.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Executes signal level changes monotonically increasing or decreas-
ing.
The setting makes sure that increasing the level value exclusively
results in an increased output level, and vice versa.
All electronic switches, which can affect the monotonicity are fixed.
The operation mode is useful for applications using level searching
algorithms which rely on a strictly monotonous behavior.

"Constant-VSWR"
Suppresses output impedance variations at the RF 50 Ω output con-
nector, due to changed level settings.

"User" Selects this entry automatically when you change one of the following
parameters from the default setting:
● "Attenuator" > Mode
● "ALC" > State or Detector Sensitivity
Note: If you select another setting characteristic, the R&S SMB100B
presets the modified attenuator and ALC parameters.

Remote command: 
[:SOURce<hw>]:POWer:LBEHaviour on page 529

Level Range
Shows the interruption-free range of the level that you can use in the currently selected
mode.
Remote command: 
[:SOURce<hw>]:POWer:RANGe:LOWer? on page 536
[:SOURce<hw>]:POWer:RANGe:UPPer? on page 536

7.6  List mode settings

The "List Mode" dialog contains all the functions and settings for creating and handling
lists with RF frequency/level pairs including the corresponding dwell times for generat-
ing the RF signal based on these values.

List mode settings
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Access:

► Select "Sweep" > "List mode".

The dialog contains parameters for configuring the list mode processing, entering
list mode data and transferring data files from or to the instrument.
The remote commands required to define these settings are described in Sec-
tion 13.16.7, "SOURce:LIST subsystem", on page 508.

● General settings....................................................................................................160
● List mode data settings......................................................................................... 162
● Import/export settings............................................................................................163

7.6.1  General settings

Access:

► Select "Sweep" > "List mode".

In the "General" tab, you can configure the trigger and dwell time modes for list
processing and activate signal generation.

Settings

State............................................................................................................................161
Current Index.............................................................................................................. 161
Mode........................................................................................................................... 161
Dwell Time Mode.........................................................................................................161
Global Dwell Time....................................................................................................... 162
Trigger Slope...............................................................................................................162
Reset...........................................................................................................................162
Execute Single............................................................................................................ 162
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State
Activates the list mode and processes the currently selected list.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 488

Current Index
Sets the list index for list processing in "Step" mode. In the other modes, the index indi-
cates the current step.
Remote command: 
[:SOURce<hw>]:LIST:INDex on page 513

Mode
Selects the mode for list processing.
See Section 7.1, "Signal generation and triggering in the sweep and list modes",
on page 135.
"Auto" Generates the signal by processing the frequency/level value pairs of

the list from the beginning to the end.
The list steps are performed automatically, controlled by the dwell
time. If you switch from any mode to "Auto", signal generation always
starts at the top of the list.

"Single / Extern Single"
Generates the signal by processing the frequency/level value pairs of
the list once from the beginning to the end after a trigger event.
The list steps are performed automatically, controlled by the dwell
time. If one cycle is completed, the instrument waits for the next trig-
ger event.

"Step / Extern Step"
Generates the signal by processing the frequency/level value pairs of
the list step-by-step, manually triggered.

Remote command: 
[:SOURce<hw>]:LIST:TRIGger:SOURce on page 515
[:SOURce<hw>]:LIST:MODE on page 513

Dwell Time Mode
Selects either variable dwell times or a fixed dwell time to perform signal generation in
list mode.
"Global" Uses the same dwell time for all lists steps, set with Global Dwell

Time.
"From List" Uses the dwell times from the list.

You can define the dwell time for each frequency/level value pair indi-
vidually, see Section 7.7, "List data editor", on page 166.

Remote command: 
[:SOURce<hw>]:LIST:DWELl:MODE on page 511

List mode settings
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Global Dwell Time
Sets the dwell time for Dwell Time Mode > "Global".
Note: In case of considerable overrun conditions, the R&S SMB100B turns off the list
mode.
See also "Dwell time" on page 147.
Remote command: 
[:SOURce<hw>]:LIST:DWELl on page 511

Trigger Slope
For "Mode = Extern Step/Single", selects the polarity of the active slope of an applied
instrument trigger.
Trigger signal is expected at the Inst Trig connector.
"Positive" The rising edge of the trigger signal triggers the instrument.
"Negative" The falling edge of the trigger signal triggers the instrument.
Remote command: 
[:SOURce]:INPut:TRIGger:SLOPe on page 494

Reset
Resets the list to the starting point.
Remote command: 
[:SOURce<hw>]:LIST:RESet on page 517

Execute Single
Manually starts list processing in "Single" mode.
Remote command: 
[:SOURce<hw>]:LIST:TRIGger:EXECute on page 515

7.6.2  List mode data settings

Access:

1. Select "Sweep" > "List mode".

2. Select "List Mode Data".

This dialog contains the parameters required for creating and editing lists, activat-
ing the learning function and selecting the list processing mode.

List mode settings
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Settings

List Mode Data............................................................................................................ 163
Edit List Mode Data.....................................................................................................163
List Range from/to.......................................................................................................163

List Mode Data
Accesses the standard "Select List" dialog for selecting, creating and editing a list file.
The currently loaded file is indicated.
You can create data lists with the internal editor or import externally created files, see
"Creating and handling lists" on page 146.
Remote command: 
[:SOURce<hw>]:LIST:CATalog? on page 516
[:SOURce<hw>]:LIST:SELect on page 518
[:SOURce<hw>]:LIST:DELete on page 516
[:SOURce<hw>]:LIST:DELete:ALL on page 517

Edit List Mode Data
Opens the build.-in table editor to define a new list data table or edit an exisitng one.
See also: Section 7.7, "List data editor", on page 166.
You find this function also in standard file select dialog, accessed via List Mode Data.

List Range from/to
Defines an index range in the current list by setting the start and stop index.
The instrument generates the signal with the values of the selected index range and
ignores all other list entries.
Remote command: 
[:SOURce<hw>]:LIST:INDex:STARt on page 513
[:SOURce<hw>]:LIST:INDex:STOP on page 513

7.6.3  Import/export settings

Access:

1. Select "Sweep" > "List Mode".

List mode settings
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2. Select "List Mode Data" > "Im-/Export".

The "Im-/Export" dialog provides the parameters for importing or exporting files with
user data in standard ASCII *.txt or *.csv file format.
The table separators and the decimal floating point numbers are customizable.

Settings

Mode........................................................................................................................... 164
ASCII File Settings...................................................................................................... 164
Select (ASCII) Source/Select (ASCII) Destination...................................................... 165
Select Source/Select ASCII Destination..................................................................... 165
Import / Export.............................................................................................................165

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 520
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 466

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".

List mode settings
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Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 519
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 483
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 467

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 468

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 520
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 484
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 468

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 519
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 468

List mode settings
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7.7  List data editor

The "List Mode" dialog provides a build-in list editor for defining the corresponding fre-
quency and level value pairs. Prerequisite to define list mode data is that you have
selected a file.

Access:

► "Sweep" > "List Mode" > "List Mode Data" > "Edit List Mode Data"

The editor for list mode provides a table with RF frequency and power values, a
column for defining variable dwell times, and standard navigation functions.

The remote commands required to define the list mode data are described in Sec-
tion 13.16.7, "SOURce:LIST subsystem", on page 508.

All columns in a row must contain values. Cells with missing values are therefore filled
automatically, using the value of the previous row.
Once you enter a value, the editor automatically adds preset values in the other col-
umns. This functionality protects against data loss, otherwise incomplete rows are lost
when saving. You can simply override these values.
If you use global dwell time in list mode, consider also that the instrument uses the
value set with Global Dwell Time for all list steps and not the values from the list.

Since the table and navigation functions can be assumed to be known, the following
description contains a brief overview.

List data editor
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Settings:

Frequency (Hz)........................................................................................................... 167
Power (dBm)............................................................................................................... 167
Dwell Time (s)............................................................................................................. 167
Data handling keys......................................................................................................167

└ Select Row....................................................................................................167
└ Edit................................................................................................................167
└ Save As/Save............................................................................................... 167

Fill................................................................................................................................167

Frequency (Hz)
Sets the frequency values for list mode operation.
Remote command: 
[:SOURce<hw>]:LIST:FREQuency on page 512

Power (dBm)
Sets the level value for the selected frequency in list mode.
Remote command: 
[:SOURce<hw>]:LIST:POWer on page 514

Dwell Time (s)
Sets the dwell time values for the frequency power value pairs in list mode operation.
Remote command: 
[:SOURce<hw>]:LIST:DWELl:LIST on page 511

Data handling keys
Standard functions for file and data handling.

Select Row ← Data handling keys
Selects a row for editing.

Edit ← Data handling keys
Enables you to insert, or delete a row or ranges within the table, and provides access
to a dialog for automatic filling, see "Fill..." on page 94.

Save As/Save ← Data handling keys
Saves the table in a file with user-defined name and predefined file extension. To save
a copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.

List data editor
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To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".

7.8  How to generate a signal in list or sweep mode

This section shows you how to configure a varying RF output signal for both, the list
and sweep modes.

To configure the frequency sweep signal

► For a step-by-step description, see Section 3.3.2, "Generating an RF frequency
sweep signal", on page 41.

Example: Fast changing frequency and level settings in list mode
The following example shows you how to generate an amplitude modulated RF signal
based on list mode data.

How to generate a signal in list or sweep mode
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General workflow

Since any change of the hardware settings or list entries can affect the RF signal char-
acteristics directly, we recommend that you proceed as follows:

1. Configure the modulation settings.
Activate the RF signal.

2. Wait until the hardware settings have settled.

3. Create a list file.

4. Configure the list mode.

5. Activate list mode.

To configure amplitude modulation and switch RF on

1. Press [Preset] to start from an initial state.

2. Select "Modulation" > "Amplitude Modulation > On".

3. Select "Level" > "RF ON" to activate RF signal generation.

To create list mode data

1. Select "Sweep" > "List Mode".

2. In the "List Mode Data" tab, select "List Mode Data > New"

3. Enter the filename ListMode_Test for the data list and confirm with "Ok".

The instrument creates a file and stores it in the /var/user/ directory.

4. Select "Edit List Mode Data".

5. Enter the first values "Frequency > 2", "Power > 0" and "Dwell > 2".

6. Enter further frequency, power and dwell time values in the same way.

7. Select "Save" and close the dialog.

To configure the list mode and start signal generation

1. In the "General" tab, select "List Mode > Auto".

2. Select "Dwell Time Mode > From List".

3. Switch state to "On".

4. Select "General > State > On".

The instrument continuously generates an amplitude-modulated RF signal whose
frequency and level values change according to the dwell times, as defined in the
list.
With active list mode, the generator displays no frequency and level values in the
status bar, but you can check the following parameters.
● In the list mode dialog, the current index indicates the steps of the signal gener-

ation.

How to generate a signal in list or sweep mode
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● In remote control mode, you can query:
– The current state with [:SOURce<hw>]:LIST:RUNNing?
– Current parameters with the commands FREQ?, POW? and LIST:DWEL?.

How to generate a signal in list or sweep mode
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8  Improving level performance
To adjust the RF output signal to specific needs in your application, the R&S SMB100B
offers different functions:
● Attenuator

The R&S SMB100B is equipped with a step attenuator that enables you to vary the
amplitude of the RF signal in a wide range. It is characterized by low VSWR (volt-
age standing wave ratio) over the full level and frequency range, and provides
highest level accuracy and noise suppression.
See "About the attenuator" on page 171.

● Automatic Level Control (ALC)
The automatic level control system provides stable RF signals with highest abso-
lute level accuracy over temperature and time.
See "About ALC" on page 174.

● User correction (UCOR)
The user correction function allows you to compensate frequency responses of
external setups (e.g. losses of cables) and achieve a stable input signal over fre-
quency directly at the DUT.
See "About UCOR" on page 177.

● Power sensors
The R&S SMB100B has excellent absolute level accuracy. Since a DUT is rarely
connected directly to the generator, but with cables or other components, the refer-
ence level shifts from the RF output to the DUT. To calibrate this level with high
accuracy, i.e. in the tenth dB range, you can connect an R&S NRP power sensor to
the generator. The power sensor transmits its readings to the generator, which indi-
cates these measurement results in the display. Thus you can adjust the RF output
power of the generator until you reach the target level at the DUT.
See Section 8.4, "Using power sensors", on page 189

8.1  Attenuator

About the attenuator

The step attenuator is an electronic device without mechanical components, providing
fast and wear free level settings.

According to the requirements of your application, you can select different attenuator
characteristics.

The following are examples of test requirements and the corresponding configuration:
● Automatic configuration

Select standard operation mode ("Auto"), in which the generator adjusts the attenu-
ation of the RF output signal automatically.

● DUT tests under low signal to noise conditions
Low output power is suitable to test the behavior of a DUT under low signal to
noise conditions.

Attenuator
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● Uninterrupted level settings with constant VSWR
A fix attenuation value is required for obtaining uninterrupted level settings with
constant VSWR.
The configuration "RF Off Mode > Unchanged" ensures that constant VSWR is
maintained if you turn the signal off and on again.

● Noise sensitive applications
The parameter "RF OFF Mode > Full Attenuation" sets maximum attenuation and
thus suppresses noise when you turn off the RF signal.

8.1.1  Attenuator settings

Access:

► Select "Level" > "Level > Attenuator".

In the "Attenuator" dialog, you can select the operating mode of the electronic step
attenuator.

The remote commands required to define these settings are described in Sec-
tion 13.13, "OUTPut subsystem", on page 419 and Section 13.16.11, "SOURce:POWer
subsystem", on page 524.

Settings

Mode........................................................................................................................... 172
Level Range................................................................................................................ 173
RF OFF Mode............................................................................................................. 173
Readjust...................................................................................................................... 173

Mode
Determines the operating mode of the step attenuator.
"Auto" Adjusts the attenuator settings automatically.
"Fixed" Fixes the attenuator and amplifier paths for the current RF level and

provides signal output with constant output VSWR. The resulting level
range is indicated under "Level Range" on page 173.

Remote command: 
:OUTPut<hw>:AMODe on page 420

Attenuator
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Level Range
Shows the interruption-free range of the level that you can use in the selected mode.
Remote command: 
:OUTPut<hw>:AFIXed:RANGe:LOWer? on page 421
:OUTPut<hw>:AFIXed:RANGe:UPPer? on page 421

RF OFF Mode
Determines the state of the step attenuator, when the RF signal is switched off.
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
"Unchanged" Freezes the setting of the step attenuator.

Use this mode if a constant VSWR (Voltage Standing Wave Ratio) is
required.

"Full Attenuation"
Switches to the maximum attenuation.
Use this mode for applications that require a high level of noise sup-
pression.

Remote command: 
[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE on page 528

Readjust
Recalculates and adjusts the internal switch positions of the RF chain according to the
current level.
The R&S SMB100B provides the "Readjust" function when you change one of the fol-
lowing parameters from the default setting:
● "RF Level" > Setting Characteristics
● "Attenuator" > Mode > FixedSetting Characteristics
Remote command: 
[:SOURce<hw>]:POWer:ALC:SONCe on page 528

8.1.2  Reverse power protection

R&S SMB100B RF instruments only

The instrument is equipped with a reverse power protection circuit.

The reverse power protection is tripped when the power of signals reflected from the
load or external signals applied to the RF output get too high. A relay opens and inter-
rupts the internal connection to the RF output. This condition is indicated in the status
bar by the "Overload" status message.

Overload
If an "Overload" status message is indicated in the status bar, perform the following:
● Remove the cause for the overload
● Press the [RF on/off] key to reset the overload protection
The RF input is activated when the overload protection is reset.

Attenuator
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Remote command: 
:OUTPut<hw>:PROTection:TRIPped? on page 421
:OUTPut<hw>:PROTection:CLEar on page 421

8.2  Automatic level control (ALC)

The R&S SMB100B is equipped with an automatic level control (ALC) unit to obtain
best RF level accuracy.

About ALC

ALC is an adaptive control system to stabilize the RF output level. It continuously moni-
tors the current level and adjusts it to keep a steady state over temperature and time.

ALC is active in almost all applications by default. However, when pulse modulation
with short pulses is used, the ALC uses table-based level settings with table values
depending on the pulse width.

Also note that ALC can detect incorrect values in multi-transmitter test setups. If mul-
tiple generators are coupled, reverse power can affect the ALC readings, which leads
to an incorrect RF output power.

ALC states and their effects

The following description basically explains the ALC states and their principle of opera-
tion:
● "Auto"

Adjusts the output level to the operating conditions automatically. ALC is active in
almost all operating modes.

● "On"
Activates the internal level control permanently, regardless of the operating condi-
tions.
Note: This mode is not useful for pulse modulation with narrow pulses and low rep-
etition rates, since the automatic level control cannot settle in time. Set ALC "Auto"
or "Table & On" instead.

● "Off (Sample & Hold)"
R&S SMB100B RF instruments only
Deactivates ALC, but still allows you to maintain a constant output level.
The R&S SMB100B switches briefly in the CW mode and enables ALC to adjust
the level to the set target value. The instrument freezes this setting, turns off ALC
again, and switches back to the operating mode.

● "Off (Table)"
Deactivates internal level control loop. The instrument calculates every level setting
using the attenuation values from the internal (ALC) table. Level attenuation
between two table values is done with linear interpolation. This mode enables you
to perform a fast and strictly monotonic, but not quite as precise level adjustment.

● "Table & On"

Automatic level control (ALC)
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Starts with the associated value of the internal level table and then activates the
automatic level control. This mode achieves maximum level accuracy and fast set-
ting times.
If pulse modulation is applied, this mode ensures fast level settings even with nar-
row pulses at low repetition rate.

The R&S SMB100B displays the level control setting as a status message in the info
line.

8.2.1  ALC settings

Access:

► Select "Level" > "Automatic Level Control".

In the "ALC" dialog, you can configure the settings for the automatic level control of
the RF signal to achieve optimal accuracy.

The remote commands required to define these settings are described in Sec-
tion 13.16.11, "SOURce:POWer subsystem", on page 524.

Settings

State............................................................................................................................175
Detector Sensitivity..................................................................................................... 176

State
Selects the internal level control mode.
"Auto" Selects the most appropriate ALC mode automatically.
"On" Activates ALC permanently.
"Off (Sample & Hold)"

R&S SMB100B RF instruments only
Deactivates the ALC, but allows you to recalibrate the level at each
frequency and level change. The value remains up to the next
change.

"Off (Table)"
Controls the level using the attenuation values of the internal ALC
table.

Automatic level control (ALC)
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"Table & On"
Starts with the attenuation setting from the internal ALC table and
continues with automatic level control.

For further details on the individual settings, an overview of the functionality and details
on what is to be considered, see "ALC states and their effects" on page 174.
Remote command: 
[:SOURce<hw>]:POWer:ALC[:STATe] on page 527

Detector Sensitivity
Determines the path of the internal level detector.
The level detector of the ALC has multiple paths distinguished by their sensitivity.
"Auto" Selects the detector path automatically, according to the given level.

This mode is the recommended operation mode.
"Low" Selects the detector path with low sensitivity.

This setting is intended for signals with high internal electronic levels.
"Med" Selects the path with medium sensitivity.

This setting corresponds to normal mode. It is intended for signals
with medium internal electronic levels.

"High" Selects the detector path with high sensitivity, intended for signals
with low internal electronic levels.

"Fix" Fixes the last set sensitivity setting.
Remote command: 
[:SOURce<hw>]:POWer:ALC:DSENsitivity on page 527

8.3  User correction

The R&S SMB100B supports a correction function to compensate external losses,
caused, for example, by the RF cable, to achieve a precise target input level at the
DUT.

The signal at the RF outputs of the R&S SMB100B is flat. However, the DUT is usually
not connected directly to the outputs of the instrument but rather via connecting cables.
Components like cables, power combiners, switches or mixers can affect the signal
flatness at the DUT input.

User correction
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Figure 8-1: Effect of external losses on the signal flatness at the DUT input

DUT = Device under test
Components = Designation of all components between the measurement equipment and the DUT, e.g.

cables
1 = Flat signal at the outputs of the R&S SMB100B
2 = Signal received at the DUT, incl. the external losses

About UCOR

User correction (UCOR) is a method that determines the external level loss of the RF
output signal over a frequency range in advance, see Figure 8-2.

The difference between the generator output level and the level at the DUT determines
the correction value at the respective frequency. Alternatively, the attenuation charac-
teristics over a certain frequency range of, for example, RF cables are also specified in
the associated specifications document.

For more information, refer to the specifications document.

Figure 8-2: Understanding the principle of user correction

DUT = Device under test
Compo-
nents

= Designation of all components between the measurement equipment and the DUT, e.g.
cables

PS = Power sensor, e.g. R&S NRP, connected at the DUT's input and the USB connector of the
R&S SMB100B

1 = Power sensor measures the level over a frequency range, where the collected values corre-
spond to the losses caused by the components between the R&S SMB100B and the DUT
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2 = Obtain the correction data by inverting the collected data; load the correction parameters in
the R&S SMB100B

3 = In the R&S SMB100B, the RF signal is pre-processed with the correction values so that the
signal at the outputs is the inverted version of the external losses

4 = Received at the DUT input, the pre-processed signal if flat

With active UCOR, the generator adds the correction value internally and thus increa-
ses the output level by exactly the amount of the loss between its output and the DUT.
For frequencies which are not contained in the list, the level correction is calculated by
interpolation of the closest correction values.

Possible ways for configuring the user correction values

You can configure correction values in the following ways:
● Internally

– Use the built-in table editor in the "UCOR > Edit User Correction Data" dialog.
Once defined, user correction values can be saved in a file.
Files with correction data can be exported, for example, to exchange configura-
tion between instruments or to modify the file content with an external program
and reload them again.

– Using the corresponding remote-control commands.
Note that you have to create a user correction file first.

● Externally
Create a file with correction values as a CSV file with Microsoft Excel, with a Note-
pad or a similar tool and save it with the predefined extension. Transfer the file to
and load it into the instrument.

UCOR file format

Files containing correction data are simple files in text or comma-separated value
(CSV) file format. The filename is user-definable; the file extension is *.ucor.

The file contains a list of correction values, one row per frequency and correction value
pair; a new line indicator separates the correction values.

For file handling, use the standard functions in the "File Manager", see Section 10.9,
"Using the file manager", on page 237.

Collecting correction data

To fill the frequency and power values in the correction table, use one of the following
options:
● Manually, row by row.
● Fill the table automatically with linearly interpolated values, calculated from value

range and step size.
● Acquire the real frequency response characteristics of the used component with

the R&S NRP power sensor, see Understanding the principle of user correction.

User correction
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Using a power sensor for frequency response measurements

Consider the following when using R&S NRP power sensors to measure the correction
values:
● Measure the level directly at the input of the DUT.
● Use the internal correction functions of an R&S NRP power sensor to increase the

measurement accuracy.
● Use S-parameter to consider the impact of any two-port device like an adapter

between the signal generator and the sensor input.

For information on the various possibilities of interoperability between
Rohde & Schwarz power sensors and Rohde & Schwarz signal generators, see the
application note 1GP141.

Interactions and characteristics
You can enable user correction in all operating modes.
The RF output level (LevelRF) is the sum of the level value and the correction for the
particular frequency:
LevelRF = "Status bar > Level" + "UCOR"

If enabled, the R&S SMB100B indicates user correction by the "Lev Ucor" icon in the
"Level" tile.

8.3.1  User correction settings

Access:

1. Select "Level" > "User Correction".

2. If you already have created a file with user correction data:

a) Select "UCOR Data" > navigate to the file "*.uco" > "Select".
b) Proceed with step 4.

3. If you need to create a file:

a) Select "UCOR Data" > "New".
b) Enter the filename UCOR_Data and confirm with "Ok".
c) Choose the file and confirm with "Select".
d) Select "Edit UCOR Data".
e) To fill the user correction data table, proceed as described in Section 8.3.2,

"Ucor data editor", on page 181.

4. Select "UCOR" > "State" > "On".

User correction
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5. Select "Level" > "RF State" > "On".

The "UCOR" dialog contains all settings for creating and handling files with user-
defined level correction values.

The remote commands required to define these settings are described in Sec-
tion 13.16.2, "SOURce:CORRection subsystem", on page 476.

Settings

State............................................................................................................................180
User Correction........................................................................................................... 180
UCOR Data................................................................................................................. 180
Edit UCOR Data..........................................................................................................181
UCOR Info...................................................................................................................181

State
Enables user correction.
The R&S SMB100B displays the status icon "Lev Ucor" in the "Level" panel.
Remote command: 
[:SOURce<hw>]:CORRection[:STATe] on page 481

User Correction
Indicates the corrected level value for a specific frequency point.
Remote command: 
[:SOURce<hw>]:CORRection:VALue? on page 480

UCOR Data
Opens the standard "File Select" function of the instrument. The provided navigation
possibilities in the dialog are self-explanatory.
Files with user correction values are files with predefined file extension *.uco. If you
select a file, the dialog indicates the filename.
You can create the file internally in the table editor or externally.
● To select an existing file, select "Select List", navigate to your user correction file

and select the file.
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● Use the general editor function to create a file or to edit an existing one.
● Use the standard file manager function to load externally created files to the instru-

ment.
Remote command: 
[:SOURce]:CORRection:CSET:CATalog? on page 481
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 480
[:SOURce]:CORRection:CSET:DELete on page 482

Edit UCOR Data
Opens the build-in table editor to define a new correction table or edit an existing one.
See also:
● Section 8.3.2, "Ucor data editor", on page 181
● "Fill..." on page 94
● Section 8.3.3, "Fill with sensor", on page 184

UCOR Info
Opens a window with information on the user correction file.
The window shows the metadata of the file and the output level parameters that are
relevant for user correction.
Remote command: 
n.a.

8.3.2  Ucor data editor

The "User Correction" dialog provides a build-in list editor for defining the correspond-
ing value pairs. Prerequisite to define correction values is that you have selected a file.
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Access:

► "Level" > "User Correction" > "Edit UCOR Data".

The editor for user correction data provides a table with RF frequency and level
values and standard navigation functions.
The remote commands required to define the user correction data are described in
Section 13.16.2, "SOURce:CORRection subsystem", on page 476.

All columns in a row must contain values. Cells with missing values are therefore filled
automatically, using the value of the previous row.
Once you enter a value, the editor automatically adds preset values in the other col-
umns. This functionality protects against data loss, otherwise incomplete rows are lost
when saving. You can simply override these values.

Since the table and navigation functions can be assumed to be known, the following
description contains a brief overview.

Settings:

Frequency (Hz)........................................................................................................... 183
Correction Value (dB)..................................................................................................183
User correction data handling keys.............................................................................183

└ Select Row....................................................................................................183
└ Edit................................................................................................................183
└ Fill with Sensor..............................................................................................183
└ Save As/Save............................................................................................... 183

Fill................................................................................................................................183
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Frequency (Hz)
Sets the frequency for level correction.
Remote command: 
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency on page 479

Correction Value (dB)
Sets the level correction value for the selected frequency.
Remote command: 
[:SOURce<hw>]:CORRection:CSET:DATA:POWer on page 479

User correction data handling keys
Standard functions for handling user correction data and files.

Select Row ← User correction data handling keys
Selects a row for editing.

Edit ← User correction data handling keys
Enables you to insert, or delete a row or ranges within the table, and provides access
to a dialog for automatic filling, see "Fill..." on page 94.

Fill with Sensor ← User correction data handling keys
Opens a dialog to configure the automatic filling of user correction data with an R&S
NRP power sensor.
See Section 8.3.3, "Fill with sensor", on page 184

Save As/Save ← User correction data handling keys
Saves the table in a file with user-defined name and predefined file extension. To save
a copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.
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To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".

8.3.3  Fill with sensor

The fill with sensor function requires that you have connected a power sensor and also
selected a file for user correction data before.

See:
● Section 8.4, "Using power sensors", on page 189
● "To create user correction data with an R&S NRP and the R&S SMB100B"

on page 207

Access:

1. Select "Level" > "User Correction".

2. Select "UCOR Data > navigate to the file *.ucor > Select".
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3. Select "Edit UCOR Data > Fill With Sensor...".

This dialog contains parameters for filling a table automatically with sensor read-
ings.

To fill the table, select "Execute".
For information on power sensors and how to use them, see Section 8.5, "Improving
the RF signal performance", on page 206.

Settings:

Fill User Correction Data with Sensor......................................................................... 185
Generator Settings used for Measurement................................................................. 186

Fill User Correction Data with Sensor
The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.
"Sensor" Displays connected sensors for selection.
"List To Fill" Indicates the used list.
"Config" Opens the sensor configuration dialog to set the parameters for the

selected power sensor.
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"Include Zeroing"
Performs a zeroing procedure before acquiring the user correction
data to improve precision.
No signal is applied to the sensor during zeroing. RF output is tempo-
rarily switched off during that time.
When unchecked, the zeroing procedure is skipped. However, the RF
signal level can be blanked shortly. This setting is useful if blanking of
RF is undesirable or the absence of power at the sensor cannot be
guaranteed.
Remote command: 
[:SOURce<hw>]:CORRection:ZERoing:STATe on page 481

"Execute" Triggers the sensor to measure and to return the data for user corr-
rection.
The "Execute" button is only enabled if a sensor is detected and the
user correction list contains at least one frequency value.
Remote command: 
[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:
POWer]:SONCe on page 480

Generator Settings used for Measurement
Displays the settings relevant for the measurement.
"Modulation" Indicates that modulation is off.

The R&S SMB100B disables modulation for the "Fill with sensor"
process, even if you have enabled a modulation and if you have star-
ted "Fill with sensor".

"Amplitude" Displays the RF level amplitude.
Remote command: 
[:SOURce<hw>]:POWer:POWer on page 530

"Offset" Displays the RF level offset.
Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet
on page 535

"UCOR Reference Level"
Displays the reference level for user correction.
This level is the sum of the RF level amplitude and RF level offset.
Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:REFLevel
on page 536

8.3.4  Import/export list files

Access:

1. Select one of the following:
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● "Sweep" > "List mode".
● "Level" > "User Correction".
● "Modulation > Pulse Modulation > Pulse Generator > Pulse Mode = Train".

2. Select "Import/Export".

Figure 8-3: Im-/Export dialog (example with UCOR settings)

The "Import/Export" dialog contains all functions and settings to import externally
created list data or to export it accordingly. You can process and store a list in the
formats *.txt (ASCII), or *.csv (plain text with identical sequence of fields). The
table separators and the decimal floating point numbers are customizable.

Settings:

Mode........................................................................................................................... 187
ASCII File Settings...................................................................................................... 187
Select (ASCII) Source/Select (ASCII) Destination...................................................... 188
Select Source/Select ASCII Destination..................................................................... 188
Import / Export.............................................................................................................188

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 520
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 466

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".
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Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 519
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 483
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 467

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 519
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 482
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 468

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 520
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 484
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 468

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 519
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 483
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 468
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8.4  Using power sensors

The R&S SMB100B works with any of the R&S NRP power sensors and thus supports
various application tasks. Using power sensors, you can for example determine attenu-
ation characteristics of downstream equipment or cables. You can use the measured
values to compensate the losses with internal control functions or with an external con-
trol circuit in real time.

For information on the various possibilities of interoperability between
Rohde & Schwarz power sensors and Rohde & Schwarz signal generators, see the
application note 1GP141.

R&S NRP power sensors are highly accurate standalone measuring devices, suitable
for a wide range of applications. The power sensors communicate directly with the sig-
nal generator, calculate the average or peak power internally, include S-parameter cor-
rection and return the measurement results to the generator.

The R&S SMB100B supports up to four power sensors, allowing up to four power mea-
surements simultaneously.

Check the firmware version of the R&S NRP sensors regularly. Update the firmware, if
necessary.
For updates, see the Rohde & Schwarz website www.rohde-schwarz.com in section
"Power Meters & Voltmeters".

For information on working with power sensors, see the following topics:
● Section 8.4.2, "Connecting R&S NRP power sensors to the R&S SMB100B",

on page 191
Overview on the supported connectors, connection options and the required acces-
sories.

● Section 8.4.3, "NRP power viewer", on page 192
A function for measuring and monitoring the RF output power or a user-defined
singnal source.

● Section 8.4.4, "NRP power control", on page 193
Controls a downstream closed loop power control circuit, to compensate frequency
response characteristics.

● Section 8.4.5, "NRP sensor configuration", on page 198
Parameter settings of the specific R&S NRP power sensor.

● Section 8.4.6, "NRP sensor mapping", on page 203
Shows all R&S NRP sensors connected to the instrument, or in the LAN.

8.4.1  About

The R&S SMB100B can perform up to four power measurements simultaneously.

Depending on the signal characteristic (CW, AM, pulsed, etc.) or the parameter to be
measured (average, peak, etc.) a suitable R&S power sensor must be used.

Using power sensors
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About the measuring principle, averaging filter, filter length, and achieving stable
results

A sensor measures the average or peak RF power of the source continuously. The
measurement results are displayed in the "NRP Power Viewer" dialog.

The power viewer function uses averaging filters for getting a stable readout.

Measurement results could be interfered, for instance, by too much noise in your
setup, by a bad suppression of harmonics or non-harmonics or when you reach the
sensitivity level of your power sensor.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. This approach is referred as a two-step averaging process.

The factor of 2 in the formula arises because the output signals from the microwave
detector are chopped at the same rate as the time windows to suppress low-frequency
noise. An independent measured value can only be obtained from two consecutive val-
ues.

The variable N in the formula indicates the filter length. The filter length then directly
influences the measurement time. The filter length can be selected automatically or it
can be manually set to a fixed value.

Follow the following general recommendation to find out the optimum filter length:
● Always start a measurement in auto mode ("Filter > Auto").

Check if the measurement results are sufficient.
● If the power is not constant, select the filter length manually ("Filter > User").

Trigger the "Auto Once" function to search for the optimum filter length for the cur-
rent measurement conditions.
The estimated value is indicated as filter length.

● If the target measurement accuracy value is known, select "Filter > Fixed Noise".
The averaging factor is selected automatically and so that the sensor's intrinsic
noise (two standard deviations) does not exceed the specified noise content.

● Depending on the R&S NRP power sensor type, the manual setting of the filter
length varies in resolution.

● Different sensor types achieve the same filtering result with different filter and time
window lengths.
For most sensors, the time window length is fixed to 20 ms, whereas, e.g., for the
R&S NRP-Z81 sensor, the time window length is 10 μs.

For more information, refer to the specifications document.

About zeroing

Activates the auto zero function.
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Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:
● During warm up after switching on or connecting the instrument
● After a substantial change of the ambient temperature
● After fastening the power sensor module to an RF connector at high temperature
● After several hours of operation
● When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.
● Switch off the RF power source for zeroing, but do not disconnect it from the power

sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Related settings and functions

● Measurements-related settings, like results, filter, filter length:
Section 8.4.5, "NRP sensor configuration", on page 198

● Software version of the connected power sensor:
:SENSe<ch>[:POWer]:TYPE? on page 436

● Acquisition of level correction data:
Section 8.3, "User correction", on page 176

Additional information

See the Rohde & Schwarz website www.rohde-schwarz.com, section "Power Meters &
Voltmeters" for:
● R&S NRP power sensor manual.
● Information on the R&S NRP-Z5 sensor hub and the available accessories.
● Sensor software updates.

8.4.2  Connecting R&S NRP power sensors to the R&S SMB100B

R&S NRP sensors are connected to the R&S SMB100B in the following ways:
● Connection to the USB connector

Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via R&S NRP-Z5 sensor hub

Using power sensors
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The R&S NRP-Z5 USB sensor hub (high-speed USB 2.0) can host up to 4 R&S
NRP sensors.
Requires additional standard USB cable (USB type A to USB type B) to any USB
type A connector of the R&S SMB100B. This connection supports internal trigger-
ing.

● Connection via USB hub with external power supply unit
Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via LAN for R&S NRPxxxSN/xxxTN/xxxAN power sensors

Using the Ethernet interface requires PoE (Power over Ethernet) to provide the
electrical power.
To establish the connection, you can use:
– A PoE Ethernet switch, e.g. R&S NRP-ZAP1 and an RJ-45 Ethernet cable.
– A PoE injector and an RJ-45 Ethernet cable.

For details, see the description R&S®NRP Power Sensors getting started.

Detection and mapping

The R&S SMB100B either detects a R&S NRP power sensor automatically or you can
scan for available power sensors manually. The "NRP Sensor Mapping" dialog lists all
detected R&S NRP power sensors, see Section 8.4.6, "NRP sensor mapping",
on page 203. The dialog enables you to add, remove and map the sensors manually.

Depending on the connection interface, the R&S SMB100B detects and maps connec-
ted R&S NRP power sensors differently:
● USB interface

Detects a sensor automatically and maps it with index "1" to index "4" according to
the sequence of connection.

● LAN interface
To detect sensors that are connected in the LAN, the instrument provides a scan
function. When you start the function, scan searches in the LAN for available R&S
NRP power sensors and adds all detected sensors to list. Assigning a mapping
index activates the sensor for the measurement.

On connection, the R&S SMB100B immediately starts the measurement of the R&S
NRP power sensor. If you preset the instrument ([Preset] key or *RST), the
R&S SMB100B stops the measurement. The connection and the mapping of the power
sensors remain.

8.4.3  NRP power viewer

The R&S SMB100B features the power viewer function for measuring or monitoring
signals with R&S NRP power sensors.

Using power sensors



Improving level performanceR&S®SMB100B

193User Manual 1178.3711.02 ─ 11

8.4.3.1  NRP power viewer settings

Access:

► Select "Power Sens" > "NRP Power Viewer".

The "Power Viewer" tab lists the mapped R&S NRP power sensors with the mea-
sured parameter mode and the current readings. The "Config" button leads you to
the configuration dialog to set the parameters for each sensor.

The remote commands required to define these settings are described in Sec-
tion 13.14, "SENSe, READ, INITiate and SLISt subsystems", on page 422, includ-
ing the triggering of the measurement and the retrieval of measurement results.
See also Section 8.5, "Improving the RF signal performance", on page 206.

Settings

Config..........................................................................................................................193

Config
Opens the "Sensor Configuration" dialog.
See also Section 8.4.5, "NRP sensor configuration", on page 198.

8.4.4  NRP power control

The NRP power control function enables you to apply stable and accurate RF power to
the DUT. For example, you can set up a downstream closed loop power control circuit
to compensate spurious effects or losses caused by power amplifiers or cables.

Using power sensors
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Example: How to set up a closed loop power control

DUT

Power 
sensor

Signal generator
Amplifier x dB 

Coupler

Measured level

RF  level Input level

Figure 8-4: Example of a test setup with NRP power control

The signal generator applies the RF output signal to an amplifier and to the DUT. An
intermediately connected coupler derivates the output power from the output signal
and forwards it to the power sensor. Thus, the power sensor measures a proportional
power in defined time intervals, and returns the results to the signal generator. If sup-
ported, the power sensor also includes given S-parameters. The signal generator com-
pares the measured power with the set level value and adjusts the level of the output
signal accordingly.
This closed loop power control enables you to control the external signal level continu-
ously and reliably achieve a constant input power at the DUT in real time.

Impact of NRP power control and operating modes
Since the frequency and level of the RF output signal are continuously adjusted during
"NRP Power Control", this operating mode interferes signal generation modes with
varying frequency and level values. In addition, the setting time increases. The reason
is the interaction between the signal generator and the R&S NRP power sensor in the
control loop.
The operating modes impact each other as follows:
● Enabling the RF frequency sweep, RF level sweep or the list mode disables a run-

ning "NRP Power Control".
● A running list or RF sweep mode blocks "NRP Power Control".
● Modulated signals can deviate from the CW signal in mean power and peak power,

and thus affect the "NRP Power Control".

8.4.4.1  NRP power control settings

Access:

► Select "Power Sens" > "NRP Power Control".

Using power sensors
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In this dialog you can configure the parameters of the power control setup for the
selected power sensor.
The remote commands required to define these settings are described in Sec-
tion 13.16.11, "SOURce:POWer subsystem", on page 524.

Settings

State............................................................................................................................195
Sensor.........................................................................................................................196
Measured Level...........................................................................................................196
Target Level.................................................................................................................196
Take Measurement as Target Level............................................................................ 196
Mode........................................................................................................................... 196
Execute Single............................................................................................................ 196
Catch Range +/-..........................................................................................................197
Delay Time.................................................................................................................. 197
Limit.............................................................................................................................197
Setting Characteristics................................................................................................ 197

State
Enables power control with the selected sensor.
The control loop periodically adjusts the generator output. After switching off, the run-
ning loop is completed.
Note: If you want to use another sensor, you must disable power control before. It is
not possible to switch between sensors when power control is active.
Remote command: 
[:SOURce<hw>]:POWer:SPC:STATe on page 533
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Sensor
Indicates the R&S NRP power sensor that is selected for power control.
To configure the power sensor parameters, see Section 8.4.5, "NRP sensor configura-
tion", on page 198.
Remote command: 
[:SOURce<hw>]:POWer:SPC:SELect on page 532

Measured Level
Indicates the current reading of the selected power sensor.
Remote command: 
:READ<ch>[:POWer]? on page 428
:SENSe<ch>:UNIT[:POWer] on page 429

Target Level
Specifies the nominal level expected at the input of the sensor. The signal generator
adjusts the output power accordingly, to meet the target value at the sensor input, and
thus the power required at the DUT.
Remote command: 
[:SOURce<hw>]:POWer:SPC:TARGet on page 533

Take Measurement as Target Level
Uses the currently measured level as reference and applies the value as target level,
see "Target Level" on page 196.
This feature simplifies setting up the control loop after manual adjustment of the mea-
surement configuration. To assign the measured level as reference level, you must
switch off "NRP Power Control". It is not possible when the control loop is running.
Remote command: 
[:SOURce<hw>]:POWer:SPC:MEASure on page 532

Mode
Selects the measurement mode for acquiring the power values measured by the sen-
sor.
"Auto" Immediately starts and measures the power continuously.
"Single" Starts when you manually select Execute Single, and executes one

power measurement cycle.
Note, that you can achieve the expected target power level at the
DUT only with linear test setups. Non-linear test setups, for example,
setups including an amplifier do not work.

Remote command: 
[:SOURce<hw>]:POWer:SPC:MODE on page 532

Execute Single
In mode "Single", starts one measurement cycle manually.
Remote command: 
[:SOURce<hw>]:POWer:SPC:SINGle on page 533
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Catch Range +/-
Sets the capture range of the control system.
Within the range:
Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the
range are not considered.
Remote command: 
[:SOURce<hw>]:POWer:SPC:CRANge on page 531

Delay Time
Sets a waiting period between the level adjustment of the generator and the next mea-
surement of the power sensor.
With this parameter, you can bypass idle times in the controlled system.
Remote command: 
[:SOURce<hw>]:POWer:SPC:DELay on page 531

Limit
Sets an upper limit for the output power.
Note: The parameter "RF level" > "Limit" and "NRP power control" > "RF Amplitude
Limit" are identical.
You can use this value to protect your DUT from damage due to high input power. If
you enter an RF level above this value, the instrument limits the output power to this
specified value, and generates the warning message:
"Pep value greater than the defined limit." However, the level indication in the status
bar is not affected.
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce<hw>]:POWer:LIMit[:AMPLitude] on page 529

Setting Characteristics
Selects additional quality characteristics to optimize the behavior of the RF signal level
for the specific application.
"Auto" Sets the RF output level automatically according to the selected

mode.
In this mode, the instrument provides the highest dynamic range and
fastest setting times.
The RF signal is shortly blanked when the step attenuator is switch-
ing.
For more information, refer to the specifications document.

Using power sensors



Improving level performanceR&S®SMB100B

198User Manual 1178.3711.02 ─ 11

"Uninterrupted"
Suppresses blanking at level transitions. Frequency transitions can
lead to an RF level blanking due to hardware-specific switching
points.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Executes signal level changes monotonically increasing or decreas-
ing.
The setting makes sure that increasing the level value exclusively
results in an increased output level, and vice versa.
All electronic switches, which can affect the monotonicity are fixed.
The operation mode is useful for applications using level searching
algorithms which rely on a strictly monotonous behavior.

"Constant-VSWR"
Suppresses output impedance variations at the RF 50 Ω output con-
nector, due to changed level settings.

"User" Selects this entry automatically when you change one of the following
parameters from the default setting:
● "Attenuator" > Mode
● "ALC" > State or Detector Sensitivity
Note: If you select another setting characteristic, the R&S SMB100B
presets the modified attenuator and ALC parameters.

Remote command: 
[:SOURce<hw>]:POWer:LBEHaviour on page 529

8.4.5  NRP sensor configuration

Access:

► Select "Power Sens" > "NRP Sensor Configuration".
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In this dialog you can configure the parameters for each mapped R&S NRP power
sensor in separate tabs.

The remote commands required to define these settings are described in Sec-
tion 13.14, "SENSe, READ, INITiate and SLISt subsystems", on page 422, includ-
ing the triggering of the measurement and the retrieval of measurement results.

Settings:

Sensor type and serial number................................................................................... 200
Level (Peak) / Level (Average)....................................................................................200
State............................................................................................................................200
Zero.............................................................................................................................200
Display........................................................................................................................ 200
Display Permanent......................................................................................................200
Use Frequency Of....................................................................................................... 201
Frequency................................................................................................................... 201
Level Offset State,Level Offset....................................................................................201
Filter............................................................................................................................ 201
Filter Length................................................................................................................ 202
Auto Once................................................................................................................... 202
Noise/Signal Ratio.......................................................................................................202
Timeout....................................................................................................................... 202
Default Aperture Time................................................................................................. 202
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Aperture Time..............................................................................................................202
S-Parameter................................................................................................................203
Enable Logging........................................................................................................... 203

Sensor type and serial number
The side tab label indicates type and serial number of an R&S NRP power sensor and
its mapping index.
The Level (Peak) / Level (Average) values display the current readings of the sensor.
Remote command: 
:SENSe<ch>[:POWer]:TYPE? on page 436
:SENSe<ch>[:POWer]:SNUMber? on page 435

Level (Peak) / Level (Average)
Indicates the measured peak or average level value.
You can also change the unit for the results display: Watt, dBm or dBμV.

Note: Peak level measurements are provided if the power sensor supports this feature.
Remote command: 
:READ<ch>[:POWer]? on page 428
:SENSe<ch>:UNIT[:POWer] on page 429

State
Enables level measurement of the R&S NRP power sensor.
Remote command: 
:INITiate<hw>[:POWer]:CONTinuous on page 428
To query the availability of a sensor at a given connector, use the command :
SENSe<ch>[:POWer]:STATus[:DEVice]? on page 435.

Zero
Activates the auto zeroing.
For details, see "About zeroing" on page 190.
Remote command: 
:SENSe<ch>[:POWer]:ZERO on page 436

Display
Sets the display of results on mean or peak power.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority on page 430

Display Permanent
Enables the display of the power sensor with the currently measured value in the sta-
tus bar of the home screen.
You can activate the permanent display for several sensors.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe on page 431
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Use Frequency Of
Selects the source for measurement.
"RF" The R&S SMB100B transfers the RF frequency and level settings to

the R&S power sensor automatically. Thus you achieve power read-
ings of high accuracy, irrespective from the connected sensor type.

"User" Sets a user defined frequency.

Example: 
If you have a frequency converting device between the generator and
the DUT. If the frequency converter doubles the frequency, you can
set twice the frequency in the R&S SMB100B. The R&S power sen-
sor considers this RF frequency setting.

Set the parameter Frequency to the measurement's frequency.
Remote command: 
:SENSe<ch>[:POWer]:SOURce on page 435

Frequency
Defines the frequency value if "Source > User" is used.
Remote command: 
:SENSe<ch>[:POWer]:FREQuency on page 433

Level Offset State,Level Offset
Activates and defines a level offset which is considered in the power measurement
result. The level offset value is always expressed in dB, irrespective of the display of
the measurement result.
This function allows you to consider, for example, an attenuator in the signal path.
Remote command: 
:SENSe<ch>[:POWer]:OFFSet on page 434
:SENSe<ch>[:POWer]:OFFSet:STATe on page 434

Filter
Selects the way the length of the used filter is defined.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 190.
"Auto" Selects the filter length automatically and adjusts it to the measured

value. The value is indicated with the parameter Filter Length.
When high output power is applied, the filter length and therefore the
measurement time can be short.
When low output power is applied, the filter length and therefore the
measurement time is increased which reduces the considered noise
content in your measurement.

"User" The filter length is defined manually, with the parameter Filter Length.
As the filter length works as a multiplier for the time window, constant
filter length results in a constant measurement time.
Values 1 and 2N are allowed.
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"Fixed Noise" The averaging factor is taken automatically in accordance to the
value Noise/Signal Ratio. Thus, the sensor's intrinsic noise (2 stan-
dard deviations) does not exceed the specified noise content.
To avoid long measurement times when the power is too low, set a
Timeout.
Timeout is the maximum acceptable measurement time which limits
the averaging factor and therefore leads to a more unstable readout.

Remote command: 
:SENSe<ch>[:POWer]:FILTer:TYPE on page 433

Filter Length
Sets or indicates the filter length, depending on the selected filter mode.
● "Filter > Auto" indicates the automatically adjusted filter length.
● "Filter > User" enables you to set the filter length manually.
● "Filter > Fixed Noise" hides the setting parameter.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO? on page 431
:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] on page 431

Auto Once
Searches the optimum filter length for the current measurement conditions. The result
is indicated with the parameter Filter Length.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 190.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:SONCe on page 432

Noise/Signal Ratio
For Filter > Fixed Noise, sets the noise content.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio on page 432

Timeout
Sets a time limit for the averaging process.
The setting is bound to the timeout of the connected sensor.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe on page 432

Default Aperture Time
The sensor default setting is sufficient. Disable this parameter to specify a user-defined
aperture time per sensor, if, for example, the readings vary.
To obtain stable readings, set the Aperture Time exactly to one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:DEFault:STATe on page 429

Aperture Time
If "Use Default Aperture Time > Off", defines the acquisition time per sensor.
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For example, to obtain a sufficient low average value, set the aperture time exactly to
one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:TIMe on page 429

S-Parameter
Lists the S-Parameter correction data files retrieved for the connected power sensor.
To activate the correction data, select the corresponding file.
S-Parameter correction is used to mathematically shift the reference plane to the DUT
by considering the S-parameters for any components connected upstream of the sen-
sor.
The S-Parameter table can be changed with the S-Parameters tool, provided as part of
the free R&S NRP Toolkit software. For more information, refer to the manual of the
connected R&S NRP power sensor.
Remote command: 
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe on page 430
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST? on page 430
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect on page 430

Enable Logging
Activates recording of R&S NRP power sensor readings in a log file.
There is 1 log file per sensor. The log files are created automatically and filled in con-
tinuously. They are text files with predefined filename SensLog<n>.txt, where <n>
indicates the connected sensor. Log files are stored on the internal memory, in the
directory /var/user/SensorLogging.

Each log file contains the measured value (2 readings when you work with peak sen-
sors), the sensor type, and the measurement time (timestamp). Logged data is not
overwritten. When a new measurement is started, the collected logging data is appen-
ded in the log file.
Check the used disc space regularly and remove log files to maintain storage capacity.
Note: The logging function is intended for measurements with long time intervals. It is
suitable source for data reconstructions if the connection to the sensor was interrupted.
Remote command: 
:SENSe<ch>[:POWer]:LOGGing:STATe on page 434

8.4.6  NRP sensor mapping

The "NRP Sensor Mapping" lists the sensors detected by the instrument.

Any R&S NRP sensor that supports the USB legacy protocol and is connected to one
of the USB interfaces, is detected automatically and added to the list. When you dis-
connect a power sensor, the R&S SMB100B removes it from the list accordingly.

R&S NRP power sensors that are connected in the LAN or use the USBTMC protocol
are only detected by the scan search function.
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Access:

► Select "Power Sens" > "NRP Sensor Mapping".

The dialog lists all detected R&S NRP sensors for selection and mapping. You can
also browse the network for sensors.
The list informs on the sensor type with serial number, specific features and the
revision of the sensor firmware.
For each sensor, you find the used protocol and the connector icon of the interface.
In the "Mapping" column, you can assign a mapping index to enable the sensor for
use. The list can contain several entries but the R&S SMB100B can only use up to
four sensors simultaneously.
The remote commands required to define these settings are described in Sec-
tion 13.14, "SENSe, READ, INITiate and SLISt subsystems", on page 422.

Settings

Sensor Mapping List................................................................................................... 204
Scan............................................................................................................................ 205
Clear............................................................................................................................205
Add Sensor................................................................................................................. 205
Add LAN Sensor......................................................................................................... 205
Add USBTMC Sensor................................................................................................. 206

Sensor Mapping List
Shows the sensors that are connected to the R&S SMB100B.
The table informs on the sensor type, specific features and the installed sensor firm-
ware. It also shows the interface the sensor is connected to, including the communica-
tion protocol and the mapping index.
Remote command: 
:SLISt[:LIST]? on page 425
:SLISt:ELEMent<ch>:MAPPing on page 427
:SLISt:SENSor:MAP on page 427
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Scan
Scans the network and the USB connections for sensors connected using the VISA
communication protocol, i.e. sensors that are addressed over LAN or USBTMC.
The instrument detects sensors communicating over the USB legacy protocol automat-
ically.
Remote command: 
:SLISt:SCAN[:STATe] on page 425

Clear
Removes all entries of R&S NRP power sensors using the VISA communication proto-
col (USB or LAN) from the sensor mapping list.
The setting does not affect sensors communicating over USB legacy protocol. To
remove a USB legacy sensor from the list, disconnect it from the interface.
Note: With the remote control commands :SLISt:CLEar:LAN
and :SLISt:CLEar:USB, you can remove the power sensors of the corresponding
VISA interface selectively.
Remote command: 
:SLISt:CLEar:LAN on page 426
:SLISt:CLEar:USB on page 426
:SLISt:CLEar[:ALL] on page 427

Add Sensor
Shows or hides the "Add Sensor" dialog to configure power sensors connected to the
R&S SMB100B over USB or LAN.

Add LAN Sensor
Configures settings to add sensors connected to the R&S SMB100B over LAN.

"IP Address or Host Name"
Displays the host name or the IP address of a R&S NRP power sen-
sor.
If the R&S SMB100B does not detect a connected R&S NRP sensor,
you can assign the address information manually.

"Add LAN Sensor"
Adds a detected R&S NRP sensor connected in the LAN to the list of
sensors, including its device ID or name and its serial number.

Remote command: 
:SLISt:SCAN:LSENsor on page 425
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Add USBTMC Sensor
Configures settings to add sensors connected to the R&S SMB100B over USB.
If the R&S SMB100B does not detect a connected R&S NRP sensor, you can assign
the device ID manually.
"Sensor"

Selects the name of the R&S NRP power sensor.
If the R&S SMB100B does not contain the R&S NRP power sensor
you use, select "<from Device ID". The "Device ID" entry field
switches in edit mode where you can enter the ID of your product
manually.

"Device ID"
Displays the device identifier of a selected R&S NRP power sensor.
If you want to assign the device ID manually, get the information in
the user documentation of your power sensor.

"Serial Number"
Displays the serial number of the R&S NRP power sensor.
If the R&S SMB100B does not detect a connected R&S NRP sensor,
you can assign the serial number manually.

"Add USBTMC Sensor"
Adds a detected R&S NRP sensor connected at the USB interface to
the list of sensors, including its device ID or name and its serial num-
ber.

Remote command: 
:SLISt:SCAN:USENsor on page 426

8.5  Improving the RF signal performance

To achieve an accurate input level at the DUT, you can compensate losses, e.g.
caused by cables between the RF output and the DUT over a frequency range.

Using the user correction function and e.g., a R&S NRP power sensor, the
R&S SMB100B utilizes the readings of the power sensor and creates a correction
value table for controlling the output level during operation.

To connect the R&S NRP to the R&S SMB100B

1. Connect the power sensor.
See Section 8.4.2, "Connecting R&S NRP power sensors to the R&S SMB100B",
on page 191.

2. Select "Power Sens" > "NRP Sensor Mapping".

3. If the sensor is not detected automatically, select "Scan > Start".

The instrument scans the network and the USB connections for connected sensors
and lists all detected R&S NRP sensors in the mapping table.
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4. In the "Mapping" column, assign the sensor to a sensor channel, see Section 8.4.6,
"NRP sensor mapping", on page 203.

5. Close the dialog.

To configure and calibrate the R&S NRP in the R&S SMB100B

Provided the power sensor is connected to the R&S SMB100B and is assigned to a
sensor channel, we recommend that you calibrate and configure the power sensor.

1. Select "Level" > "RF ON > Off"

2. Select "Power Sens" > "NRP Power Viewer".

3. To configure a sensor, select "Config".

4. Select "Zero" to start zeroing of the sensor.
Note: Always turn the RF power off or disconnect the sensor from RF before zero-
ing, since the function calibrates the power sensor at zero signal power.

The zeroing process takes a few seconds, depending on the power sensor type.

5. Configure additional parameters for the selected sensor as required.

6. Select "State > On".

7. Close the dialog.

To create user correction data with an R&S NRP and the R&S SMB100B

We assume, that the power sensor is connected, assigned and ready for operation.

1. Select "Level" > "User Correction".
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2. Select "UCOR Data" > "UCOR Data...."

3. Create a file: "New" > Filename and confirm with "OK".

4. Select the new file with "Select".

5. Select "Edit UCOR Data...".

6. Select "Edit" > "Fill".

The "Fill Table" dialog enables you to fill in the values of the columns automatically.

7. To fill in the frequency column:

a) Select "Select Column To Fill > Frequency / Hz".
b) Select "Range > e.g. 15" to determine the number of values.
c) Select "Start Value > e.g. 1.56 GHz".
d) Select "Increment Value > e.g. 1 MHz", to determine the frequency steps.
e) Select "Fill", to insert the frequency values.
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The "Fill" function also fills the column of the "Correction Value / dB" values with a
predefined value, since empty cells lead to the data loss of the entire line. If you
need different values, you can change them manually, or you can use the auto-
matic function "Fill with Sensor" as described in the next steps.

8. Select "Fill with Sensor".

The "Fill User Correction Data With Sensor" dialog provides an overview of the
sensor configuration.

9. Select "Execute".

The R&S SMB100B successively sets each frequency point, reads the measured
power of the sensor and fills in the value in the correction table.

10. Select "Save" to save the data in the file.

11. Close the dialog.

To calibrate the power level with user correction data

We assume that a user correction file is available in the user directory of the
R&S SMB100B or on a memory stick or in a shared directory.

If you have created and saved the file immediately before this step, the file is loaded in
the "User Correction" dialog automatically. Otherwise you can load a previously saved
file.

1. Select "Level" > "User Correction".

2. Select "UCOR Data" > "UCOR Data...", if there is no file loaded already.

3. Select the directory and file you want to use.
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4. Load the file with "Select".

5. To view the file content, select "Edit UCOR Data...".

6. Select "UCOR Data" > "State" > "On" to apply the user correction values.

When you activate the RF output, the R&S SMB100B considers the user correction
data and adjusts the signal level accordingly to compensate external frequency
responses.

Improving the RF signal performance
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9  Reference oscillator
The R&S SMB100B is equipped with an internal reference oscillator that generates a
reference frequency of 10 MHz. It is used as internal reference source for the synthe-
sizer.

Alternatively, you can apply an external reference signal. If equipped with the required
options, the R&S SMB100B can process external reference frequency in the range
1 MHz to 100 MHz and the 1 GHz reference frequency.

Regardless of the used reference source (internal or external), the R&S SMB100B
always provides the configured reference frequency at the output. You can use it, for
example to synchronize several interconnected instruments, see Section 9.5, "Using
the reference frequency for instruments synchronization", on page 216, for an overview
of typical test situations.

The reference oscillator settings are not affected by an instrument preset ([Preset] key
or *RST) and the "Save/Recall" function. They are reset only by "Set To Default" in the
corrresponding refererence frequency dialog or by a factory preset.

9.1  Required options

R&S SMB100B base unit equipped with the following options:
● Reference oscillator (R&S SMBB-B1/-B1H)
● 1 GHz reference (R&S SMBB-B3)
● 1 MHz to 100 MHz flexible reference input (R&S SMBB-K704)

For more information, refer to the specifications document.

9.2  Reference frequency settings

Access:

1. Select "Frequency" > "Reference Frequency".

Reference frequency settings
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In the "Reference Frequency" tab, you can select the reference frequency signal
source and the frequency and synchronization bandwidth mode of an external ref-
erence signal.

2. Observe the information on the home screen, "Frequency" tile.

The "Frequency" tile indicates the current reference oscillator configuration, incl.
the reference oscillator source, external reference frequency (rounded value) and
output connector. A warning symbol in the "Frequency" tile indicates a missing
external source.

The remote commands required to define these settings are described in Sec-
tion 13.16.12, "SOURce:ROSCillator subsystem", on page 537.

Settings:

Set to Default.............................................................................................................. 213
Source.........................................................................................................................213
Show/Show Connector................................................................................................213
Deactivate RF Output (if external reference is missing)..............................................213
External Reference Frequency................................................................................... 213
Variable Reference Frequency....................................................................................214
Synchronization Bandwidth.........................................................................................214
Nominal Synchronization Bandwidth...........................................................................214
Minimum Locking Range.............................................................................................214
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Set to Default
Resets the reference oscillator settings to default.
Remote command: 
[:SOURce]:ROSCillator:PRESet on page 539

Source
Selects the reference frequency source.
"Internal" Uses the internal reference oscillator, either with calibrated or a user-

defined Adjustment Value.
Note: The internal reference frequency automatically uses Synchroni-
zation Bandwidth > Narrow. Thus, if you preset this parameter, or set
the reference source from "External" to "Internal" manually, the
R&S SMB100B sets the bandwidth to "Narrow".

"External" Uses an external reference signal.
Note: If the external reference is missing, the R&S SMB100B issues
a warning message and indicates the icon  (external reference
missing).
To set the frequency of the external reference, see "External Refer-
ence Frequency".

Remote command: 
[:SOURce]:ROSCillator:SOURce on page 539

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

Deactivate RF Output (if external reference is missing)
Turns off the RF output when the external reference signal is selected, but no signal is
supplied.
This function prevents that no improper RF signal due to the missing external refer-
ence signal is used for measurements. A message indicates that the RF output is
deactivated.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] on page 540

External Reference Frequency
Selects the frequency of the external reference input signal.
"10 MHz" 10 MHz external reference frequency

"100 MHz"/"1 GHz"
Option: R&S SMBB-B3
The R&S SMB100B locks its internal 500 MHz reference oscillator on
the 100 MHz or 1 GHz reference.
Selects the external reference frequency.

"Variable" Requires R&S SMBB-K704.
The external reference signal has an arbitrary frequency, within the
permissible range from 1 MHz to 100 MHz.

Reference frequency settings
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Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency on page 540

Variable Reference Frequency
Requires R&S SMBB-K704 and "External Reference Frequency" > "Variable".
Sets a variable value for the external reference frequency.
For more information, refer to the specifications document.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable on page 540

Synchronization Bandwidth
Selects the synchronization bandwidth for an external reference signal, set with
"Source > External".
The resulting bandwidth is indicated by the parameter Nominal Synchronization Band-
width.
"Narrow" The internal reference oscillator is synchronized to the external signal

with narrow bandwidth.
This setting is recommended if the phase noise of the external signal
is worse than the phase noise of the internal OCXO.

"Wide" Synchronizes the internal oscillator to the external signal with the
maximum possible bandwidth.
This mode is the recommended standard mode and for precise refer-
ence sources of high spectral purity.
Note: If the frequency of the external reference signal is outside the
locking range of the internal reference oscillator, spurs due to the dif-
ference of the internal and external reference frequency are gener-
ated in the reference PLL.
The R&S SMB100B issues an error message.
For more information, refer to the specifications document.

Remote command: 
[:SOURce]:ROSCillator:EXTernal:SBANdwidth on page 540

Nominal Synchronization Bandwidth
Indicates the nominal synchronization bandwidth for the selected external reference
frequency and the synchronization bandwidth.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:NSBandwidth? on page 541

Minimum Locking Range
Indicates the minimum locking range for the selected external reference frequency and
the synchronization bandwidth.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:MLRange? on page 541

Reference frequency settings
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9.3  Reference output settings

Access:

1. Select "Frequency" > "Reference Frequency".

2. Select "Reference Output".

In the "Reference Output" tab, you can set the reference frequency value at the
output connectors.
As a result of parameter dependencies, "Preset This Parameter" sometimes does
not affect output dialogs.
The remote commands required to define these settings are described in Sec-
tion 13.16.12, "SOURce:ROSCillator subsystem", on page 537.

Settings:

Reference Output/1 GHz Reference Output............................................................... 215
Show/Show Connector................................................................................................215

Reference Output/1 GHz Reference Output
Selects frequency reference output signal for downstream instruments.
"Off" Deactivates the reference signal output.
"10 MHz" Derives a signal with 10 MHz frequency from the internal reference

oscillator and provides this signal at the output.
"100 MHz" Option: R&S SMBB-B3

Provides the 100 MHz reference frequency signal at the output.

"1 GHz" Option: R&S SMBB-B3
Provides the 1 GHz reference frequency signal at the output.

"Input Signal (loop through)"
Passes the external reference frequency to the output directly.

Remote command: 
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE on page 541
[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE on page 542

Show/Show Connector
Opens a dialog that displays the location of the connector on the front panel or rear
panel of the instrument. A blinking rectangle shows the connector.

Reference output settings
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9.4  Adjustment settings

Access:

1. Select "Frequency" > "Reference Frequency".

2. Select "Adjustment".

Settings:

Adjustment Active....................................................................................................... 216
Adjustment Value........................................................................................................ 216

Adjustment Active
Selects the adjustment mode.
"Off" Uses the calibrated internal reference frequency.
"On" Allows you to apply a deviation to the internal reference frequency,

according to your requirements.
Enter the value in the Adjustment Value field.

Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] on page 543

Adjustment Value
Sets a user-defined adjustment value for the internal reference frequency. This value
takes effect when it is activated with Adjustment Active.
● "0" represents the calibrated state.
● The setting range depends on the reference oscillator type and its factory calibra-

tion value.
Note:
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue on page 542

9.5  Using the reference frequency for instruments syn-
chronization

Test setups with two or more instruments often require that the instruments use a com-
mon reference frequency. Depending on the availability of external reference frequency
source and its quality, the instruments are connected and configured in different ways.

Using the reference frequency for instruments synchronization
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This section gives an overview of the possible test setups and the related settings. The
following situations are considered:
● External reference source is not available or the built-in reference oscillator is of

better quality than the external source
(see "Distributing the internal 10 MHz reference signal to further instruments"
on page 217)

● Clean external reference source with quality exceeding the quality of the built-in
reference oscillator
(see "Using external reference source" on page 218)

● Interfered or noisy external reference signal
(see "Deriving 10 MHz from the external reference frequency" on page 219)

● 1 GHz reference coupling for phase coherence of the RF signals with enhanced
long-term phase stability
(see "Sharing the 1 GHz reference frequency to obtain phase-coherent signals"
on page 217)

Connectors overview

Use the "Show Connector" function to indicate the connector on the front/real panel:
● "Ref In/Ref Out" on page 38
● 1GHz "Ref In/Ref Out" on page 38

Distributing the internal 10 MHz reference signal to further instruments

The internal reference oscillator provides the reference frequency:
● Internal fref = 10 MHz (10 MHz at connector Ref Out)
● Source = "Internal"
● Reference Output/1 GHz Reference Output = "10 MHz"

Figure 9-1: Synchronizing instruments using the internal 10 MHz reference signal of the
R&S SMB100B

Ref In, Ref Out = Connectors

For more information, refer to the specifications document.

Sharing the 1 GHz reference frequency to obtain phase-coherent signals

Compared to 10 MHz, a 1 GHz reference signal significantly improves the achievable
phase stability between two signal sources. Because the synchronization frequency
increases by a factor of 100, the relative phase fluctuations between the sources can
be reduced.

Using the reference frequency for instruments synchronization
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1 GHz at connector Ref In 1GHz and 1 GHz at Ref Out 1GHz
● External fRef = 1 GHz
● Source = "External"
● External Reference Frequency = "1 GHz"
● 1GHz Reference Output = "1 GHz"

Using external reference source

If you have a clean external reference signal with 10 MHz or 100 MHz frequency, for
example, you can directly pass it to the output. The signal quality remains the same.

10 MHz, 100 MHz at connector Ref Out and Ref In
● External fRef = 10 MHz or 100 MHz

(earlier RF hardware versions: 5 MHz, 10 MHz, 13 MHz)
● Source = "External"
● Reference Output = "10 MHz, 100 MHz" or "Input Signal (loop through)"

(earlier RF hardware versions: 5 MHz, 10 MHz, 13 MHz)
● Set the synchronization bandwidth according to the requirements of the applica-

tion.

Figure 9-2: Synchronizing instruments with a 10 MHz external reference signal

Ref. Frequency Source = e.g., Rohde & Schwarz signal analyzer
fRef = 10 MHz, 100 MHz, 1 MHz to 100 MHz external reference frequency
Ref In, Ref Out = Connectors

You can forward reference frequency between 1 MHz and 100 MHz directly to the out-
put in the same way.

Note: R&S SMB100B can forward only a defined range of external reference frequen-
cies.

For more information, refer to the specifications document.

● External fRef = 1 MHz to 100 MHz
(1 MHz to 100 MHz at connector Ref In and Ref Out)

● Source = "External"
● Variable Reference Frequency = "Variable"
● External Reference Frequency = current external frequency
● Reference Output = "Input Signal (loop through)" or specify the reference fre-

quency the synchronized instrument supports
● Set the synchronization bandwidth according to the requirements of the applica-

tion.

Using the reference frequency for instruments synchronization
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Deriving 10 MHz from the external reference frequency

10 MHz reference frequency can be derived from the following external reference sig-
nals:
● 10 MHz from internal oscillator locked to external input
● 100 MHz and 1 GHz external reference signals
● External reference signal between 1 MHz and 100 MHz
● If the external reference signal is interfered (noisy)

Figure 9-3: Synchronizing instruments with 10 MHz (derived from an external reference frequency)

Ref. Frequency Source = e.g., Rohde & Schwarz signal analyzer
fRef = 10 MHz, 100 MHz, 1 MHz to 100 MHz, 1 GHz** external reference frequency
** = 1 GHz uses Ref In 1 GHz connector
Ref In, Ref Out = Connectors

1 GHz, 1 MHz to 100 MHz at connector Ref In 1 GHz/Ref In and 10 MHz at Ref Out
● E.g., external Ref. fref = 100 MHz
● Source = "External"
● External Reference Frequency = "100 MHz"
● Reference Output/1 GHz Reference Output = "10 MHz"
● Synchronization Bandwidth = "Narrow"

Using the reference frequency for instruments synchronization
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10  File and data management
The R&S SMB100B uses files to save all instrument data. The instrument allows you to
save and to load instrument settings, and to import and to export user data for process-
ing in another instrument or later. Finally, you can create a screenshot of the current
settings displayed on the screen and save it as a file.

This section focuses on the functions provided for managing of user data files and cov-
ers the topics listed below.

For information on the related remote control commands, see Section 13.5, "MMEMory
subsystem", on page 382.

For information on how to save the displayed setting in a file, see Section 10.11, "Cre-
ating screenshots of current settings", on page 249.

● Accessing, retrieving and handling data............................................................... 220
● About the file system.............................................................................................221
● Restoring an instrument configuration.................................................................. 224
● Protecting data......................................................................................................229
● Saving and recalling settings................................................................................ 230
● Accessing files with user data...............................................................................234
● Exporting and importing remote command lists....................................................236
● Loading, importing and exporting lists...................................................................237
● Using the file manager.......................................................................................... 237
● Transferring files from and to the instrument........................................................ 243
● Creating screenshots of current settings...............................................................249

10.1  Accessing, retrieving and handling data

Depending on the origin and content, this description distinguishes between the follow-
ing data types:
● Operational data
● Non-operational data

Operational data (data for intended use)

Your instrument uses and generates this data because of its intended use and accord-
ing to the settings and configuration you have made. Thus, this data makes up most of
the data that the R&S SMB100B creates, such as user files that contain user-defined
configurations or data, like instrument settings or measurement data. See also "Types
of user data" on page 222.

You can access, retrieve and delete user files, see Section 10.9, "Using the file man-
ager", on page 237.

Non-operational data (usage data)

The R&S SMB100B generates this data during and through its use. Such data is col-
lected e.g. for troubleshooting, to help our customer support center find solutions

Accessing, retrieving and handling data
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quickly, or if you have purchased and activated the Health and Utilization Monitoring
Service (HUMS).

The R&S SMB100B does not generate this data continuously and in real-time; this
data is saved on the product. You can store the data on a remote server, for example
via a network connection.

The R&S SMB100B generates the following data:
● User and authentication data
● Network and communication data
● Software and firmware update data
● Diagnostic and troubleshooting data
● Environmental conditions
● Hardware component metadata
● User behavior (HUMS only)

On demand, this data is stored in a ZIP file containing files in TXT format. The volume
of the non-operational data depends on the usage of the product and typically amounts
to about 30 Mbyte.

You can access, retrieve and delete this data, see:
● Network and communication data, see Section 10.5, "Saving and recalling set-

tings", on page 230.
The R&S SMB100B displays the network address data on the screen.

● Hardware component metadata, see Section 14.8.1, "Hardware configuration set-
tings", on page 626.

● User behavior, monitored by HUMS, see Section 12.5.8, "HUMS settings",
on page 320.
The R&S Health and Utilization Monitoring Service user manual is available on the
Rohde & Schwarz internet.

● For all other data stored in the instrument, see Section 14.9, "Collecting information
for technical support", on page 629.

For additional information on the different memory types of your product and on how to
protect sensitive data, see:
● Section 10.4, "Protecting data", on page 229.
● Instrument security procedures document.

10.2  About the file system

Depending on their content, this description distinguishes between system files and
user files. System files and the system directory are protected and not accessible. User
files contain user-defined configurations or data.

This section focuses on user files. It provides an overview of the R&S SMB100B file
system and covers the following topics:
● "Types of user data" on page 222

About the file system
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● "File storage location" on page 222
● "File handling" on page 223
● "File naming conventions" on page 223
● "File extensions" on page 223
● "File contents" on page 224

Types of user data

The following data types contain user data:
● Settings or configuration files, for example, you save the current instrument set-

tings and load these settings on another instrument.
See Section 10.5, "Saving and recalling settings", on page 230.

● SCPI scripts that contain a series of commands. You can run the script to perform
a task.
See Section 10.7, "Exporting and importing remote command lists", on page 236.

● Externally or internally generated lists, for example, user correction lists. You can
load these list files on the instrument.
See Section 10.8, "Loading, importing and exporting lists", on page 237 and Sec-
tion 10.6, "Accessing files with user data", on page 234.

Depending on the data storage method, user data can be:
● Persistent, i.e. user files that are recorded on the data storage.

Data is preserved when instrument is powered off and can be accessed and modi-
fied subsequently.

● Temporary, i.e. volatile data that the instrument retains while it is powered on.
Volatile data is immediately lost when the R&S SMB100B is switched off.

File storage location

Without any additional measures, the R&S SMB100B stores user files on the internal
memory or if connected, on a memory stick.

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

Default storage location

The R&S SMB100B stores user data in the user directory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Section 10.9,
"Using the file manager", on page 237. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

About the file system
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File handling

To access files and the file system of the instrument or to use the general file manage-
ment functions such as copying and moving data, use the standard "File Manager" dia-
log.

See Section 10.9, "Using the file manager", on page 237.

To transfer files from and to the instruments or to exchange files, use one of the follow-
ing alternatives:
● Connect a memory stick to one of the USB interfaces.

The instrument automatically recognizes a connected memory stick and assigns
the /usb/ drive to it.

● Connect the instrument to a LAN.
An instrument connected to a LAN supports two standard file transfer methods
from a remote client:
– FTP (file transfer protocol)
– File sharing according to the SAMBA/SMB (server message block) protocol.
Both file transfer methods open the folder /user that is the /var/user/ folder on
the instrument.
For a step-by-step description, see Section 10.10, "Transferring files from and to
the instrument", on page 243.

● Map a network folder or a computer to an instrument connected to a LAN.
A mapped network folder is indicated as /shares/<"Local Folder">.
For a step-by-step description, see Section 10.9.4, "Mapping a network folder",
on page 241.

File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

File extensions

The R&S SMB100B distinguishes the files according to their extensions; each type of
file is assigned a specific file content and also a specific file extension. The extension
is usually of no consequence to you since access to the files occurs in the individual
dialogs where only the relevant type of file is available. For example, files with user
correction data can only be saved and loaded in the "UCOR" dialog.

About the file system
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See Section A.2, "Available user files and file extensions", on page 653 for an overview
of the supported file extensions.

File contents

To maintain the file size and to accelerate processing times, the instrument saves set-
tings that deviate from their default values. Considered is also configuration data for
the operating elements and lists with user data, e.g. dialog positions and a list of user
correction data. However, if a list data is part of the instrument settings, a reference to
this list is saved, not the list itself.

This approach ensures that the created files contain only relevant information and
allows you to transfer instrument settings even between different equipped signal gen-
erators. During the recall process, the instrument interprets only the relevant settings;
all non-referenced parameters are set to their preset values. Error messages indicate
the settings which cannot be implemented, like referencing non-existing lists or the
attempt to activate settings which are not supported by the instrument.

10.3  Restoring an instrument configuration

The R&S SMB100B has various options to set default settings. You can preset the
R&S SMB100B to an initial state at any time as a known starting point for configura-
tions. It is often useful as a first step during troubleshooting when unusual results arise.

The figure Figure 10-1 shows the impact of the particular reset functions.

Figure 10-1: Preset functions for parameters and operating modes

Overview of the characteristics of the preset functions

Select the preset option that most fits to your particular application:

Restoring an instrument configuration



File and data managementR&S®SMB100B

225User Manual 1178.3711.02 ─ 11

● [Preset]
It is the most frequent function. A preset executes a defined instrument setup to
provide an initial instrument state as a basis for a new configuration.
It resets all parameters and switching states including the states of inactive operat-
ing modes. Also, it resets external instruments connected to the R&S SMB100B.
A preset does not change network settings, remote access settings or system set-
tings.

► To execute a preset, press the [Preset] key at the front panel.

● "Set to Default"
This function relates to individual dialogs or tabs and resets the associated settings
of the corresponding dialog. All other settings are retained.

► To reset the settings, click "Set To Default".

● "Preset this parameter"
Sets a single parameter to its default value.

1. To reset an individual parameter, open its context-sensitive menu.

2. Select "Preset This Parameter".

● "Factory Preset"
A factory preset is the most profound preset function that resets almost all instru-
ment settings, including reference oscillator, network and remote access settings.
A factory preset does not change the following settings:
– Security, password, and settings protected by these passwords
– User-defined data, like setups or data lists
– Settings that relate to an integration of the instrument in a measurement setup.

► NOTICE! Execute a "Factory Preset" only if it is necessary. After a "Factory Pre-
set", the network connection to the instrument no longer exists.
To restore the factory defaults, select "System Config" > "Setup" > "Settings" >
"Factory Preset".

Restoring an instrument configuration
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Presetting the instrument to a user-defined state

The reset functions set the parameters and operating modes to default values prede-
fined by the factory. Alternatively to the instrument default settings, you can preset the
instrument to a user-defined state:
● Save and reload user-defined settings as preset, see Section 10.3.3, "Presetting

the instrument to a user-defined state", on page 227.
● Save and reload user-defined instrument states, see Section 10.5.2, "Saving and

recalling instrument settings", on page 233.

Marking parameters with non-default values

To check the current state of the settings concerning default values, the
R&S SMB100B offers a feature that visually identifies deviations from the default val-
ues.

For more information, see Section 10.3.2, "Identifying parameters with non-default val-
ues", on page 227.

10.3.1  Preset, set to default and factory preset settings

Preset..........................................................................................................................226
Set To Default..............................................................................................................226
Preset this Parameter................................................................................................. 226
Execute Factory Preset...............................................................................................227

Preset
Resets all parameters and switching states, and closes all opened dialogs.
Note:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.
Consider also the following possibilities:
● You can define the settings that are restored when you preset the instrument

(see Section 10.3.3, "Presetting the instrument to a user-defined state",
on page 227)

● You can reset the instrument to the factory state
(see "Execute Factory Preset" on page 227)

See also Table 10-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
*RST on page 378

Set To Default
Resets the associated settings of the corresponding dialog or tab.

Preset this Parameter
Restores the default value of a single parameter.

Restoring an instrument configuration
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Execute Factory Preset
Resets the instrument to its factory settings.
Note: "Factory Preset" retains all security settings and does not delete any user files
like setups or user data.
See also Table 10-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
:SYSTem:FPReset on page 381

10.3.2  Identifying parameters with non-default values

To recognize the current state of the settings related to their default values at the first
glance, enable a function that visually identifies parameters in states different than pre-
set.

To enable this display:

1. To open the context-sensitive menu, touch and hold the screen anywhere in the
GUI of the R&S SMB100B.

2. Select "Mark All Parameters Changed from Preset".

If enabled, marks the parameters that deviate from their default values.

Example: 

Figure 10-2: Marked parameters show that the value deviates from its default

Frequency = changed (default = 1 GHz)
Offset = changed (default = 0 kHz)
Multiplier = unchanged
Variation active = changed (default = disabled)
Variation step = unchanged

10.3.3  Presetting the instrument to a user-defined state

You can define the settings that are restored when you preset the instrument.

Restoring an instrument configuration
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Note: The preset of the instrument to a user-defined state does not include all modified
settings. For information, see the corresponding description of the settings.

1. Configure the settings as required.

2. Save them as described in Section 10.5.2, "Saving and recalling instrument set-
tings", on page 233:

a) Save the settings as a file with the predefined filename UserPreset without
file extension.
The save function assigns the file extension .savrcltxt automatically.

b) Save this file in the directory /var/user/.

The filename UserPreset and the directory /var/user/ are mandatory.

3. Press the [Preset] key.
When operating the instrument remotely, send the *RST command.

The instrument restores the user-defined settings. An "Info" message appears and
confirms loading of a file with user-defined preset settings.

10.3.4  Reference

See Table 10-1 for an overview of the main generator settings that are affected by the
corresponding preset functions. While the regular [Preset] key primarily resets the sig-
nal relevant parameters of the instrument, the "Factory Preset" affects almost all instru-
ment settings.

For information on the default values of further parameters, see the description of the
corresponding remote commands.
Table 10-1: Key parameters affected by preset and factory preset

Parameter Preset value Preset Factory
Preset

RF frequency 1 GHz x x

RF level (RF output) off x x

RF level limit 30 dBm - x

Offsets 0 x x

Modulation state off x x

LF output state off x x

Sweep state off x x

List mode state off x x

Reference frequency settings - - x

Network settings - - x

Hostname - - x

GPIB address - - x

Restoring an instrument configuration
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Parameter Preset value Preset Factory
Preset

Start or stop display update - - x

Display and keyboard settings - - x

Password and password-protected settings - - -

Security settings - - -

User files (setups, user correction, etc.) - - -

HUMS off - x

10.4  Protecting data

During operation, the R&S SMB100B saves user data permanently in the user direc-
tory, see "File storage location" on page 222.

To protect any classified data and to avoid saving any sensitive data on the
R&S SMB100B permanently, you have the following options:
● Activate the volatile mode. This mode redirects user data to the volatile memory,

see "Volatile Mode" on page 279.
The internal memory is write-protected.
Once you power off the instrument for at least five minutes, all volatile memory
modules lose their contents.
To avoid loosing this data, connect an external memory device, for example, a
USB flash drive.
See also:
– "Default storage location" on page 222
– "Volatile Mode" on page 279
– Section 10.10.4, "Using a USB storage device for file transfer", on page 247

● If the R&S SMB100B is equipped with the removable memory R&S SMBB-B85
and an SD card is inserted:
– If the volatile mode is disabled (default setting) the R&S SMB100B saves user

data permanently and only on this storage medium.
You can access data saved on the removable memory just as data saved in
the /var/user/.

– If the volatile mode is enabled, the R&S SMB100B redirects user data to the
volatile memory (SDRAM).
The volatile memory loses its contents when you power off the instrument.

● Save user files temporarily in the /var/volatile directory, which remains
available only until the instrument is turned off.
You can access data in the volatile memory just as data that is saved permanently
in the /var/user/.
See also Section 10.9.3, "Displaying all saved files", on page 241.

Protecting data
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To remove the μSD card

This step-by-step instruction holds for R&S SMB100B microwave instruments only.

1. NOTICE! You can damage the instrument and loose data when removing the μSD
card during operation.
Switch off the R&S SMB100B.
See "To shut down the product" on page 29.

2. Remove the μSD card from the instrument.

For detailed information on how to protect the instrument and to protect sensitive data
from unauthorized access, refer to the document Instrument Security Procedures.

10.5  Saving and recalling settings

You can save and recall instrument settings, user settings and other related data for
the following use cases:
● Reload or repeat a specific signal generation task on the instrument.
● Transfer a specific configuration of your instrument to another instrument, for

example in multi-intrument setups.
● Save or load complete instrument settings to or from a file.

Save or recall the complete instrument settings

Two different methods are available for managing complete instrument settings:
● Quick (immediate) Save/Recall

A defined set of instrument settings are saved or recalled quickly in just one step,
without defining a filename or storage location. This function enables a fast switch-
ing between different instrument settings.

● Save/Recall in files with user-defined names
The defined set of instrument settings are saved to a definable storage location.
The file extension is *.savrcltxt.
Settings files created in this way are visible in the file system and accessible with
the supported methods for file handling.

In the general case, a recall process replaces the instruments settings with the saved
values. An exception is the frequency and level settings. During recall of the instrument
settings, it is possible to retain the current settings or to overwrite them with the saved
values.

10.5.1  Save/Recall settings

Access:

1. Select "System Config > Save/Recall".

Saving and recalling settings
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2. Select "Operation Mode" > "Save" or "Recall" to open the corresponding settings.

The settings for both operation modes are similar and related.

Settings:

Operation Mode.......................................................................................................... 231
Directory, File List and Filename.................................................................................231
Recent files................................................................................................................. 232
Show SCPI List........................................................................................................... 232
SCPI List..................................................................................................................... 232
Save............................................................................................................................ 232
Quick Save x............................................................................................................... 232
Exclude Frequency..................................................................................................... 232
Exclude Level..............................................................................................................232
Recall.......................................................................................................................... 233
Quick Recall x............................................................................................................. 233
File Manager............................................................................................................... 233

Operation Mode
Accesses the settings for storing ("Save") and loading ("Recall") of the instrument set-
tings. Also, you can import SCPI-Files ("SCPI-Import") or export SCPI files ("SCPI-
Export").
See Section 10.7, "Exporting and importing remote command lists", on page 236.

Directory, File List and Filename
Note:
You access this generic standard function each time you perform one of the following:
● Save or load (settings) files
● Define a folder in that these files are saved
● Navigate through the file system.

Saving and recalling settings
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The dialog name changes depending on the context. The provided functions are self-
explanatory and similar.
Use the settings for example as follows:
● To navigate through the file system, use the directory tree.
● To create a file, load and save files, use the dedicated functions "New", "Select",

Save, and Recent files.
● To access the general data table editor, use the "Edit" button
● To perform standard file management functions, like create directories, move, copy,

delete files and/or directories, use the standard "File Manager" function (see Sec-
tion 10.9, "Using the file manager", on page 237).

Remote command: 
To list all files in a directory:
:MMEMory:CDIRectory on page 387
:MMEMory:CATalog? on page 386
[:SOURce]:CORRection:CSET:CATalog? on page 481

Recent files
Displays the files last used.

Show SCPI List
Opens the "SCPI List", which lists the current settings of the R&S SMB100B as SCPI
commands.
The R&S SMB100B provides this function for Operation Mode > SCPI-Export.

SCPI List
Provides a list of all SCPI commands corresponding to the current instrument settings.

Save
Saves the current instrument settings under the defined filename.
Remote command: 
:MMEMory:STORe:STATe on page 391

Quick Save x
Stores the current instrument setting in one of the intermediate memories.
These instrument settings are retained until a different instrument setting is stored in
the intermediate memory. When the instrument is switched off, the contents of the
intermediate memories are retained.
Remote command: 
*SAV on page 379

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.
Remote command: 
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL on page 490

Exclude Level
The current level is retained when a stored instrument setting is loaded.

Saving and recalling settings
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Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL on page 535

Recall
Restores the selected configuration.
During recall, the instrument considers all related settings, for example sweeps in
active state or lists. An error message indicates the settings which cannot be imple-
mented.
Remote command: 
:MMEMory:LOAD:STATe on page 389

Quick Recall x
Loads the selected configuration from one of the intermediate memories. A message
appears if no instrument configuration is stored in this memory.
Remote command: 
*RCL on page 378

File Manager
Accesses the "File Manager" dialog, see Section 10.9, "Using the file manager",
on page 237.

10.5.2  Saving and recalling instrument settings

Instrument settings can be saved to a file and loaded again later, so that you can
repeat the tests with the same settings.

To access and recall instrument setups quickly

► Assign the appropriate action to the [★ (User)] key.
See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.

To save and recall instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode" > "Save".

2. Select "Quick Save 1".

The instrument saves its settings in the intermediate memory 1. The filename and
the storage location cannot be changed.

3. Adapt the instrument settings as required. Select "Quick Save 2"

4. To restore the settings, select the "Operation Mode > Recall"

5. Select "Quick Recall 1"

The instrument is restored to the previous state.

6. Select "Quick Recall 2" to switch to the settings saved in the second file.

Saving and recalling settings



File and data managementR&S®SMB100B

234User Manual 1178.3711.02 ─ 11

To save complete instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode" > "Save".

2. In the file selection dialog, select a filename and storage location for the settings
file.

3. Select "Save".

A file with the defined name and path and the extension *.savrcltxt is created.

To restore an instrument configuration

Save the configuration as described in "To save complete instrument settings"
on page 234.

1. To restore settings, select "System Config > Save/Recall" > "Operation Mode >
Recall".

2. To retain the current frequency settings, enable "Save"/"Recall" > "Exclude Fre-
quency",

3. To retain the current level settings, enable "Save"/"Recall" > "Exclude Level",

4. In the file select dialog, select the filename and storage location of the settings file.

The settings are restored, but the frequency and level settings are retained. You
can repeat the signal generation with the same settings.
See also Section 10.3.3, "Presetting the instrument to a user-defined state",
on page 227.

10.6  Accessing files with user data

Signal generation in list mode, the generation of pulse train signals or applying user
correction values use data from list files. Whenever a list file is required as a data
source, the instrument provides direct access to the standard "File Select" function.
This function enables you to select, create and edit the list files.

10.6.1  File select settings

The "File Select" dialog opens automatically each time the signal generation requires a
list file as a data source.

To access a loadable data list file

1. Select "Sweep" > "List Mode Data" > "List Mode" = "Data".

A file select dialog for loading, creating and modifying a file opens.

Accessing files with user data
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Tip: The name of the dialog is context-sensitive and differs depending on the par-
ticular function this dialog is from. However, the provided functions are similar.

2. To load an existing file:
Navigate through the file system.
Select the file and confirm with "Select".

3. To create a file, for example if there is no data list file specified:
Navigate through the file system.
Select "New" and specify the filename.

A new empty file is created and saved in the selected folder.

4. To edit an existing or newly created file:
Navigate through the file system.
Select the file and select "Edit".

The standard "Data List Editor" dialog opens.

5. Edit the file content.
Confirm with "Save".

Settings:

Directory, File List and Filename.................................................................................235
Functions for handling of data lists..............................................................................236
Recent files................................................................................................................. 236
File Manager............................................................................................................... 236

Directory, File List and Filename
Note:
You access this generic standard function each time you perform one of the following:
● Save or load (settings) files
● Define a folder in that these files are saved
● Navigate through the file system.

Accessing files with user data
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The dialog name changes depending on the context. The provided functions are self-
explanatory and similar.
Use the settings for example as follows:
● To navigate through the file system, use the directory tree.
● To create a file, load and save files, use the dedicated functions "New", "Select",

Save, and Recent files.
● To access the general data table editor, use the "Edit" button
● To perform standard file management functions, like create directories, move, copy,

delete files and/or directories, use the standard "File Manager" function (see Sec-
tion 10.9, "Using the file manager", on page 237).

Remote command: 
To list all files in a directory:
:MMEMory:CDIRectory on page 387
:MMEMory:CATalog? on page 386
[:SOURce]:CORRection:CSET:CATalog? on page 481

Functions for handling of data lists
Provided are the following standard functions for file handling:
"Select" Select and load the file.

Remote command: 
[:SOURce<hw>]:LIST:SELect on page 518
[:SOURce<hw>]:PULM:TRAin:SELect on page 466
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 480

"New" Creates file with the specified "Filename".
To confirm, select "OK"; use "Cancel" to undo the operation.
To edit the file content, select "File Select > Edit".

"Edit" Accesses the "Data List Editor" and loads the selected file for editing

Recent files
Displays the files last used.

File Manager
Accesses the "File Manager" dialog, see Section 10.9, "Using the file manager",
on page 237.

10.7  Exporting and importing remote command lists

To set specific instrument settings or perform tasks automatically, you can create
scripts or import scripts that contain the settings in the form of remote control com-
mand sequences.

The R&S SMB100B also offers a SCPI macro recorder with code generator to record
manual settings and create an executable script.

Completed scripts are saved in files and possibly converted to different formats,
depending on the language of the source code.

Exporting and importing remote command lists
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The R&S SMB100B supports the following commonly used languages:
● Plain SCPI: *.txt
● MATLAB: *.m
● NICVI: *.c
● Python: *.py
It is also possible to convert the SCPI command list to a user-specific language.

How to: Section 12.9, "Using remote command scripts", on page 354

10.8  Loading, importing and exporting lists

The R&S SMB100B provides built-in editors for creating list files, for example for the
list mode or lists with user correction data. You can also create or evaluate them with
an external application. The instrument provides interfaces with the following function-
ality:
● Import and export list files in a standard ASCII format file

Lists are saved and loaded in the corresponding dialogs. For example, the user correc-
tion data list is created and saved in the "User Correction" dialog.

10.9  Using the file manager

The "File Manager" is a tool similar to a standard Windows Explorer. It helps you man-
age mass storage media and files saved on the R&S SMB100B.

You can perform the following tasks:
● Copying multiple files from disk to other media

See Section 10.10, "Transferring files from and to the instrument", on page 243
● Copying files into another directory

See Cut, Copy&Paste and Delete
● Renaming and deleting files
● Creating directories

See Create New Directory
● Mapping shared network folders

See Section 10.9.4, "Mapping a network folder", on page 241
● Displaying saved files

See Section 10.9.3, "Displaying all saved files", on page 241

Using the file manager
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10.9.1  File manager settings

Access:

► Select "System Config > Save/Recall" > "File Manager".

Tip: Each "Save/Recall" dialog and each "File Select" dialog provides a quick
access to the "File Manger".

The "File Manager" dialog provides all standard functions required for file manage-
ment. It displays the contents of the selected folder on the R&S SMB100B and pro-
vides functions to rename, delete, copy, or move individual files.

Settings:

Map Network Share.................................................................................................... 238
File Type......................................................................................................................238
Directory and Filename............................................................................................... 239
Cut, Copy&Paste and Delete...................................................................................... 239
Rename.......................................................................................................................239
Create New Directory..................................................................................................239

Map Network Share
Opens a dialog where you can map one or more network folders. See Section 10.9.2,
"Map network share settings", on page 239.
See also Section 10.9.4, "Mapping a network folder", on page 241.

File Type
Selects the file type to be listed. If a file type with a specific file extension is selected,
only files with this extension are listed.
See Section A.2, "Available user files and file extensions", on page 653 for an overview
of the supported file extensions.

Using the file manager
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Directory and Filename
Selects the directory in which the file to be deleted or copied is located. The dialog lists
all files in this directory. Selected files are highlighted. The path is indicated above the
directory tree.
Unlike the "Save/Recall" and "File Select" dialogs, the "File Manager" displays the full
filenames including extensions.
Remote command: 
:MMEMory:CDIRectory on page 387

Cut, Copy&Paste and Delete
Standard file management functions.
Before a file is deleted, you have to confirm the delete operation.
Remote command: 
:MMEMory:DELete on page 389
:MMEMory:COPY on page 387

Rename
Renames the selected file or directory.
Remote command: 
:MMEMory:MOVE on page 390

Create New Directory
Creates a folder and opens an edit dialog box to enter name and path (absolute or rel-
ative to the current directory) of the new folder.
Remote command: 
:MMEMory:MDIRectory on page 390

10.9.2  Map network share settings

Access:

► Select "System Config > Save/Recall" > "File Manager" > "Map Network Share".

The "Map Network Share" dialog provides settings that are similar to the standard Win-
dows Explorer function "Map network drive". These settings help you to create up to 10
"shortcuts" to shared folders or computers in the network.

The dialog displays a list of current mapped network folders. The directory tree of the
"File Manager", "Save/Recall", and "File Select" dialogs indicate a mapped network
folder as /shares/<"Local Folder">.

Using the file manager
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See also Section 10.9.4, "Mapping a network folder", on page 241.

Settings:

Network Folder............................................................................................................240
Local Folder................................................................................................................ 240
User Name.................................................................................................................. 240
Password.................................................................................................................... 241
Reconnect at Startup.................................................................................................. 241
Connect.......................................................................................................................241
Change........................................................................................................................241
Disconnect.................................................................................................................. 241

Network Folder
Enter the path of the folder or computer, e.g. //<IP Address>/user or //<server
name>/user.

Local Folder
Enter a letter or an alias name to describe the folder.
In the directory tree, a mapped network folder is indicated as /shares/
<"Local Folder">.

User Name
Enter a user name of a user that has the permission to access the selected network
folder.

Using the file manager
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Password
Enter the user password of the selected user.

Reconnect at Startup
Enables reconnecting every time you start up the instrument.

Connect
Triggers the instrument to prove the credential and to map (i.e. connect) the selected
network folder or computer to the instrument.
You can map up to 10 network folders.

Change
Applies the changes.

Disconnect
Disconnects the network drive.

10.9.3  Displaying all saved files

To display all files on the internal memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/user/.

To display all files on a connected USB flash drive

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /usb/.

To display all files in the volatile memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/volatile/.

10.9.4  Mapping a network folder

Possibly you would like to transfer instrument or user settings to another
R&S SMB100B, distribute waveform files to several instruments or you have to access
frequently the same network drive. In these cases, on a R&S SMB100B connected to a
LAN you can create a shortcut to this network folder or this computer.

How to: Section 3.1.7, "Connecting to LAN", on page 25

To map a network folder, proceed as follows:

1. On the computer or the network folder you want to map, enable remote access.
You can specify a list of users allowed for remote access.

Using the file manager



File and data managementR&S®SMB100B

242User Manual 1178.3711.02 ─ 11

Note: The remote access settings depend on the operating system the remote
computer is using. For step-by-step instructions, refer to the documentation of the
particular operating system.

2. On the R&S SMB100B, enable file transfer via SMB (samba).

3. Select "System Config" > "Setup" > "Remote Access" > "Network" to configure the
following network settings:

a) Select "Address Mode" > "Auto (DHCP)".
b) Check that the "DNS Suffix" and "DNS Server" are correct.

4. In the "Save/Recall" dialog, select "File Manager" > "Map Network Share".

5. In the "Map Network Share" dialog, select:

a) In the "Network Folder" field, enter //<IP Address>/user or //
<Server Name>/user.

b) In the "Local Folder" field, enter an alias name, e.g. setups.
c) Enter the "User Name" and "Password" of a user with a remote access permis-

sion to the selected network folder.
d) If necessary, enable "Reconnect at Startup".
e) Select "Connect".

The selected network folder is mapped to your instrument. The list of mapped net-
work folders is updated.

6. Close the "Map Network Share" dialog.

The navigation tree in the "File Manager" dialog displays the mapped network
folder as /shares/Setups.

If the connection does not succeed, consider to check the following:
● Is the network folder or computer you try to map turned on?
● Is the network folder or computer enabled for remote access?
● Does the selected user name have the necessary permissions?

Using the file manager
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See also Section 10.10.5, "Using a file server for test files exchange", on page 248.

10.10  Transferring files from and to the instrument

As explained in "File handling" on page 223, you access the file system of the
R&S SMB100B via one of the following ways:
● Via the built-in "File Manager"

See Section 10.9, "Using the file manager", on page 237.
● On an instrument connected to a LAN:

– Via one of the standard functions FTP or SMB (samba)
See Section 10.10.2, "Accessing the file system using FTP", on page 245 and
Section 10.10.3, "Accessing the R&S SMB100B file system using SMB
(Samba)", on page 246

– Via mapped network drives
See Section 10.9.4, "Mapping a network folder", on page 241.

● Via a connected USB storage device
See Section 10.10.4, "Using a USB storage device for file transfer", on page 247

Mainly because of security reasons, the access to the file system of your
R&S SMB100B can be denied, because one or all these access methods are deliber-
ately disabled. Access to the file system via LAN and/or USB requires that the corre-
sponding service is enabled and a write access to the file system is enabled. Refer to
Section 10.10.1, "Removing file system protection", on page 243 for description of the
required steps.

This section provides an introduction to the topic. For comprehensive information, refer
to the application note 1GP72: Connectivity of Rohde&Schwarz Signal Generators.

● Removing file system protection........................................................................... 243
● Accessing the file system using FTP.................................................................... 245
● Accessing the R&S SMB100B file system using SMB (Samba)...........................246
● Using a USB storage device for file transfer......................................................... 247
● Using a file server for test files exchange............................................................. 248

10.10.1  Removing file system protection

Before you try to access the file system via FTP, SMB (samba) or USB, fulfill the follow-
ing:
● Disable write protection on the file system
● Enable the corresponding service or interface

To enable write permission on the file system

1. Select "System Config" > "Setup" > "Security" > "Security".

2. Select "General" > "Disk & Memory".

3. Enable "Volatile Mode".

Transferring files from and to the instrument
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4. Enter the "Security Password".
The default password is 123456. For more information, see Section 11.4, "Using
the security settings", on page 277.

The R&S SMB100B requests a reboot.

5. Confirm the request.

The system reboots. The enabled settings are active.

To enable file transfer over FTP

1. Select "System Config" > "Setup" > "Security" > "Security".

2. Select "LAN Services" > "Common Services" > "LAN" > "On".

3. Enable "FTP"

4. Enter the "Security Password".
The default password is 123456. For more information, refer to Section 11.4,
"Using the security settings", on page 277.

5. Select "Accept".

To enable file transfer over SMB (samba)

1. Select "System Config > Setup > Security > Security > LAN Services"

2. Enable "LAN Interface"

3. Select "Samba Services".

4. Enable the "SMB 1.0/2.0 Client".

5. Enable the "SMB 1.0/2.0 Server".

6. Enter the "Security Password".
The default password is 123456. For more information, see Section 11.4, "Using
the security settings", on page 277.

7. Select "Accept".

To enable file transfer over USB

1. Select "System Config > Setup > Security > Security > General"

2. Select "Disk & Memory".

3. Enable "USB Storage"

4. Enter the "Security Password".
The default password is 123456. For more information, see Section 11.4, "Using
the security settings", on page 277.

5. Select "Accept".

Transferring files from and to the instrument
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10.10.2  Accessing the file system using FTP

If the R&S SMB100B is connected to a LAN, you can use file transfer protocol (FTP) to
access the file system and to transfer files from and to the instrument.

How to: Section 3.1.7, "Connecting to LAN", on page 25

To access the file system over FTP

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter ftp://<"IP Address" of the Instrument>, e.g.
ftp://10.124.0.166.
Tip: The R&S SMB100B indicates its IP address on the home screen.

A log-on dialog opens and requests a password.

The default user name and password is instrument.

Tip:
Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".
We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.
See Section 11.4.5, "Password management", on page 287.

5. Enter the password to access the user directory.
The user directory corresponds to the /var/user/ directory of the instrument.

There, you can perform standard functions like creating directory, or saving files.

6. In the user directory, create a directory, e.g. test ftp.

7. Select "System Config > Save/Recall".
Open the /var/user/ directory.

The dialog displays the /var/user/test ftp directory.

Transferring files from and to the instrument
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10.10.3  Accessing the R&S SMB100B file system using SMB (Samba)

The SMB (Samba) protocol is an alternative way to access the file system of the instru-
ment from a remote PC. This protocol works if both the instrument and the PC are con-
nected to a LAN.

How to: Section 3.1.7, "Connecting to LAN", on page 25

To access the file system over SMB

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter //<"IP Address" of the Instrument>, e.g. ftp://
10.124.0.166.
Tip: The R&S SMB100B indicates its IP address on the home screen.

The user directory corresponds to the /var/user/ directory of the instrument;
the volatile directory - to the /var/volatile directory.

Transferring files from and to the instrument
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To map the R&S SMB100B as a network drive to the remote PC

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via SMB (Samba)

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.
Open the "Map Network Drive" dialog.

a) Select a valid "Drive", e.g. W.
b) In the "Folder" field, enter //<"IP Address" of the Instrument>/user

or //<"Hostname" of the Instrument>/user
For example: //10.124.0.166/user or //SMB100B-102030/user.
Tip: The R&S SMB100B indicates its IP address on the screen.

c) Select "Finish".

A log-on dialog opens and requests a user name and a password.

Tip:
Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".
We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.
See Section 11.4.5, "Password management", on page 287.

4. Enter the user name and the password of your instrument.

The /var/user/ directory of the instrument is mapped to and displayed as a net-
work drive of the remote PC.

You can access the files in the /var/user/ directory, perform standard function
like creating directory, or saving files.

10.10.4  Using a USB storage device for file transfer

Alternatively to the file transfer possibility via LAN, you can use a USB storage device
for direct file transfer from and to the instrument.

We recommend that you transfer files with user data (like lists or instrument setup files)
to the instrument, rather than load and play them from a connected USB storage
device.

Transferring files from and to the instrument
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To transfer a file with user data to the instrument

1. Connect a USB storage device, for example a USB memory stick to one of the
USB interfaces of the instrument.

The R&S SMB100B recognizes the connected USB storage device automatically.

2. Enable file transfer via USB

3. Enable write permission on the file system

4. Select "System Config > Save/Recall".

The dialog displays the /var/user/ directory and the /usb/ drive.

5. In the "Save/Recall" dialog, select "File Manager".

6. In the directory tree, navigate to the /usb/ drive.
Select the required file with user data.

7. Select "Copy".

8. In the directory tree, navigate to the /var/user/ directory.
Select "Paste".

The file with user data is transferred to the instrument.

10.10.5  Using a file server for test files exchange

You can use a central file storage location like a file server in your company network to
save setup files, SCPI scripts, application programs, or waveform files on it. Usually,
you would like to distribute the files to several instruments. If the R&S SMB100Bs are
connected to a LAN, you can create a shortcut on the instruments to the file server.

To access the file server

1. On each R&S SMB100B, map the required directory of the file server to the instru-
ment.
Perform the steps described in Section 10.9.4, "Mapping a network folder",
on page 241.

2. On each R&S SMB100B, use the same alias name for the directory of the file
server, i.e. enter the same "Local Folder" (in this example Setups).

On any of the R&S SMB100B, you access the file server directly from the "File
Manager" and under the same name, e.g. /shares/Setups.
An extra advantage in remote control is that the same application program would
control the instruments.
For example, use the remote control command MMEMory:CDIRectory
"/shares/Setups" to set the default directory for mass storage.

Transferring files from and to the instrument
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10.11  Creating screenshots of current settings

The save/recall function enables you to save current settings in a file. To document the
most important settings for a performed signal generation, you can also save a hard-
copy of the current display.

● Hardcopy settings................................................................................................. 249
● Creating a hardcopy of the display........................................................................252

10.11.1  Hardcopy settings

Access:

► Select "System Config" > "Setup" > "User Interface" > "Hardcopy".

The remote commands required to define these settings are described in Sec-
tion 13.11, "HCOPy subsystem", on page 412.

Settings:

File.............................................................................................................................. 250
Format.........................................................................................................................250
Options........................................................................................................................250
Save............................................................................................................................ 250
Hardcopy Options > Common.....................................................................................250

└ Automatic Naming.........................................................................................251

Creating screenshots of current settings
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└ Format...........................................................................................................251
└ Region...........................................................................................................251

Hardcopy Options > Automatic Naming......................................................................251
└ Path...............................................................................................................251
└ Clear Path.....................................................................................................252
└ Prefix, Year, Month, Day............................................................................... 252
└ Current Auto Number....................................................................................252

File...
In "Automatic Naming > Off" mode, accesses the standard file select dialog for select-
ing the filename and folder the hardcopy is stored in.
If you have enabled "Automatic Naming", the instrument displays the automatically
generated filename.
Remote command: 
:HCOPy:FILE[:NAME] on page 414

Format
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 414
:HCOPy:DEVice:LANGuage on page 414

Options...
Accesses Hardcopy Options dialog.

Save
Saves a hardcopy of the current display as a file.
Remote command: 
:HCOPy[:EXECute] on page 415

Hardcopy Options > Common
Access: select "Hardcopy > Options... > Common".
With the provided settings, you can customize the file format and the syntax of the
automatically assigned filename.
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Automatic Naming ← Hardcopy Options > Common
If enabled, creates the output filenames automatically according to the rules set with
the Hardcopy Options > Automatic Naming settings.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:STATe on page 416

Format ← Hardcopy Options > Common
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 414
:HCOPy:DEVice:LANGuage on page 414

Region ← Hardcopy Options > Common
Displays the snapshot area.
Remote command: 
:HCOPy:REGion on page 414

Hardcopy Options > Automatic Naming
Access: select "Hardcopy > Options... > Automatic Naming".

Provided are the following settings:

Path... ← Hardcopy Options > Automatic Naming
Selects the directory.
Note: To select the destination path, specify also a filename. Otherwise an error mes-
sage is displayed and selection is canceled.
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Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory on page 415

Clear Path ← Hardcopy Options > Automatic Naming
Deletes all image files with extensions *.bmp, *.jpg, *.png and *.xmp in the direc-
tory set for automatic naming.
Before the command is executed, a warning message prompts you to confirm the dele-
tion of the files.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar on page 416

Prefix, Year, Month, Day ← Hardcopy Options > Automatic Naming
Determines the rules for "Automatic Naming".
Per default, the automatically generated filename is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>, where Y, M and D mean
year, month, Day; Number is the Current Auto Number.

You can activate or deactivate each component separately.
The "Resulting filename" indicates the current filename syntax.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix on page 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe on page 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe on page 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe on page 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe on page 417

Current Auto Number ← Hardcopy Options > Automatic Naming
Indicates the number which is used in the automatically generated filename.
Note: When initially switching on the instrument, the number is reset to the lowest pos-
sible value. Starting with number 0 the output directory is scanned for existing files. As
long as files with the same name are existing, the number is increased by 1. The num-
ber is automatically set so that the resulting filename is unique within the selected path.
The current number is not in the save/recall file but is temporarily stored within the
database. At the following save operation, the number is increased.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer? on page 417

10.11.2  Creating a hardcopy of the display

To create a hardcopy

► Select "System Config" > "Setup" > "User Interface" > "Hardcopy".

Alternatively, you can use the following controls to create a hardcopy quickly:
● On the screen, select context-sensitive menu >  (print).
● On an external keyboard, press the [Print] key.
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● Assign the hardcopy function to the [User] key.
See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.

The R&S SMB100B creates a snapshot of the screen and opens the "Hardcopy"
dialog for saving it in a file.

To configure and save the hardcopy

1. To define the output format, select "Format" > "JPG".

2. To enable the instrument to create output filenames, select "Automatic Naming" >
"On".

3. Select "Options ...".

4. In the "Hardcopy Options" dialog:

a) To change the default storage directory, select "Automatic Naming Settings" >
"Path".

b) Define a path and a filename.
For example, select the default directory /var/user.

c) If necessary, modify the parameters in the "Automatic Naming Settings".
d) Close the "Hardcopy Options" dialog.

5. In the "Hardcopy" dialog, select "Save".

The instrument saves a hardcopy of the current instrument display as a *.jpg file.
Also, creates the filename automatically.

To export a hardcopy

1. Connect the instrument to the LAN.

2. Transfer the file to a remote computer
See Section 10.10, "Transferring files from and to the instrument", on page 243.

3. On the remote computer, select the file.
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11  General instrument functions
The general instrument functions include basic instrument settings, regardless of the
selected operating mode and measurement. Some of these settings like screen display
and peripherals are initially configured at the setup of the instrument, according to per-
sonal preferences and requirements. However, you can individually adjust the settings
at any time, for example, if necessary for specific applications.

The following special functions help you in service and basic system configuration:
● Section 11.1, "Customizing the user interface", on page 254

Allows you to adjust the display and keyboard language settings.
● Section 11.2, "Organizing frequently used settings as favorites", on page 260

Enables you to group user defined settings in a favorites list or to assign actions to
the [★ (User)] as quick access for later retrieval.

● Section 11.3, "Managing licenses and license keys", on page 268
If you have purchased an additional option for the R&S SMB100B, you can enable
it using a license key.

● Section 10.3, "Restoring an instrument configuration", on page 224
At any time, you can restore a default configuration to start a measurement at a
defined instrument state, or set the instrument to factory preset.

● Section 16.3, "Performing maintenance tasks", on page 633
Special functions like calibration routines and self-tests put your instrument to an
initial state.

● Section 11.4, "Using the security settings", on page 277
Special security and protection functions protect your instrument from unauthorized
use or activate specific test routines.

11.1  Customizing the user interface

The R&S SMB100B provides basic alignments of instrument settings regarding the
user interface, that means the touch panel (screen), the appearance of the displayed
dialogs and graphics, and an external keyboard.

Start / stop display update

The operating system of the R&S SMB100B refreshes the displayed settings by default
in almost real-time, to keep the display updated with the internally used values. How-
ever, you can turn off this function to reduce settling times when the instrument is
remote controlled.

We recommend that you switch off the display update for optimum sweep performance
with short dwell times and for fast settling times.
Consider that in this case the displayed values can differ from the operated values.
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In detail described in the following paragraphs, you can:
● Set display and keyboard language, see Section 11.1.1, "Display and keyboard

settings", on page 255
● Set date and time for the system clock, see Section 16.3.2, "Date and time",

on page 637
● Configure and activate a Screen Saver
● Deactivate display update to improve performance, see Section 11.1.2, "Display

update settings", on page 257
● Determine the state of the RF signal, and the level display in the status bar when

you turn on the R&S SMB100B, see Section 11.1.3, "Defining the RF signal state
on power on", on page 258.

11.1.1  Display and keyboard settings

Access:

1. Select "System Config > Setup > User Interface > Display".

2. Select "Keyboard".
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In the "Display" and "Keyboard" dialogs, you can enable the screen saver function
and configure the language for the key assignment of an external keyboard and the
keypad.

The remote commands required to configure the display and keyboard are described in
Section 13.9, "DISPlay subsystem", on page 406 and Section 13.12, "KBOard subsys-
tem", on page 418.

Screen Saver.............................................................................................................. 256
Wait Time.................................................................................................................... 256
Display........................................................................................................................ 256
RF Hardkey................................................................................................................. 257
Layout......................................................................................................................... 257
Alphanumeric Keys..................................................................................................... 257

Screen Saver
Activates the screensaver.
If activated, the display including backlight is switched off after the selected Wait Time
elapses and if no entries via touch panel, front panel, external mouse, or external key-
board are made
Remote command: 
:DISPlay:PSAVe[:STATe] on page 407

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no
entries are made.
Remote command: 
:DISPlay:PSAVe:HOLDoff on page 407

Display
Adjusts the brightness of the display.
Increase the value to turn up the display brightness.
Remote command: 
:DISPlay:BRIGhtness on page 408
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RF Hardkey
Adjusts the brightness of the [RF on/off] key.
Increase the value to change the contrast between the key and the front panel back-
ground color.
Remote command: 
:DISPlay:BUTTon:BRIGhtness on page 408

Layout
Selects the language of an external keyboard connected over USB. The function
assigns the corresponding keys automatically.
Remote command: 
:KBOard:LAYout on page 418

Alphanumeric Keys
Selects the layout of the numeric keypad on the front panel.
"Digits Only" Assigns only numeric keys.
"Digits and Let-
ters"

Enables numeric and alphanumeric keys.

Remote command: 
:FPANel:KEYBoard:LAYout on page 418

11.1.2  Display update settings

Access:

► Select "System Config > Setup > User Interface > Start/Stop Display Update".

This dialog enables you, to deactivate updating the display.

The remote command to switch off the display update is described in Section 13.9,
"DISPlay subsystem", on page 406.

Display Update is
Disables the automatic refreshing of the displayed values.
Remote command: 
:DISPlay:UPDate[:STATe] on page 408
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11.1.3  Defining the RF signal state on power on

As additional functions for the level settings, you can determine the state of the RF sig-
nal, and the level display in the status bar when you turn on the R&S SMB100B.

Power-On/EMF settings

Access:

► Select "Level" > "Power-On / EMF".

The "Power-On/EMF" dialog contains all settings for configuring the power-on
behavior and the level display.

Settings:

Power-On State...........................................................................................................258
Display Level as Voltage of EMF................................................................................ 258

Power-On State
Determines the RF signal output state when the instrument is switched on.
You can disable the RF output signal in general, or start it in the same state as it had
been when it was switched off.
Remote command: 
:OUTPut<hw>[:STATe]:PON on page 419

Display Level as Voltage of EMF
Activates display of the signal level as voltage of the EMF (no-load voltage).
If disabled, the level is displayed as a voltage over a 50 Ohm load.
Note:
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce<hw>]:POWer:EMF:STATe on page 528

11.1.4  How to set the initial instrument settings

This section describes how to set up the R&S SMB100B initially.
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11.1.4.1  Setting the keyboard language

You can select the language of the external keyboard connected to the instrument.

To adjust the keyboard settings

1. Press the [Setup] key.

2. Select "User Interface > Keyboard".

3. Select the "Layout".

The dialog closes and the changes take effect immediately.

11.1.4.2  Setting the screen saver

You can enable a screen saver that automatically turns off the display after a user-
defined period of time. The screen saver is activated if no settings are made on the
touch screen, or via keys or the rotary knob during the selected wait time.

To activate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Activate the "Screen Saver".
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4. Define the "Wait Time" in minutes.

The instrument turns off the display after the defined period of time.

5. To reactivate the display, tap the screen or press any key on the front panel.

To deactivate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Disable the "Screen Saver" state.

11.2  Organizing frequently used settings as favorites

The R&S SMB100B provides two possibilities to define frequently used settings and
procedures for later retrieval individually.

User menu and [★ (User)] key

These two functions work similar to the favorites function of a browser or other pro-
grams. They allow you to create a list of frequently used actions or to group frequently
used settings in one dialog.

You can collect the parameters of your configuration in a favorites list, i.e. in the "User
Menu", or define settings and actions with the [★ (User)] key:
● "User Menu" to group settings of specific tasks.

Similar to a favorites function, you can use this menu for:
– Grouping the settings required for a task in one dialog.
– Saving and recalling the settings of a task.
– Transferring the settings for use on multiple instruments.

● [★ (User)] key, with customizable function.
You can perform the following steps using this key:
– Open the "User Menu" (default functionality).
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– Add or remove settings and functions.
– Execute actions and access functions.

Possible applications

The ★ (User) key and the "User Menu" are useful for the following situations:
● There are functions or tasks you have to perform in a defined order but the setting

parameters are distributed across several dialogs.
● There are functions or tasks you have to perform frequently but they are not acces-

sible via the front panel keys.
● The required functions are grouped in a dialog that is not directly accessible from

the home screen.
● Your task involves loading and executing of SCPI scripts.

See Section 12.9, "Using remote command scripts", on page 354.
● A quick access to saved setups is required.
● There are functions and tasks you have to perform on several instruments.

Dialog identification

To identify each dialog, the instrument uses a dedicated dialog ID. The dialog ID con-
tains the dialog position on the display and the current active tab. The action that trig-
gers the instrument to open a dialog uses this identification.

Save/Recall vs. recall setup

If you need to restore a specific signal generation setup and perform further configura-
tions based on this particular instrument state, the R&S SMB100B provides two
options:
● "Save/Recall" function

For a detailed description, refer to Section 10.5, "Saving and recalling settings",
on page 230.

● "Recall Setup" function
If the "Recall Setup" is the only user action assigned to the [★ (User)] key, pressing
this key triggers the R&S SMB100B to load the user-defined preset file immedi-
ately.
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11.2.1  Configuring settings quickly with the user menu

Access:

1. Press the [★ (User)] key.

The "User Menu" dialog opens.

If you execute this action for the first time, the dialog displays instructions on how
to use the "User Menu".

2. If you already have a saved user menu file on the instrument, you can load with
"Recall User Menu".

Creating a user menu

To create your own user dialog with settings:

1. Open a dialog with settings you frequently use.

2. Select a parameter.

3. Open the context menu and select "Add to User Menu".

A favorites icon  indicates that the parameter is used in the "User Menu".
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The "User Menu" button in the taskbar confirms that you have created a "User
Menu" with at least one entry.

4. Press the [★ (User)] key.

The "User Menu" dialog shows all parameters that you have added to the list.

You can modify the parameter settings directly in this dialog, e.g .change a state or
set values, as you do in the particular dialog the parameter originally belongs to.

5. To remove an entry, select the parameter either in the "User Menu" or in the dialog
where it originally belongs to.

a) Open the context menu and select "Remove from User Menu".

6. To remove all entries at once, select "Clear User Menu".

7. To save your individual favorites list, select "Save User Menu", and follow the file
managing instructions.
The file system automatically assigns the file extension *.user_menu.

8. To recall a previously saved user menu, select "Recall User Menu" and proceed
accordingly.
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Providing a user menu favorites list for several instruments

To transfer files from or to an instrument:

1. Create the favorites list, as described in "Creating a user menu" on page 262.

2. Save the favorites list.

3. To tansfer a file from or to an instrument, the R&S SMB100B provides several
options, see "File handling" on page 223.

11.2.2  How to assign actions to the [★ (User)] key

The customizable [★ (User)] key has no predefined function assigned. You can individ-
ually define actions to be executed or functions to be accessed when pressing this key.

To assign a frequently used dialog to the [★ (User)] key:

1. Open the dialog you want to quickly access.
For example, select "Frequency" > "Reference Frequency"

2. Select "System Configuration" > "Setup" > "User Interface" > "Define User Key".

3. To create an action:

a) Specify the "Name".
E.g. Open reference frequency.

b) Select "Wizard" > "Open Dialog"
c) Select "Select Dialog" and select a settings dialog from the list

The corresponding SCPI command is automatically displayed and can be modified.

4. Select "Add" to save the new action in the list of user key actions.

5. To execute the created action, press ★ (User).
In the list of actions ("Define User Key Actions" dialog), navigate to the required
action.
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In this example, this is "Open reference frequency".

The R&S SMB100B opens the dialog.

Tip: If you have assigned only one action to the user key, the R&S SMB100B per-
forms the action immediately.

11.2.3  User menu settings

The "User Menu" dialog contains function keys to organize, save and load a favorites
list. You can also modify, add or delete list entries directly in the dialog.

Clear User Menu
Removes all entries from the "User Menu" at once.

Save User Menu
Saves the current "User Menu" under the defined filename.

Recall User Menu
Loads the selected "User Menu" file.
This function enables you to use the user specific favorites file on another instrument.
However, if functions or parameters are not provided due to varying configuration of
the instrument, the settings of these particular parameters take no effect.
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11.2.4  Define user key actions settings

Access:

► Select "System Config" > "Setup" > "User Interface" > "Define User Key".

The dialog displays a list of the currently enabled actions and provides functions to
define new, edit or remove existing actions. If no actions have been defined, the list
is empty.
See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.

The remote commands required to define these settings are described in Section 13.9,
"DISPlay subsystem", on page 406.

Name
Enters a user-defined name for the action.

Wizard
Defines the action to be executed.
"Load SCPI Script"

Selects and executes the SCPI script.
"Recall Setup" Opens the file dialog for selecting a saved setup with user-defined

settings.
"Open Dialog"

Selects an open settings dialog or menu.
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Select
Depending on the selected "Wizard", provides access to:
● the standard "File Select" function for loading an SCPI script or setup file
● a list of all currently opened dialogs.

See SCPI.

SCPI
For the currently selected action, displays the corresponding SCPI command with the
associated parameter for dialog identification (dialog ID). The automatically displayed
SCPIs are enabled for subsequent modification.
Remote command: 
:DISPlay:DIALog:OPEN on page 410
See also :DISPlay:DIALog:ID? on page 409

Add, Change, Remove
Standard functions for managing of the actions.

Back to Execute Mode
Opens the "Select Action to Execute" dialog. Select an Action form the list to execute
it.
To return to the "Define User Key Actions" dialogs, select Select Action to Execute >
Define Actions.

Select Action to Execute > Define Actions

Opens the "Define User Key Actions" settings dialog.
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11.3  Managing licenses and license keys

An option is ready to operate after it is enabled with a license keycode supplied with
the option. The license key is delivered as a file or on paper. Unregistered licenses
must be registered for a particular instrument before the corresponding option can be
enabled for operation.

For reliable operation, a software option usually requires the latest firmware version.
The required version is specified in the delivery. If your instrument works with a former
firmware version, update the firmware before enabling the software option.
The firmware update is described in the release notes provided on the product page of
the R&S SMB100B.

11.3.1  Manage license keys settings

The "Manage Licnese Keys" dialog provides all information on the available licenses.
Instrument-related steps guide you through the process of registering or deactivating
licenses.

Access:

1. Select "System Config" > "Setup" > "Instrument Assembly" > "Manage License
Keys" > "Manage License Keys".

In this tab, you can activate licenses for newly purchased or newly registered
options.

2. Select "Installed License Keys".
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This tab lists all active options, with information on the available number of an
option, the license type and registration. You can query inactive or disabled options
also.

3. Select "Open License Server".

The "Manage License Keys" dialog covers all required parameters for activating or
deactivating newly purchased or newly registered options, and provides access to
the onboard license server, see Section 11.3.2, "Using the license server",
on page 271.

Settings:

Device ID.....................................................................................................................269
Enter License Key....................................................................................................... 269
Import License Key from File...................................................................................... 270
Export Deactivation Response to File......................................................................... 270
License Installation Info...............................................................................................270
Installed License Keys................................................................................................ 270

└ Show Inactive................................................................................................270
└ Show Deactivated.........................................................................................270
└ Installed License Keys Table.........................................................................270

Open License Server.................................................................................................. 271

Device ID
Displays the instrument-specific identification number. The device ID is a unique string
with the following structure:
<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.
For license keys delivered as a file, use Import License Key from File....
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Import License Key from File...
Opens a dialog for selecting the file with the license key.
Use this function also to import the deactivation key file generated by the R&S License
Manager online tool (see How to move a portable license).

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file.
This key is required during the unregistration process, e.g. when you want to deinstall
an option or have a portable option, which you want to register later on another instru-
ment (see How to move a portable license).

License Installation Info
Indicates status information on the performed actions.

Installed License Keys
Access: select "System Config > Setup > Instrument Assembly > Manage License
Keys > Installed License Keys".
Comprises information on the installed options.

Show Inactive ← Installed License Keys
Enables the display of the inactive (expired) licenses in the Installed License Keys
Table.

Show Deactivated ← Installed License Keys
Enables the display of the deactivated licenses in the Installed License Keys Table.
See How to move a portable license for information on how to activate deactivated
licenses.

Installed License Keys Table ← Installed License Keys
Shows information on the currently installed options.
"Export License Key to File"

Opens a dialog to save the generated license key file. This file is
required during the unregistration process.
If you have a portable unregistered option, you can register it later on
another instrument (see How to move a portable license).

"Option" Displays the short designation of the option.
Note: Open the Hardware Options/Software Options dialog to
retrieve more information about the installed options.

"License Count"
Displays the number of the licenses for the selected option key.
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"License Type" Displays the type of license.
A license type determines the common qualification application dura-
tion and the portability of a license. The following license types are
provided: evaluation, permanent, portable, quantified, time-controlled
with a duration of 1, 3, 6 or 12 months. A license can also be deacti-
vated or expired.
For time limited licenses, the left time of applicability is displayed too.

"Registrations" (reserved for future use)

Open License Server
Opens the R&S License Server of the R&S SMB100B, see Section 11.3.2, "Using the
license server", on page 271.

11.3.2  Using the license server

The R&S SMB100B now supports handling of software licenses using the license
server from Rohde & Schwarz.

The R&S License Server is a browser application you can access directly in the
R&S SMB100B. The onboard license server is integrated in the instrument firmware
with connection to a local smartcard memory. The local smartcard holds local licenses,
i.e. licenses used on this specific instrument.

To open the license server

Access:

1. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Installed License Keys".

Managing licenses and license keys



General instrument functionsR&S®SMB100B

272User Manual 1178.3711.02 ─ 11

2. Select "Open License Server".

The license server browser opens in a browser window and starts initially in the
"Configuration" view.

Figure 11-1: R&S license server dialog

The selection button in the status bar on the left enables you to access the "Analyt-
ics" or "Licenses" views, see "Short glance at the main views" on page 272.

The icons in the status bar on the right lead you to information on the license server:
● "About": shows the software version.
● "User Manual": opens the embedded license server user manual.
● "Help": provides the functional description on a specific dialog and its settings.

Short glance at the main views

The section provides a brief insight into the main windows of the license server. For
details and handling of the application, refer to the embedded user documentation.

1. To access a view, select the menu button.

2. Select "Configuration".

Figure 11-2: Configuration menu

Accesses the license server, access lists and installed product definitions.
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a) Select "Local license server".

Figure 11-3: Example of a local license server view

Shows the onboard license server of the instrument. With the column selection,
you can indicate or unhide characteristics of the available server. The task bar
buttons provide access to the corresponding functions and access lists.

b) Select "Product definitions".

Figure 11-4: Example of a product definition view

Shows installed product definitions. To view the available characteristics, use
the column selection.

3. Select "Licenses".
Provides access to the available license servers.

The "License keys" view lists the license key options that are available on the
selected server. To show additional information, use the column selection.
The task bar functions enable you to activate or deactivate a license, to get details
on an option and export license keys or information on the selected product.

4. Select "Analytics".
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Figure 11-5: Analytics menu

Provides access to the license providers, client applications and enables you to
export statistics data for evaluation in external applications.

Shows information on configured client applications, license providers and license
types. To show additional information, use the column selection.

To manage licenses on the R&S SMB100B

To request or return a license, proceed as follows:

1. Access: see "To open the license server" on page 271.

The browser application opens.

2. Select "Licenses"

3. Select a license server in the menu list, e.g. "R&S SMB100B".

The "License keys" view lists the enabled options available on the selected server.

4. Select "Status" > "Select all" to list also options that are currently deactivated.

The "Licenses" view shows all active, inactive and time limited options.

5. To get detailed information on a specific option:

a) Select the option in the list.
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b) In the task bar, select "Details".

Figure 11-6: Example of the license characteristics of an option

6. To enable a discontinued license: , select  in the taskbar.

a) Select the license you want to activate.
b) In the task bar, select .

7. To return a license, proceed the same way:

a) Select the license.
b) Deactivate the license with .

8. Follow the instructions on the screen.

11.3.3  How to move a portable license

This example is intended to explain how to perform the required steps at the instru-
ment.

Use a USB flash drive to transfer the license key files between the instruments and the
browser.

We assume knowledge about the handling of the R&S License Manager online tool
and the description of the whole process.

1. Open your browser. Enter https://extranet.rohde-schwarz.com/service.
Select "Manage Licenses > Move Portable License".

The first step requires the Device IDs of the source and target instruments.

2. To find out the Device IDs, proceed as follows:

Managing licenses and license keys
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a) On the source instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys > Manage License Keys > Device ID".

b) On the target instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys".

c) In the "Mange License Keys" tab, select "Device ID".
d) In the browser, select "Manage Licenses > Move Portable License > Select

Devices".
e) Enter the Device IDs.

3. On the source instrument, select "System Config > Setup > Instrument Assembly >
Installed License Keys > License Keys Table".

a) Navigate to the portable license that you want to move.
b) Select the "Export License to File" column.

A standard file manager dialog opens.

4. Enter a filename.

5. Save the exported license key, e.g. k123_portable_key_to_move.xml.

6. In the browser, select "Manage Licenses > Move Portable License > Select
License (from file)":

a) Select the exported license key.
b) Check the selection.
c) Create the deactivation key.
d) Save it to file.

7. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Import License Keys from File".
Select the transferred deactivation key.

8. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Export Deactivation Response to File".

9. In the browser, go to "Manage Licenses > Move Portable License > Install Deacti-
vation Key (from file)".

10. Enter the deactivation response of the instrument.

The license is deactivated for the source instrument.

11. In the "Manage Licenses > Move Portable License", go to step "Create License" to
generate a license key for this portable option and the selected target instrument.

a) Download the license key as a file.
b) Transfer it to the target instrument.
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12. In the target instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > New License > Import License Keys from File".

13. Select the created license key file.

The portable option is installed on the target instrument.

11.4  Using the security settings

The protection function of the R&S SMB100B provides several levels to activate partic-
ular functions like self-test or tests for service purposes specifically.

Protection

The five protection levels are automatically active on startup that means all protected
functions are locked.

To unlock a protection level:

► In the "System Config > Setup > Security > Protection" dialog, enter the correct
password.

To lock a protection level:

► Clear the corresponding checkbox.

Protection levels

The following functions are protected in the respective levels:
● Protection level 1

Protects against accidental changes, like, for example, the clock and date, several
internal adjustments functions and the self-test, as well as network settings or the
instrument hostname.
You can access this level with the password 123456.

● Protection level 2
Unlocks protected service functions. It is accessible to authorized personnel of
Rohde & Schwarz service department only.

● Protection level 3 to 5
Are reserved for internal use.

Security

The security concept of the R&S SMB100B helps you to protect your instrument
against uncontrolled access and changes.

All modified security settings require that you enter the Security Password and confirm
with Accept.
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Provided security services are:
● General security parameters, such as:

– USB storage that secures controlled access to the mass memory of the instru-
ment

– Volatile mode that prevents information to be written to the internal memory
permanently.

– Sanitizing that prevents the instrument from leaving a secure environment with
stored user information.

– Annotation frequency and amplitude prevent reading the display.
– User interface prevent manual operation and reading the display.

● Password management secures controlled user access to the instrument
With the two-step password concept, you can assign a user-defined password for
the operating system, and a security password for accessing the mass storage of
the instrument.
See Section 11.4.5, "Password management", on page 287.

● LAN services secure controlled network access
You can individually lock and unlock supported LAN interface services, including
the SMB client and SMB server that use versions 1.0 and 2.0 of the SMB protocol.
Remote control over LAN requires you have enabled the interface, but you can dis-
able not needed LAN services individually.
Note: Disabling LAN services needed for remote control over LAN locks the instru-
ment access persistently. You cannot address the instrument any longer.
See Section 11.4.4, "Configuring LAN services", on page 283.

● User interface prevents front panel operation and/or reading the display.

For more information, see the document R&S SMB100B Instrument Security Proce-
dures.

● Disk & memory security settings...........................................................................278
● Manual operation security settings........................................................................280
● Protection level settings........................................................................................ 282
● Configuring LAN services......................................................................................283
● Password management........................................................................................ 287
● Preventing unauthorized access...........................................................................290

11.4.1  Disk & memory security settings

Access:

1. Select "System Config" > "Setup" > "Security" > "Security".

2. Select "General" > "Disk & Memory".
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The "Disk & Memory" tab secures controlled access to the mass memory and pre-
vents information from leaving a secure environment.

The remote commands available to control security settings are described in Sec-
tion 13.17, "SYSTem subsystem", on page 555.

USB Storage
Activates the access to external USB storage media.
To apply the change enter the security password and confirm with "Accept".
See Section 10.10.4, "Using a USB storage device for file transfer", on page 247.
Note: Remove all USB memory devices before disabling the USB storage. If any USB
memory device remains connected, disabling is blocked, and the instrument returns a
warning message.
The microSD card is also considered a USB memory device and must be removed. If
you have sealed the SD card slot, you can not disable the USB storage.

Volatile Mode
Activates volatile mode, so that no user data can be written on the internal memory
permanently.
In volatile mode:
● Data that the instrument normally stores on the internal memory is redirected to

volatile memory.
● The user directory is mapped to the volatile memory. You access the temporary

data just as data stored in the /var/user/, see Section 10.4, "Protecting data",
on page 229.

● Data on the internal memory cannot be changed. It is protected against modifica-
tion or erasure.

● You can only save data:
– Temporarily in the volatile memory
– On a connected external storage device, such as a memory stick

To apply the change enter the security password and confirm with "Accept".
Enabling the volatile mode also requires a reboot, prompted by the instrument.
The icon  indicates the enabled volatile mode.
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Remote command: 
:SYSTem:SECurity:VOLMode[:STATe] on page 578

Sanitize
Executes the erase procedure that sanitizes the internal memory.
The sanitizing function makes sure that no user information is stored on the instrument
when it leaves the secure environment.
To apply the change enter the security password and confirm with "Accept".
Note: If the instrument is subject to high security, and you have disabled volatile mode,
the internal memory holds user-data, and thus poses a security risk.
See also Section 11.4, "Using the security settings", on page 277 for more information
on the security concept.
Remote command: 
:SYSTem:SECurity:SANitize[:STATe] on page 577

11.4.2  Manual operation security settings

Access:

1. Select "System Config" > "Setup" > "Security" > "Security".

2. Select "General" > "Manual Operation".

The "Manual Operation" tab enables you to lock front panel operation and/or read-
ing the display.

The remote commands available to control security settings are described in:
● Section 13.9, "DISPlay subsystem", on page 406
● Section 13.17, "SYSTem subsystem", on page 555.

Annotation Frequency
Enables the display of the currently used frequency in the status bar.

Using the security settings



General instrument functionsR&S®SMB100B

281User Manual 1178.3711.02 ─ 11

To apply the change enter the security password and confirm with "Accept".
How to: see "To disable frequency and level indication in the status bar" on page 293.
Remote command: 
:DISPlay:ANNotation:FREQuency on page 409

Annotation Amplitude
Enables the display of the currently selected level in the status bar.
To apply the change enter the security password and confirm with "Accept".
How to: see "To disable frequency and level indication in the status bar" on page 293.
Remote command: 
:DISPlay:ANNotation:AMPLitude on page 408

User Interface
Allows you to lock the controls for manual operation and the display individually.
To apply the change enter the security password and confirm with "Accept".
How to: see "To disable the user interface" on page 293.
See also Section 11.4, "Using the security settings", on page 277.
"Enabled" Enables the display and all controls for the manual operation of the

instrument.
"Touchscreen Off"

Locks the touch sensitivity of the screen.
This security feature protects the instrument against unintentional
change of settings by accidentally touching of the screen.
Still available controls for manual operation are:
● The keys at the front panel, including the rotary knob
● The external mouse and keyboard
● Remote operation over VNC
The instrument indicates the locked touchscreen by an icon .
Unlocking is possible via VNC, external controls or remote control.

"VNC Only" Locks the keys at the front panel, the touchscreen and externally con-
nected keyboard and mouse.
The display on the screen remains and shows the current settings
and changes.
The instrument indicates the activated "VNC only" feature by the icon

.
Unlocking is possible via VNC or turning off and on again.
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"Display Only" Locks the manual operation of the instrument. The display on the
screen remains and shows the current settings and changes.
This security feature protects the instrument against unauthorized
access, but still shows the current settings and processes, for exam-
ple when you operate the instrument via remote control.
The function disables:
● The touchscreen functionality of the display
● The keys at the front panel of the instrument
● The external mouse and keyboard
The instrument indicates the locked controls by a padlock  softkey.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 293.

"Disabled" Locks the display and all controls for the manual operation of the
instrument.
This security feature protects the instrument against unauthorized
reading and access, for example when you operate the instrument via
remote control.
The function disables:
● The display
● The touchscreen
● The keys at the front panel of the instrument
● The external mouse and keyboard
The screen shuts off and displays a padlock symbol  instead.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 293.

Remote command: 
:SYSTem:ULOCk on page 564
:SYSTem:DLOCk on page 563
:SYSTem:KLOCk on page 563

Enabling a locked user interface for manual operation
Follow the instructions listed in "Unlocking (reactivating) the user interface for manual
operation" on page 293.
Remote command: 
:SYSTem:ULOCk on page 564
:SYSTem:DLOCk on page 563
:SYSTem:KLOCk on page 563

11.4.3  Protection level settings

Access:

► Select "System Config" > "Setup" > "Security" > "Protection".
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The "Protection" dialog provides access to the unlocking of different protection lev-
els.
Several functions in the instrument are password-protected to prevent for example
accidental changes, "Protection" on page 277.

The remote commands required to unlock a protected stage are described in Sec-
tion 13.17, "SYSTem subsystem", on page 555.

Protection Level/Password
Unlocks the selected level of protection, if you enter the correct password.
The default protection level 1 password is 123456.
To lock the protection level again, clear the checkbox.
Remote command: 
:SYSTem:PROTect<ch>[:STATe] on page 566

11.4.4  Configuring LAN services

Access:

1. Select "System Config > Setup > Security > Security > LAN Services > Common
Services".

2. NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or the com-
mon services "SCPI over LAN", "VNC" and "HTTP" locks the remote access to the
instrument.
Do not disable the LAN interface or LAN services needed for remote control while
you operate the instrument remotely.
Proceed with step step 4 for troubleshooting disabled services.
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In the "Common Services" side tab, you can individually disable the supported ser-
vices of the LAN interface.

3. Disable LAN services as needed.

a) Disable the service.
b) To confirm disabling, enter the security password.
c) Select "Accept".

4. If you have locked the access accidentally, you have the following options:
● Update the instrument firmware using ISO image

(<instrument>_<version-number>.iso).
Note: A firmware update with the ISO image resets the instrument. The instru-
ment reset dismisses user-specific configurations and deletes user data.
Contact the Rohde & Schwarz (https://www.rohde-schwarz.com/support) to get
the ISO image.

● Ship the instrument to your local service department. The service center
experts can enable the remote access over LAN without loosing user-specific
settings and data.
See www.services.rohde-schwarz.com.

5. Select "System Config > Setup > Security > Security > LAN Services > Samba Ser-
vices".
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In the "Samba Services" side tab, you can activate former versions of the SMB cli-
ent and SMB server.

The remote commands available to control security settings are described in Sec-
tion 13.17, "SYSTem subsystem", on page 555.

How to:
● "To disable LAN access in general" on page 291
● "To disable LAN services individually" on page 291
● "To enable SMB version 1.0/2.0 client and server" on page 292

Common Services.......................................................................................................285
└ LAN...............................................................................................................285
└ LAN Services................................................................................................ 285

Samba Services.......................................................................................................... 286
└ SMB 1.0/2.0 Client........................................................................................286
└ SMB 1.0/2.0 Server.......................................................................................287

Security Password...................................................................................................... 287
Accept......................................................................................................................... 287

Common Services
Enables the LAN interface and supported LAN interface services.

LAN ← Common Services
Enables the LAN interface in general, and thus provides remote access over all
unlocked services.
Remote command: 
:SYSTem:SECurity:NETWork[:STATe] on page 577

LAN Services ← Common Services
Enables the supported LAN interface services individually.
"SCPI over LAN"

Access over LAN to control the instrument remotely, by using SCPI
(Standard Commands for Programmable Instruments) commands.
See also "To set up the controller with R&S VISA" on page 346 and
"To start remote control with R&S VISA" on page 348
Remote command: 
:SYSTem:SECurity:NETWork:SOE[:STATe] on page 576

"VNC" Access over VNC (Virtual Network Computing) interface, a graphical
desktop sharing system that uses RFB protocol to control the instru-
ment remotely.
See also Section 12.10, "Setting up remote operation over VNC",
on page 364.
Remote command: 
:SYSTem:SECurity:NETWork:VNC[:STATe] on page 577
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"SSH (SCP)" Access over SSH (Secure Shell), a network protocol for secure data
communication.
Remote command: 
:SYSTem:SECurity:NETWork:SSH[:STATe] on page 576

"Remote Support"
Remote support over SSH (SCP).
The service provides communication for service purposes only.
Remote command: 
:SYSTem:SECurity:NETWork:REMSupport[:STATe]
on page 575

"HTTP" Access with HTTP (Hyper Text Transfer Protocol), the application pro-
tocol for hypermedia information systems.
Remote command: 
:SYSTem:SECurity:NETWork:HTTP[:STATe] on page 574

"FTP" Access with FTP (File Transfer Protocol), used to transfer files from a
host to the instrument and vice versa.
See also Section 10.10.2, "Accessing the file system using FTP",
on page 245.
Remote command: 
:SYSTem:SECurity:NETWork:FTP[:STATe] on page 574

"SMB (Samba)"
Access to SMB (Server Message Block), used for providing shared
access to files, printers and serial ports of a network.
See also Section 10.10.3, "Accessing the R&S SMB100B file system
using SMB (Samba)", on page 246.
Remote command: 
:SYSTem:SECurity:NETWork:SMB[:STATe] on page 576

"Avahi (Zeroconf)"
Avahi, a service for automatic configuration of the instrument in a net-
work environment.
Remote command: 
:SYSTem:SECurity:NETWork:AVAHi[:STATe] on page 574

"Software Update"
Allows updating the software.
Remote command: 
:SYSTem:SECurity:NETWork:SWUPdate[:STATe] on page 576

Samba Services
Enables support of SMB client and SMB server version 1.0 and 2.0 of the SMB proto-
col.
Support of version 1.0 and 2.0 is additional to the current SMB protocol version sup-
ported in the firmware. This firmware supports SMB protocol up to version 3.1.1.

SMB 1.0/2.0 Client ← Samba Services
Enables support of the SMB client compatible with SMB protocol versions 1.0 and 2.0.
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SMB 1.0/2.0 Server ← Samba Services
Enables support of the SMB server compatible with SMB protocol versions 1.0 and 2.0.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is 123456.
How to: "To change the security password" on page 290

Accept
Applies the modified settings, provided the security password is entered and correct.

11.4.5  Password management

Access:

1. Select "System Config > Setup > Security > Security > Password Management >
User Password".

In this tab, you can assign the security and a user-defined password.

2. Select "System Config > Setup > Security > Security > Password Management >
Security Password".
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How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.

Settings:

User Name.................................................................................................................. 288
User Password............................................................................................................288

└ Old Password................................................................................................288
└ New Password..............................................................................................289
└ Confirm Password.........................................................................................289
└ Change Password.........................................................................................289

Security Password...................................................................................................... 289
└ Old Password................................................................................................289
└ New Password..............................................................................................289
└ Confirm Password.........................................................................................289
└ Change Password.........................................................................................290

User Name
Indicates the user name used for access to the Linux operating system and valid for
VNC, FTP and SMB (Samba) access.

User Password
Access: select "System Config > Setup > Security > Security > Password Management
> User Password".
Allows you to change and confirm the user password.

Old Password ← User Password
Enters the current user password. The default password is "instrument".
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "To change the user password of the instrument" on page 290.
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● "To change the security password" on page 290.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Section 14.10, "Contacting customer support", on page 630.

New Password ← User Password
Enters the new user password.
The security password can contain decimal characters only.

Confirm Password ← User Password
Confirms the new user password by repeating.
How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.

Change Password ← User Password
Changes the user password accordingly.

Security Password
Access: select "System Config > Setup > Security > Security > Password Management
> Security Password".
Enables you to change and confirm the security password.

Old Password ← Security Password
Enters the currently used security password. The default password is '123456'.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.
The security password is required when changing the status of the USB and LAN inter-
face or other security settings.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Section 14.10, "Contacting customer support", on page 630.

New Password ← Security Password
Enters the new security password.
The security password can contain decimal characters only.

Confirm Password ← Security Password
Confirms the new security password by repeating.
How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.
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Change Password ← Security Password
Changes the password accordingly.

11.4.6  Preventing unauthorized access

The default computer name and user password are instrument. The user password is
the password required for VNC, FTP and SMB (samba) connections. If for example,
the VNC service or FTP are enabled, anyone in the network who knows the computer
name and user password of the instrument can access it.

The default security password is 123456. The security password is required when
changing the status of the USB and LAN interfaces.

To prevent unauthorized access, use the following configurations exclusively or com-
plementary:
● "To change the user password of the instrument" on page 290
● "To change the security password" on page 290
● "To disable LAN access in general" on page 291
● "To disable LAN services individually" on page 291
● "To enable SMB version 1.0/2.0 client and server" on page 292
● "To disable frequency and level indication in the status bar" on page 293
● "To disable the user interface" on page 293

If security is a concern, see the document instrument security procedures for compre-
hensive description.

To change the user password of the instrument

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.

a) Select "System Config > Setup > Security > Security > Password Management
> User Password".

b) Enter the current password in the "Old Password" field.
c) Enter the new password in the "New Password" and "Confirm Password" fields.
d) Select "Change Password".

The user password is changed; the user name is displayed ("Security > Password
Management > User Password > User Name").

To change the security password

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "To change the user password of the instrument" on page 290.
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● "To change the security password" on page 290.

a) Select "System Config > Setup > Security > Security > Password Management
> Security Password".

b) Enter the current password in the "Old Password" field.
The default password is 123456.

c) Enter the new password in the "New Password" and "Confirm Password" fields.
d) Select "Change Password".

To disable LAN access in general

1. NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or certain
services lock the remote access to the instrument.
The following services lock the remote access when disabled: "LAN", "SCPI over
LAN", "VNC" and "HTTP".
If you have locked the access accidentally, you have the following options:
● Update the instrument firmware using ISO image

(<instrument>_<version-number>.iso).
Note: A firmware update with the ISO image resets the instrument. The instru-
ment reset dismisses user-specific configurations and deletes user data.
Contact the Rohde & Schwarz (https://www.rohde-schwarz.com/support) to get
the ISO image.

● Ship the instrument to your local service department. The service center
experts can enable the remote access over LAN without loosing user-specific
settings and data.
See www.services.rohde-schwarz.com.

2. Select "System Config > Setup > Security > Security".

3. Select "LAN Services > Common Services".

4. Disable "LAN" state.

5. Enter the Security Password.

6. Select "Accept".

All LAN connections are blocked, including the LAN services. Communication over
LAN is not possible.

To disable LAN services individually

1. Select "System Config > Setup > Security > Security".

2. Select "LAN Services > Common Services".

3. Uncheck all services you want to block, for example "FTP > Off" or "VNC > Off".
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4. Uncheck the services you want to block, for example "FTP" and "VNC".

5. Enable "LAN" state, if disabled.

6. Enter the Security Password.

7. Select "Accept".

Communication over LAN is possible for the enabled services only.

To enable SMB version 1.0/2.0 client and server

By default, support of SMB client and SMB server of the SMB protocol versions 1.0
and 2.0 is disabled.

Activate support only, if needed:

1. Select "System Config > Setup > Security > Security".

2. Select "LAN Services > Samba Services".
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3. For example, check "SMB 1.0/2.0 Client".

4. Select "SMB 1.0/2.0 Client > On" and "SMB 1.0/2.0 Server > On".

5. Enter the Security Password.

6. Select "Accept".

Enables the access for the SMB Samba client, the access for the SMB Samba
server remains blocked.

To disable frequency and level indication in the status bar

These settings are useful to prevent unauthorized personnel from reading the display,
when you remotely control the instrument from a different location.

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "Annotation Frequency > Off" or "Annotation Amplitude > Off".

3. Enter the Security Password.

4. Select "Accept".

To disable the user interface

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "User Interface > Disabled".

3. Enter the Security Password.

4. Select "Accept".

The screen shuts off and displays a padlock symbol  instead.
There are further possible configurations. For details, see "User Interface"
on page 281.

Unlocking (reactivating) the user interface for manual operation

1. In manual operation:

a) On the instrument's keypad or external keyboard, press any key.
The instrument prompts you to enter the security password for unlocking.

If you press the character of the first key, the input field accepts the character
immediately.

b) Delete the entry before inserting the password.
Enter the security password 123456.

2. In remote control mode:

Using the security settings
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a) Send the command SYST:ULOC ENABled to release all locks at once.
b) Send the command SYST:KLOC OFF to unlock the keyboard and touchscreen.
c) Send the command SYST:DLOC OFF to release all locks.

Via remote control, there is no password required.

11.5  Undoing or restoring actions

"Undo" is a function that removes the effect of the last action on the instrument and
reverts it to an older state. Conversely, "Redo" restores a previously undone action.

You can "Undo/Redo" actions according to two criteria:
● Step by step

Gradually undo/redo the actions in reverse order as previously performed.
Depending on the available memory the "Undo/Redo" steps may restore all
actions.

● Multiple steps at once
Select any specific action in the history list to "Undo/Redo" multiple actions in a sin-
gle step.
Note: This mode requires a system restoration file on the instrument.

Access:

► Select "Setup > Settings > Undo/Redo".

The dialog contains all functions for enabling the "Undo/Redo" functionality.

Undoing or restoring actions
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Settings:

State............................................................................................................................295
History List.................................................................................................................. 295
Clear History............................................................................................................... 295
Apply........................................................................................................................... 295

State
Enables the recording of the performed actions.

History List
Lists the performed actions, provided "Undo/Redo" state is "On".

Clear History
Deletes the recorded list of the performed steps.

Apply
Performs the "Undo/Redo".
If you select a previously performed action of the list, all subsequent actions are
undone. The list entries remain.
If you select a subsequently executed action, you can restore all the actions undone up
to this state.

11.6  Shutting down and rebooting the instrument

The [On/Standby] front panel key switches the instrument from the standby to the
ready state or vice versa. In remote operation from a remote computer or in manual
control, there is another possibility to shut down the instrument or to reboot the system.

Access:

► Select "System Config > Setup > Maintenance > Shut Down".

● :SYSTem:REBoot on page 584
● :SYSTem:SHUTdown on page 585

Shutting down and rebooting the instrument
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12  Network operation and remote control
As an alternative to the interactive operation directly at the instrument, you can operate
the R&S SMB100B also from a remote location.

The various interfaces provide flexible access to the instrument, such as remote con-
trol, remote operation or remote file access. These remote access modes are funda-
mentally different, although they are often considered interchangeable, as described in
Section 12.1, "Overview of remote access modes", on page 297.

Figure 12-1 shows the possibilities of the physical connection (interfaces) for remote
access.

Figure 12-1: Supported remote connections

The following descriptions provide information required for operating the
R&S SMB100B remotely. The information applies to all applications and operating
modes supported by the instrument. Definitions specified in the SCPI standard are not
provided.
For basic knowledge on remote control operation and additional information, see the
following documents, available on the Rohde & Schwarz website:
● Getting started: Remote control via SCPI
● Application note 1GP72: "Connectivity of Rohde&Schwarz Signal Generators"
● Application note 1MA208: "Fast Remote Instrument Control with HiSLIP"
● Application note 1GP98: "SCPI Recorder Test Automation on a Fingertip"

● Overview of remote access modes.......................................................................297
● Remote control interfaces and protocols...............................................................298
● Remote control programs and libraries.................................................................303
● Status reporting system........................................................................................ 306
● Remote access settings........................................................................................309
● LXI status settings.................................................................................................332
● LXI browser settings..............................................................................................333
● Setting up remote control......................................................................................340

https://www.rohde-schwarz.com/rc-via-scpi
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● Using remote command scripts.............................................................................354
● Setting up remote operation over VNC................................................................. 364
● References............................................................................................................370

12.1  Overview of remote access modes

This section outlines the possible access modes and their major characteristics.

Remote control (SCPI)

● A remote PC controls the instrument, usually via VISA (Virtual Instrument Software
Architecture) interfaces.

● Remote control disables the manual operation of the instrument; you can set differ-
ent lock states.

● The GUI is not visible.
● Remote control commands (SCPI) perform the settings, either individually or in

sequences (SCPI programs).
● Using SCPI programs is faster than the manual operation, since they automate

repeating applications.

Remote operation (VNC)

● A remote device accesses the instrument via the common platform technology
VNC (Virtual Network Computing).

● The protocol allows simultaneous operation from several remote devices and the
instrument nevertheless remains locally operable.

● The GUI is visible.
● To perform the settings, you can operate the instrument as with the manual control.
● During remote operation via VNC, the direct control of the instrument is not dis-

abled.
You can control the instrument from the front panel and via the remote computer
alternately.

● Clients supporting remote operation depend on the used remote device, see
Table 12-1.

● How to: see Section 12.10, "Setting up remote operation over VNC", on page 364.
Table 12-1: Supported VNC operation modes

Remote device VNC client Requirements Characteristics

Desktop

(Windows, Linux,
MacTMOS)

● Ultr@VNC
● Other dedicated client soft-

ware

Ultr@VNC or Client Software
must be installed.

Fast, supports several options like
full screen mode or auto-login.

 ● Any web browser Java Runtime must be installed
and activated in the browser set-
tings.

Fast and convenient - only the
instrument address required.

Java runtime is sometimes con-
sidered as security concern.

Overview of remote access modes
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Remote device VNC client Requirements Characteristics

 ● Web browser with HTML5 Web sockets must be supported. Slower than the other modes.

No additional installation or acti-
vation required.

No security concern.

Smart device

(Tablet/ smartphone)

● Dedicated client App App must be installed. Fast, supports several options like
full screen mode or auto-login.

 ● Web browser with HTML5 Web sockets must be supported. Support of QR code scanning

Slower than a dedicated App.

Remote file access (FTP, SAMBA/SMB)

● A remote client accesses the instrument's file system, using the protocols FTP (file
transfer protocol) and SAMBA/SMB (server message block).

● The protocols enable you to transfer files from or to the instrument and to get direct
access to its file sharing directory share.

How to:

Section 10.10.2, "Accessing the file system using FTP", on page 245.

Section 10.10.3, "Accessing the R&S SMB100B file system using SMB (Samba)",
on page 246

"To enable SMB version 1.0/2.0 client and server" on page 292

12.2  Remote control interfaces and protocols

The instrument supports various interfaces for remote control. Table 12-2 gives an
overview on the connectivity:

Table 12-2: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and library Remarks

Local area network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol
(IVI-6.1)
TCPIP::host address::hislip0[::INSTR]
VISA

● VXI-11
TCPIP::host address[::
LAN device name][::INSTR]
VISA

● Socket communication (Raw Ethernet, simple
Telnet)
TCPIP::host address[::
LAN device name]::<port>::SOCKET
VISA or socket controller

The LAN connector is at the rear panel of the
instrument.

The interface is based on TCP/IP, see Sec-
tion 12.2.1, "LAN interface", on page 299 for
details on the address information.

USB ● USBTMC
USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
VISA

The USB In connector is at the rear panel of the
instrument.

For a description of the interface, see Sec-
tion 12.2.2, "USB interface", on page 301

Remote control interfaces and protocols
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Interface Protocols, VISA*) address string and library Remarks

GPIB (IEC/IEEE Bus
Interface)

● VISA*) address string:
GPIB::<address>[::INSTR] (no secondary
address)
VISA (optional)

The optional GPIB bus interface according to
standard IEC 625.1/IEEE 488.1 is at the rear
panel of the instrument.

For a description of the interface, see Sec-
tion 12.2.3, "GPIB interface (IEC/IEEE bus
interface)", on page 302.

*) VISA (Virtual Instrument Software Architecture) is a standardized software interface library providing input and output functions to
communicate with instruments. A VISA installation on the controller is a prerequisite for remote control over LAN (when using
VXI-11 or HiSLIP protocol), USB and serial interface. When using socket communication or the GPIB interface, VISA installation is
optional. For basic information, see Remote control via SCPI.

www.rohde-schwarz.com/rsvisa provides the standardized I/O software library
R&S VISA for download at the Rohde & Schwarz website www.rohde-schwarz.com/
rsvisa.

How to: Section 12.8, "Setting up remote control", on page 340 describes how to con-
figure the remote control interfaces.

● LAN interface........................................................................................................ 299
● USB interface........................................................................................................301
● GPIB interface (IEC/IEEE bus interface)...............................................................302
● LXI browser interface............................................................................................ 303

12.2.1  LAN interface

The LAN interface of the instrument consists of a connector, a network interface card
and protocols.

For remote control, the instrument and the controller PC must be connected to a com-
mon network with TCP/IP network protocol.

There are two methods to establish a LAN connection to the instrument:
● A non-dedicated network (Ethernet) connection from the instrument to an existing

network.
● A dedicated network connection (Point-to-point connection) between the instru-

ment and a single computer.

How to: Section 3.1.7, "Connecting to LAN", on page 25

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

VISA resource strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in the LAN. The resource string is a unique identifier,

Remote control interfaces and protocols
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composed of the specific IP address of the instrument and some network and VISA-
specific keywords.

TCPIP::<host address>[::<LAN device name>][::INSTR]

TCPIP = designates the network protocol
host address = designates the IP address or hostname of the instrument
[::LAN device name] = defines the protocol and the instance number of a subinstrument
[::INSTR] = indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
the device is registered in the network. Optionally, you can also assign its LAN device
name.

If assigned, the IP address is displayed in the home screen.

The following section lists the characteristics of the VISA resource strings for the corre-
sponding interface protocols. The emphasized characters determine the protocol.

For description of the interface protocols, control commands and messages, refer to
Remote control via SCPI.

HiSLIP

TCPIP::<host address>::hislip0[::INSTR]

hislip0 = HiSLIP device name, designates that the interface protocol HiSLIP is used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

Example: 
TCPIP::192.1.2.3::hislip0

VXI-11

TCPIP::<host address>[::inst0][::INSTR]

[::inst0] = LAN device name, indicates that the VXI-11 protocol is used (optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

Example: 
TCPIP::192.1.2.3::INSTR

Socket communication

TCPIP::<host address>::<port>::SOCKET

Remote control interfaces and protocols
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port = determines the used port number
SOCKET = indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as
port number) and of "SOCKET" to complete the resource string.

Basically, instruments from Rohde & Schwarz use port number 5025 for socket com-
munication.

Example: 
TCPIP::192.1.2.3::5025::SOCKET

12.2.2  USB interface

Option: R&S SMBB-K986

For remote control using USB, the controller PC and the instrument must be connected
over the USB type B interface. Software for instrument control and the VISA program
library must be installed on the controller.

The serial interface "RS232" enables you to connect the instrument over serial inter-
face. You can connect to the interface by using the external USB/serial-adapter
R&S TS1-USB and a serial crossover (null modem) cable.

For more information, refer to the specifications document.

VISA detects and configures the Rohde & Schwarz instrument automatically when the
USB connection is established. You do not have to install a separate driver.

USBTMC (USB Test & Measurement Class Specification) is a protocol that is built on
top of USB for communication with USB devices. It defines class code information of
the instrument, that identifies its functionality to load the respective device driver. Using
VISA library, the protocol supports service request, trigger, and other specific opera-
tions.

USB resource string

The resource string represents an addressing scheme that is used to establish a com-
munication session with the instrument. It is based on the instrument address and
some instrument- and vendor-specific information.

The USB resource string syntax is as follows:

USB::<vendor ID>::<product ID>::<serial number>[::INSTR]

USB = denotes the used interface
<vendor ID> = is the manufacturer ID for Rohde & Schwarz
<product ID> = is the product identification of the instrument
<serial number> = is the individual serial number at the rear of the instrument
[::INSTR] = indicates the instrument resource class (optional)

Remote control interfaces and protocols
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RS232 resource string

The RS232 resource string represents the addressing scheme for a device connected
to the serial interface of the instrument.

The USB resource string syntax is as follows:

ASRL<port number>[::INSTR]

ASRL is the name of the serial interface

<port number> is the number of the serial interface

Example: 
ASRL1::INSTR

12.2.3  GPIB interface (IEC/IEEE bus interface)

Option: R&S SMBB-K986

To control the R&S SMB100B over the GPIB bus, the instrument and the controller PC
must be connected with a GPIB bus cable. A GPIB bus card, the card drivers and the
program libraries for the used programming language must be installed on the control-
ler.

For description of the characteristics, control commands and messages of the GPIB
interface, refer to Remote control via SCPI.

GPIB address

The controller PC addresses the instrument with the GPIB bus channel, see Sec-
tion 12.5.3, "GPIB address settings", on page 314. GPIB provides channel addresses
from 0 to 30.

The GPIB resource string syntax is as follows:

GPIB:://<channel>[::INSTR]

GPIB = denotes the used interface
<channel address> = the used channel
[::INSTR] = indicates the instrument resource class (optional)

Note: If the VISA implementation supports the GPIB interface, you can optionally
define the VISA Instrument Control Resource (INSTR). It is used to define the basic
operations and attributes for a device, such as reading, writing, or triggering.

Example: 
GPIB::28::INSTR
28 is the selected GPIB bus channel

Remote control interfaces and protocols
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12.2.4  LXI browser interface

The LXI browser interface allows easy configuration of the LAN and remote control of
the R&S SMB100B without additional installation requirements. The instrument's LXI
browser interface works correctly with all W3C compliant browsers.

See Section 12.11.1, "LXI functionality", on page 370 for more about LXI.

The LAN settings are configured using the instrument's LXI browser interface descri-
bed in Section 12.7.1, "LAN configuration", on page 335.

For LXI status information in the R&S SMB100B, see Section 12.6, "LXI status set-
tings", on page 332.

12.3  Remote control programs and libraries

This section shows how the remote-control programs access the instrument, and the
libraries they require for the corresponding interface protocols.

Figure 12-2: Overview of remote control interfaces, protocols and libraries

Possible setups and access functions

The following examples give an overview of dependencies between the available libra-
ries, the possible interfaces and protocols, and whether an instrument driver is provi-
ded. For detailed information, see the application note 1GP72.

Remote control programs and libraries
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Example: Remote control (application) program using VISA

Figure 12-3: Application program using VISA

Protocol Remote control program

Socket viOpen (..., "TCPIP:SMB100B-102030::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:SMB100B-102030::inst0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

HiSLIP viOpen (..., "TCPIP:SMB100B-102030::hislip0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0AAD::0x01DE::100001::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

GPIB viOpen (..., "GPIB::28::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

Remote control programs and libraries
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Example: Remote control program using instrument driver (VISA available)

Figure 12-4: Application using instrument driver (VISA available)

Protocol Remote control program

Socket rssmb_init ("TCPIP:SMB100B-102030::5025::SOCKET", ...)
rssmb_SetFrequency (..., 2e9)

VXI-11 rssmb_init ("TCPIP:SMB100B-102030::inst0::INSTR", ...)
rssmb_SetFrequency (..., 2e9)

HiSLIP rssmb_init ("TCPIP:SMB100B-102030::hislip0::INSTR", ...)
rssmb_SetFrequency (..., 2e9)

USBTMC rssmb_init ("USB::0x0AAD::0x01DE::100001::INSTR", ...)
rssmb_SetFrequency (..., 2e9)

GPIB rssmb_init ("GPIB::28::INSTR", ...)
rssmb_SetFrequency (..., 2e9)

Remote control programs and libraries
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Example: Remote control program using instrument driver (VISA not available)

Figure 12-5: Remote control program using instrument driver (VISA not available)

Protocol Remote control program

Socket rssmb_init ("TCPIP:SMB100B-102030::5025::SOCKET", ...)
rssmb_SetFrequency (..., 2e9)

GPIB rssmb_init ("GPIB::28::INSTR", ...)
rssmb_SetFrequency (..., 2e9)

12.4  Status reporting system

The status reporting system stores all information on the current operating state of the
instrument and on errors which have occurred. This information is stored in the status
registers and in the error queue. You can query the status of the registers with the
remote commands of the Section 13.18, "STATus subsystem", on page 585.

12.4.1  Overview of the status registers

The Figure 12-6 shows the hierarchical structure of information in the status registers
(ascending from left to right).

Status reporting system
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Figure 12-6: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation
ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Questionable Status Summary Bit
2 = Error- /Event-Queue
1, 0 = not used

Status reporting system
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The following sections describe the instrument-specific bit assignments of the opera-
tion status and the questionable status registers.
For more information, see:
● Remote control via SCPI: provides general information on the status reporting sys-

tem of Rohde & Schwarz instruments. This document also provides information on
the standard event status register and the error queue.

● SCPI standard documentation for comprehensive information on the standard

12.4.2  Instrument-specific status operation register

The condition part contains information on currently executed actions. The event part
covers information on the actions performed since the last readout of the register.

To read the register, use the query commands :STATus:OPERation:CONDition?
on page 586 and :STATus:OPERation[:EVENt] on page 587.

The remote commands for the status questionable register are described in Sec-
tion 13.18, "STATus subsystem", on page 585.
Table 12-3: Assignment of the bits used in the operation status register

Bit No. Meaning

0 Calibrating

The bit is set during the calibration phase.

1–2 Not used

3 Sweeping

This bit is set during a sweep in automatic or single mode.

4–15 Not used

12.4.3  Instrument-specific status questionable register

This status register contains information on questionable instrument states. Questiona-
ble states occur when the instrument is not operated in compliance with its specifica-
tions.

To read the register, use the query commands :STATus:QUEStionable:
CONDition on page 588 or :STATus:QUEStionable[:EVENt] on page 588.

The remote commands for the status questionable register are described in Sec-
tion 13.18, "STATus subsystem", on page 585.
Table 12-4: Assignment of the bits used in the questionable status register

Bit No. Meaning

0–15 Not used

Status reporting system

https://www.rohde-schwarz.com/rc-via-scpi


Network operation and remote controlR&S®SMB100B

309User Manual 1178.3711.02 ─ 11

12.4.4  Reset values of the status reporting system

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except for *RST and
SYSTem:PRESet affect the functional instrument settings. In particular, DCL does not
change the instrument settings.
Table 12-5: Resetting the status reporting system

Event Switching on supply
voltage
Power-On-Status-
Clear

DCL,
SDC
(Device
Clear,
Selected
Device
Clear)

*RST or
SYSTem:
PRESet

STATus:
PRESet

*CLS

Effect 0 1

Clear STB, ESR - Yes - - - Yes

Clear SRE, ESE - Yes - - - -

Clear PPE - Yes - - - -

Clear error queue Yes Yes - - - Yes

Clear output buffer Yes Yes Yes 1) 1) 1)

Clear command processing
and input buffer

Yes Yes Yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

12.5  Remote access settings

This section describes the settings required for accessing and configuring the provided
remote control interfaces. It includes network settings, access addresses, emulation
settings for using the command sets of other generators, and the access with smart
devices.

● Network settings....................................................................................................310
● VISA resource strings settings..............................................................................313
● GPIB address settings.......................................................................................... 314
● RS232 settings......................................................................................................315
● Instrument emulations settings............................................................................. 316
● Active remote connection settings........................................................................ 318
● Closed remote connection settings.......................................................................319
● HUMS settings...................................................................................................... 320
● HUMS enhanced settings..................................................................................... 322
● QR code................................................................................................................331

Remote access settings
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12.5.1  Network settings

Access:

► Select "System Config" > "Remote Access" > "Network".

The "Network" dialog provides settings of the general network environment, and
specific identification parameters of the instrument in the network. If necessary, you
can configure the instrument address settings manually.
How to: "To assign the instrument address manually" on page 342.

The remote commands required to configure the network remotely are described in
Section 13.17, "SYSTem subsystem", on page 555.

Settings:

Network Status............................................................................................................310
Restart Network.......................................................................................................... 310
Hostname.................................................................................................................... 311
Workgroup...................................................................................................................311
Address Mode............................................................................................................. 311
IP Address...................................................................................................................311
Subnet Mask................................................................................................................311
Default Gateway..........................................................................................................312
DNS Suffix...................................................................................................................312
DNS Server................................................................................................................. 312
MAC Address.............................................................................................................. 312

Network Status
Indicates that the instrument is connected to the network.
Remote command: 
:SYSTem:COMMunicate:NETWork:STATus? on page 569

Restart Network
Terminates the network connection of the instrument and sets it up again. You can use
this function to fix network problems.

Remote access settings
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Note: This function restarts only the connection of the instrument to the network. It
does not impact the network itself.
Remote command: 
:SYSTem:COMMunicate:NETWork:RESTart on page 569

Hostname
Displays the hostname.
Each instrument is delivered with an assigned hostname, a logical name which can be
used instead of the IP address. With the default network settings, the IP address is
allocated by the DHCP server. This address can change each time the instrument is
reconnected. Unlike the IP address, the hostname name does not change.
Note:
This function is password-protected. Unlock the protection level 1 to access it.
● We recommend that you do not change the default network settings or the host-

name to avoid problems with the network connection.
If you change the hostname, be sure to use a unique name.

Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname on page 569

Workgroup
Sets the individual windows workgroup name of the R&S SMB100B. This parameter is
required in case the instrument is integrated in a windows network.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup on page 570

Address Mode
Selects the mode for assigning the IP address.
"Auto (DHCP)"

Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol).

"Static" Enables you to assign the IP address manually.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress:MODE on page 568

IP Address
Displays the IP address of the instrument in the network.
To assign the IP address manually, see "To assign the instrument address manually"
on page 342.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress on page 568

Subnet Mask
Displays the bit group of the subnet in the host identifier.

Remote access settings
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The TCP/IP protocol is preinstalled with the subnet mask 255.255.255.0. If the DHCP
server is available Address Mode A AUTO (DHCP), the setting is read-only. The sub-
net mask consists of four number blocks separated by dots. Each block contains 3
numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are allowed
in a block (as an example see the preinstalled address).
To assign the subnet mask manually, select Address Mode > Static.
Note: When assigning the subnet mask manually, make sure that the address matches
with the subnet mask of the controlling host interface.
How to: "To assign the instrument address manually" on page 342.
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK on page 570

Default Gateway
Displays the gateway address.
This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.
To assign the gateway address manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway on page 570

DNS Suffix
Displays the primary DNS (Domain Name System) suffix, that means the DNS name
without the hostname part.
The DNS system uses the suffix for registration and name resolution for unique identifi-
cation of the instrument in the entire network.
To assign the DNS suffix manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain on page 569

DNS Server
Determines the preferred server for name resolution. The DNS server contains the
underlying numerical values that are required for name resolution of the hostname as
part of the IP address.
To select the DNS server manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS on page 570

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S SMB100B.
Remote command: 
:SYSTem:COMMunicate:NETWork:MACaddress on page 568
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12.5.2  VISA resource strings settings

Access:

► Select "System Config" > "Remote Access" > "Visa Resource Strings".

The "Visa Resource String" dialog displays the VISA resource strings provided for
remote control over the different interfaces.

The remote commands required to query the address information remotely are descri-
bed in Section 13.17, "SYSTem subsystem", on page 555.

Settings:

HISLIP.........................................................................................................................313
VXI11...........................................................................................................................313
Socket......................................................................................................................... 314
GPIB............................................................................................................................314
USB.............................................................................................................................314
SERIAL....................................................................................................................... 314

HISLIP
Displays the visa resource string for remote control with HiSLIP protocol.
See also Section 12.2.1, "LAN interface", on page 299.
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 567

VXI11
Displays the visa resource string for remote control over LAN.
See also Section 12.2.1, "LAN interface", on page 299.
Remote command: 
:SYSTem:COMMunicate:NETWork:RESource? on page 568
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Socket
Displays the visa resource string for remote control over LAN, using the socket com-
munication protocol.
See also Section 12.2.1, "LAN interface", on page 299.
Remote command: 
:SYSTem:COMMunicate:SOCKet:RESource? on page 571

GPIB
Displays the visa resource string for remote control over the GPIB interface.
See also Section 12.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 302.
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 567

USB
Displays the visa resource string for remote control over the USB interface.
See also Section 12.2.2, "USB interface", on page 301.
Remote command: 
:SYSTem:COMMunicate:USB:RESource? on page 572

SERIAL
Displays the visa resource string for remote control over the serial interface.
See also Section 12.2.2, "USB interface", on page 301.
Remote command: 
:SYSTem:COMMunicate:SERial:RESource? on page 571

12.5.3  GPIB address settings

Access:

► Select "System Config" > "Remote Access" > "GPIB Address".

The "GPIB Address" enables you to select the channel for remote control over the
IEC/IEE bus interface.

The remote command to configure the setting remotely is described in Section 13.17,
"SYSTem subsystem", on page 555.
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Settings:

GPIB Channel Address............................................................................................... 315

GPIB Channel Address
Sets the GPIB (IEC/IEEE bus) channel address for the connected instrument.
Remote command: 
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess on page 567

12.5.4  RS232 settings

Access:

► Select "System Config > Remote Access > RS232".

The "RS232" dialog enables you to control the instrument over a serial interface
using a USB adapter. The controller and the instrument must be connected with
the external USB/serial-adapter R&S TS1-USB and a serial crossover (null
modem) cable. The USB connection requires the Visa library to be installed on the
controller. Visa detects and configures the R&S SMB100B automatically when the
USB connection is established.

For more information, refer to the specifications document.

The remote commands required to configure the parameters remotely are described in
Section 13.17, "SYSTem subsystem", on page 555.

Settings:

Baud Rate
Sets the baudrate for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:BAUD on page 570

Parity
Sets the parity for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:PARity on page 571
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Stop Bits
Sets the number of stop bits for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:SBITs on page 571

12.5.5  Instrument emulations settings

About instrument emulations

You can remotely control the R&S SMB100B using the command set of another signal
generator. With this function you can, for example, replace a signal generator with an
R&S SMB100B in an automated test setup, without adjusting the command scripts
used.

The R&S SMB100B also covers command sets of Rohde & Schwarz signal genera-
tors. To achieve optimal compatibility when replacing an instrument, we recommend
that you select the emulation command set for the corresponding signal generator.

You find the remote control command sets supported by the R&S SMB100B in a selec-
tion list.

The selected instrument also defines the identification string that is retrieved with query
*IDN?. If necessary, use the parameter Mode and IDN String to change this string.

As any other parameter, the remote control command set can also be changed
remotely by the command :SYSTem:LANGuage.

While working in an emulation mode, the R&S SMB100B specific command set is dis-
abled and the SCPI command :SYSTem:LANGuage is discarded.

To return to the SCPI command set of the R&S SMB100B, use the corresponding com-
mand of the selected command set.

If for example an HP generator is emulated, the HP command EX returns to the instru-
ment-specific GPIB command set.

Access:

► Select "System Config" > "Remote Access" > "Instrument Emulations".
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The "Instrument Emulations" dialog enables you to emulate a remote control com-
mand set of another signal generator.

The remote commands required to configure the emulation settings remotely are
described in Section 13.17, "SYSTem subsystem", on page 555.

Settings:

Language
Selects the instrument whose remote command set is emulated by the R&S SMB100B.
Remote command: 
:SYSTem:LANGuage on page 573

Mode
Selects the way the instrument identification is performed.
"Automatic" Sets the "IDN String" and the "OPT String" automatically for the

instrument selected with the parameter Language.
"User Defined" Enables you to define the "IDN String" and the "OPT String".
Remote command: 
:SYSTem:IDENtification on page 572

Set to Default
In "Mode > User Defined", resets the *IDN and *OPT strings.

Remote command: 
:SYSTem:IDENtification:PRESet on page 572

IDN String
Indicates the identification string of the instrument when queried with the common
command *IDN?.
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In addition to the preset values, you can define your own identification string so that
each generator uses an individual identification, like My_SigGen for instance, see
Mode .
Remote command: 
*IDN? on page 377
:SYSTem:IRESponse on page 573

OPT String
Indicates the option string of the instrument as queried with common command *OPT?.

In Mode > "User Defined", you can define your own option string. A query responds
with this option string instead of the automatically created option string.
Remote command: 
*OPT? on page 377
:SYSTem:ORESponse on page 573

12.5.6  Active remote connection settings

This dialog displays the active SCPI and TCP/IP connections.

Access:

1. Select "System Config" > "Remote Access" > "Remote Connections".

2. Select "Active".

The "Active" tab shows the currently active remote connections, and you can
enable the display of the active connections in the task bar.

Settings:

Show Remote Connections in Taskbar....................................................................... 319
SCPI Connections.......................................................................................................319
TCP/IP Connections....................................................................................................319
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Show Remote Connections in Taskbar
Displays the currently active connections in the taskbar.

SCPI Connections
Displays the VISA resources strings of the remote connections currently controlling the
instrument via the LAN interface.
Remote command: 
n.a.

TCP/IP Connections
Displays the types and client addresses of the remote connections currently controlling
the instrument via the LAN interface.
Remote command: 
n.a.

12.5.7  Closed remote connection settings

Access:

1. Select "System Config" > "Remote Access" > "Remote Connections".

2. Select "Closed".

This dialog displays a history list of the connections that have accessed the instru-
ment before.

Settings:

SCPI Connections.......................................................................................................320
TCP/IP Connections....................................................................................................320
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SCPI Connections
Lists the VISA resource strings of the last remote connections that have accessed the
instrument via the LAN interface before.
Remote command: 
n.a.

TCP/IP Connections
Lists the types and client addresses of the last remote connections that had accessed
the instrument via the LAN interface before.
Remote command: 
n.a.

12.5.8  HUMS settings

Requires R&S SMBB-K980.

About health and utilization monitoring system (HUMS)

The R&S SMB100B comes with a health and utilization monitoring system (HUMS)
providing information about the R&S SMB100B. Aim is to increase the overall utiliza-
tion, to avoid downtime and to increase the overall security level of a fleet of instru-
ments.

HUMS provides, for example, information about:
● Instrument identification, hardware components, software packages, licenses
● Usage of remote control, usage via keyboard / mouse, usage of test applications
● Hardware utilization and status, including S.M.A.R.T. data of the system drive
● User-defined static information, for example, an inventory code

Interfaces and protocols

The HUMS installation on the R&S SMB100B includes an SNMP agent and a REST
service with HTTP endpoints. So you can access the health and usage information via
LAN, using the SNMP protocol or the REST protocol. Accessing the data does not
interfere with remote control via SCPI commands or with measurement execution.

Reference information for both protocols is available on the R&S SMB100B at the
address http://<instrument>/api/hums/v1/documents?name=<interface>.

For <instrument>, enter the hostname (e.g. SMB100B-102030) or the IP address (e.g.
10.121.0.34) of your instrument, as for access to the GUI.

For <interface> = snmp, you get a .zip file containing the MIB files for SNMP. For
<interface> = rest, you get a web page with the OpenAPI specification of the REST
API.

Address example: http://SMB100B-102030/api/hums/v1/documents?name=snmp.

The following table lists the REST endpoints and the SNMP MIB file names.
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REST endpoint
/api/hums/v1/...

SNMP MIB Description Typical data

documents --- developer information SNMP MIB files, swagger specification of
HUMS REST endpoints

greetings RS-GREETINGS-MIB identity information manufacturer, model, serial number, version

equipment/bios RS-BIOS-INFO-MIB BIOS information BIOS manufacturer, version and release date

date-time RS-TIME-DATE-MIB time and date information UTC and local time, timezone, dst (daylight
savings time)

device-history RS-DEVICE-HISTORY-MIB history events instrument-specific event information and noti-
fications

device-tags RS-DEVICE-TAGS-MIB customer information user-definable key information, associated
with the instrument, e.g. asset number, owner,
location

equipment RS-EQUIPMENT-MIB footprint information hardware and software configuration, licenses

hums-info RS-HUMS-INFO-MIB basic information on the
HUMS service

HUMS version, counter of SNMP and REST
requests, amount of collected data, HUMS
database size

storage RS-STORAGE-MIB S.M.A.R.T. data of drive system drive temperature, drive health

system-info RS-SYSTEM-INFO-MIB a system overview OS and BIOS version, IP address, locale

system-status RS-SYSTEM-STATUS-MIB system status information global system status, static notifications

utilization RS-UTILIZATION-MIB utilization information instrument activity, e.g., power on time, RF on
time, option utilization, remote interface traffic

For detailed information about HUMS and its applications, refer to:
● The R&S®HUMS Health and Utilization Monitoring Service user manual, available

on the Rohde & Schwarz website.
● The application note GFM336

Access:

► Select "System Config" > "Remote Access" > "HUMS".

The dialog provides settings to configure the health and utilization monitoring sys-
tem (HUMS) of the R&S SMB100B.
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The remote commands required to define these settings are described in Section 13.8,
"HUMS remote control commands", on page 399.

Settings:

State............................................................................................................................322
Enhanced Settings...................................................................................................... 322
Delete History..............................................................................................................322
Export History..............................................................................................................322

State
Activates HUMS.
Data is only recorded if HUMS is enabled. If disabled, already recorded data can still
be retrieved.
The setting is reset by a factory preset to "off".
Remote command: 
DIAGnostic:HUMS:STATe on page 401

Enhanced Settings
Opens a dialog for configuring enhanced protocol settings, see Section 12.5.9, "HUMS
enhanced settings", on page 322.
Access is only available, when HUMS is enabled, see State.

Delete History
Deletes all information from the HUMS service including the device history.
Note: Regarding the instrument security, the sanitization procedure also deletes the
history of the HUMS service, see Section 11.4.1, "Disk & memory security settings",
on page 278.
Remote command: 
DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL on page 400

Export History
Triggers an export of the logged data of the HUMS service into a *.zip file.

A standard file dialog opens, to save the log file. By default, the file is saved to the
directory /var/user/.
Remote command: 
DIAGnostic:HUMS:DEVice:HISTory? on page 399
DIAGnostic:HUMS:SAVE on page 401

12.5.9  HUMS enhanced settings

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".
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3. Select "Enhanced Settings".

The dialog provides enhanced settings for configuring protocol settings and device
tags.

The remote commands required to define these settings are described in Section 13.8,
"HUMS remote control commands", on page 399.

● Protocol settings....................................................................................................323
● SNMP user settings.............................................................................................. 325
● Device tag settings................................................................................................329

12.5.9.1  Protocol settings

The "Protocol" tab of the "Enhanced HUMS Settings" dialog provides protocol settings
for SNMP or REST protocol.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".

4. Select "Protocol".

The dialog provides enhanced settings for configuring protocol settings and device
tags.

Settings:

SNMP..........................................................................................................................324
REST...........................................................................................................................324
SNMP Configuration................................................................................................... 324

└ Location........................................................................................................ 324
└ Contact..........................................................................................................324
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└ Read Only Community..................................................................................324
└ Read&Write Community............................................................................... 325

User Settings...............................................................................................................325

SNMP
Enables the SNMP agent and selects the supported SNMP version to communicate
with the service.
The setting is reset by a factory preset to "v1/v2c".
"Off" The SNMP agent is disabled.
"v1/v2c" Selects SNMP version 2, which also enables version v1.
"v1/v2c/v3" Selects all SNMP version v1, v2c and v3.
"v3" Selects SNMP version v3.
Remote command: 
SYSTem:COMMunicate:SNMP:VERSion on page 405

REST
Enables the REST API protocol.
The setting is reset by a factory preset to "On".
Remote command: 
SYSTem:COMMunicate:REST:ENABle on page 403

SNMP Configuration
For SNMPv1 and SNMPv2c authentication, you can assign a community password for
read only and/or read and write access. For SNMPv3 authentication, you can define
"User" profiles.

Location ← SNMP Configuration
Defines the SNMP location information. This information complies with the server's
physical location and is used for identification of the SNMP server. By default, this input
field is empty.
Remote command: 
SYSTem:COMMunicate:SNMP:LOCation on page 404

Contact ← SNMP Configuration
Sets the SNMP contact information. This information complies with the person who
manages the SNMP server and is used for identification of the SNMP server. By
default, this input field is empty.
Remote command: 
SYSTem:COMMunicate:SNMP:CONTact on page 404

Read Only Community ← SNMP Configuration
Sets a password for read only access of SNMPv1 or SNMPv2 communities.
The setting is reset by a factory preset to the "<serial number>" of the instrument.
Remote command: 
SYSTem:COMMunicate:SNMP:COMMunity:RO on page 403
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Read&Write Community ← SNMP Configuration
Sets a password for read and write access of SNMPv1 or SNMPv2 communities.
The setting is reset by a factory preset to the "<serial number>" of the instrument.
Remote command: 
SYSTem:COMMunicate:SNMP:COMMunity:RW on page 403

User Settings
Accesses the "Configure SNMP Users for HUMS" dialog.

12.5.9.2  SNMP user settings

For SNMPv3 authentication, you can define user profiles.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".

4. In the protocol tab, select SNMP communication with SNMPv3, e.g. "SNMP >
v1/v2c/v3".

5. Select "User Settings".

The "Configure SNMP User for HUMS" dialog provides an overview of all defined
SNMP users and their profiles. With the "Add" and "Delete All" controls, you can
add or remove users.

Settings:

Add..............................................................................................................................326
Delete All.....................................................................................................................326
User table....................................................................................................................326

└ Edit................................................................................................................326
└ Name............................................................................................................ 327
└ Prefix.............................................................................................................327
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└ Level............................................................................................................. 327
└ Delete............................................................................................................327

Add SNMP User for HUMS......................................................................................... 327
└ SNMP User Name........................................................................................ 328
└ SNMP User Prefix.........................................................................................328
└ SNMP User Level......................................................................................... 328
└ SNMP User Public Passphrase.................................................................... 329
└ SNMP User Encrypted Passphrase..............................................................329
└ Add / Update.................................................................................................329

Add
Accesses the "Add SNMP User for HUMS" dialog.
In this dialog, you can define a user and its profile, see "Add SNMP User for HUMS"
on page 327.

Delete All
Removes all users from the list.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL on page 405

User table
Lists all defined SNMP users.

The table informs on the user name and its specified user profile.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:ALL? on page 405

Edit ← User table
Accesses the "Edit SNMP Users for HUMS" dialog, where you can modify an already
defined user profile.
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For description on the entry fields, see Add SNMP User for HUMS.

Name ← User table
Shows the user name of the user who should have specific user rights.

Prefix ← User table
Shows the access right of the selected user.

Level ← User table
Shows the security level of the selected user.

Delete ← User table
Removes the selected user from the list.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:DELete on page 405

Add SNMP User for HUMS
Configuration dialog for defining SNMP users and their profiles.
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Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER on page 404

SNMP User Name ← Add SNMP User for HUMS
Defines the name of the user for assigning specific user rights. Entering a user name is
mandatory.

SNMP User Prefix ← Add SNMP User for HUMS
Defines the access right for a user.
"Read Only" Allows the user to only read information.
"Read & Write" Allows the user to read and modify information.

SNMP User Level ← Add SNMP User for HUMS
Defines the security level of the SNMP user. Depending on the security level, the ser-
vice requests user name and passphrases for authentication and encryption.
"No Authentication & No Privacy"

Low security level. Using this level, the service queries the user name
only. Password authentication and password for encrypted data trans-
fer is not requested.
See "SNMP User Public Passphrase" on page 329 and "SNMP User
Encrypted Passphrase" on page 329 for data transfer is not reques-
ted.

"Authentication & No Privacy"
Medium security level: Requests the user name and password
authentication, but no data transfer encryption.
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"Authentication & Privacy"
High security level: Requests the user name, and both, the password
authentication and the password for data transfer encryption.

SNMP User Public Passphrase ← Add SNMP User for HUMS
Defines the password for authentication. The password must have of 8 to 12 charac-
ters with any combination of ASCII characters.

SNMP User Encrypted Passphrase ← Add SNMP User for HUMS
Defines the password for encryption. This password must have at least 8 characters
with any combination of ASCII characters. When encryption is defined, the
R&S SMB100B supports the DES (directed enhanced services) protocol.

Add / Update ← Add SNMP User for HUMS
Assigns the defined user with its profile to the list.
If you change an already defined user profile, the instrument provides the "Update"
button to apply the modifications.

12.5.9.3  Device tag settings

The "Device Tags" tab of the "Enhanced HUMS Settings" dialogs displays the defined
device tags. You can also add or delete device tags here.

A device tag is a label to assign to your instrument. You can create any device tag for
your instrument and define it by a specific key and value.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".
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Configures device tags for tagging user-defined information of the instrument in a
table. You can define up to 32 device tags, e.g., for HUMS history evaluation.
To add a device tag, define "Key" and "Value" of the device tag in the table. Click
"Add" to add all device tags of the table to the HUMS history.

Settings:

ID.................................................................................................................................330
Key.............................................................................................................................. 330
Value........................................................................................................................... 330
Delete..........................................................................................................................331
Add..............................................................................................................................331
Delete All.....................................................................................................................331

ID
Identification count of a device tag entry.

Key
Sets the identification key of a device tag.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 402

Value
Sets the value of the identification key of a device tag.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 402
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Delete
Deletes the selected device tag from the HUMS history.
Remote command: 
DIAGnostic:HUMS:TAGS:DELete on page 402

Add
Adds a new device tag to the HUMS service.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 402
DIAGnostic:HUMS:TAGS:ALL? on page 401

Delete All
Removes all device tags from the HUMS history.
Remote command: 
DIAGnostic:HUMS:TAGS:DELete:ALL on page 402

12.5.10  QR code

Access:

► Select "System Config" > "Remote Access" > "QR Code".

The "QR Code" dialog shows the current instrument address (IP address) in quick
response (QR) format.

This functionality provides fast access to the instrument via VNC with, for example, a
smartphone or a tablet.

See Section 12.10.2, "Using a smart device", on page 367
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12.6  LXI status settings

On the R&S SMB100B, an LXI functionality is already installed and enabled. Thus, you
can access he instrument using any web browser.

See Section 12.7, "LXI browser settings", on page 333.

Access:

► Select "System Config > Setup > Remote Access > LXI Status".

The LXI "LAN Status" dialog shows the parameters of the LAN connection.

Alternatively, you can change the LAN settings using the LXI web browser interface,
see Section 12.7.1, "LAN configuration", on page 335.

Settings:

LAN Status.................................................................................................................. 332
Hostname / MAC Address / IP Address...................................................................... 332
LAN Reset...................................................................................................................333

LAN Status
The LED indicates the LXI status.
"green" Normal operation
"green (flashing)"

Device identification
"red" LAN fault

Hostname / MAC Address / IP Address
See "Hostname" on page 311.
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LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.
According to the LXI standard, a LAN reset must set the following network parameters
to a default state:

Parameter Value

TCP/IP mode DHCP + Auto IP address

Dynamic DNS Enabled

ICMP ping Enabled

Password for LAN configuration LxiWebIfc

The LAN reset also resets the following parameters for the R&S SMB100B:

Parameter  

Hostname Instrument-specific hostname

Description signal generator

Negotiation Auto detect

VXI-11 discovery Enabled

12.7  LXI browser settings

Accessing the R&S SMB100B over the LXI browser inerface, you can perform the fol-
lowing tasks:
● Modifying network configurations, see Section 12.7.1, "LAN configuration",

on page 335.
● Accessing the instrument remotely
● Analyzing SCPI remote diagnostics
● Monitoring the use and status of the instrument

This service requires option R&S SMBB-K980 "Health and utilzation monitoring
service (HUMS)".

Access:

► In the address field of the browser, enter the URL address, composed of the instru-
ment's IP address or host name, for example http://10.113.1.151.
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment homepage.
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The instrument homepage (welcome page) opens.

The navigation pane of the browser interface contains the following elements:
● "LXI"

– "Home" opens the instrument homepage.
The homepage displays the device information required by the LXI stan-
dard, including the VISA resource string in read-only format.

– "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LED flashes. A green LXI status symbol indicates
that a LAN connection has been established; a red symbol indicates that no
LAN cable is connected.

– "Lan Configuration" allows you to configure LAN parameters and to initiate
a ping, see Section 12.7.1.3, "Ping client", on page 337.

– "Status" displays information about the LXI status of the instrument.
– "Utilities" provides access to the LXI event logging functionality required by

the LXI standard.
● "Instrument Control"

"Web Control" provides remote access to the instrument.
See "To start remote control with the LXI browser" on page 344.

● "Diagnostics"
– "SCPI Remote Trace" records messages exchanged via the remote control

interface, see Section 12.7.2, "SCPI remote trace", on page 337.
– "Health & Utilization" (option: R&S SMBB-K980) enables you to monitor the

use and status of an instrument, see Section 12.7.3, "Health and utiliza-
tion", on page 339.

● "Datasheet"
Provides the Datasheet with the specification data of the instrument at the time
of delivery, see Section 12.7.4, "Datasheet", on page 339.

● "Help"
– "Glossary" explains terms related to the LXI standard.
– www.rohde-schwarz.com opens the Rohde & Schwarz homepage.
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12.7.1  LAN configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

It comprises the following navigation entries.

● IP configuration..................................................................................................... 335
● Advanced config....................................................................................................336
● Ping client..............................................................................................................337

12.7.1.1  IP configuration

The "IP configuration" web page displays all mandatory LAN parameters and allows
their modification.

The "IP Address Mode" selects a configuration mode for the IP address of the instru-
ment. With static configuration, the entered IP address, subnet mask, and default gate-
way are used. With dynamic configuration, DHCP or dynamic link local addressing
(automatic IP) is used to obtain the instrument IP address.

Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.

See Section 11.4.5, "Password management", on page 287.
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12.7.1.2  Advanced config

The "Advanced Config" web page provides LAN settings that are not declared manda-
tory by the LXI standard.

The following advanced parameters are available:
● "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service

discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

● "ICMP Ping": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

● "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "To change the user password of the instrument" on page 290.
● "To change the security password" on page 290.

See Section 11.4.5, "Password management", on page 287.
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12.7.1.3  Ping client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the ICMP echo request and echo reply
packets, this function checks whether the communication with a device via LAN is
working. Ping is useful for the diagnosis of IP network or router failures.

To initiate a ping at the instrument:

1. On the "Ping Client" page, enter the IP address of the host in the "Destination
Address" field (for example 10.113.1.151).

2. Select "Submit".

12.7.2  SCPI remote trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S SMB100B.

See "To activate SCPI remote trace" on page 345

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided by the lower toolbar to locate error mes-
sages and messages containing arbitrary search strings. You can also export the mes-
sage log to a *.csv file and evaluate the file using a suitable program.

To trace and display messages, switch on "logging" and "live mode" in the toolbar.
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Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

● "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

● "Filter": applies a filter to columns and/or rows when working (live mode off)
● "Refresh": reads the message log from the internal database and displays it
● "Download": stores the SCPI trace log to a *.csv file
● "Clear": deletes all message log entries in the database and at the screen
● "Details": displays details of the selected message, for example an SCPI command

in hex format (also possible by double\-clicking a message)

Columns

The following columns are available if no column filter is applied:

● "Rec": record number of the message within the message log
● "MT": indicates the type of the message. Possible values and related message

contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, highlighted by red color
– T = execution time, i.e. time required by the instrument to process the com-

mand internally.
● I: number of the subinstrument
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● "message": indicates the type of the message. Possible values and related mes-
sage contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, denoted in red
– T = execution time, i.e. time required by the instrument to process the com-

mand internally

12.7.3  Health and utilization

Option: R&S SMBB-K980

The health and utilization monitoring service allows you to monitor the usage and sta-
tus of the instrument, it's options, including S.M.A.R.T. data of the system drive. You
can retrieve information on remote accesses over SCPI commands, web browsers or
protocols, as for example SNMP or REST.

For detailed information on R&S HUMS, see the following documents, available on the
Rohde & Schwarz website:
● User manual "R&S Health and Utilization Monitoring Service" , describing how to

access and use the service.
● Application note GFM336, providing information on the SNMP and REST API,

including a list of all SNMP variables and REST endpoints.

12.7.4  Datasheet

The datasheet functionality allows you to retrieve the specification data of the instru-
ment at the time of delivery.

The document contains all specified value ranges and information of the datasheet, for
example important as reference values for recalibration.
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For more information, refer to the specifications document.

12.8  Setting up remote control

When you switch on the R&S SMB100B, it is always in manual operation state ("local"
state). You can operate the instrument over the touchscreen, the front panel and an
external keyboard and/or mouse.

Prerequisites

For remote control, make sure that you have fullfilled the following prerequisites:
● The instrument and the controller PC are connected for remote control.

See Section 3.1.7, "Connecting to LAN", on page 25.
● The instrument and the controller are switched on.
● The LAN interface and SCPI over LAN are enabled.

See Section 11.4.4, "Configuring LAN services", on page 283.
● A remote control program is running on the controller.

If security is a concern, see:
● Document Instrument Security Procedures.
● Section 11.4.6, "Preventing unauthorized access", on page 290.

The following sections describe how to start remote control over the available interface
protocols.

● Configuring remote access................................................................................... 341
● Starting remote control with LXI............................................................................344
● Starting remote control with VXI-11.......................................................................345
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● Starting remote control with socket communication..............................................350
● Starting remote control over GPIB........................................................................ 351
● Starting remote control over USB......................................................................... 352
● Stopping remote control........................................................................................352

12.8.1  Configuring remote access

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the DHCP protocol,

this service assigns all address information automatically (default setting).
● If the network does not support DHCP or if there is no server available, the instru-

ment tries to obtain the IP address using the Zeroconf(Avahi) protocol.
This protocol enables the instrument to self-configure an IP address and subnet
mask. Zeroconf (Avahi) IP addresses start with the number blocks 169.254.*.*, with
the subnet mask of 255.255.

The automatic address configuration establishes the physical connection to the LAN
without any additional configuration.

An IP address that is assigned with the Zeroconf protocol although the network
requires an IP address assigned from the DHCP server can cause network connection
failures.
See Section 14.5, "Resolving network connection failures", on page 622.
If both services fail to connect, you must set the address information manually.
See also "To assign the instrument address manually" on page 342.

To find the VISA resource string

► Select "System Config > Remote Access > VISA Resource Strings".
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The dialog shows the VISA resource strings that enable you to access the instru-
ment for remote control.

Note: Using the RS232 serial interface via USB requires the USB serial adapter
R&S TS-USB1.

To assign the instrument address manually

It is assumed that you have connected the instrument in the LAN.

1. Obtain the instrument address information for the R&S SMB100B and the IP
address for the local default gateway from your network administrator. If necessary,
also obtain the name of your DNS domain and the IP addresses of the DNS server
on your network.
Obtain the IP address and subnet mask for the R&S SMB100B and the IP address
for the local default gateway from your network administrator. If necessary, also
obtain the name of your DNS domain and the IP addresses of the DNS server on
your network.

2. On the instrument, select "System Config > Remote Access > Network".

3. Select "Address Mode > Static".

4. Select the "IP Address".

5. Enter the IP address, for example 192.168.0.1.

The IP address consists of four number blocks separated by dots. Each block con-
tains 3 numbers in maximum.

6. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.

Note: The subnet mask must be the same for both, the R&S SMB100B and the
host interface, the instrument is connected to.

7. Enter the "Default Gateway", "DNS Suffix", and "DNS Server" if necessary.
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Using the hostname

In a LAN that uses a DNS server, each computer or instrument connected in the LAN
can be addressed with an unambiguous Hostname (also referred to as computer
name) instead of the IP address. The DNS server translates the hostname to the IP
address.

Using the hostname is useful in networks with dynamic TCP/IP and DHCP protocol
services, that assign the address information automatically. Thus, it can be that the
services assign a new IP address each time the instruments restarts, but they do not
change the hostname.

Each instrument is delivered with an assigned hostname, that remains constant as
long as it is not explicitly changed.

This function is password-protected. Unlock the protection level 1 to access it.

The default hostname name follows the syntax <INST>-<Serial Number>, where:
● <INST> is the short name of your instrument, as stated on the front panel.
● <Serial Number> is the individual serial number of the instrument.

You can find the serial number at the rear panel of instrument. It is the third part of
the device ID printed on the barcode sticker.

To query and change the hostname

1. Select "System Config > Remote Access > Network".

Section "Instrument Name" displays the assigned "Hostname".

Note: This function is password-protected. Unlock the protection level 1 to access
it.

2. Select "System Config > Setup > Security > Protection".

3. Enable the "Protection Level 1".
The default protection level 1 password is 123456.

The parameter "Hostname" in the "Network" tab is now enabled for configuration.

4. Change the "Hostname".

Configuring LAN access and services

By default, the LAN interface and the supported LAN interface services are enabled.
For security reasons, for example to protect the instrument against unauthorized
access, you can block either the LAN services individually, or the access over LAN in
general.

Setting up remote control



Network operation and remote controlR&S®SMB100B

344User Manual 1178.3711.02 ─ 11

For information on how you configure the remote access individually, see the following
sections:
● Section 11.4.4, "Configuring LAN services", on page 283
● "To disable LAN access in general" on page 291
● "To disable LAN services individually" on page 291
● "To enable SMB version 1.0/2.0 client and server" on page 292

Configuring access over GPIB

To control the instrument remotely over the GPIB bus, it must be addressed using the
GPIB address. The remote control address is factory-set to 28, but it can be changed if
it does not fit in the network environment. For remote control, addresses 0 through 30
are allowed. The GPIB address is maintained after a reset of the instrument settings.

To change the GPIB address

1. Select "System Config" > "Remote Access" > "GPIB Address".

2. Select "GPIB Channel Address" and enter a value between 0 and 30.

Risk of losing remote connection
If the remote access and network settings had been configured to values different to
the default, executing a factory preset via remote control terminates the connection to
the instrument.

12.8.2  Starting remote control with LXI

Using the LXI browser interface you can access and control the R&S SMB100B instru-
ment remotely from a controller PC without additional installation. Remote control over
LXI supports file upload and download between the instrument and the controller PC.

It is assumed that the instrument is set up in the LAN.

See "Prerequisites" on page 340.

To start remote control with the LXI browser

1. On the controller PC, start a browser that supports HTML5 (W3C compliant).

2. Enter the IP address of the R&S SMB100B in the browser's address bar.

The browser displays the R&S SMB100B's welcome page.

3. In the navigation pane, select "Instrument Control" > "Web Control".

Remote access to the instrument requires the password. The default password is
instrument.

4. Enter the password.

5. Confirm with [Enter].
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The current screen of the R&S SMB100B appears in the browser window.

6. Use the mouse cursor and keyboard to access the functionality of the instrument
as if you operate the instrument directly.

To activate SCPI remote trace

The remote trace functionality allows you to trace SCPI commands and messages
exchanged over the LAN of the R&S SMB100B. To communicate with the instrument
over SCPI, use a suitable remote control application.

1. Set up the remote control session as described under "To start remote control with
the LXI browser" on page 344.

2. In the navigation pane, select "Diagnostics > SCPI Remote Trace".

3. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode > on".

4. Using the remote control program, send your SCPI commands to the
R&S SMB100B.

The "SCPI Remote Trace" tab displays all sent commands and responses.

5. Select "logging > on".
(Live mode and logging exclude each other).

"logging > on" displays all commands and responses, and traces messages also.

The SCPI remote trace function records all sent commands, received responses
and messages, and saves them in an internal database. If "live mode" is disabled,
you can display the recent traces on request, using the "refresh" button. You can
also save the log in a file.
Note: The diagnostics functionality is extended in later releases, e.g. to download
or upload SCPI command files from / to the instrument.

12.8.3  Starting remote control with VXI-11

This connection uses the I/O software library R&S VISA from Rohde & Schwarz to
setup a LAN remote control link to the instrument.

R&S VISA is running on a controller PC with Windows operating system. You can send
commands to the instrument and receive the responses.

For information installing, operating and the utility applications the software provides,
see R&S VISA product page www.rohde-schwarz.com/rsvisa.

The remote control connection requires a VISA installation but no additional hardware
on the controller PC. The LAN I/O channel is selected at initialization time using the
VISA resource string (also referred to as "address string"). A VISA alias (short name)
replaces the complete resource string. The host address is the R&S SMB100B's host-
name or its IP address.

See Section 12.2.1, "LAN interface", on page 299.
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To set up the controller with R&S VISA

To remote control the R&S SMB100B, we use the R&S VISA Tester application. The
application communicates over the TCP/IP protocol.

1. On the controller PC, install the R&S VISA program.
See www.rohde-schwarz.com/rsvisa > "RS VISA release notes".

2. On the instrument, enable the LAN interface and "SCPI over LAN".

3. On the controller, start, e.g., "R&S VISA > Tester".

4. In the menu bar, select "Choose VISA Implementation > Rohde & Schwarz Visa"

5. Confirm with "OK".

6. In the menu bar, select "Find Resource" to search for the instrument in the LAN.
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7. Select "VXI-11".

8. Select the "refresh" button to start the search.

R&S VISA scans the network for connected instruments and lists all detected
instruments in the "Resource" list.
Note: The search can take some time, particularly in large networks.

9. Select the required instrument.

10. Confirm with "Ok".

The "Find and select resource" dialog closes and R&S VISA indicates the IP
address in the "Resource" field of the main application window.

11. As an alternative to the IP address, you can assign an alias name to the
R&S SMB100B:

a) In the menu bar, select "RsVisaConfig".

b) In the toolbar, select "+" to access the "VISA Resource String Composer".
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c) Fill in the "Alias" name, the "VISA Resource String" and the "Device IP Address
or hostname" as shown in the figure.

R&S VISA indicates the assigned "Alias" name.

d) Confirm with "OK".
R&S VISA identifies the R&S SMB100B and you can address it either with the
resource string or the alias name.

12. In the main window, select "Connect".

R&S VISA establishes the connection to the R&S SMB100B.

You can send settings to configure the instrument and receive its responses.

Note: If the connection cannot be set up, R&S VISA displays an error in the log
view.
See also Section 14.5, "Resolving network connection failures", on page 622.

To start remote control with R&S VISA

To set the instrument to remote control state, you can send any command from the
controller.

1. Start the R&S VISA Tester.
Establish the connection to the R&S SMB100B.
See "To set up the controller with R&S VISA" on page 346.

2. In the R&S VISA "Basics" tab, enter a SCPI command, e.g. *IDN?.
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3. Confirm with "Query".

The instrument switches to remote control when it receives a command from the
controller.

4. Select "Read" to obtain the instrument response.

The instrument returns the response.
Remote control over R&S VISA is enabled.

To check remote control with VISA

You can check the communication by sending a setting command and querying the
response:

1. Set, e.g. the frequency with the command:
SOUR1:FREQ 3 GHz.

2. Select "Write".

3. Enter the command SOUR:FREQ?.

4. Select "Query".

If the R&S SMB100B responses with the frequency value xyou entered, remote
control works properly.

To monitor the remote control operation

1. Check the "Show Log" checkbox on the top right.

R&S VISA displays each VISA operation in the log-view on the left.

2. Check the "Write Log" checkbox.
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R&S VISA saves all log-view entries to a log file.

You can operate the log-view in two modes:
● "Live Mode": shows only the most recent messages
● "View Mode" allows you to scroll the history

To return to manual operation, see Section 12.8.7, "Stopping remote control",
on page 352.

12.8.4  Starting remote control with socket communication

This section provides an example on how to establish a remote control connection over
Telnet client and a simple sockets-based program example that can be further devel-
oped.

The telnet client transmits information unencrypted. Therefore, for sensitive information
we recommend that you use a client which supports secure protocols, like SSH.

To set up a Telnet connection

To control the software, only a Telnet program is required. The Telnet program is part of
each operating system.

The controller PC and the instrument are connected in the same network.

1. On the instrument, enable the LAN interface and "SCPI over LAN".
See Section 11.4.4, "Configuring LAN services", on page 283.

2. On the controller PC, start the Telnet program.

3. Enter the socket address.
The socket address is a combination of the IP address or the hostname of the
R&S SMB100B and the number of the port configured for remote-control via Telnet.
Tip: The R&S SMB100B uses the port number 5025 for remote connection via Tel-
net.

The connection to the instrument is set up and you can send remote-control com-
mands.
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4. Telnet does not reflect your first entry.
Insert a command, e.g. *IDN and confirm with "Enter".

5. Observe the screen.

A response on the query confirms that the connection is working. The client dis-
plays all subsequent inputs and responses.

6. Even if the cursor is not visible on the screen, just enter a remote-control com-
mand. Confirm with Enter.

12.8.5  Starting remote control over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib_32.bas) are added to the projects.

Drivers for instrument, for example IVI-COM and LabVIEW drivers, are available for
download area on the product page at:
https://www.rohde-schwarz.com/driver/smb100b/

To start remote control over GPIB

1. Connect instrument and controller using a GPIB cable.
Switch them on.

2. Select "System Config > Remote Access > GPIB Address" > "GPIB Channel
Address = 28".
The GPIB address of the instrument must be the default value of 28.
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3. Execute the following commands on the controller:

a) Open the port to the instrument.
CALL IBFIND("DEV1", generator%)

b) Inform the controller about instrument address.
CALL IBPAD(generator%, 28)

c) Reset the instrument.
CALL IBWRT(generator%, "*RST;*CLS")

d) Set the instrument to new address.
CALL IBWRT(generator%, "SYST:COMM:GPIB:ADDR 18")

e) Inform the controller about new address.
CALL IBPAD(generator%, 18)

The GPIB address of the instrument is changed.

4. To return to manual operation, see Section 12.8.7, "Stopping remote control",
on page 352.

12.8.6  Starting remote control over USB

For remote control, the PC and the instrument must be connected over the USB type B
interface. A USB connection requires the VISA library to be installed. VISA detects and
configures the R&S instrument automatically when the USB connection is established.
You do not have to enter an address string or install a separate driver.

To start remote control over USB

1. Connect instrument and controller using USB cable. Switch them on.

2. Execute the following commands on the controller:

a) Open the port to the instrument.
viOpen (..., "USB::0x0AAD::0x01DE::100001::INSTR", ...)

b) Reset the instrument.
viRST (generator%, "*RST;*CLS")

c) Set 2 GHz frequency
viPrintf (..., "SOUR:FREQ 2GHz\n")

d) Set 20 dBm output level
viPrintf (..., "SOUR:POW -20dBm\n")

The RF frequency and signal level of the instrument are changed.

3. To return to manual operation, see Section 12.8.7, "Stopping remote control",
on page 352.

12.8.7  Stopping remote control

Before returning to manual control, command processing must be completed. Other-
wise, the instrument switches back to remote control immediately.
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You have the following options to switch from remote control to manual operation:
● Closing the remote control session
● Using remote control commands
● Selecting the remote icon in the status bar directly on the screen
● Using the "Local" key

To find out active remote connections

► Check the indication on the taskbar:

A softkey in the taskbar indicates if and what kind of remote connections are cur-
rently set up.
See also Section 12.5.6, "Active remote connection settings", on page 318

To return to manual operation

Depending on the used remote control state, the transition from remote control to man-
ual operation requires different actions.

► Select the corresponding transition action as shown in the table.

Table 12-6: Remote control status icons

GUI symbol Transition to remote
control state...

Remote control state characteris-
tics

Transition to manual operation...(local state)

&GTR (controller PC) Remote control, but usable front
panel keys.

The parameters are in read-only
mode.

● &GTL (SCPI
If &NREN has been set before &GTL is locked.
Use &GTR instead.

● CALL IBLOC (generator%), (visual basic).
● viGpibControlREN() (VISA function)
● "Remote" icon in the status bar
● [Local] (front panel or key emulation)

 The green arows indicate a currently
performed setting.

The setting must be completed (white arrows)
before you can return to manual operation.

 &LLO (controller) Remote control with locked front
panel keys to prevent user interac-
tion.

The parameters are in read-only
mode.

You can unlock LLO, and thus return
to manual operation only over remote
control commands.

● &LOCS
● &REMS

Changes from "Remote LLO" to "Remote"
state.

● CALL IBLOC (generator%)
● viGpibControlREN()
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12.9  Using remote command scripts

To configue a test setup quickly, or to make complex test setups or repeating measure-
ments reproducible, you can automate the required settings with remote command
scripts. A remote command script contains a sequence of SCPIs which configure the
corresponding settings. When created, it is converted to an executable format, saved
in a file and can be run whenever needed.

The graph shows the main steps required to create and execute a SCPI script.

Figure 12-7: Steps for performing SCPI Scripts

● SCPI recording settings........................................................................................ 354
● Creating remote command lists............................................................................ 358
● Checking and verifying a remote command list.................................................... 361
● Converting a remote command list to a script.......................................................362
● Running a remote command script....................................................................... 364

12.9.1  SCPI recording settings

The R&S SMB100B provides information on the required SCPI command for the avail-
able measurement settings, functions, and results in the context-sensitive menu.

Access:

1. Select a parameter.

2. Open the context-sensitive menu (tap and hold).

The context-sensitive menu provides the SCPI recording functions to help you cre-
ate your script.
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● Show SCPI command settings..............................................................................355
● SCPI recording list settings...................................................................................355
● SCPI recording export settings............................................................................. 356

12.9.1.1  Show SCPI command settings

Access:

1. Select the parameter.

2. Open the context-sensitive menu.

3. Select "Show SCPI Command".

This function provides the syntax of the remote command with the current setting.

Setttings:

Copy............................................................................................................................355
Close........................................................................................................................... 355

Copy
Copies the command and the current setting.

Close
Exits the "SCPI Command" dialog.

12.9.1.2  SCPI recording list settings

Access:

1. Select a parameter.

2. Open the context-sensitive menu.

3. Select "Show SCPI Recording List".

The "SCPI Recording List" shows the recorded commands.
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Setttings:

SCPI Recording List....................................................................................................356
Remove All..................................................................................................................356
Remove First...............................................................................................................356
Remove Last............................................................................................................... 356
Export..........................................................................................................................356

SCPI Recording List
Lists the automatically or manually recorded SCPI commands.

Remove All
Deletes all entries in the SCPI command list.

Remove First
Deletes the first entry in the SCPI command list.

Remove Last
Deletes the last entry in the SCPI command list.

Export
Opens the "SCPI Recording Export" dialog for configuring the file parameters for the
SPCI command script file.
See Section 12.9.1.3, "SCPI recording export settings", on page 356.

12.9.1.3  SCPI recording export settings

The R&S SMB100B displays recorded remote command lists in the "SCPI Recording
Export" dialog. This dialog opens automatically, when you stop recording. To open the
dialog manually, proceed as described.

Access:

1. Select a parameter.

2. Open the context-sensitive menu.

3. Select "Show SCPI Recording List".
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4. Select "Export".

The "SCPI Recording Export" dialog contains all functions required for export of
command lists to a file. It enables you to select the source code format, assign an
individual filename and display the file content.

Setttings:

Format.........................................................................................................................357
Code Template............................................................................................................ 357
File.............................................................................................................................. 357
Export..........................................................................................................................358
Reload.........................................................................................................................358
File content..................................................................................................................358

Format
Selects the source code format for the command list.
"Plain SCPI" Uses SCPI syntax.
"Predefined Code Generator"

Accesses the predefined templates for common source code genera-
tors that convert the recorded settings in the programming languages
MATLAB or NICVI or Python.

"User Code Generator"
Use this setting to convert a script by a user-specific code generator.

Code Template
Opens a standard file handling dialog for saving or loading predefined or user-defined
code templates.
See Section 10.6.1, "File select settings", on page 234.

File
Opens a standard file handling dialog for selecting the directory and file name for the
output file.
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See Section 10.6.1, "File select settings", on page 234.

Export
Saves the remote command list file in the selected directory.

Reload
Reloads a remote command list file.

File content
Displays the content of the remote command list in the selected format and code tem-
plate.

12.9.2  Creating remote command lists

Using the SCPI recorder functions, you can create a SCPI command list directly on the
instrument and then export the list for use on the controller PC. You can also edit or
write a script manually, using a suitable editor on the controller. For manual creation,
you can retrieve the command corresponding to a setting directly on the instrument.

You can create a SCPI list directly on the instrument at any time of operation, in the
following ways:
● Recording settings automatically

The "Start SCPI Recording" function adds the SCPI command of each step that
you perform to the SCPI list. You can start, stop and resume automatic recording,
and also add individual commands manually.
See "To record settings automatically" on page 359.

● Recording settings manually
The "Add SCPI Command to Recording List" function adds the SCPI command
and settings value of an individual step to the SCPI list.
See "To record settings manually" on page 359.

● Generating a SCPI command list of all settings in one step
Adds the SCPI commands of the current instrument settings in one step in a SCPI
list.
See "To generate a SCPI command list of all settings in one step" on page 360.
Note: This function lists all commands in alphabetical order, in contrast to the
recording or manual creation, which consider the order the settings are configured.
If a setting cannot be set by a SCPI command, no SCPI command found is entered
instead of a command when generate all settings at once.
Using this function can slow down the performance or cause errors during execu-
tion.
Therefore, always check and revise a script if necessary.
See "To display a remote command list" on page 361 and "To review a remote
command list" on page 361.

● Copying and pasting individual SCPI commands manually
"Show SCPI command" enables you to copy the SCPI command and the current
setting and paste it into any suitable editor.
See "To copy and paste SCPI commands" on page 359.
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To record settings automatically

1. On the screen, open the context-sensitive menu.

2. Select "Start SCPI recording".

The R&S SMB100B now records all steps you take.

3. To stop SCPI recording, select "Stop SCPI recording" in the context-sensitive
menu.

The "SCPI Recording List" dialog opens.

4. Proceed with "To review a remote command list" on page 361.

To record settings manually

1. Select the parameter or function.

2. Set the parameter.

3. Open the context-sensitive menu.

4. Select "Add SCPI Command to Recording List".

The R&S SMB100B adds the SCPI command of the setting including the value in a
temporary SCPI command list.

Tip: "Context-Sensitive > Show SCPI Recording List" opens the dialog with the
recorded settings.

5. Continue with the next setting accordingly whenever you want to record it.

6. Proceed with "To review a remote command list" on page 361.

To copy and paste SCPI commands

1. On the instrument, select the parameter or function.

2. Set the parameter.

3. Open the context-sensitive menu.

4. Select "Show SCPI Command".
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The R&S SMB100B displays the syntax and the setting value of the SCPI com-
mand.

With the "Copy" function, you can copy and paste the SCPI command and setting
value, e.g., in a command script on a PC.

To generate a SCPI command list of all settings in one step

Using the save/recall function, you can create a SCPI command list for all settings in
one step.

1. Press the [Save/Recall] key.

The instrument opens the standard "Save/Recall" dialog.

2. Select "Operating mode" > "SCPI Export".

The dialog adjusts the entry fields for configuring the command list file. "Show
SCPI List" provides access to the list of all setttings the instrument has recorded.

3. Select the "/var/user" directory in which you want to save the SCPI command list.

4. In the "Format" entry field, select the source code format.

5. Enter a filename.

6. Select "Export".
The R&S SMB100B saves the SCPI command list as *.txt file.
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Note: Exporting the SCPI list of the instrument state in one step usually requires
postprocessing on an external PC, as this function lists all instrument states and
commands in alphabetical order.
In contrast, recording or manual creation of a SCPI command list considers the
order the settings are configured.

12.9.3  Checking and verifying a remote command list

Before converting a command list to an executable script, we recommend that you
check if the entries are correct and complete. It can be that ...
● a parameter has not assigned a SCPI command or an element of the user inter-

face has not an assigned parameter. In these cases, :SYST:INF:SCPI 'SCPI
command not available' is entered in the list instead.
Such entries are also detected during execution. The instrument recognizes these
incomplete commands and displays notification.

● a preset has been executed, but several standards then perform some internal set-
tings that are also assigned to the list with "SCPI Export".

● after a preset some settings are still defined, which are then written to the list gen-
erated with "SCPI Export."

To display a remote command list

On the instrument, you have different options to access a remote command list.

1. During automatic or manual recording:

a) Open the context-sensitive menu.
b) Select "Show SCPI Recording List".

2. At the end of automatic recording:

a) Open the context-sensitive menu.
b) Select "Stop SCPI Recording".

3. After exporting a command list to a file.

a) Select "SCPI Recording Export" > "Show file content".

The "SCPI Recording List" opens.

To review a remote command list

To rework a remote command list, you must transfer it to a computer.

1. Export the list to a PC, using, for example, a USB flash drive.

2. Check the list, e.g. by comparing it with the modified settings in the manual mode.

Tip: To find out your settings, you can use the "Mark all parameters changed from
preset" function.
See Section 10.3.2, "Identifying parameters with non-default values", on page 227.

3. Search for missing or incomplete command entries.

a) Add missing commands.
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b) Complete missing parts of commands.
c) Remove superfluous entries, e.g. :SYST:INF:SCPI 'SCPI command not

available'.
d) Remove unnecessary content written after a preset.

4. Rearrange the commands to a reasonable order. For example, if you set a STATe
command to the last position in a list, you can avoid intermediate calculations of
the signal.

12.9.4  Converting a remote command list to a script

For conversion of a remote command list into an executable script, a code generator
translates the commands into the source code of a proprietary programming language,
based on a code template. Therefore, each progamming language requires a dedica-
ted code template.

The R&S SMB100B provides the following predefined code templates by default:
● Plain SCPI

Represents SCPI base format, that is ASCII format, saved as text file (*.txt).
● MATLAB

A programming environment, frequently used in signal processing and test and
measurement applications (*.m).
You can directly use this format with MATLAB(c) Toolkit. For comprehensive infor-
mation on this topic, refer to the application note 1GP60.

● NICVI
An ANSI C programming environment designed for measurements and tests (*.c).
You can directly use this format with National Instruments LabWindows CVI.

● Python3
A general-purpose and high-level programming language (*.py).

You can also convert a script to a user-specific format. In this case, you need a code
template with the extension *.expcodetmpl.

When converted, you can save the script in a file with the extension corresponding to
the programming language.

To configure a plain SCPI script file

1. Select "Show SCPI Recording List" in the context-sensitive menu.

2. Select "Export".
The "SCPI Recording Export" dialog opens.

3. Select the "Format" > "Plain SCPI".

4. Select "File".
A standard file handling dialog opens.

5. Configure filename and directory and confirm with "Ok".

6. In the "SCPI Recording Export" dialog, select "Export".
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The R&S SMB100B saves the recorded data in *.txt format. The "File Content"
section shows the SCPI commands of the script file.

To convert the command list to a predefined code template

1. Select "Show SCPI Recording List" in the context-sensitive menu.

2. Select "Export".
The "SCPI Recording Export" dialog opens.

3. In the "SCPI Recording Export" dialog, select "Format" > "Predefined Code Gener-
ator".

The "CodeTemplate" button appears.

4. Select "Code Template".

The "SCPI Recording Export - Select Predefined Code Template" dialog opens.

5. Select a predefined code template, e.g., "MATLAB".

6. Confirm with "Select".

The R&S SMB100B returns to the "SCPI Recording Export" dialog.

7. Select "File".
A standard file handling dialog opens.

8. Configure filename and directory and confirm with "Ok".

9. In the "SCPI Recording Export" dialog, select "Export".
The R&S SMB100B saves the recorded data in the corresponding format. The "File
Content" section shows the content of the script file in the corresponding program-
ming language.

To convert the command list to a user-defined code template

Before creating a script in a user-specific format, make sure that you have saved the
code template with the file extension *.expcodetmpl in the instrument.

1. Select "Show SCPI Recording List" in the context-sensitive menu.

2. In the "SCPI Recording Export" dialog, select "Format" > "Use Code Generator".

The "CodeTemplate" button appears.

3. Select "Code Template".

The "SCPI Recording Export - Select User Code Template" dialog opens.

4. Select your user-defined code template.

5. Confirm with "Select".

The R&S SMB100B returns to the "SCPI Recording Export" dialog.

6. Select "File".
A standard file handling dialog opens.

7. Configure filename and directory and confirm with "Ok".
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8. In the "SCPI Recording Export" dialog, select "Export".
The R&S SMB100B saves the recorded data in the corresponding format. The "File
Content" section shows the content of the script file in the corresponding program-
ming language.

12.9.5  Running a remote command script

An executable script automates measurement tasks on the instrument. Usually control-
led by a remote PC, you can also save and run a script directly in the instrument by
assigning the script to the [★ (User)] key.

See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.

12.10  Setting up remote operation over VNC

VNC accesses the R&S SMB100B over LAN from a remote device using a web
browser or a VNC client. With the screen displayed on the controller, you can control
the instrument as if you operate it directly. Establishing the access depends on the
used remote device and VNC client software.

See Section 12.1, "Overview of remote access modes", on page 297.

The following examples descibe how to set up remote operation with remote devices:
● Using a controller PC

– "To operate the instrument from a web browser over VNC" on page 365
– "To operate the instrument from a Linux/Unix client over VNC" on page 366
– "To operate the instrument from a Windows client over VNC" on page 366

● Using a smart device
– "To operate the instrument using a VNC App on a smart device" on page 369
– "To operate the instrument from a web browser over VNC" on page 365
– "To access the instrument with QR code on a smart device" on page 369

To enable VNC service on the R&S SMB100B

1. NOTICE! Enabled VNC service can lead to unauthorized access.
Change the computer name and password of the instrument.
See Section 11.4.6, "Preventing unauthorized access", on page 290.

2. Select "System Config > Setup > Security > Security".

3. Select "LAN Services > Common Services".

4. Enable "VNC".

5. Enter the Security Password.

6. Confirm with "Accept".

Setting up remote operation over VNC
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● Using a controller PC............................................................................................ 365
● Using a smart device.............................................................................................367
● Stopping remote operation....................................................................................370

12.10.1  Using a controller PC

Prerequisites

For remote operation, make sure that you have fullfilled the following prerequisites:
● The instrument and the controller PC are connected in the same network.

See Section 3.1.7, "Connecting to LAN", on page 25.
● The instrument and the controller are switched on.
● The LAN interface and VNC LAN service is enabled.

See Section 11.4.4, "Configuring LAN services", on page 283.
● A suitable application is running on the remote device.

– Web browser
The R&S SMB100B supports remote operation over VNC with any web
browser, e.g., Windows Internet Explorer, Mozilla Firefox, or an HTML5 web
browser.

– VNC client software
The software application provides remote operation of the R&S SMB100B.

VNC client software
Linux/Unix operating systems include a VNC client software by default.
For remote devices with windows operating system a VNC client software must be
installed manually. Various free-of charge programs such as Ultr@VNC or similar VNC
client programs are available for download on the Internet.

If security is a concern, see:
● Document Instrument Security Procedures.
● Section 11.4.6, "Preventing unauthorized access", on page 290.

To operate the instrument from a web browser over VNC

1. Install the JRE (Java Runtime Environment) on the remote computer.
Note: Skip this step if you are working with an HTML5 web browser.

2. Enter the IP address of the instrument in the address field of the web browser, e.g.
http://10.113.1.151

The VNC authentication screen appears.

3. Enter the user password.
The default password is instrument.
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4. Confirm with with "OK".

When the VNC connection is established, the screen of the signal generator
appears and you can operate the instrument from the remote computer.

To operate the instrument from a Linux/Unix client over VNC

1. Start a web browser on the remote computer. Enter the IP address of the instru-
ment.

2. Enter the following address:
vnc://<IP-address of the instrument>, for example vnc://10.113.1.151.

A dialog opens requesting the password for the remote VNC connection.

3. Enter the user password.
The default password is instrument.

4. Confirm with with "OK".

When the VNC connection is established, the screen of the signal generator
appears and you can operate the instrument from the remote computer.

To operate the instrument from a Windows client over VNC

1. Install the VNC viewer program component on the remote computer.

a) Download a VNC client program from the Internet.
For example the free of charge software Ultr@VNC (vncviewer.exe is avail-
able, see http://www.uvnc.com/download/index.html.

b) Execute the VNC client installation.
c) Select the VNC viewer program component and follow the installation instruc-

tions.

2. Start VNC viewer program component on the PC.

3. Select "VNC Server"

Setting up remote operation over VNC
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4. Enter the IP address of the instrument.

5. Confirm with "Connect".

An authentication dialog opens.

6. Enter the user password for authentication.
The default password is instrument.

7. Confirm with "LogOn".

When the connection is established, the screen of the signal generator appears
and you can operate the instrument from the remote computer.

12.10.2  Using a smart device

The R&S SMB100B supports remote operation over VNC from a smart device (remote
client), like a tablet (tablet computer) or a smartphone. The smart device accesses the
instrument over WLAN, either by a suitable App, or an HTML5 web browser with
embedded javascript.

There are several possibilities to establish a WLAN connection between the smart
device and the R&S SMB100B. This section gives an example of how a network envi-
ronment can be built up, and some essential configuration steps.

For more information, see:
● 1MA216: Remote Operation of Windows Based Instruments with Apple iPad
● 7BM82: Apple iPad Remote Control of Broadcasting T&M Instruments

Setting up remote operation over VNC
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Example: 

Figure 12-8: Example of a network configuration for remote operation with a smart device

As shown in the figure, the R&S SMB100B and the WLAN router are connected to the
LAN router. The smart device accesses the Rohde & Schwarz instrument via the
WLAN router.
The WLAN router as an additional access point enables you to operate the instrument
even from a great distance.

Prerequisites

For the remote operaton, you need the following equipment and configuration:
● Equipment:

– LAN router
– WLAN router (hot spot) for accessing the instrument
– Smart device

● The instrument and the smart device PC are connected in the same network.
● The instrument and the smart device are switched on.
● The LAN interface and VNC LAN service is enabled.

See Section 11.4.4, "Configuring LAN services", on page 283.
● A suitable application is running on the smart device.

– Web browser
The R&S SMB100B supports remote operation over VNC with any HTML5
compliant web browser, e.g., Internet Explorer, Firefox, Google Chrome or
Safari.

– VNC app
An application that implements the VNC functionality for remote operation. The
VNC App must be suitable to the used smart device.
Refer to the manufacturer's website to find a VNC App supported for your
smart device, and how it is installed.

– QR code

Setting up remote operation over VNC
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If your smart device is equipped with a camera and a QR code reader, you can
scan the instrument's IP address or access the instrument with the Safari web
browser.
Refer to the manufacturer's website to find a QR code reader supported for
your smart device, and how it is installed.

We recommend that all components in the network use DHCP, which automatically
assigns the relevant address information.

To operate the instrument using a VNC App on a smart device

1. Set up the network connection as shown in Figure 12-8

2. Configure the WLAN router according to the manufacturer's instructions.

3. Install the required VNC App on your smart device.

4. On the smart device, start the VNC App.
Enter the IP address of the instrument in the address field of VNC App.

The VNC authentication screen appears.

5. Enter the user password.
The default password is instrument.

6. Enter the password to establish the remote access.
The default user name and password is instrument.

When the VNC connection is established, the screen of the signal generator
appears and you can operate the instrument from the smart device.

To operate the instrument from a web browser over VNC

1. Install the JRE (Java Runtime Environment) on the remote computer.
Note: Skip this step if you are working with an HTML5 web browser.

2. Enter the IP address of the instrument in the address field of the web browser, e.g.
http://10.113.1.151

The VNC authentication screen appears.

3. Enter the user password.
The default password is instrument.

4. Confirm with with "OK".

When the VNC connection is established, the screen of the signal generator
appears and you can operate the instrument from the remote computer.

To access the instrument with QR code on a smart device

1. Set up the network connection as shown in Figure 12-8

2. Configure the WLAN router according to the manufacturer's instructions.

3. Install the required QR code reader software on your smart device.

4. On the smart device, start the QR code reader.
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5. On the R&S SMB100B, select "System Config > Remote Access".

6. Select the "QR-Code" tab.

7. Scan the QR code of the instrument with your smart device.

8. On the smart device, decode the scanned QR code and forward it to the web
browser.

The VNC authentication screen appears.

9. Enter the user password.
The default password is instrument.

When the VNC connection is established, the screen of the signal generator
appears and you can operate the instrument from the smart device.

12.10.3  Stopping remote operation

To stop remote operation

To terminate remote operation over VNC depends on the used client:

► Select the action that applies to the used client:

a) On an external Unix/Linux PC, close the Internet browser or the signal genera-
tor window.

b) On an external Windows PC, close the VNC viewer program.
c) On a smart device, close the application.

The connection is terminated but not disabled. It can be established again anytime.

12.11  References

12.11.1  LXI functionality

LAN Extensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology.

LXI is intended to be the LAN-based successor to GPIB, combining the advantages of
Ethernet with the simplicity and familiarity of GPIB. Like GPIB, LXI determines and
standardizes the way the instrument behaves in a LAN.

The LXI implementation in the R&S SMB100B allows you to change certain LAN set-
tings, to reset the LAN connection, and to identify the instrument.

References
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For information about the LXI standard, refer to the LXI website at https://www.lxistan-
dard.org.
See also "News from Rohde & Schwarz, article 2006/II - 190".

The LXI functionality in the R&S SMB100B is characterized by a common LAN imple-
mentation, including an ICMP ping responder for diagnostics. Using a web browser,
you can configure the instrument. A LAN Configuration Initialize (LCI) mechanism
resets the LAN configuration. The instrument also supports automatic detection in a
LAN via the VXI-11 discovery protocol and programming by IVI drivers.

In addition, the R&S SMB100B provides the following LXI-related functionality:
● Integrated "LXI Status" dialog for LXI status indication and reset of the LAN config-

uration, see Section 12.6, "LXI status settings", on page 332.
● "LXI Browser Interface", as described in Section 12.7.1, "LAN configuration",

on page 335.
● "SCPI Remote Trace" utility, see Section 12.7.2, "SCPI remote trace", on page 337.

Firmware update
To enable the full LXI functionality after a firmware update, shut down and restart the
instrument.

12.11.2  Code generator templates

This section describes the main structure of the code generator templates, and shows
the method with the NICVI template.

The code generation is controlled by templates with the following blocks:

Command Function

#EXTENSION_START
#EXTENSION_END

Defines the output file extension.

#INIT_CODE_START
#INIT_CODE_END

Contains initial entries, such as included files and
libraries, buffer size, commands for synchronization,
or creating a VISA session.

All entries between start and end are written once at
the beginning of the output file.

#COMMAND_CODE_START
#COMMAND_CODE_END

Frame for a SCPI command. A command is
accessed with %COMMAND.

#NO_COMMAND_CODE_START
#NO_COMMAND_CODE_END

Frame for a parameter with no SCPI command
available. A parameter is accessed with
%PARAMETER.

#EXIT_CODE_START
#EXIT_CODE_END

Closes the visa session.

All entries between start and end are written once at
the end of the output file.

Templates are created in ASCII format with file extension *.expcodetempl.

References
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Example: 
Example to the code generator template NICVI.expcodetmpl:

#EXTENSION_START
.c
#EXTENSION_END

#INIT_CODE_START
#include <ansi_c.h>
#include <visa.h>
#include <cvirte.h>

#define MAX_BUFFER_SIZE 200
static ViStatus status;
static ViSession defaultRM, handle;

static void write_command(char *command)
{
  char writeBuffer[MAX_BUFFER_SIZE];
        char readBuffer[MAX_BUFFER_SIZE];
        int length;
        int readCount;
        
        strcpy(writeBuffer, command);
        //append "*OPC?" to sync
        strcat(writeBuffer, ";*OPC?");
        length = strlen (writeBuffer);
        writeBuffer[length]='\n';
        length = length+1;
        viWrite (handle, writeBuffer, length, VI_NULL);
        //read result
        viRead(handle, readBuffer, 100, &readCount);
}     
int main (int argc, char *argv[])
{
  if (InitCVIRTE (0, argv, 0) == 0)
     return -1;    /* out of memory */
        //create a VISA session and return a handle to it
     viOpenDefaultRM (&defaultRM);
        //create a VISA session to the serial port and return a handle to it
        viOpen (defaultRM, (ViRsrc)"TCPIP::localhost::INSTR", VI_NULL, VI_NULL, 
&handle);
#INIT_CODE_END

#COMMAND_CODE_START
  write_command("%COMMAND");
#COMMAND_CODE_END

#NO_COMMAND_CODE_START
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  //no SCPI command available for parameter %PARAMETER !
#NO_COMMAND_CODE_END

#EXIT_CODE_START
  viClose (handle);
        viClose (defaultRM);
        return 0;
}
#EXIT_CODE_END
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13  Remote control commands
In the following, all remote-control commands are presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, see Section 12, "Network
operation and remote control", on page 296.
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13.1  Conventions used in SCPI command descriptions

The following conventions are used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value, and it is the
result of a query.
Parameters required only for setting are indicated as "Setting parameters".
Parameters required only to refine a query are indicated as "Query parameters".
Parameters that are only returned as the result of a query are indicated as "Return
values".

● Conformity

Conventions used in SCPI command descriptions
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Commands that are taken from the SCPI standard are indicated as "SCPI con-
firmed". All commands used by the R&S SMB100B follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an "Asynchronous
command".

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as "*RST" values, if available.

● Factory preset values
Default parameter values that are reset only by factory preset.

● Default unit
The default unit is used for numeric values if no other unit is provided with the
parameter.

● Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

13.2  Programming examples

The corresponding sections of the same title provide simple programming examples for
the R&S SMB100B. The purpose of these examples is to present all commands for a
given task. Real applications require application-specific sets of commands and config-
urations.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines start with two characters //, for example, comments.

At the beginning of the most remote control program, an instrument preset or reset is
recommended to set the R&S SMB100B to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

In all the examples we assume the following:
● A remote PC is connected to the instrument.
● The remote PC and the instrument are switched on.
● A connection between them is established.
● The security setting "System Config" > "Setup" > "Security" > "SCPI over LAN" is

enabled.

Programming examples
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13.3  Common commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CLS.............................................................................................................................376
*ESE.............................................................................................................................376
*ESR?...........................................................................................................................376
*IDN?............................................................................................................................377
*IST?............................................................................................................................ 377
*OPC............................................................................................................................377
*OPT?...........................................................................................................................377
*PRE............................................................................................................................ 378
*PSC............................................................................................................................ 378
*RCL.............................................................................................................................378
*RST.............................................................................................................................378
*SAV.............................................................................................................................379
*SRE............................................................................................................................ 379
*STB?...........................................................................................................................379
*TRG............................................................................................................................ 379
*TST?........................................................................................................................... 380
*WAI.............................................................................................................................380

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event status read
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Returns the contents of the event status register in decimal form and then sets the reg-
ister to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification

Returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<part number>/<serial num-

ber>,<firmware version>"

Example: Rohde&Schwarz,SMB100B,11400.1000K02/0,4.00.033
Usage: Query only

Manual operation: See "IDN String" on page 317
See "Hardware Options/Software Options" on page 628

*IST?

Individual status query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query writes a "1" into the
output buffer when all preceding commands have been executed, which is useful for
command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description, refer to the specifications document.
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Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "OPT String" on page 318
See "Hardware Options/Software Options" on page 628

*PRE <Value>

Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on status clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Number>

Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

Manual operation: See "Quick Recall x" on page 233

*RST

Reset
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Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

Manual operation: See "Preset" on page 226

*SAV <Number>

Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the com-
mand :MMEM:STOR:STAT.

Manual operation: See "Quick Save x" on page 232

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

*TRG corresponds to the INITiate:IMMediate command.

Usage: Event
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*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code.

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
For details, see the Service Manual supplied with the instrument.
0
No errors occurred.

Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

13.4  Preset commands

The preset commands are not bundled in one subsystem. Therefore, they are listed
separately in this section.

Four presetting actions are available:
● Activating the default state of all internal instrument functions (*RST on page 378).

Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. reference oscillator source settings.

● Activating the preset state of the parameters related to the selected signal path (:
SOURce<hw>:PRESet on page 381)

● Activating the preset state of all parameters that are not related to the signal path
(:DEVice:PRESet on page 381)

● Activating the original state of delivery (factory reset, :SYSTem:FPReset
on page 381). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

When resetting, the following deviation between remote and manual control exists:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.

Preset commands
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:DEVice:PRESet............................................................................................................ 381
:SOURce<hw>:PRESet.................................................................................................. 381
:SYSTem:PRESet.......................................................................................................... 381
:SYSTem:FPReset......................................................................................................... 381

:DEVice:PRESet

Presets all parameters which are not related to the signal path, including the LF gener-
ator.

Example: DEV:PRES
Presets all instruments settings that are not related to the signal
path.

Usage: Event

:SOURce<hw>:PRESet

Presets all parameters which are related to the selected signal path.

Example: SOUR:PRES
Presets all settings that are related to signal path

Usage: Event

:SYSTem:PRESet

Triggers an instrument reset. This command has the same effect as:
● The [Preset] key.

However, the command does not close open GUI dialogs like the key does.
● The *RST command

For an overview of the settings affected by the preset function, see Table 10-1

Example: SYST:PRES
All instrument settings (also the settings that are not currently
active) are reset to their default values.

Usage: Setting only

:SYSTem:FPReset

Triggers an instrument reset to the original state of delivery.

Example: SYST:FPR
All instrument settings (also the settings that are not currently
active) are reset to the factory values.

Usage: Event

Manual operation: See "Execute Factory Preset" on page 227
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13.5  MMEMory subsystem

The MMEMory subsystem (Mass MEMory) contains the commands for managing files
and directories as well as for loading and saving complete instrument settings in files.

Mass storage location

Without any additional measures, the R&S SMB100B stores user files on the internal
memory or if connected, on a memory stick.

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

Default storage location

The R&S SMB100B stores user data in the user directory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Section 10.9,
"Using the file manager", on page 237. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

13.5.1  File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

File extension

The file and the optional file extension are separated by a period sign. The
R&S SMB100B distinguishes the files according to their extensions; each type of file is
assigned a specific file content and hence a specific file extension. Refer to Sec-
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tion A.2, "Available user files and file extensions", on page 653 for an overview of the
supported file extensions.

Wildcards

The two characters "*" and "?" function as "wildcards", i.e. they are used for selecting
several files. The "?" character represents exactly one character, while the "*" charac-
ter represents all characters up to the end of the filename. "*.*" therefore represents all
files in a directory.

Filename and file path

When used in remote control commands, the parameter <filename> is specified as a
string parameter with quotation marks. It can contain either the complete path including
the root user directory /var/user and filename, or only the filename. The filename
must include the file extension. The same applies for the directory /var/volatile
and for the parameters <directory_name> and <path>.

Depending on how much information is provided, the values specified in the parameter
or with the command MMEM:CDIR are used for the path and drive setting in the com-
mands.

13.5.2  Handling files in the default or in a specified directory

For better overview and easy file handling, you may not save all user files in the user
directory /var/user but rather organize them into subdirectories.

The command syntax defines two general ways to access files with user data in a spe-
cific directory:
● Change the current default directory for mass memory storage and then directly

access the files in this default directory, like saved list files, files with user data or
save/recall files.
The subsequent commands for file handling (select, delete, read out files in the
directory, etc.) require only specification of the filename. File extension can be
omitted; after syntax evaluation of the used command, the R&S SMB100B filters
out the relevant files.

● Define the complete file path, including the user directory /var/user, created
subdirectories and filename.
As a rule, whenever an complete file path is determined, it overwrites a previously
specified default directory.

The following example explains this rule as a principle. Exceptions of this general rule
are stated in the description of the corresponding command. The Section 13.5.3, "Pro-
gramming examples", on page 384 explains the general working principle with the
commands for mass memory storage.

The same rule applies to the /var/volatile directory, see Example "Working with
files in the volatile memory" on page 386.
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Example: Load file with user data from a specific directory
This example shows the principle of file handling in remote environment by using list
commands. Working with the files of other subsystems is analogical. We assume that
the directory /var/user/my_files is existing and contains the files
list_test.lsw and list_2.lsw.

//Query files in the user diectory
SOURce1:LIST:CATalog?
// -
// no files

// Set the default directory
MMEMory:CDIRectory "/var/user/my_files"
SOURce1:LIST:CATalog?
// "list_test","list_2"

// Specify the complete path to select a list file (*.lsw) 
// in the specific directory
SOURce1:LIST:SELect "/var/user/my_files/list_test"
SOURce1:LIST:DELete "/var/user/my_files/list_2"

13.5.3  Programming examples

Example: Saving and loading current settings
This example shows two ways of how to save the current instrument setting in the file
settings.savrcltxt in the directory /var/user/savrcl.

Before the instrument settings can be saved in a file, they have to be saved in an inter-
mediate memory using common command *SAV <number>. The specified number is
then used in the :MMEMory:STORe:STATe command.
Also, after loading a file with instrument settings with command :MMEMory:LOAD:
STATe, these settings have to be activated with the common command *RCL
<number>.

// Save the current settings in an intermediate memory with number 4
*SAV 4

// save the settings in a file in a specific directory;
// the complete path has to be specyfied
MMEMory:STORe:STATe 4,"/var/user/savrcl/settings.savrcltxt"

// save the settings in a file in the default directory;
// set the default directory; specify only the file name
MMEMory:CDIRectory  "/var/user/savrcl"
*SAV 4
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MMEMory:STORe:STATe 4,"settings.savrcltxt"

// Load the saved settings in the intermediate memory 4 and activate them
MMEMory:LOAD:STATe 4,"/var/user/settings.savrcltxt"
*RCL 4

Example: Working with files and directories
This example shows how to list files in a directory, list the subdirectories, query the
number of files in a directory, create directory, rename and delete files.

// Query the current default directory for mass storage,
// change the directory to the default user directory "/var/user"
// and read out the files in it
MMEMory:CDIRectory?
// "/var/user/temp"
MMEMory:CDIRectory
MMEMory:CDIRectory?
// "/var/user/"
MMEMory:CATalog?
// 1282630,8102817792,".,DIR,4096","..,DIR,4096","Log,DIR,4096",
// "settings.savrcltxt,BIN,16949","temp,DIR,4096","test,DIR,4096",
// "list.lsw,BIN,1245201"
// the directory "/var/user" contains the predefined directory "Log",
// the subdirectories "test" and "temp"
// as well as the files "settings.savrcltxt" and "list.lsw"

// query only the subdirectories of the current or specified directory
MMEMory:DCATalog? "/var/user"
// ".","..","Log","temp","test"

// query only number of subdirectories in the current or specified directory
MMEMory:DCATalog:LENGth? "/var/user"
// 5

// query number of files in the current or specified directory
MMEMory:CATalog:LENGth? "/var/user"
// 7

// Create a new directory for mass memory storage in the specified directory
MMEMory:MDIRectory "/var/user/new"

// Copy the file "settings.savrcltxt" into the new directory
MMEMory:COPY "/var/user/settings.savrcltxt","/var/user/new/settings.savrcltxt"

// Rename the file "settings.savrcltxt" into the new directory
// and read out the files in this specific directory
MMEMory:CDIRectory  "/var/user/new"
MMEMory:MOVE "settings.savrcltxt","settings_new.savrcltxt"
MMEMory:CATalog? "/var/user/new"
// 25141,8102789120,".,DIR,4096","..,DIR,4096","settings_new.savrcltxt,BIN,16949"
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// Delete an empty directory, e.g. the "test" directory 
MMEMory:RDIRectory "/var/user/test"
// Delete the entire directory, including files and subdirectories 
:MMEMory:RDIRectory:RECursive "var/user/test"

Example: Working with files in the volatile memory
This example shows how to work with files in the /var/volatile directory.

// Change the default directory for mass storage,
// read out the files, load and play a file with the ARB 
MMEMory:CDIRectory "/var/volatile"
MMEMory:CDIRectory?
// "/var/volatile"
MMEMory:CATalog?
//13928,525352960,".,DIR,60","..,DIR,4096","list.lst,BIN,9772"

SOURce1:LIST:SELect "/var/volatile/list"
SOURce1:FREQuency:MODE LIST
OUTPut1:STATe 1

13.5.4  Remote control commands
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:MMEMory:CATalog:LENGth?......................................................................................... 387
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:MMEMory:DCATalog:LENGth?....................................................................................... 389
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:MMEMory:LOAD:STATe.................................................................................................389
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:MMEMory:RDIRectory:RECursive...................................................................................391
:MMEMory:STORe:STATe...............................................................................................391
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:MMEMory:CATalog?

Returns the content of a particular directory.
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Return values: 
<Catalog> string

String parameter to specify the directory.
If you leave out the path, the command returns the contents of
the directory selected with :MMEMory:CDIRectory.
The path may be relative or absolute.

Usage: Query only

Manual operation: See "Directory, File List and Filename" on page 231

:MMEMory:CATalog:LENGth? [<Path>]

Returns the number of files in the current or in the specified directory.

Query parameters: 
<Path> string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<FileCount> integer

Number of files.

Usage: Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.

Parameters:
<Directory> <directory_name>

String containing the path to another directory. The path can be
relative or absolute.
To change to a higher directory, use two dots '..' .

Manual operation: See "Directory, File List and Filename" on page 231
See "Directory and Filename" on page 239

:MMEMory:COPY <SourceFile>, <DestinationFile>

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters: 
<SourceFile> string

String containing the path and file name of the source file
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<DestinationFile> string
String containing the path and name of the target file. The path
can be relative or absolute.
If <DestinationFile> is not specified, the <SourceFile> is
copied to the current directory, queried with the :MMEMory:
CDIRectory command.
Note: Existing files with the same name in the destination direc-
tory are overwritten without an error message.

Usage: Setting only

Manual operation: See "Cut, Copy&Paste and Delete" on page 239

:MMEMory:DATA <Filename>, <BinaryData>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.

Parameters:
<BinaryData>

Setting parameters: 
<Filename> string

String parameter to specify the name of the file.

Query parameters: 
<Filename> #<number><length_entry><data>

#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has
<length_entry>: indicates the number of subsequent bytes
<data>: binary block data for the specified length.
For files with a size with more than nine digits (gigabytes), the
instrument allows the syntax #(<Length>), where <Length>
is the file size in decimal format.

Example: MMEMory:DATA '/var/user/test.txt',#15hallo
Writes the block data to the file test.txt.
The digit 1 indicates a length entry of one digit; the digit 5 indi-
cate a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/user/test.txt'
Sends the data of the file test.txt from the instrument to the
controller in the form of a binary block.
Response: #15hallo
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:MMEMory:DCATalog?

Returns the subdirectories of a particular directory.

Return values: 
<DCatalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<Path>]

Returns the number of subdirectories in the current or specified directory.

Query parameters: 
<Path> string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the contents of the current directory,
to be queried with :MMEMory:CDIRectory command.

Return values: 
<DirectoryCount> integer

Number of parent and subdirectories.

Usage: Query only

:MMEMory:DELete <Filename>

Removes a file from the specified directory.

Setting parameters: 
<Filename> string

String parameter to specify the name and directory of the file to
be removed.

Usage: Setting only

Manual operation: See "Cut, Copy&Paste and Delete" on page 239

:MMEMory:LOAD:STATe <SavRclStateNumb>, <file_name>

Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters: 
<SavRclStateNumb> Determines to the specific <number> to be used with the *RCL

command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.
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Usage: Setting only

Manual operation: See "Recall" on page 233

:MMEMory:MDIRectory <Directory>

Creates a subdirectory for mass memory storage in the specified directory. If no direc-
tory is specified, a subdirectory is created in the default directory. This command can
also be used to create a directory tree.

Setting parameters: 
<Directory> string

String parameter to specify the new directory.

Usage: Setting only

Manual operation: See "Create New Directory" on page 239

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters: 
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Usage: Setting only

Manual operation: See "Rename" on page 239

:MMEMory:MSIS <Path>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).

Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

:MMEMory:RDIRectory <Directory>

Removes an empty directory from the mass memory storage system. If no directory is
specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Example: See Example "Working with files and directories" on page 385.
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Usage: Setting only

:MMEMory:RDIRectory:RECursive <Directory>

Removes the specified directory, including files and subdirectories from the mass
memory storage system. If no directory is specified, the command removes the subdir-
ectories of the default directory.

The command the entire directory without further prompt or notification.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Example: See Example "Working with files and directories" on page 385.

Usage: Setting only

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>

Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *SAV.

Setting parameters: 
<savrcl_state_nr> Corresponds to the specific <number> defined with the *SAV

command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Event

Manual operation: See "Save" on page 232

:MEMory:HFRee?

Returns the used and available memory in Kb.

Return values: 
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.

<HeapAvailableKb> integer
Available heap memory.

Usage: Query only
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13.6  CALibration subsystem

The CALibration subsystem contains the commands needed for performing internal
adjustments. This procedure is triggered by the query commands.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

CALibration<hw> [1] Optional suffix

Understanding the query response

● 0: error-free execution of the adjustments
● 1: indicates that an error occurred; the process has been canceled

Example: Querying the most recent internal adjustments
CALibration:ALL:DATE?
"2024-07-16"
CALibration:ALL:INFormation?
"" // no adjustment info available
CALibration:ALL:TEMP?
"-2.0 K"
CALibration:ALL:TIME?
"17 days"

:CALibration:ALL[:MEASure]?......................................................................................... 392
:CALibration<hw>:ALL:DATE?.........................................................................................393
:CALibration<hw>:ALL:INFormation?............................................................................... 393
:CALibration<hw>:ALL:TEMP?........................................................................................ 393
:CALibration<hw>:ALL:TIME?......................................................................................... 394
:CALibration<hw>:CONTinueonerror................................................................................394
:CALibration:DATA:EXPort.............................................................................................. 394
:CALibration:DATA:FACTory:DATE?.................................................................................394
:CALibration:DELay:MINutes...........................................................................................395
:CALibration:DELay:SHUTdown[:STATe].......................................................................... 395
:CALibration:DELay[:MEASure]?..................................................................................... 395

:CALibration:ALL[:MEASure]? [<Force>]

Starts all internal adjustments that do not need external measuring equipment.

Query parameters: 
<Force> string

Return values: 
<Measure> 1 | ON | 0 | OFF
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Example: CAL:ALL:MEAS?
// Response: "0"
// Executes the adjustments of all instrument functions. 
// When completed, it indicates that the adjustment 
// has been performed successfully.

Usage: Query only

Manual operation: See "Adjust All" on page 634

:CALibration<hw>:ALL:DATE?

Queries the date of the most recently executed full adjustment.

Suffix: 
<hw>

.
[1]
Optional suffix

Return values: 
<Date> string

Example: See Example "Querying the most recent internal adjustments"
on page 392.

Usage: Query only

Manual operation: See "Last Full Adjustment" on page 634

:CALibration<hw>:ALL:INFormation?

Queries the current state of the internal adjustment.

Return values: 
<CalInfoText> string

Example: See Example "Querying the most recent internal adjustments"
on page 392.

Usage: Query only

Manual operation: See "Information" on page 635

:CALibration<hw>:ALL:TEMP?

Queries the temperature deviation compared to the calibration temperature.

Suffix: 
<hw>

.
[1]
Optional suffix

Return values: 
<Temperature> string

Example: See Example "Querying the most recent internal adjustments"
on page 392.
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Usage: Query only

Manual operation: See "Temperature Offset" on page 635

:CALibration<hw>:ALL:TIME?

Queries the time elapsed since the last full adjustment.

Return values: 
<Time> string

Example: See Example "Querying the most recent internal adjustments"
on page 392.

Usage: Query only

Manual operation: See "Time" on page 635

:CALibration<hw>:CONTinueonerror <State>

Continues the calibration even though an error was detected. By default adjustments
are aborted on error.

Suffix: 
<hw>

.
[1]
Optional suffix

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: CAL:CONT ON
// Continues calibration after an error

Manual operation: See "Continue Adjustment on Error" on page 635

:CALibration:DATA:EXPort

Collects the internal adjustment data and provides the data for export in a zip file. You
can export the data for service and evaluation purposes.

Example: :CALibration:DATA:EXPort

Usage: Event

:CALibration:DATA:FACTory:DATE?

Queries the date of the last factory calibration.

Return values: 
<Date> string

Example: CAL:DATA:FACT:DATE? 
// "2016-01-01"
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Usage: Query only

Manual operation: See "Last Full Factory Adjustment" on page 627

:CALibration:DELay:MINutes <Minutes>

Sets the warm-up time to wait before internal adjustment starts automatically.

Automatic execution starts only, if you have enabled the calibration with command :
CALibration:DELay[:MEASure]? ON.

Parameters:
<Minutes> integer

Range: 30  to  120
*RST: n.a. (no preset. default: 60)

Example: :CALibration:DELay:MINutes 30
// sets the time delay for warm-up of the instrument.

Manual operation: See "Warm Up Time" on page 636

:CALibration:DELay:SHUTdown[:STATe] <Shutdown>

Enables the instrument to shut down automatically after calibration.

Parameters:
<Shutdown> 1 | ON | 0 | OFF

*RST: 0

Example: :CALibration:DELay:SHUTdown[:STATe] ON|1
// inititates that the instrument shuts down when the adjustments are completed.

Manual operation: See "Shutdown After Adjustment" on page 636

:CALibration:DELay[:MEASure]?

Starts the delayed adjustment process. When the warm-up time has elapsed (see :
CALibration:DELay:MINutes, it executes the internal adjustments.

If you have enabled automatic shutdown, :CALibration:DELay:SHUTdown[:
STATe] ON, the instrument shuts down when the adjustments are completed.

Return values: 
<Error> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: 0)

Example: :CALibration:DELay[:MEASure] ON|1
// enables the adjustment processs to start after the warm-up time automatically

Usage: Query only

Manual operation: See "Adjust All Delayed" on page 636
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13.7  DIAGnostic subsystem

The DIAGnostic subsystem contains the commands used for instrument diagnosis
and servicing. SCPI does not define any DIAGnostic commands; the commands lis-
ted here are all device-specific. All DIAGnostic commands are query commands
which are not affected by *RST.

The test functions are intended for services purposes.
They are thus password-protected functions. Unlock the corresponding protection level
to access them, see :SYSTem:PROTect<ch>[:STATe].
For more information, see R&S SMB100B Service Manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

DIAGnostic<hw> [1] Optional suffix

Example: Programming example
The example lists the commands required to query assemblies and test points for diag-
nosis purposes.
// Query the modules available in the instrument
// and variant and revision state of a certain assembly
DIAGnostic1:BGINfo:CATalog?
// FRONT_AF,PSU300,IFB.BV,MB2_AF,...
DIAGnostic1:BGINfo? "PSU300"
// PSU300 2118.2067.02 01.00 100000

// Query the test points available in the instrument
// and trigger the measurement in a selected test point
DIAGnostic1:POINt:CATalog?
// ATT6HP_AF_DET_N,ATT6HP_AF_DET_P,ATT6HP_AF_DET_TEMP...
DIAGnostic1:MEASure:POINt? "ATT6HP_AF_DET_N"
//  0.000000V

// Query the operating hours and number of power-on so far.
DIAGnostic:INFO:OTIMe?
// 112 h
DIAGnostic:INFO:POCount? 
// 14

Commands

:DIAGnostic<hw>:BGINfo:CATalog?.................................................................................397
:DIAGnostic<hw>:BGINfo?..............................................................................................397
:DIAGnostic:INFO:OTIMe?..............................................................................................397
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:DIAGnostic:INFO:POCount?.......................................................................................... 398
:DIAGnostic<hw>:POINt:CATalog?...................................................................................398
:DIAGnostic<hw>[:MEASure]:POINt?...............................................................................398

:DIAGnostic<hw>:BGINfo:CATalog?

Queries the names of the assemblies available in the instrument.

Return values: 
<Catalog> string

List of all assemblies; the values are separated by commas
The length of the list is variable and depends on the instrument
equipment configuration.

Example: See Example "Programming example" on page 396.

Usage: Query only

:DIAGnostic<hw>:BGINfo? [<Board>]

Queries information on the modules available in the instrument, using the variant and
revision state.

Query parameters: 
<Board> string

Module name, as queried with the command :
DIAGnostic<hw>:BGINfo:CATalog?.
To retrieve a complete list of all modules, omit the parameter.
The length of the list is variable and depends on the instrument
equipment configuration.

Return values: 
<BgInfo> <Module name> <Module stock number incl. variant> <Module

revision> <Module serial number>
List of comma-separated entries, one entry per module.
Each entry for one module consists of four parts that are separa-
ted by space characters.

Example: See Example "Programming example" on page 396.

Usage: Query only

Manual operation: See "Assembly" on page 626

:DIAGnostic:INFO:OTIMe?

Queries the operating hours of the instrument so far.

Return values: 
<OperationTime> integer

Range: 0  to  INT_MAX
*RST: 0
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Example: See Example "Programming example" on page 396.

Usage: Query only

Manual operation: See "Operation Time / h" on page 627

:DIAGnostic:INFO:POCount?

Queris how often the instrument has been turned on so far.

Return values: 
<PowerOnCount> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Programming example" on page 396.

Usage: Query only

Manual operation: See "Power On Count" on page 627

:DIAGnostic<hw>:POINt:CATalog?

Queries the test points available in the instrument.

For more information, see R&S SMB100B Service Manual.

Return values: 
<Catalog> string

List of comma-separated values, each representing a test point

Example: See Example "Programming example" on page 396.

Usage: Query only

:DIAGnostic<hw>[:MEASure]:POINt? <Name>

Triggers the voltage measurement at the specified test point and returns the measured
voltage.

For more information, see R&S SMB100B Service Manual.

Query parameters: 
<Name> <test point identifier>

Test point name, as queried with the command :
DIAGnostic<hw>:POINt:CATalog? on page 398

Return values: 
<Value> <value><unit>

Example: See Example "Programming example" on page 396.

Usage: Query only
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13.8  HUMS remote control commands

The remote control commands for the health and utilizations monitoring system
(HUMS) comprise commands of the DIAGnostic subsystem and the commands of
the SYSTem:COMMunicate:REST and SYSTem:COMMunicate:REST subsystems.

For all HUMS-related remote control commands, see refer to the "R&S®HUMS Health
and Utilization Monitoring Service" User Manual on the Internet.

Commands

DIAGnostic:HUMS:DELete:ALL....................................................................................... 399
DIAGnostic:HUMS:DEVice:HISTory?................................................................................399
DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL............................................................... 400
DIAGnostic:HUMS:FORMat............................................................................................ 400
DIAGnostic:HUMS:SAVE................................................................................................ 401
DIAGnostic:HUMS:STATe............................................................................................... 401
DIAGnostic:HUMS:TAGS:ALL?....................................................................................... 401
DIAGnostic:HUMS:TAGS:DELete.................................................................................... 402
DIAGnostic:HUMS:TAGS:DELete:ALL..............................................................................402
DIAGnostic:HUMS:TAGS[:VALue]....................................................................................402
SYSTem:COMMunicate:REST:ENABle.............................................................................403
SYSTem:COMMunicate:SNMP:COMMunity:RO................................................................ 403
SYSTem:COMMunicate:SNMP:COMMunity:RW................................................................403
SYSTem:COMMunicate:SNMP:CONTact..........................................................................404
SYSTem:COMMunicate:SNMP:LOCation......................................................................... 404
SYSTem:COMMunicate:SNMP:USM:USER......................................................................404
SYSTem:COMMunicate:SNMP:USM:USER:ALL?............................................................. 405
SYSTem:COMMunicate:SNMP:USM:USER:DELete.......................................................... 405
SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL................................................... 405
SYSTem:COMMunicate:SNMP:VERSion..........................................................................405

DIAGnostic:HUMS:DELete:ALL

Deletes the complete HUMS data. This includes device history, device tags, SCPI con-
nections, utilization history and utilizations.

Example: //Delete HUMS data
DIAG:HUMS:DEL:ALL

Usage: Event

DIAGnostic:HUMS:DEVice:HISTory?

Queries the device history information of the connected instrument. Depending on the
set data format, the queried data is either displayed in XML or JSON format. For more
information about setting the data format, see DIAGnostic:HUMS:FORMat
on page 400.

Return values: 
<HistoryInfo> <block_data>
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Device history information of the connected instrument as block
data in a comma-separated list:
#blockdata[{event1},{event2},{event3}...]
With the following parameters:
<eventID>,<eventTimestamp>,<eventMessage>,
<eventDetails>,<eventSeverity>
Binary block data with the following syntax:
#<Digits><Length><Binarydata>
#
Indicates the start of the binary block
<Digits>
Decimal value
Gives the number of decimal digits used for the <Length>
value
<Length>
Decimal value
Number of bytes the follow in the <Binary data> part
<Binary data>
Binary data in ASCII format

Example: //Return device history
DIAG:HUMS:DEV:HIST?
Returns for example:
#44715[{"eventId":32,"eventTimestamp":
"2021-02-02T17:25:39Z","eventMessage":
"Deviation from Self Alignment Temperature",
"eventDetails":
"Deviations resolved","eventSeverity":0}

Usage: Query only

Manual operation: See "Export History" on page 322

DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL

Deletes the complete device history information of the connected instrument.

Example: //Delete complete device history
DIAG:HUMS:DEV:HIST:DEL:ALL

Usage: Event

Manual operation: See "Delete History" on page 322

DIAGnostic:HUMS:FORMat <DataFormat>

Selects the format for the queried HUMS data. You can query the HUMS data either in
JSON format or XML format.

The defined format affects all other commands that return block data.

Parameters:
<DataFormat> JSON | XML
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JSON
Returns the HUMS data in JSON format.
XML
Returns the HUMS data in XML format.
*RST: JSON

Example: //Return data in JSON format
DIAG:HUMS:FORM JSON

DIAGnostic:HUMS:SAVE <path>

Saves the HUMS history as a ZIP file to your preferred path.

Setting parameters: 
<path>

Example: //Save HUMS history data
DIAG:HUMS:SAVE 'C:\HUMS\hums_2021.zip'

Usage: Setting only

Manual operation: See "Export History" on page 322

DIAGnostic:HUMS:STATe <State>

Turns the HUMS service and data collection on and off.

Parameters:
<State> ON | OFF | 1 | 0

*RST: ON

Example: //Turn on HUMS service
DIAG:HUMS:STAT ON

Manual operation: See "State" on page 322

DIAGnostic:HUMS:TAGS:ALL?

Queries all key-value tags that you have assigend to the instrument. Depending on the
set data format, the queried data is either displayed in XML or JSON format. For more
information about setting the data format, see DIAGnostic:HUMS:FORMat
on page 400.

Return values: 
<ID> ID number of the defined tag.

<Key> String containing key name of the defined tag.

<Value> String containing value of the defined tag.

Example: //Return all tags
DIAG:HUMS:TAGS:ALL?
1,"location","building_11",2,"time zone","CET"
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Usage: Query only

Manual operation: See "Add" on page 331

DIAGnostic:HUMS:TAGS:DELete <ID>

Deletes a certain tag you assigned to your instrument, including its key and value.

Setting parameters: 
<ID> ID number of the tag you want to delete.

To identify the ID number, query all device tags from the system
first. For more information, see DIAGnostic:HUMS:TAGS:
ALL? on page 401.

Example: //Delete tag
DIAG:HUMS:TAGS:DEL 0

Usage: Setting only

Manual operation: See "Delete" on page 331

DIAGnostic:HUMS:TAGS:DELete:ALL

Deletes all key-value tags you have assigned to the instrument.

Example: //Delete all tags
DIAG:HUMS:TAGS:DEL:ALL

Usage: Event

Manual operation: See "Delete All" on page 331

DIAGnostic:HUMS:TAGS[:VALue] <ID>, <Key>, <Value>
DIAGnostic:HUMS:TAGS[:VALue]? <ID>

Adds or modifies a key-value pair (device tag).

The query returns the key-value pair for a given ID or an empty string if the ID is
unknown.

Parameters:
<Key> String containing key name of the queried tag.

<Value> String containing value of the queried tag.

Parameters for setting and query: 
<ID> 0 - 31

ID number of the tag you want to modify or query.
To identify the ID number, query all device tags from the system
first. For more information, read here DIAGnostic:HUMS:
TAGS:ALL? on page 401.

Example: //Add or modify a tag (tag 1)
DIAG:HUMS:TAGS 1,'location','building_11'
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Manual operation: See "Key" on page 330
See "Value" on page 330
See "Add" on page 331

SYSTem:COMMunicate:REST:ENABle <RestState>

Turns communication via the REST API on and off.

Parameters:
<RestState> ON | OFF | 0 | 1

Example: //Return REST state
SYST:COMM:REST:ENAB?

Manual operation: See "REST" on page 324

SYSTem:COMMunicate:SNMP:COMMunity:RO <CommunityString>

Defines the SNMP community string for read-only access.

Prerequisites for this command:
● Select an SNMP version that supports communities (SYSTem:COMMunicate:

SNMP:VERSion on page 405).

Setting parameters: 
<CommunityString> String containing the community name.

Example: //Set community name
SYST:COMM:SNMP:VERS V12
SYST:COMM:SNMP:COMM:RO 'ABC'

Usage: Setting only

Manual operation: See "Read Only Community" on page 324

SYSTem:COMMunicate:SNMP:COMMunity:RW <CommunityString>

Defines the SNMP community string for read-write access.

Prerequisites for this command:
● Select an SNMP version that supports communities (SYSTem:COMMunicate:

SNMP:VERSion on page 405).

Setting parameters: 
<CommunityString> String containing the community name.

Example: //Set read-write access
SYST:COMM:SNMP:VERS V12
SYST:COMM:SNMP:COMM:RW 'ABC'

Usage: Setting only

Manual operation: See "Read&Write Community" on page 325
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SYSTem:COMMunicate:SNMP:CONTact <SnmpContact>

Defines the SNMP contact information for the administrator.

You can also set the contact information via SNMP if you do not set it via SCPI.

Parameters for setting and query: 
<SnmpContact> String containing SNMP contact.

*RST: "" (empty string)

Example: //Set SNMP contact
SYST:COMM:SNMP:CONT 'ABC'

Manual operation: See "Contact" on page 324

SYSTem:COMMunicate:SNMP:LOCation <SnmpLocation>

Defines the SNMP location information for the administrator.

You can also set the location information via SNMP if you do not set it via SCPI.

Parameters for setting and query: 
<SnmpLocation> String containing SNMP location.

*RST: "" (empty string)

Example: //Return SNMP location
SYST:COMM:SNMP:LOC?

Manual operation: See "Location" on page 324

SYSTem:COMMunicate:SNMP:USM:USER <Name>, <Access>, <Level>[,
<Auth_pwd>[, <Priv_pwd>]]

Defines an SNMP user profile.

Prerequisites for this command:
● Select SNMPv3 (SYSTem:COMMunicate:SNMP:VERSion on page 405).

Setting parameters: 
<Name> String containing name of the user.

<Access> RO | RW
Defines the access right a user can have.

<Level> NOAuth | AUTH | PRIVacy
Defines the security level.

<Auth_pwd> String containing the authentication password.

<Priv_pwd> String containing the privacy password.

Example: //Create user profile
SYST:COMM:SNMP:VERS V123
SYST:COMM:SNMP:USM:USER 'Peter','RO','PRIV',
'1234','XYZ'
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Usage: Setting only

Manual operation: See "Add SNMP User for HUMS" on page 327

SYSTem:COMMunicate:SNMP:USM:USER:ALL?

Queries the number of users and a list of all SNMP users for SNMPv3.

Prerequisites for this command:
● Select SNMPv3 (SYSTem:COMMunicate:SNMP:VERSion on page 405).

Return values: 
<Count> Total number of registered SNMP users.

<Name> List of all user names as a comma-separated list.

Example: //Return all SNMP users
SYST:COMM:SNMP:USM:USER:ALL?

Usage: Query only

Manual operation: See "User table" on page 326

SYSTem:COMMunicate:SNMP:USM:USER:DELete <UserName>

Deletes a specific SNMP user profile.

Setting parameters: 
<UserName> String containing name of SNMP user profile to be deleted.

Example: //Delete SNMP user profile
SYST:COMM:SNMP:USM:USER:DEL "Peter"

Usage: Setting only

Manual operation: See "Delete" on page 327

SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL

Deletes all SNMP user profiles.

Example: //Delete all SNMP user profiles
SYST:COMM:SNMP:USM:USER:DEL:ALL

Usage: Event

Manual operation: See "Delete All" on page 326

SYSTem:COMMunicate:SNMP:VERSion <SnmpVersion>

Selects the SNMP version.

Parameters for setting and query: 
<SnmpVersion> OFF | V12 | V123 | V3 | DEFault
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OFF
SNMP communication is off.
V12
SNMP communication with SNMPv2 or lower.
V123
SNMP communication with SNMPv2 and SNMPv3.
V3
SNMP communication with SNMPv3.
*RST: V123

Example: //Select the SNMP version
SYST:COMM:SNMP:VERS V12

Manual operation: See "SNMP" on page 324

13.9  DISPlay subsystem

The DISPlay system contains the commands to set the power-save mode of the
instrument.

Programming Examples

Example: Activating screen saver mode and display update
Use the following commands to switch on the screen saver of your instrument or to
automatic display. These settings are particularly useful when you control the instru-
ment remotely.

// Set the wait time interval and activate the screen saver
DISPlay:PSAVe:HOLDoff 10
DISPlay:PSAVe:STATe ON

// Disable the display of the current frequency and level values in remote control
DISPlay:ANNotation:ALL "<password>", ON
// DISPlay:ANNotation:FREQuency "<password>", ON
// DISPlay:ANNotation:AMPLitude "<password>", ON

// Enable automatic update of the display at defined time intervals
DISPlay:UPDate[:STATe] ON

Example: Querying the dialog IDs, opening and closing dialogs
Use the following commands to query the dialog IDs of all currently open dialogs. The
dialog ID is a prerequisite for opening and closing dialogs via the remote control.

The dialog ID is also required to define user key actions.
See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.
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// Query the dialog IDs of all open dialogs
DISPlay:DIALog:ID?
// CEUtraDLGenSetDlg,_,$A DlgKeyRf_Rosc

// Open and close dialogs via remote control
DISPlay:DIALog:OPEN "CEUtraDLGenSetDlg,_,$A"
DISPlay:DIALog:OPEN "DlgKeyRf_Rosc"
DISPlay:DIALog:CLOSe "DlgKeyRf_Rosc"
DISPlay:DIALog:CLOSe:ALL 

:DISPlay:PSAVe:HOLDoff............................................................................................... 407
:DISPlay:PSAVe[:STATe].................................................................................................407
:DISPlay:BRIGhtness..................................................................................................... 408
:DISPlay:BUTTon:BRIGhtness.........................................................................................408
:DISPlay:UPDate[:STATe]............................................................................................... 408
:DISPlay:ANNotation:AMPLitude..................................................................................... 408
:DISPlay:ANNotation:FREQuency....................................................................................409
:DISPlay:ANNotation[:ALL]..............................................................................................409
:DISPlay:DIALog:ID?......................................................................................................409
:DISPlay:DIALog:OPEN..................................................................................................410
:DISPlay:DIALog:CLOSe................................................................................................ 410
:DISPlay:DIALog:CLOSe:ALL.......................................................................................... 411

:DISPlay:PSAVe:HOLDoff <HoldoffTimeMin>

Sets the wait time for the screen saver mode of the display.

Parameters:
<HoldoffTimeMin> integer

Range: 1  to  60
*RST: n.a. (factory preset: 10)
Default unit: minute

Example: see Example "Activating screen saver mode and display update"
on page 406

Manual operation: See "Wait Time" on page 256

:DISPlay:PSAVe[:STATe] <State>

Activates the screen saver mode of the display.

We recommend that you use this mode to protect the display, if you operate the instru-
ment in remote control.

To define the wait time, use the command :DISPlay:PSAVe:HOLDoff.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example "Activating screen saver mode and display
update" on page 406
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Manual operation: See "Screen Saver" on page 256

:DISPlay:BRIGhtness <BRIGhtness>

Sets the brightness of the dispaly.

Parameters:
<BRIGhtness> float

Range: 1.0  to  20.0
Increment: 1.0
*RST: 14.0

Example: DISPlay:BRIGhtness 14

Manual operation: See "Display" on page 256

:DISPlay:BUTTon:BRIGhtness <ButtonBrightnes>

Sets the brightness of the [RF on/off] key.

Parameters:
<ButtonBrightnes> integer

Range: 1  to  20
*RST: n.a. (no preset. default: 14)

Example: DISPlay:BUTTon:BRIGhtness 15

Manual operation: See "RF Hardkey" on page 257

:DISPlay:UPDate[:STATe] <Update>

Activates the refresh mode of the display.

Parameters:
<Update> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example "Activating screen saver mode and display
update" on page 406

Manual operation: See "Display Update is" on page 257

:DISPlay:ANNotation:AMPLitude <SecPassword>, <State>

Indicates asterisks instead of the level values in the status bar.

Parameters:
<SecPassword> string

<State> 1 | ON | 0 | OFF
*RST: n.a. (factory preset: 1)
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Example: See Example "Activating screen saver mode and display
update" on page 406

Manual operation: See "Annotation Amplitude" on page 281

:DISPlay:ANNotation:FREQuency <SecPassWord>, <State>

Indicates asterisks instead of the frequency values in the status bar.

Parameters:
<SecPassWord> string

<State> 1 | ON | 0 | OFF
*RST: n.a. (factory preset: 1)

Example: See Example "Activating screen saver mode and display
update" on page 406

Manual operation: See "Annotation Frequency" on page 280

:DISPlay:ANNotation[:ALL] <SecPassword>, <State>

Displays asterisks instead of the level and frequency values in the status bar of the
instrument.

We recommend that you use this mode if you operate the instrument in remote control.

Parameters:
<SecPassword> string

<State> 1 | ON | 0 | OFF
*RST: 1

Example: See Example "Activating screen saver mode and display
update" on page 406

:DISPlay:DIALog:ID?

Returns the dialog identifiers of the open dialogs in a string separated by blanks.

Return values: 
<DialogIdList> <DialogID#1>< ><DialogID#2>< > ... < ><DialogID#n>

Dialog identifiers are string without blanks. Blanks are represen-
ted as $$.
Dialog identifiers <DialogID> are composed of two main parts:
<DialogName>[<OptionalParts>]
<DialogName>
Meaningful information, mandatory input parameter for the com-
mands:
:DISPlay:DIALog:OPEN on page 410
:DISPlay:DIALog:CLOSe on page 410
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<Optional parts>
String of $<X> values, where <X> is a character, interpreted as
follows:
$q<DialogQualifier>: optional dialog qualifier, usually the
letter A or B, as displayed in the dialog title.
$i<Instances>: comma-separated list of instance indexes,
given in the order h,c,s,d,g,u,0. Default is zero; the termi-
nating ",0" can be omitted.
$t<TabIds>: comma-separated indexes or tab names;
required, if a dialog is composed of several tabs.
$x<Left>$y<Top>$h<Left>$w<Top>: position and size;
superfluous information.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 406

Usage: Query only

Manual operation: See "SCPI" on page 267

:DISPlay:DIALog:OPEN <DialogId>

Opens the specified dialog.

Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is mandatory.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 406

Usage: Setting only

Manual operation: See "SCPI" on page 267

:DISPlay:DIALog:CLOSe <DialogId>

Closes the specified dialog.

Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is sufficient.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 406

Usage: Setting only
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:DISPlay:DIALog:CLOSe:ALL

Closes all open dialogs.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 406

Usage: Event

13.10  FORMat subsystem

The commands in the FORMat subsystem determine the format of data returned by the
R&S SMB100B to the controller. This affects all query commands that return a list of
numerical data or block data, noted in the descriptions of the commands. The set data
format applies to both paths.

Example: Configuring the format of data returned to a controller

// Select the format o be returned by the instrument
//
FORMat:BORDer SWAPped
// returns the most significant byte of each floating point
// number first and the least significant byte last

FORMat:SREGister: HEXadecimal
// returns the content of the status register
// as a hexadecimal number

FORMat:DATA ASCii
//  transfers the data in ASCII format

:FORMat:BORDer.......................................................................................................... 411
:FORMat:SREGister.......................................................................................................412
:FORMat[:DATA]............................................................................................................ 412

:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:
<Border> NORMal | SWAPped

NORMal
Expects/sends the least significant byte of each IEEE754 float-
ing-point number first and the most significant byte last.
SWAPped
Expects/sends the most significant byte of each IEEE754 float-
ing-point number first and the least significant byte last.
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*RST: NORMal

Example: :FORM:BORD SWAP
transfers the data with the most significant bit first.

:FORMat:SREGister <Format>

Determines the numeric format for responses of the status register.

Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal

ASCii
Returns the register content as a decimal number.
BINary|HEXadecimal|OCTal
Returns the register content either as a binary, hexadecimal or
octal number. According to the selected format, the number
starts with #B (binary), #H (hexadecimal) or #O (octal).
*RST: ASCii

Example: :FORM:SREG HEX
returns the register content as a hexadecimal number.

:FORMat[:DATA] <Data>

Determines the data format the instrument uses to return data via the IEC/IEEE bus.

The instrument automatically detects the data format used by the controller, and
assigns it accordingly. Data format determined by this SCPI command is in this case
irrelevant.

Parameters:
<Data> ASCii | PACKed

ASCii
Transfers numerical data as plain text separated by commas.
PACKed
Transfers numerical data as binary block data.
The format within the binary data depends on the command.
The various binary data formats are explained in the description
of the parameter types.
*RST: ASCii

Example: :FORM ASC
transfers the data as ASCII data.

13.11  HCOPy subsystem

The HCOPy subsystem contains the commands to generate and save a hard copy of
the display.
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To access a stored hard copy file, use the commands of the MEMM subsystem.

Example: Store a hard copy of the display
The following example lists commands to configure and execute a hard copy to an
automatic named file.

:HCOPy:DEVice:LANGuage PNG
:HCOPy:FILE:NAME:AUTO:STATe 1
// defines the output format
// sets the instrument to automatically create output file names

// ******************************************************************
// Configure hard copy options, set automatic naming rules
// An automatically generated file name consists of:
// <Prefix><YYYY><MM><DD><Number>.<Format>
// ******************************************************************
:HCOPy:DEVice:LANGuage BMP
// defines output format *.bmp
:HCOPy:REGion DIALog    
// selects the region to be copied
:HCOPy:FILE:AUTO:DIR "/usb/HCopy" 
// sets destination directory of automatic named file
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:"hardcopy"
:HCOPy:FILE:NAME:AUTO:FILE:YEAR:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:MONTh:STATe 1
// uses automatic naming prefix
// sets automatic naming prefix to "hardcopy"
// uses automatic naming date parameters year and month

// ******************************************************************
// Execute and transfer the hard copy
// ******************************************************************
:HCOPy:EXECute
:HCOPy:DATA 
// generates a hard copy
// transfers the hard copy to the remote client
:HCOPy:FILE:AUTO:FILE? 
// queries the automatic file name
// "hardcopy1607001.bmp"  
:HCOPy:FILE:AUTO:NUMBer? 
// queries the number in the automatic file name
// "001"  
:HCOPy:FILE:AUTO? 
// queries the path and file name of the automatically generated file
// "/usb/HCopy/hardcopy1607001.bmp"  
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13.11.1  Hard copy settings

With the following commands, you can configure the settings of a hard copy.

:HCOPy:DATA?..............................................................................................................414
:HCOPy:IMAGe:FORMat................................................................................................ 414
:HCOPy:DEVice:LANGuage............................................................................................414
:HCOPy:REGion............................................................................................................ 414
:HCOPy:FILE[:NAME].....................................................................................................414
:HCOPy[:EXECute]........................................................................................................ 415

:HCOPy:DATA?

Transfers the hard copy data directly as a NByte stream to the remote client.

Return values: 
<Data> block data

Example: See Example "Store a hard copy of the display" on page 413

Usage: Query only

:HCOPy:IMAGe:FORMat <Format>
:HCOPy:DEVice:LANGuage <Language>
Selects the graphic format for the hard copy. You can use both commands alterna-
tively.

Parameters:
<Language> BMP | JPG | XPM | PNG

*RST: PNG

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Format" on page 250

:HCOPy:REGion <Region>

Selects the area to be copied.

You can create a snapshot of the screen or an active dialog.

Parameters:
<Region> ALL | DIALog

*RST: ALL

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Region" on page 251

:HCOPy:FILE[:NAME] <Name>

Determines the file name and path to save the hard copy, provided automatic naming
is disabled.
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Note: If you have enabled automatic naming, the instrument automatically generates
the file name and directory, see Section 13.11.2, "Automatic naming", on page 415.

Parameters:
<Name> string

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "File..." on page 250

:HCOPy[:EXECute]

Generates a hard copy of the current display. The output destination is a file.

Example: See Example "Store a hard copy of the display" on page 413

Usage: Event

Manual operation: See "Save" on page 250

13.11.2  Automatic naming

Use the following commands to automatically assign a file name.

:HCOPy:FILE[:NAME]:AUTO?.........................................................................................415
:HCOPy:FILE[:NAME]:AUTO:DIRectory........................................................................... 415
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar................................................................. 416
:HCOPy:FILE[:NAME]:AUTO:FILE?................................................................................. 416
:HCOPy:FILE[:NAME]:AUTO:STATe.................................................................................416
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe................................................................417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe...........................................................417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe............................................................. 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?.................................................................. 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix..................................................................... 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe........................................................... 417

:HCOPy:FILE[:NAME]:AUTO?

Queries path and file name of the hardcopy file, if you have enabled Automatic Nam-
ing.

Return values: 
<Auto> string

Example: See Example "Store a hard copy of the display" on page 413

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO:DIRectory <Directory>

Determines the path to save the hard copy, if you have enabled Automatic Naming.
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If the directory does not yet exist, the instrument automatically creates a new directory,
using the instrument name and /var/user/ by default.

Parameters:
<Directory> string

*RST: /var/user/

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Path..." on page 251

:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar

Deletes all files with extensions *.bmp, *.jpg, *.png and *.xpm in the directory set
for automatic naming.

Example: See Example "Store a hard copy of the display" on page 413

Usage: Event

Manual operation: See "Clear Path" on page 252

:HCOPy:FILE[:NAME]:AUTO:FILE?

Queries the name of the automatically named hard copy file.

An automatically generated file name consists of:

<Prefix><YYYY><MM><DD><Number>.<Format>.

You can activate each component separately, to individually design the file name.

Return values: 
<File> string

Example: See Example "Store a hard copy of the display" on page 413.

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO:STATe <State>

Activates automatic naming of the hard copy files.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Automatic Naming" on page 251
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe <State>
Uses the date parameters (year, month or day) for the automatic naming. You can acti-
vate each of the date parameters separately.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Prefix, Year, Month, Day" on page 252

:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?

Queries the number that is used as part of the file name for the next hard copy in auto-
matic mode.

At the beginning, the count starts at 0. The R&S SMB100B searches the specified out-
put directory for the highest number in the stored files. It increases this number by one
to achieve a unique name for the new file.

The resulting auto number is appended to the resulting file name with at least three
digits.

Return values: 
<Number> integer

Range: 0  to  999999
*RST: 0

Example: See Example "Store a hard copy of the display" on page 413

Usage: Query only

Manual operation: See "Current Auto Number" on page 252

:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix <Prefix>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe <State>
Uses the prefix for the automatic generation of the file name, provided PREF:STAT is
activated.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 413

Manual operation: See "Prefix, Year, Month, Day" on page 252
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13.12  KBOard subsystem

The KBOard subsystem contains the commands to set a connected keyboard.

Example: Configuring the keypad

KBOard:LAYout US
// sets the American keyboard assignment

FPANel:KEYBoard:LAYout LETTers
// enables the alphanumerical and the 
// numerical assignment of the front panel keys.

:FPANel:KEYBoard:LAYout............................................................................................. 418
:KBOard:LAYout.............................................................................................................418

:FPANel:KEYBoard:LAYout <Layout>

Selects the layout of the front panel keypad.

Parameters:
<Layout> DIGits | LETTers

DIGits
Enables numerical keys only.
LETTers
Enables numerical and alphanumerical keys.
*RST: n.a. (factory preset: DIGits)

Example: :FPANel:KEYBoard:LAYout LETTers
// enables the alphanumerical additional
// and the numerical assignment of the keys.

Manual operation: See "Alphanumeric Keys" on page 257

:KBOard:LAYout <Layout>

Selects the language for an external keyboard and assigns the keys acccordingly.

Parameters:
<Layout> CHINese | DANish | DUTCh | ENGLish | ENGUK | FINNish |

FRENch | FREBe | FRECa | GERMan | ITALian | JAPanese |
KORean | NORWegian | PORTuguese | RUSSian | SPANish |
SWEDish | ENGUS
*RST: n.a. (factory preset: ENGLish)

Example: :KBOard:LAYout US
// activates American keyboard

Manual operation: See "Layout" on page 257

KBOard subsystem



Remote control commandsR&S®SMB100B

419User Manual 1178.3711.02 ─ 11

13.13  OUTPut subsystem

In the OUTPut subsystem, you can configure the output signals.

The LF output signal is defined with the commands of the Section 13.16.6,
"SOURce:LFOutput subsystem", on page 495 system.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

OUTPut<hw> [1] Optional suffix

:OUTPut:ALL[:STATe]..................................................................................................... 419
:OUTPut<hw>[:STATe]....................................................................................................419
:OUTPut<hw>[:STATe]:PON............................................................................................419
:OUTPut<hw>:AMODe................................................................................................... 420
:OUTPut<hw>:IMPedance?.............................................................................................420
:OUTPut<hw>:AFIXed:RANGe:LOWer?........................................................................... 421
:OUTPut<hw>:AFIXed:RANGe:UPPer?............................................................................421
:OUTPut<hw>:PROTection:CLEar................................................................................... 421
:OUTPut<hw>:PROTection:TRIPped?.............................................................................. 421

:OUTPut:ALL[:STATe] <State>

Enables the RF output signal of the instrument.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: OUTPut:ALL:STATe 0
Disables the RF output signal.

:OUTPut<hw>[:STATe] <State>

Activates the RF output signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :OUTPut1 ON
Activates the RF output.

Manual operation: See "RF State/RF ON" on page 57

:OUTPut<hw>[:STATe]:PON <Pon>

Defines the state of the RF output signal when the instrument is switched on.
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Parameters:
<Pon> OFF | UNCHanged

*RST: n.a. (factory preset: UNCHanged)

Example: :OUTPut1:PON OFF
The RF output is deactivated when the instrument is switched
on.

Manual operation: See "Power-On State" on page 258

:OUTPut<hw>:AMODe <AMode>

Sets the step attenuator mode at the RF output.

Parameters:
<AMode> AUTO | FIXed | NORMal | HPOWer

AUTO
The step attenuator adjusts the level settings automatically,
within the full variation range.
FIXed
The step attenuator and amplifier stages are fixed at the current
position, providing level settings with constant output VSWR.
The resulting variation range is calculated according to the posi-
tion.
*RST: AUTO

Example: :SOURce1:POWer:ALC:STATe 1
:OUTPut1:AMODe FIXed

Manual operation: See "Mode" on page 172

:OUTPut<hw>:IMPedance?

Queries the impedance of the RF outputs.

Return values: 
<Impedance> G1K | G50 | G10K

*RST: G50

Example: :OUTPut1:IMP?
queries the impedance of RF output.
Response: 50
the impedance is 50 ohms

Usage: Query only

Manual operation: See "RF output impedance" on page 57
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:OUTPut<hw>:AFIXed:RANGe:LOWer?
:OUTPut<hw>:AFIXed:RANGe:UPPer?
Queries the settable minimum/maximum value in mode :OUTPut:AMODe FIXed, i.e.
when the attenuator is not being adjusted.

See :OUTPut<hw>:AMODe on page 420

Return values: 
<Upper> float

Increment: 0.01
Default unit: dBm

Example: :OUTPut1:AMODe FIXed
:OUTPut1:AFIXed:RANGe:UPPer?
// -27
:OUTPut1:AFIXed:RANGe:LOW?
// -50

Usage: Query only

Manual operation: See "Level Range" on page 173

:OUTPut<hw>:PROTection:CLEar

Resets the protective circuit after it has been tripped.

To define the output state, use the command :OUTPut<hw>[:STATe].

Example: :OUTPut1:PROT:CLE
Resets the protective circuit of the RF output.

Usage: Event

Manual operation: See "Overload" on page 173

:OUTPut<hw>:PROTection:TRIPped?

Queries the state of the protective circuit.

Return values: 
<Tripped> 1 | ON | 0 | OFF

*RST: 0

Example: :OUTPut1:PROT:TRIP
queries the state of the protective circuit of the RF output.
Response: 0
the protective circuit has not tripped.

Usage: Query only

Manual operation: See "Overload" on page 173
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13.14  SENSe, READ, INITiate and SLISt subsystems

These subsystems contain the commands for configuring the power measurements
with R&S NRP power sensor connected to the R&S SMB100B.

The local state is set with the INIT command. Switching off the local state enhances
the measurement performance. Measurements results can be retrieved in local state
on or off.
Sensor parameters are set with the SENSe commands.
To start the measurement and retrieve the result, use the :READ<ch>[:POWer]?
command.

Suffix Value range Description

SENSe<ch> [1] to 4 Indicates the sensor

Use the :SLISt commands to change the sensor mapping

READ<ch> [1] to 4 Sensor assignment

INIate<hw> [1] to 4 Sensor assignment

ELEMent<ch> [1] to 25 Sensor-mapping list
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Programming examples

Example: Detecting and assigning a power sensor
SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy"
// Lists all automatically detected sensors.

SLISt:SCAN:STATe 1
// Searches for sensors connected in the LAN or via the USBTMC protocol.

SLISt:SCAN:LSENsor 'NRQ6',101624 // sensor name, serial number
SLISt:SCAN:LSENsor 11.123.1.123, 101624 // IP address, serial number
// Adds sensors to the list, that are connected to LAN.

SLISt:SCAN:USENsor 'NRQ6',101624 //sensor name, serial number
SLISt:SCAN:USENsor #H15b,101624  //device ID (hexadecimal), serial number
SLISt:SCAN:USENsor 347,101624    //device ID (decimal), serial number
// Adds a sensor to the list, that is connected to the USB interface.

SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy",
// "NRP33SN-V-900005-USBTMC","NRP33SN-V-900011-LAN"
// Lists all automatically detected sensors.

SLISt:ELEMent3:MAPPing SENS1
// Maps the third sensor from the list to the first sensor channel.

SLISt:SENSor:MAP "NRPS18S-100654-USB Legacy", SENS3
// Maps the sensor to channel 3.

SLISt:CLEar[ALL]
// Remove all sensors that use VISA communication protocol
// from the sensor mapping list.
SLISt:CLEar:LAN 
// Remove all sensors from the list, that use VISA and are connected over LAN.
SLISt:CLEar:USB 
// Remove all sensors from the list, that use VISA and are connected over USB.

Example: Performing a simple power measurement
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
INITiate1:CONTinuous ON
// Switches the continous power measurement on.

READ1?
// Triggers the measurement and displays the results.
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Example: Performing a power measurement with a fixed filter
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
SENSe1:SOURce RF 
// Sensor measures the power of the RF signal.

SENSe1:FILTer:TYPE NSRatio
// Selects fixed noise filter mode.

SENSe1:FILTer:NSRatio 0.02 DB
// Sets the maximum noise component in the result to 0.02 DB.

SENSe1:FILTer:NSRatio:MTIMe 10
//Limits the settling time to 10 seconds.

SENSe1:APERture:DEFault:STATe 0
// Deactivates the default aperture time of the sensor.

SENSe1:APERture:TIMe 10e-6
// Sets the aperture time to 10 us.

SENSe1:UNIT DBM
// Selects unit dBm for the measured value.

INITiate:CONTinuous ON
// Switches the continous power measurement on.

READ?
// Triggers the measurement and displays the results.

:SLISt[:LIST]?................................................................................................................ 425
:SLISt:SCAN[:STATe]......................................................................................................425
:SLISt:SCAN:LSENsor....................................................................................................425
:SLISt:SCAN:USENsor................................................................................................... 426
:SLISt:CLEar:LAN.......................................................................................................... 426
:SLISt:CLEar:USB..........................................................................................................426
:SLISt:CLEar[:ALL].........................................................................................................427
:SLISt:ELEMent<ch>:MAPPing........................................................................................427
:SLISt:SENSor:MAP.......................................................................................................427
:INITiate<hw>[:POWer]:CONTinuous............................................................................... 428
:READ<ch>[:POWer]?.................................................................................................... 428
:SENSe<ch>:UNIT[:POWer]............................................................................................429
:SENSe<ch>[:POWer]:APERture:DEFault:STATe.............................................................. 429
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:SLISt[:LIST]?

Returns a list of all detected sensors in a comma-separated string.

Return values: 
<SensorList> String of comma-separated entries

Each entry contains information on the sensor type, serial num-
ber and interface.
The order of the entries does not correspond to the order the
sensors are displayed in the "NRP Sensor Mapping" dialog.

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Query only

Manual operation: See "Sensor Mapping List" on page 204

:SLISt:SCAN[:STATe] <State>

Starts the search for R&S NRP power sensors, connected in the LAN or via the
USBTMC protocol.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Manual operation: See "Scan" on page 205

:SLISt:SCAN:LSENsor <IP>

Scans for R&S NRP power sensors connected in the LAN.
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Setting parameters: 
<IP> string

*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Setting only

Manual operation: See "Add LAN Sensor" on page 205

:SLISt:SCAN:USENsor <DeviceID>, <Serial>

Scans for R&S NRP power sensors connected over a USB interface.

Parameters:
<Serial> integer

Range: 0  to  999999

Setting parameters: 
<DeviceID> String or Integer

Range: 0  to  999999
*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Setting only

Manual operation: See "Add USBTMC Sensor" on page 206

:SLISt:CLEar:LAN

Removes all entries of R&S NRP power sensors connected in the LAN from the sensor
mapping list.

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Event

Manual operation: See "Clear" on page 205

:SLISt:CLEar:USB

Removes all entries of R&S NRP power sensors connected over USB and using the
VISA communication protocol from the sensor mapping list.

Does not affect entries for sensors communicating over the USB legacy protocol.

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Event
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Manual operation: See "Clear" on page 205

:SLISt:CLEar[:ALL]

Removes all entries of R&S NRP power sensors using the VISA communication proto-
col (USB or LAN) from the sensor mapping list.

Does not affect sensors communicating over USB legacy protocol.

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Event

Manual operation: See "Clear" on page 205

:SLISt:ELEMent<ch>:MAPPing <Mapping>

Assigns an entry from the :SLISt[:LIST]? to one of the four sensor channels.

Parameters:
<Mapping> SENS1 | SENSor1 | SENS2 | SENSor2 | SENS3 | SENSor3 |

SENS4 | SENSor4 | UNMapped
Sensor channel.
*RST: UNMapped

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Manual operation: See "Sensor Mapping List" on page 204

:SLISt:SENSor:MAP <SensorId>, <Mapping>

Assigns a sensor directly to one of the sensor channels, using the sensor name and
serial number.

To find out the the sensor name and ID, you can get it from the label of the R&S NRP,
or using the command :SLISt:SCAN[:STATe]. This command detects all R&S NRP
power sensors connected in the LAN or via 'USBTMC protocol.

Setting parameters: 
<SensorId> string

<Mapping> enum

Example: See Example "Detecting and assigning a power sensor"
on page 423.

Usage: Setting only

Manual operation: See "Sensor Mapping List" on page 204
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:INITiate<hw>[:POWer]:CONTinuous <Continuous>

Switches the local state of the continuous power measurement by R&S NRP power
sensors on and off. Switching off local state enhances the measurement performance
during remote control.

The remote measurement is triggered with :READ<ch>[:POWer]?). This command
also returns the measurement results. The local state is not affected, measurement
results can be retrieved with local state on or off.

Parameters:
<Continuous> 1 | ON | 0 | OFF

*RST: 0

Example: INIT1:CONT ON
Switches on the local state of continuous power measurement.

Manual operation: See "State" on page 200

:READ<ch>[:POWer]?

Triggers power measurement and displays the results.

Note: This command does not affect the local state, i.e. you can get results with local
state on or off. For long measurement times, we recommend that you use an SRQ for
command synchronization (MAV bit).

Suffix: 
<ch>

.
1 to 3

Return values: 
<Power> float or float,float

The sensor returns the result in the unit set with command :
SENSe<ch>:UNIT[:POWer]
Certain power sensors, such as the R&S NRP-Z81, return two
values, first the value of the average level and - separated by a
comma - the peak value.

Example: :SENS1:UNIT DBM
Selects unit dBm for presentation of measurement result.
:READ1?
Queries the measurement result of the sensor.
-45.6246576745440230
-45.6 dBm were measured at the given frequency.

Example: R&S NRP-Z81
:READ1?
-55.62403263352178,-22.419472478812476
-55.6 dBm is the measured average level, -22. 4 dBm is the
measured peak level at the given frequency.

Usage: Query only
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Manual operation: See "Measured Level" on page 196
See "Level (Peak) / Level (Average)" on page 200

:SENSe<ch>:UNIT[:POWer] <Power>

Selects the unit (Watt, dBm or dBμV) of measurement result display, queried with :
READ<ch>[:POWer]?.

Parameters:
<Power> DBM | DBUV | WATT

*RST: DBM

Example: :SENS2:UNIT DBM
Selects dBm as unit for the measured value returned by com-
mand READ.
:READ2?
Response: 7.34
7.34 dBm are measured by sensor 2.

Manual operation: See "Measured Level" on page 196
See "Level (Peak) / Level (Average)" on page 200

:SENSe<ch>[:POWer]:APERture:DEFault:STATe <UseDefAp>

Deactivates the default aperture time of the respective sensor.

To specify a user-defined value, use the command :SENSe<ch>[:POWer]:
APERture:TIMe on page 429.

Parameters:
<UseDefAp> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Default Aperture Time" on page 202

:SENSe<ch>[:POWer]:APERture:TIMe <ApTime>

Defines the aperture time (size of the acquisition interval) for the corresponding sensor.

Parameters:
<ApTime> float

Range: depends on connected power sensor
Increment: 1E-9
*RST: depends on connected power sensor

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Aperture Time" on page 202
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:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect <Select>

Several S-parameter tables can be stored in a sensor. The command selects a loaded
data set for S-parameter correction for the corresponding sensor.

Parameters:
<Select> float

*RST: 0

Manual operation: See "S-Parameter" on page 203

:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe <State>

Activates the use of the S-parameter correction data.

Note: If you use power sensors with attenuator, the instrument automatically activates
the use of S-parameter data.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENSe1:POWer:CORRection:SPDevice:STATe 1
Activates the use of the S-parameters correction data.

Manual operation: See "S-Parameter" on page 203

:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?

Queries the list of the S-parameter data sets that have been loaded to the power sen-
sor.

Return values: 
<List> string list

*RST: 0

Usage: Query only

Manual operation: See "S-Parameter" on page 203

:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority <Priority>

Selects average or peak power for permanent display.

Parameters:
<Priority> AVERage | PEAK

*RST: AVERage

Example: :SENS1:DISP:PERM:STAT ON
Turns on the permanent view.
:SENS1:DISP:PERM:PRI AVER
Sets the average power for display.

Manual operation: See "Display" on page 200
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:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe <State>

Activates the permanent display of the measured power level results. The instrument
also indicates the sensor type, the connection, the measurement source and the offset
if set.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:POW:DISP:PERM:STAT ON
Turns on the permanent view.

Manual operation: See "Display Permanent" on page 200

:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?

Queries the current filter length in filter mode AUTO (:SENSe<ch>[:POWer]:
FILTer:TYPE)

Return values: 
<Auto> float

Range: 1  to  depends on R&S NRP power sensor type

Example: :SENS1:FILT:TYPE AUTO
Selects auto filter.
:SENS1:FILT:LENG:AUTO?
Queries the automatically set filter length.
Response: 1024

Usage: Query only

Manual operation: See "Filter Length" on page 202

:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] <User>

Selects the filter length for SENS:POW:FILT:TYPE USER. As the filter length works as
a multiplier for the time window, a constant filter length results in a constant measure-
ment time (see also "About the measuring principle, averaging filter, filter length, and
achieving stable results" on page 190).

The R&S NRP power sensors provide different resolutions for setting the filter length,
depending on the used sensor type.

For more information, refer to the specifications document.

Parameters:
<User> float

Range: 1  to  depends on R&S NRP power sensor type
*RST: 1
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Example: :SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:LENG 16
Sets a filter length of 16. E.g. using a sensor with 20 ms time
window, the resulting measurement time is 640 ms (2x16x20
ms)

Manual operation: See "Filter Length" on page 202

:SENSe<ch>[:POWer]:FILTer:NSRatio <NSRatio>

Sets an upper limit for the relative noise content in fixed noise filter mode (:
SENSe<ch>[:POWer]:FILTer:TYPE). This value determines the proportion of intrin-
sic noise in the measurement results.

Parameters:
<NSRatio> float

Range: 0.001  to  1
Increment: 0.001
*RST: 0.01

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Noise/Signal Ratio" on page 202

:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe <MTime>

Sets an upper limit for the settling time of the auto-averaging filter and thus limits the
length of the filter.

Parameters:
<MTime> float

Range: 1  to  999.99
Increment: 0.01
*RST: 8

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Timeout" on page 202

:SENSe<ch>[:POWer]:FILTer:SONCe

Starts searching the optimum filter length for the current measurement conditions. You
can check the result with command :SENS1:POW:FILT:LENG:USER? in filter mode
USER (:SENSe<ch>[:POWer]:FILTer:TYPE).
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Example: SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:SONC
Activates the search for the optimum filter length.
:SENS1:FILT:LENG?
Returns the found optimum filter length.
Response: 128

Usage: Event

Manual operation: See "Auto Once" on page 202

:SENSe<ch>[:POWer]:FILTer:TYPE <Type>

Selects the filter mode. The filter length is the multiplier for the time window and thus
directly affects the measurement time.

Parameters:
<Type> AUTO | USER | NSRatio

AUTO
Automatically selects the filter length, depending on the mea-
sured value. The higher the power, the shorter the filter length,
and vice versa.
Note: To avoid long settling times when the power is low, you
can limit the averaging factor limited with the "timeout" parame-
ter (:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe).
USER
Allows you to set the filter length manually. As the filter-length
takes effect as a multiplier of the measurement time, you can
achieve constant measurement times.
NSRatio
Selects the filter length (averaging factor) according to the crite-
rion that the intrinsic noise of the sensor (2 standard deviations)
does not exceed the specified noise content. You can define the
noise content with command :SENSe<ch>[:POWer]:FILTer:
NSRatio.
*RST: AUTO

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Filter" on page 201

:SENSe<ch>[:POWer]:FREQuency <Frequency>

Sets the RF frequency of the signal, if signal source :SENSe<ch>[:POWer]:SOURce
USER is selected.
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Parameters:
<Frequency> float

*RST: 1 GHz

Example: :SENS1:SOUR USER
Selects user-defined source.
:SENS1:FREQ 2.44GHz
Sets the RF frequency of the source which is 2.44 GHz.

Manual operation: See "Frequency" on page 201

:SENSe<ch>[:POWer]:LOGGing:STATe <State>

Activates the recording of the power values, measured by a connected R&S NRP
power sensor.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS:LOGG:STAT ON
Activates recording of the power measurement of the first sen-
sor.

Manual operation: See "Enable Logging" on page 203

:SENSe<ch>[:POWer]:OFFSet <Offset>

Sets a level offset which is added to the measured level value after activation with
command :SENSe<ch>[:POWer]:OFFSet:STATe. The level offset allows, e.g. to
consider an attenuator in the signal path.

Parameters:
<Offset> float

Range: -100.0  to  100.0
*RST: 0
Default unit: dB

Example: :SENS1:POW:OFFS 10.0
Sets a level offset of 10 dB

Manual operation: See "Level Offset State,Level Offset" on page 201

:SENSe<ch>[:POWer]:OFFSet:STATe <State>

Activates the addition of the level offset to the measured value. The level offset value is
set with command :SENSe<ch>[:POWer]:OFFSet.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: :SENS1:POW:OFFS 0.4dB
Sets a level offset of 0.4 dB
:SENS1:POW:OFFS:STAT ON
A level offset of 0.4 dB is added to the measured value.

Manual operation: See "Level Offset State,Level Offset" on page 201

:SENSe<ch>[:POWer]:SNUMber?

Queries the serial number of the sensor.

Return values: 
<SNumber> string

Example: :SENS1:SNUM?
Queries the serial number.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 200

:SENSe<ch>[:POWer]:SOURce <Source>

Determines the signal to be measured.

Note: When measuring the RF signal, the sensor considers the corresponding correc-
tion factor at that frequency, and uses the level setting of the instrument as reference
level.

Parameters:
<Source> A | USER | RF

*RST: A

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 424.

Manual operation: See "Use Frequency Of" on page 201

:SENSe<ch>[:POWer]:STATus[:DEVice]?

Queries if a sensor is connected to the instrument.

Return values: 
<Status> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:STAT?
Response: 1
A sensor is connected.

Usage: Query only

Manual operation: See "State" on page 200
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:SENSe<ch>[:POWer]:SVERsion?

Queries the software version of the connected R&S NRP power sensor.

Return values: 
<SVersion> string

Example: :SENS1:POW:SVER?
Queries the software version of the power sensor.

Usage: Query only

:SENSe<ch>[:POWer]:TYPE?

Queries the sensor type. The type is automatically detected.

Return values: 
<Type> string

Example: :SENS1:TYPE?
Queries the type of sensor.
Response: NRP-Z21
The R&S NRP-Z21 sensor is used.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 200

:SENSe<ch>[:POWer]:ZERO

Performs zeroing of the sensor.

Zeroing is required after warm-up, i.e. after connecting the sensor.

Note: Switch off or disconnect the RF power source from the sensor before zeroing.

We recommend that you zero in regular intervals (at least once a day), if:
● The temperature has varied more than about 5 °C.
● The sensor has been replaced.
● You want to measure very low power.

Example: :SENS1:ZERO
Executes zeroing.

Usage: Event

Manual operation: See "Zero" on page 200

13.15  SCONfiguration subsystem

The SCONfiguration subsystem contains the commands for defining the system
configuration setting, like stream mapping and used baseband configuration.
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Required options

R&S SMBB-K554 Multiplier Control

Common suffixes

The following common suffixes are used in the control commands:
● RF<ch>
This suffix defines the RF connector. Since the R&S SMB100B has only one RF con-
nector, the value range is [1] and using the suffix is optional.

Example: Connecting and configuring external instruments
The following example lists commands to connect and configure external instruments.

// ********************************************************************************
// Getting information about connected external instruments.
// ********************************************************************************
// General information about the connected external device
SCONfiguration:EXTernal:RF1:REMote:INFO?
//Response: "SZM75-100001","Frontend Connection","127.0.0.1","SZM75-100001","connected"

// Connector direction
SCONfiguration:EXTernal:RF1:DIRection?
// Response: OUT

// Status of the remote connection
SCONfiguration:EXTernal:RF1:RCONnection:STATe?
// Response: 1

// Name of the connected external instrument
SCONfiguration:EXTernal:RF1:INAMe?
// Response: "SZM75-100003"

// ********************************************************************************
// Connecting a frequency multiplier.
// ********************************************************************************
//Query available external instruments
SCONfiguration:EXTernal:REMote:LIST?
//Response: SZM75-100003,SZM75-100001,SZM75-100002

// Connecting a frequency multiplier
SCONfiguration:EXTernal:RF:REMote:ICONnect "SZM75-100001"

// Query the IF of the connected frequency multiplier
SOURce1:EFRontend:FREQuency:IFRequency:VALue?
// Response: 18750000000
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13.15.1  External instruments

The following commands configure external instruments, e.g. frequency multiplier
R&S SZM.

Commands:

:SCONfiguration:EXTernal:ACONnect.............................................................................. 438
:SCONfiguration:EXTernal:REMote:CONNect[:ALL]...........................................................438
:SCONfiguration:EXTernal:REMote:DISConnect[:ALL]....................................................... 438
:SCONfiguration:EXTernal:PBEHaviour............................................................................ 438
:SCONfiguration:EXTernal:RF<ch>:DIRection?................................................................. 439
:SCONfiguration:EXTernal:RF<ch>:RCONnection:STATe?................................................. 439
:SCONfiguration:EXTernal:RF<ch>:INAMe?......................................................................439
:SCONfiguration:EXTernal:REMote:LIST?........................................................................ 439
:SCONfiguration:EXTernal:REMote:REName....................................................................440
:SCONfiguration:EXTernal:RF<ch>:REMote:ISELect......................................................... 440
:SCONfiguration:EXTernal:RF<ch>:REMote:ICONnect...................................................... 440
:SCONfiguration:EXTernal:RF<ch>:REMote:INFO?........................................................... 440
:SCONfiguration:EXTernal:REMote:CLEan....................................................................... 441
:SCONfiguration:EXTernal:RF<ch>:REMote:CONNect.......................................................441
:SCONfiguration:EXTernal:RF<ch>:REMote:DISConnect................................................... 441

:SCONfiguration:EXTernal:ACONnect <State>

Enables automatic detection and connection setup of connected external instruments.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Auto Connect" on page 123

:SCONfiguration:EXTernal:REMote:CONNect[:ALL]
:SCONfiguration:EXTernal:REMote:DISConnect[:ALL]
Triggers the instrument to establish the connections to all configured external instru-
ments or to disconnect all existing connections.

Usage: Event

Manual operation: See "Connect/Disconnect" on page 122

:SCONfiguration:EXTernal:PBEHaviour <State>

If enabled, the connection to the external instruments is retained after preset (*RST) of
the instrument.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)
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Manual operation: See "Preset behavior: Keep connections to external instru-
ments" on page 123

:SCONfiguration:EXTernal:RF<ch>:DIRection?

Queries the connector direction.

Return values: 
<Direction> NONE | IN | OUT

*RST: IN

Example: See Example "Connecting and configuring external instruments"
on page 437.

Usage: Query only

Manual operation: See "Direction" on page 123

:SCONfiguration:EXTernal:RF<ch>:RCONnection:STATe?

Queries the status of the remote connection.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Connecting and configuring external instruments"
on page 437.

Usage: Query only

Manual operation: See "Remote Connection Status" on page 124

:SCONfiguration:EXTernal:RF<ch>:INAMe?

Queries the name of the connected external instrument.

Return values: 
<InstrName> string

Example: See Example "Connecting and configuring external instruments"
on page 437.

Usage: Query only

Manual operation: See "Instrument Name" on page 124

:SCONfiguration:EXTernal:REMote:LIST?

Lists all available instruments.

Return values: 
<InstrNames> String

String with symbolic names and/or alias names
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Example: See Example "Connecting and configuring external instruments"
on page 437

Usage: Query only

Manual operation: See "External Instrument" on page 125

:SCONfiguration:EXTernal:REMote:REName

Changes the symbolic name of the instrument.

Usage: Setting only

:SCONfiguration:EXTernal:RF<ch>:REMote:ISELect <InstrName>[, <RfPath>]

Selects an external instrument for the selected connector.

Parameters:
<InstrName> String

Instrument alias name, as retrieved with the command :
SCONfiguration:EXTernal:REMote:LIST?.

<RfPath> String
Determines the used RF output of the external instrument.
For a one-path instrument, the output path is fixed.

Manual operation: See "Apply" on page 126

:SCONfiguration:EXTernal:RF<ch>:REMote:ICONnect <InstrName>, <RfPath>

Selects an external instrument for the selected connector and triggers connection.

Parameters:
<InstrName> string

Instrument alias name, as retrieved with the command :
SCONfiguration:EXTernal:REMote:LIST?.

<RfPath> string
Determines the used RF output of the external instrument.
For a one-path instrument, the output path is fixed to RF1.

Example: See Example "Connecting and configuring external instruments"
on page 437.

Usage: Setting only

Manual operation: See "Apply and Connect" on page 126

:SCONfiguration:EXTernal:RF<ch>:REMote:INFO?

Queries information on the external instrument.
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Example: See Example "Connecting and configuring external instruments"
on page 437.

Usage: Query only

Manual operation: See "Set Symbolic Name" on page 125
See "Remote Channel" on page 125
See "Hostname or IP Address" on page 125
See "Device ID" on page 125

:SCONfiguration:EXTernal:REMote:CLEan

Removes all instruments not connected via USB cable to the R&S SMB100B from the
"External Instrument" list.

Usage: Event

Manual operation: See "Clean All" on page 125

:SCONfiguration:EXTernal:RF<ch>:REMote:CONNect

Triggers the connection to the external instrument at the selected connector.

Usage: Event

:SCONfiguration:EXTernal:RF<ch>:REMote:DISConnect

Triggers the disconnection of the external instrument at the selected connector.

Usage: Event

13.16  SOURce subsystem

The SOURce subsystem contains the commands for configuring signals.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] ● SOURce[1] = RF output
(optional keyword)

● LF output = SOURce:LFOutput
(SOURce is optional keyword)

● Analog modulation subsystems............................................................................ 442
● SOURce:CORRection subsystem.........................................................................476
● SOURce:EFRontend subsystem...........................................................................484
● SOURce:FREQuency subsystem......................................................................... 487
● SOURce:INPut subsystem....................................................................................493
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● SOURce:LFOutput subsystem..............................................................................495
● SOURce:LIST subsystem..................................................................................... 508
● SOURce:NOISe subsystem..................................................................................520
● SOURce:PGEN subsystem...................................................................................522
● SOURce:PHASe subsystem.................................................................................523
● SOURce:POWer subsystem.................................................................................524
● SOURce:ROSCillator subsystem..........................................................................537
● SOURce:SWEep subsystem.................................................................................543

13.16.1  Analog modulation subsystems

Option: see Section 5.1, "Required options", on page 68.

The subsystems in this section describe all commands for analog modulation of the RF
signal. Divided in separate sections, you can configure amplitude modulation (AM), fre-
quency modulation (FM) , phase modulation (PhiM) and pulse modulation (PULM).

You can perform each of the modulations either with an internally generated modula-
tion signal or with an externally applied signal.

To configure the internal signal, use the commands listed in Section 13.16.6,
"SOURce:LFOutput subsystem", on page 495.

For more information:

See Section 5, "Analog modulations", on page 68.

13.16.1.1  SOURce:MODulation subsystem

The command in this subsytem allows you to disable all active modulations at once,
and, vice versa, to restore the last active ones.

[:SOURce<hw>]:MODulation[:ALL][:STATe] <State>

Activates all modulations that were active before the last switching off.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: SOURce1:AM1:DEPTh 30
SOURce1:AM1:SOURce LF1
SOURce1:AM1:STATe 1
SOURce1:FM1:DEViation 1000
SOURce1:FM1:STATe 1
// disable both modulation
SOURce1:MODulation:ALL:STATe 0
SOURce1:AM1:STATe?
// 0
SOURce1:FM1:STATe?
// 0
// enable both modulation
SOURce1:MODulation:ALL:STATe 1
SOURce1:AM1:STATe?
// 1
SOURce1:FM1:STATe?
// 1

Manual operation: See "[Mod on/off]" on page 70

13.16.1.2  SOURce:AM subsystem

Option: R&S SMBB-K720

The AM subsystem contains the commands for setting the amplitude modulation and
also the broadband amplitude modulation.

The following examples show some variants for generating AM signals.

The following examples show some variants for generating AM signals.

Example: Creating an amplitude modulated RF signal
Using the internal LF generator, the following command sequence configures an ampli-
tude-modulated signal.
// Reset the instrument to start from a defined state.
*RST

// Set RF frequency and amplitude
:SOURce1:FREQuency:CW 6000000000
:SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the modulation signal
:SOURce1:LFOutput1:SHAPe SINE
:SOURce1:LFOutput1:FREQuency 20000

// Configure the amplitude modulation settings and switch AM on 
:SOURce1:AM1:SOURce LF1
:SOURce1:AM1:DEPTh 30
:SOURce1:AM:RATio 40
:SOURce1:AM1:DEViation:MODe UNC
:SOURce1:AM1:STATe 1
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Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure an amplitude-modulated signal with determined deviations depths.
// Configure the AM modulation settings with combined LF signal sources
:SOURce1:AM1:SOURce LF1
:SOURce1:AM1:DEPTh 32
// Select the modulation signal source for the second path
:SOURce1:AM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
:SOURce1:AM1:DEViation:MODe TOT
:SOURce1:AM1:DEPTh:SUM 60

// Query the deviation depth of modulation signal in the second path
:SOURce1:AM2:DEPTh?
// Response:  28

// Combine the signals of both paths with fixed ratio
:SOURce1:AM1:DEViation:MODe RAT
:SOURce1:AM1:RATio 100
:SOURce1:AM2:DEPTh 25

// Query the deviation depth of modulation signal in the first path
:SOURce1:AM1:DEPTh?
// Response:  25

:SOURce1:AM1:STATe 1
:SOURce1:AM2:STATe 1

SOURce subsystem



Remote control commandsR&S®SMB100B

445User Manual 1178.3711.02 ─ 11

Example: Using an external signal source
Using an external signal source, you can also determine whether you want to use only
the AC component of the external modulation signal.
// Reset the instrument to start from a defined state
*RST

// Set frequency and amplitude
:SOURce1:FREQuency:CW 6000000000
:SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the amplitude modulation settings and turn on AM
:SOURce1:AM1:SOURce EXT1
:SOURce1:AM1:DEPTh 40

// Query the input sensitivity at the external modulation input
:SOURce1:AM1:SENSitivity?
// Response:  40
// Since the voltage value for full modulation is 1V, 
// the resulting sensitivity is precisely 50%/V. 
// This value is assigned to the voltage value for full
// modulation of the input.

// Select the coupling mode AC for external amplitude modulation
:SOURce1:INPut:MODext:COUPling1 AC

// For external AM signal input, adjust the sensitivity.
:SOURce1:AM1:SOURce EXT1
:SOURce1:AM1:SENSitivity 25
:SOURce1:AM1:SENSitivity?
Response: 25

// Switch on AM and RF signal output
:SOURce1:AM1:STATe 1
:OUTPut1:STATe 1

The following commands are available:

[:SOURce<hw>]:AM<ch>:STATe......................................................................................445
[:SOURce<hw>]:AM<ch>:SOURce.................................................................................. 446
[:SOURce<hw>]:AM<ch>[:DEPTh]...................................................................................446
[:SOURce<hw>]:AM:DEPTh:SUM....................................................................................447
[:SOURce<hw>]:AM:DEViation:MODE............................................................................. 447
[:SOURce<hw>]:AM:RATio..............................................................................................447
[:SOURce<hw>]:AM<ch>:SENSitivity...............................................................................448

[:SOURce<hw>]:AM<ch>:STATe <State>

Activates amplitude modulation.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Creating an amplitude modulated RF signal"
on page 443.

Manual operation: See "State" on page 74

[:SOURce<hw>]:AM<ch>:SOURce <Source>

Selects the modulation source for amplitude modulation.

Parameters:
<Source> EXT1 | NOISe | LF2 | LF1 | INTernal | EXTernal

LF1|LF2
Uses an internally generated LF signal.
EXT1
Uses an externally supplied LF signal.
NOISe
Uses the internally generated noise signal.
INTernal
Uses the internally generated signal of LF1.
EXTernal
Uses an external LF signal (EXT1).

Example: See Example "Creating an amplitude modulated RF signal"
on page 443.

Manual operation: See "Source" on page 74

[:SOURce<hw>]:AM<ch>[:DEPTh] <Depth>

Sets the depth of the amplitude modulation in percent.

Suffix: 
<ch>

.
1..2
Modulation signal channel

Parameters:
<Depth> float

Range: 0  to  100

Example: See Example "Creating an amplitude modulated RF signal"
on page 443.

Manual operation: See "Depth" on page 77
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[:SOURce<hw>]:AM:DEPTh:SUM <AmDepthSum>

Sets the total depth of the LF signal when using combined signal sources in amplitude
modulation.

Parameters:
<AmDepthSum> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Using combined LF signals" on page 444.

Manual operation: See "Total Depth" on page 78

[:SOURce<hw>]:AM:DEViation:MODE <AmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total depth.

Parameters:
<AmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation depth values of both paths are independent.
TOTal
Couples the deviation depth of both paths.
RATio
Couples the deviation depth ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 444.

Manual operation: See "Deviation Mode" on page 77

[:SOURce<hw>]:AM:RATio <Ratio>

Sets the deviation ratio (path#2 to path#1) in percent.

Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.1
*RST: 100

Example: See Example "Creating an amplitude modulated RF signal"
on page 443.

Manual operation: See "Ratio Path2/Path1" on page 78
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[:SOURce<hw>]:AM<ch>:SENSitivity <Sensitivity>

Sets the sensitivity of the external signal source for amplitude modulation in %/V.

Parameters:
<Sensitivity> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Creating an amplitude modulated RF signal"
on page 443.

Manual operation: See "Sensitivity" on page 77

13.16.1.3  SOURce:FM subsystem

Option: R&S SMBB-K720

The FM subsystem contains the commands for setting the frequency modulation.

Example: Creating a frequency modulated RF signal
Using the internal LF generator, the following command sequence configures a fre-
quency-modulated signal.

// Reset the instrument to start from a defined state
*RST

// Set RF frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the modulation signal
SOURce1:LFOutput1:SHAPe SINE
SOURce1:LFOutput1:FREQuency 20000

// Configure the frequency modulation settings and switch FM on 
SOURce1:FM1:SOURce LF1
SOURce1:FM1:DEViation 1000
SOURce1:FM:RATio 40
SOURce1:FM:MODe LNOise
SOURce1:FM1:STATe 1

// Switch on LF and RF signal output
SOURce1:LFOutput1:STATe 1
OUTPut1:STATe 1 

Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure a frequency-modulated signal with determined deviations.
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// Configure the FM modulation settings with combined LF signal sources
SOURce1:FM1:SOURce LF1
SOURce1:FM1:DEViation 1000
// Select the modulation signal source for the second path
SOURce1:FM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
SOURce1:FM1:DEViation:MODe TOT
SOURce1:FM1:DEViation:SUM 5000

// Query the deviation depth of modulation signal in the second path
SOURce1:FM2:DEViation?
// Response:  4000

// Combine the signals of both paths with fixed ratio
SOURce1:FM1:DEViation:MODe RAT
SOURce1:FM1:RATio 100
SOURce1:FM2:DEVIation 10000

// Query the deviation depth of modulation signal in the first path
SOURce1:AM1:DEViation?
// Response:  1000

SOURce1:FM1:STATe 1
SOURce1:FM2:STATe 1

Example: Using an external signal source
Alternatively configure the frequency modulation settings with an external modulation
signal.

// Reset the instrument to start from a defined state
*RST

// Set RF frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the frequency modulation settings and switch FM on 
SOURce1:FM1:SOURce EXT1
SOURce1:FM1:DEViation 5000

// Query the input sensitivity at the external modulation input
:SOURCe1:FM1:SENSitivity?
// Response:  1000
// since the voltage value for full modulation is 1V, 
// the resulting sensitivity is precisely 5000 Hz/V.

// Switch on FM and RF signal output
SOURce1:FM1:STATe 1
OUTPut1:STATe 1
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The following commands are available:

[:SOURce<hw>]:FM<ch>:STATe......................................................................................450
[:SOURce<hw>]:FM<ch>[:DEViation]............................................................................... 450
[:SOURce<hw>]:FM<ch>:SOURce.................................................................................. 450
[:SOURce<hw>]:FM:DEViation:MODE............................................................................. 451
[:SOURce<hw>]:FM:DEViation:SUM................................................................................451
[:SOURce<hw>]:FM:RATio..............................................................................................452
[:SOURce<hw>]:FM:MODE.............................................................................................452
[:SOURce<hw>]:FM:SENSitivity?.....................................................................................452

[:SOURce<hw>]:FM<ch>:STATe <State>

Activates frequency modulation.

Suffix: 
FM<ch>

.
1..2
determines the modulation signal channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Creating a frequency modulated RF signal"
on page 448.

Manual operation: See "State" on page 74

[:SOURce<hw>]:FM<ch>[:DEViation] <Deviation>

Sets the modulation deviation of the frequency modulation in Hz.

Suffix: 
FM<ch>

.
1|2
Modulation signal channel

Parameters:
<Deviation> float

The maximum deviation depends on the RF frequency and the
selected modulation mode (see the specifiacton document).
Range: 0  to  max
Increment: 0.01
*RST: 1E3

Example: See Example "Creating a frequency modulated RF signal"
on page 448.

Manual operation: See "Deviation" on page 74

[:SOURce<hw>]:FM<ch>:SOURce <Source>

Selects the modulation source for frequency modulation.
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Suffix: 
FM<ch>

.
1|2
Modulation signal channel.

Parameters:
<Source> EXT1 | NOISe | LF2 | LF1 | INTernal | EXTernal

LF1|LF2
Uses an internally generated LF signal.
INTernal
Uses the internally generated signal of LF1.
EXTernal
Uses an external LF signal (EXT1).
NOISe
Uses the internally generated noise signal.
*RST: LF1 <FM1>; LF2 <FM2>

Example: See Example "Creating a frequency modulated RF signal"
on page 448.

Manual operation: See "Source" on page 74

[:SOURce<hw>]:FM:DEViation:MODE <FmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total deviation.

Parameters:
<FmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation values of both paths are independent.
TOTal
Couples the deviation of both paths.
RATio
Couples the deviation ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 448.

Manual operation: See "Deviation Mode" on page 75

[:SOURce<hw>]:FM:DEViation:SUM <FmDevSum>

Sets the total deviation of the LF signal when using combined signal sources in fre-
quency modulation.
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Parameters:
<FmDevSum> float

Range: 0  to  40E6
Increment: 0.01
*RST: 1E3

Example: See Example "Using combined LF signals" on page 448.

Manual operation: See "Total Deviation" on page 75

[:SOURce<hw>]:FM:RATio <Ratio>

Sets the deviation ratio (path2 to path1) in percent.

Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.1
*RST: 100

Example: See Example "Creating a frequency modulated RF signal"
on page 448.

Manual operation: See "Ratio Path2/Path1" on page 75

[:SOURce<hw>]:FM:MODE <Mode>

Selects the mode for the frequency modulation.

Parameters:
<Mode> HBANdwidth | LNOise

HBANdwidth
Selects maximum range for modulation bandwidth.
LNOise
Selects optimized phase noise and spurious characteristics with
reduced modulation bandwidth and FM deviation.
*RST: HBANdwidth

Example: See Example "Creating a frequency modulated RF signal"
on page 448.

Manual operation: See "Mode" on page 75

[:SOURce<hw>]:FM:SENSitivity?

Queries the sensitivity of the externally supplied signal for frequency modulation. The
sensitivity depends on the set modulation deviation.

SOURce subsystem



Remote control commandsR&S®SMB100B

453User Manual 1178.3711.02 ─ 11

Return values: 
<Sensitivity> float

Sensitivity in Hz/V.
It is assigned to the voltage value for full modulation of the input.
Range: 0  to  max
Increment: 0.01

Example: See Example "Using an external signal source" on page 449.

Usage: Query only

13.16.1.4  SOURce:PM subsystem

Option: R&S SMBB-K720

The PM subsystem contains the commands for setting the phase modulation. You can
configure the internal modulation source (LF generator) with the commands listed in
Section 13.16.6, "SOURce:LFOutput subsystem", on page 495.

Example: Performing phase modulation
The following example shows a command sequence to perform phase modulation.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the RF signal frequency and level
:SOURce:FREQuency:CW 4000000000
:SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the phase modulation settings
:SOURce1:LFOutput1:SHAPe SINE
:SOURce1:LFOutput1:FREQuency 1000

// Select the LF signal generated by the internal modulation generator
// or the internally generated noise signal
:SOURce1:PM1:DEViation 1
:SOURce1:PM1:SOURce LF1
// :SOURce1:PM1:SOURce INTernal
// :SOURce1:PM1:SOURce NOISe
:SOURce1:PM1:RATio 40
:SOURce1:PM1:MODE HBAN

// Alternatively configure the phase modulation settings for an 
// external modulation source and query the input sensitivity.
:SOURce1:PM1:SOURce EXT1
// :SOURce1:PM1:SOURce EXTernal
:SOURce1:PM1:DEViation 1
:SOURce1:PM1:SENSitivity?
// Response: 1 
// since the voltage value for full modulation is 1V, 
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// the resulting sensitivity is precisely 1RAD/V. 

// Activate the signal output
:SOURce1:PM1:STATe 1
:OUTPut1:STATe 1

Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure a phase-modulated signal with determined deviations.

// Configure the Phase modulation settings with combined LF signal sources
:SOURce1:PM1:SOURce LF1
:SOURce1:PM1:DEViation 1.5
// Select the modulation signal source for the second path
:SOURce1:PM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
:SOURce1:PM1:DEViation:MODe TOT
:SOURce1:PM1:DEViation:SUM 2

// Query the deviation depth of the modulation signal in the second path
:SOURce1:PM2:DEViation?
// Response:  0.5

// Combine the signals of both paths with fixed ratio
:SOURce1:PM1:DEViation:MODe RAT
:SOURce1:PM1:RATio 80
:SOURce1:PM2:DEViation?
// Response:  1.2

// Query the deviation depth of modulation signal in the first path
:SOURce1:PM1:DEViation?
// Response:  1.5

:SOURce1:FM1:STATe 1
:SOURce1:FM2:STATe 1

The following commands are available:

[:SOURce<hw>]:PM<ch>:STATe......................................................................................454
[:SOURce<hw>]:PM<ch>:SOURce.................................................................................. 455
[:SOURce<hw>]:PM:MODE............................................................................................ 455
[:SOURce<hw>]:PM:DEViation:MODE............................................................................. 456
[:SOURce<hw>]:PM:DEViation:SUM................................................................................456
[:SOURce<hw>]:PM:RATio..............................................................................................456
[:SOURce<hw>]:PM:SENSitivity?.................................................................................... 457
[:SOURce]:PM<ch>[:DEViation].......................................................................................457

[:SOURce<hw>]:PM<ch>:STATe <State>

Activates phase modulation.
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Activation of phase modulation deactivates frequency modulation.

Suffix: 
PM<ch>

.
1|2
Sets the modulation signal channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Performing phase modulation" on page 453.

Manual operation: See "State" on page 74

[:SOURce<hw>]:PM<ch>:SOURce <Source>

Selects the modulation source for phase modulation signal.

Suffix: 
PM<ch>

.
1|2
Sets the modulation signal channel.

Parameters:
<Source> EXT1 | NOISe | LF2 | LF1 | INTernal | EXTernal

LF1|LF2
Uses an internally generated LF signal.
EXT1
Uses an externally supplied LF signal.
NOISe
Uses the internally generated noise signal.
INTernal
Uses the internally generated signal of LF1.
EXTernal
Uses an external LF signal (EXT1).

Example: See Example "Performing phase modulation" on page 453.

Manual operation: See "Source" on page 74

[:SOURce<hw>]:PM:MODE <Mode>

Selects the mode for the phase modulation.

Parameters:
<Mode> HBANdwidth | HDEViation | LNOise

HBANdwidth
Sets the maximum available bandwidth.
HDEViation
Sets the maximum range for ΦM deviation.
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LNOise
Selects a phase modulation mode with phase noise and spuri-
ous characteristics close to CW mode.
*RST: HBANdwidth

Example: See Example "Performing phase modulation" on page 453.

Manual operation: See "Mode" on page 77

[:SOURce<hw>]:PM:DEViation:MODE <PmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total deviation.

Parameters:
<PmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation values of both paths are independent.
TOTal
Couples the deviation of both paths.
RATio
Couples the deviation ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 454

Manual operation: See "Deviation Mode" on page 76

[:SOURce<hw>]:PM:DEViation:SUM <PmDevSum>

Sets the total deviation of the LF signal when using combined signal sources in phase
modulation.

Parameters:
<PmDevSum> float

Range: 0  to  max
Increment: 1E-6
*RST: 1

Example: See Example "Using combined LF signals" on page 454

Manual operation: See "Total Deviation" on page 76

[:SOURce<hw>]:PM:RATio <Ratio>

Sets the deviation ratio (path2 to path1) in percent.
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Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.01
*RST: 100

Example: See Example "Performing phase modulation" on page 453.

Manual operation: See "Ratio Path2/Path1" on page 76

[:SOURce<hw>]:PM:SENSitivity?

Queries the sensitivity of the externally applied signal for phase modulation.

The returned value reports the sensitivity in RAD/V. It is assigned to the voltage value
for full modulation of the input.

Return values: 
<Sensitivity> float

Example: See Example "Performing phase modulation" on page 453.

Usage: Query only

[:SOURce]:PM<ch>[:DEViation] <Deviation>

Sets the modulation deviation of the phase modulation in RAD.

Parameters:
<Deviation> float

The maximal deviation depends on the RF frequency and the
selected modulation mode (see the specifications document).
Range: 0  to  max
Increment: 1
*RST: 1
Default unit: RAD

Example: See Example "Performing phase modulation" on page 453.

Manual operation: See "Deviation" on page 76

13.16.1.5  SOURce:PULM subsystem

Option: see Section 5.1, "Required options", on page 68.

The PULM subsystem contains the commands for setting the pulse modulation.

● Pulse modulation settings..................................................................................... 458
● Pulse train settings................................................................................................463
● Pulse train data exchange.....................................................................................466
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Pulse modulation settings

With the commands described in this section, you can configure the settings for pulse
modulation, select the trigger mode and determine delay times for the pulse modula-
tion signal.

Example: Perform pulse modulation
The example shows a command sequence to perform pulse modulation.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the RF signal frequency and level
:SOURce:FREQuency:CW 4000000000
:SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the pulse modulation settings
// Select the internal modulation generator,
// set trigger mode, select pulse mode, transition type

// Trigger a single pulse

:SOURce:PULM:SOURce INT
:SOURce:PULM:TRIGger:MODE SING
:SOURce:PULM:MODE DOUB 
:SOURce:PULM:TTYPe SMO

:SOURce:PULM:TRIGger:IMMediate

// Alternatively configure the pulse modulation settings for 
// external modulation source
// Select the source, set the polarity of the external signal,
// select the impedance for the external pulse modulation input/
// for the external pulse modulation trigger input
:SOURce:PULM:SOURce EXT
:SOURce:PULM:POLarity NORMal
:SOURce:PULM:IMPedance G1K

// Configure the pulse generator settings
// Set pulse period, width, and delay
:SOURce:PULM:PERiod 10 us
:SOURce:PULM:WIDth 8 us
:SOURce:PULM:DOUBle:WIDTh 0.0000012
:SOURce:PULM:DOUBle:DELay 0.0000045

// Route the signal to the signal valid output connector
// to use the signal for synchronizing the pulse modulation.
:SOURce:PULM:OUTPut:SYNC ON

// Activate the signal output
:SOURce:PGENerator:OUTPut:STATe 1
:SOURce:PULM:STATe 1
:OUTPut1:STATe 1
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The following commands are available:

[:SOURce<hw>]:PULM:MODE........................................................................................ 459
[:SOURce<hw>]:PULM:TRIGger:MODE........................................................................... 459
[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate................................................... 460
[:SOURce<hw>]:PULM:PERiod....................................................................................... 460
[:SOURce<hw>]:PULM:WIDTh........................................................................................460
[:SOURce<hw>]:PULM:DELay........................................................................................ 460
[:SOURce<hw>]:PULM:DOUBle:DELay............................................................................461
[:SOURce<hw>]:PULM:DOUBle:WIDTh........................................................................... 461
[:SOURce<hw>]:PULM:DOUBle:STATe............................................................................ 461
[:SOURce<hw>]:PULM:STATe.........................................................................................461
[:SOURce<hw>]:PULM:SOURce..................................................................................... 461
[:SOURce<hw>]:PULM:TTYPe........................................................................................462
[:SOURce<hw>]:PULM:OUTPut:SYNC[:STATe].................................................................462
[:SOURce<hw>]:PULM:POLarity..................................................................................... 462
[:SOURce<hw>]:PULM:IMPedance..................................................................................463

[:SOURce<hw>]:PULM:MODE <Mode>

Selects the mode for the pulse modulation.

Parameters:
<Mode> SINGle | DOUBle | PTRain

SINGle
Generates a single pulse.
DOUBle
Generates two pulses within one pulse period.
PTRain
Generates a user-defined pulse train.
Specify the pulse sequence with the commands:
[:SOURce<hw>]:PULM:TRAin:ONTime
[:SOURce<hw>]:PULM:TRAin:OFFTime
[:SOURce<hw>]:PULM:TRAin:REPetition
*RST: SINGle

Example: See Example "Perform pulse modulation" on page 458.

Options: PTRain requires R&S SMBB-K27

Manual operation: See "Pulse Mode" on page 88

[:SOURce<hw>]:PULM:TRIGger:MODE <Mode>

Selects a trigger mode - auto, single, external, external single or external gated - for
generating the modulation signal.

Parameters:
<Mode> AUTO | EXTernal | EGATe | SINGle | ESINgle

*RST: AUTO

Example: See Example "Perform pulse modulation" on page 458.
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Manual operation: See "Trigger Mode" on page 89

[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate

If [:SOURce<hw>]:PULM:TRIGger:MODESINGle, triggers the pulse generator.

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Execute Single Trigger" on page 91

[:SOURce<hw>]:PULM:PERiod <Period>

Sets the period of the generated pulse, that means the repetition frequency of the inter-
nally generated modulation signal.

Parameters:
<Period> float

The minimum value depends on the installed options
R&S SMBB-K22 or R&S SMBB-K23
Range: 20E-9  to  100
Increment: 5E-9
*RST: 10E-6

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Pulse Period" on page 90

[:SOURce<hw>]:PULM:WIDTh <Width>

Sets the width of the generated pulse, that means the pulse length. It must be at least
20ns less than the set pulse period.

Parameters:
<Width> float

Range: 20E-9  to  100
Increment: 10E-9
*RST: 2E-6

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Pulse Width" on page 90

[:SOURce<hw>]:PULM:DELay <Delay>

Sets the pulse delay.

Parameters:
<Delay> float

*RST: 1ms

Example: See Example "Perform pulse modulation" on page 458.
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Manual operation: See "Pulse Delay" on page 90

[:SOURce<hw>]:PULM:DOUBle:DELay <Delay>

Sets the delay from the start of the first pulse to the start of the second pulse.

Parameters:
<Delay> float

*RST: 1E-6

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Double Pulse Delay" on page 90

[:SOURce<hw>]:PULM:DOUBle:WIDTh <Width>

Sets the width of the second pulse.

Parameters:
<Width> float

Increment: 5E-9

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Double Pulse Width" on page 90

[:SOURce<hw>]:PULM:DOUBle:STATe <State>

Provided for backward compatibility with former Rohde & Schwarz signal generators.

Works like the command [:SOURce<hw>]:PULM:MODEDOUBle.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:PULM:STATe <State>

Activates pulse modulation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "State" on page 71

[:SOURce<hw>]:PULM:SOURce <Source>

Selects between the internal (pulse generator) or an external pulse signal for the mod-
ulation.
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Parameters:
<Source> INTernal | EXTernal

*RST: INTernal

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Source" on page 72

[:SOURce<hw>]:PULM:TTYPe <Source>

Sets the transition mode for the pulse signal.

Parameters:
<Source> SMOothed | FAST

SMOothed
flattens the slew rate, resulting in longer rise/fall times.
FAST
enables fast transitions with shortest rise and fall times.
*RST: FAST

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Transition Type" on page 72

[:SOURce<hw>]:PULM:OUTPut:SYNC[:STATe] <Sync>

Routes the pulse modulation signal to the [Signal Valid] connector.

Parameters:
<Sync> 1 | ON | 0 | OFF

*RST: OFF

Options: R&S SMBB-K23 (Pulse Generator)

Manual operation: See "Pulse Sync Out" on page 91

[:SOURce<hw>]:PULM:POLarity <Polarity>

Sets the polarity of the externally applied modulation signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
Suppresses the RF signal during the pulse pause.
INVerted
Suppresses the RF signal during the pulse.
*RST: NORMal

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Polarity" on page 99
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[:SOURce<hw>]:PULM:IMPedance <Impedance>

Sets the impedance for the external pulse trigger and pulse modulation input.

Parameters:
<Impedance> G50 | G10K

*RST: G10K

Example: See Example "Perform pulse modulation" on page 458.

Manual operation: See "Impedance" on page 99

Pulse train settings

Option: R&S SMBB-K27

This section describes the commands for the pulse train modulation and the associ-
ated file handling.

See Section 5.4.4.2, "Pulse generator > pulse train settings", on page 91.

Example: Generating a pulse train signal
The following settings are required to perform pulse train modulation.

Always create and select pulse train data list first before you activate the pulse train
mode. Otherwise, an error is displayed.

*RST; *CLS

// Set the RF signal frequency and level
:SOURce:FREQuency:CW 4000000000
:SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Create a pulse train data list
// Select the directory
:MMEM:CDIR '/var/user/'
:SOURce1:PULM:TRAin:CATalog?
// Reaponse: "my_pt"
// Create and7or select the pulse train data file
:SOURce1:PULM:TRAin:SELect "/var/user/pt"
// Enter the pulse train data
:SOURce:PULM:TRAin:ONTime 0.0001,0.00025,0.0001
:SOURce:PULM:TRAin:OFFTime 500us,500us,300us
:SOURce:PULM:TRAin:REPetition 2,0,3
// the second pulse is ignored

// Select pulse train mode
// Select the internal modulation generator and the pulse mode
:SOURce1:PULM:SOURce INT
:SOURce1:PULM:MODE PTR
:SOURce1:PULM:TRIGger:MODE EXT
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:SOURce1:PGENerator:OUTPut:STATe 1
:SOURce1:PGENerator:OUTPut:POLarity NORM
:SOURce:PGENerator:OUTPut:STATe 1
:SOURce:PULM:STATe 1
:OUTPut1:STATe 1

:SOURce1:PULM:TRAin:CATalog?
// Response: "my_pt, pt"
:SOURce1:PULM:TRAin:DEL "/var/user/my_pt"

The following commands are available:

[:SOURce<hw>]:PULM:TRAin:CATalog?.......................................................................... 464
[:SOURce<hw>]:PULM:TRAin:DELete............................................................................. 464
[:SOURce<hw>]:PULM:TRAin:ONTime............................................................................ 465
[:SOURce<hw>]:PULM:TRAin:OFFTime...........................................................................465
[:SOURce<hw>]:PULM:TRAin:REPetition:POINts?............................................................465
[:SOURce<hw>]:PULM:TRAin:ONTime:POINts?............................................................... 465
[:SOURce<hw>]:PULM:TRAin:OFFTime:POINts?............................................................. 465
[:SOURce<hw>]:PULM:TRAin:REPetition.........................................................................465
[:SOURce<hw>]:PULM:TRAin:SELect..............................................................................466

[:SOURce<hw>]:PULM:TRAin:CATalog?

Queries the available pulse train files in the specified directory.

Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "Generating a pulse train signal" on page 463.

Usage: Query only

Manual operation: See "Pulse Train Data" on page 93

[:SOURce<hw>]:PULM:TRAin:DELete <Filename>

Deletes the specified pulse train file.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See Example "Generating a pulse train signal" on page 463.

Usage: Setting only

Manual operation: See "Pulse Train Data" on page 93
See "Edit Pulse Train Data" on page 94
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[:SOURce<hw>]:PULM:TRAin:ONTime <OnTime>
[:SOURce<hw>]:PULM:TRAin:OFFTime <OffTime>
Enters the pulse on/off times values in the selected list.

Parameters:
<OffTime> Offtime#1{, Offtime#2, ...} | binary block data

List of comma-separated numeric values or binary block data,
where:
The list of numbers can be of any length.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See :FORMat[:DATA] on page 412 for details.
The maximum length is 2047 values.
Range: 0 ns to 10 ms

Example: See Example "Generating a pulse train signal" on page 463.

Manual operation: See "Edit Pulse Train Data" on page 94

[:SOURce<hw>]:PULM:TRAin:REPetition:POINts?
[:SOURce<hw>]:PULM:TRAin:ONTime:POINts?
[:SOURce<hw>]:PULM:TRAin:OFFTime:POINts?
Queries the number of on and off time entries and repetitions in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Generating a pulse train signal" on page 463.

Usage: Query only

[:SOURce<hw>]:PULM:TRAin:REPetition <Repetition>

Sets the number of repetitions for each pulse on/off time value pair.

Parameters:
<Repetition> Repetition#1{, Repetition#2, ...}

0 = ignore value pair
Set "Repetition = 0" to skip a particular pulse without deleting
the pulse on/off time value pair
Range: 0  to  65535

Example: See Example "Generating a pulse train signal" on page 463.

Manual operation: See "Edit Pulse Train Data" on page 94
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[:SOURce<hw>]:PULM:TRAin:SELect <Filename>

Selects or creates a data list in pulse train mode.

If the list with the selected name does not exist, a new list is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "Generating a pulse train signal" on page 463.

Manual operation: See "Pulse Train Data" on page 93
See "File Name" on page 98
See "Functions for handling of data lists" on page 236

Pulse train data exchange

Option: R&S SMBB-K27

With the following commands, you can configure pulse trains in ASCII format and
export or import them accordingly.

:SOURce1:PULM:SOURce INT
:SOURce1:PULM:MODE PTR
:SOURce1:PULM:TRAin:SELect "/var/user/pt"
:SOURce1:PULM:STATe 1

:SOURce1:PULM:TRAin:DEXChange:MODE EXP
:SOURce1:PULM:TRAin:DEXChange:AFILe:EXTension TXT
:SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal DOT
:SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn SEM
:SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn COMM
:SOURce1:PULM:TRAin:DEXChange:SELect "/var/user/pt.pulstrn"
:SOURce1:PULM:TRAin:DEXChange:AFILe:SELect "/var/user/pt_script.txt"
:SOURce1:PULM:TRAin:DEXChange:EXECute

The following commands are available:

[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE............................................................466
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension............................................ 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal............................... 467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn...............................467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog?..............................................467
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect................................................. 468
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect...........................................................468
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute........................................................468

[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE <Mode>

Determines the import or export of a list.

Specify the source or destination file with the command [:SOURce<hw>]:PULM:
TRAin:DEXChange:SELect.
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Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "Mode" on page 96

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII file for import or export, or to query existing
files.

Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets "." (decimal point) or "," (comma) as the decimal separator used in the ASCII data
with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog?

Queries the available ASCII files in the current or specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.
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Example: See "Pulse train data exchange" on page 466.

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a pulse train list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See "Pulse train data exchange" on page 466.

Manual operation: See "Select Source/Select ASCII Destination" on page 97

[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute

Usage: Event

Manual operation: See "Import / Export" on page 97

Executes the import or export of the selected list file, according to the transfer direction
set with command [:SOURce<hw>]:PULM:TRAin:DEXChange:MODE.

13.16.1.6  SOURce:STEReo subsystem

Option: R&S SMBB-B5

The SOURce:STEReo subsystem contains the commands for generating FM stereo
multiplex signals, the radio traffic service ARI (Automotive Radio Information) and
Radio Data System (RDS).

Additional functions are available using the SOURce:STEReo:DIRect commands,
see Section 13.22, "Direct commands for the stereo/rds coder option R&S SMBB-B5",
on page 596.
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Example: Activating stereo modulation
The following example shows a command sequence for stereo modulation.

// Reset the instrument to start from an initial state
*RST; *CLS
// Set the FM deviation, audio source, preemphasis
// and max modulation frequency

SOURce:STEReo:DEViation 25000
SOURce:STEReo:SOURce SPEX
SOURce:STEReo:AUDio:PREemphasis:STATe 1
SOURce:STEReo:AUDio:PREemphasis 75 us
SOURce:STEReo:AUDio:MODE RNEL
SOURce:STEReo:MMF 1500

// Configure the pilot tone
SOURce:STEReo:PILot:DEViation 5000
SOURce:STEReo:PILot:PHASe 3

// Configure and activate ARI
STEReo:ARI 2800
SOURce:STEReo:ARI:TYPE BK
STEReo:ARI:BK C
SOURce:Stereo:ARI:STATe 1

//Configure and activate RDS
STEReo:RDS 1200
SOURce:STEReo:RDS:DATaset DS3
SOURce:STEReo:RDS:TRAFfic:PROGram:STATe 1
SOURce:STEReo:RDS:TRAFfic:ANNouncement:STATe 1
STEReo:RDS:STATe 1

// Activate the signal output
SOURce:STEReo:STATe 1

[:SOURce]:STEReo:DIRect.............................................................................................470
[:SOURce]:STEReo:STATe............................................................................................. 470
[:SOURce]:STEReo[:DEViation].......................................................................................470
[:SOURce]:STEReo:AUDio:MODE...................................................................................471
[:SOURce]:STEReo:SOURce..........................................................................................471
[:SOURce]:STEReo:EXTernal:IMPedance........................................................................ 472
[:SOURce]:STEReo:MMF............................................................................................... 472
[:SOURce]:STEReo:AUDio:PREemphasis........................................................................472
[:SOURce]:STEReo:AUDio:PREemphasis:STATe..............................................................472
[:SOURce]:STEReo:PILot:STATe..................................................................................... 473
[:SOURce]:STEReo:PILot[:DEViation].............................................................................. 473
[:SOURce]:STEReo:PILot:PHASe....................................................................................473
[:SOURce]:STEReo:ARI:STATe....................................................................................... 473
[:SOURce]:STEReo:ARI[:DEViation]................................................................................ 474
[:SOURce]:STEReo:ARI:TYPE:STATe..............................................................................474
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[:SOURce]:STEReo:ARI:TYPE........................................................................................474
[:SOURce]:STEReo:ARI:BK[:CODE]................................................................................ 475
[:SOURce]:STEReo:RDS:STATe......................................................................................475
[:SOURce]:STEReo:RDS[:DEViation]...............................................................................475
[:SOURce]:STEReo:RDS:DATaset...................................................................................476
[:SOURce]:STEReo:RDS:TRAFfic:PROGram[:STATe]....................................................... 476
[:SOURce]:STEReo:RDS:TRAFfic:ANNouncement[:STATe]................................................476

[:SOURce]:STEReo:DIRect <Direct>

Sends a R&S SMB100B command string to the stereo coder.

The direct commands offer extended settings possibilities for the stereo coder, see
Section 13.22, "Direct commands for the stereo/rds coder option R&S SMBB-B5",
on page 596.

Parameters:
<Direct> string

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Program Service Name" on page 86
See "Program Identification" on page 86

[:SOURce]:STEReo:STATe <State>

Activates/deactivates stereo modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "State" on page 80

[:SOURce]:STEReo[:DEViation] <Deviation>

Sets the MPX (Multiplex stereo signal) deviation.

Parameters:
<Deviation> integer

Range: 0  to  depends on instrument hardware
*RST: 40 kHz

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "FM Deviation" on page 80
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[:SOURce]:STEReo:AUDio:MODE <Mode>

Selects the generated identifiers of the AUDio signal.

Parameters:
<Mode> LEFT | RIGHt | RELeft | REMLeft | RNELeft

LEFT
A mono signal containing the left channel is generated/fed in.
RIGHt
A mono signal containing the right channel is generated/fed in.
RELeft
A stereo signal with right and left channel is generated/fed in.
The channels have the same frequency and phase.
REMLeft
The signal on the left external audio input is used for both chan-
nels, left and right. The right channel is inverted.
RNELeft
(External source only)
A stereo signal containing different, independent right and left
channels is feed in. It is possible, for example, to feed a fixed
audio frequency to the first channel while a frequency sweep is
being performed in the second channel.
*RST: LEFT

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Mode" on page 80

[:SOURce]:STEReo:SOURce <Source>

Selects the source for the audio signal.

Parameters:
<Source> OFF | LREXt | SPEXt | LFGen

OFF
No audio signal is provided, ARI and RDS signal can be gener-
ated separately.
LREX
The external audio signal is feed in via the analog L and R
inputs.
SPEX
The external audio signal is feed in via the digital S/P DIF inter-
face
LFG
The audio stereo signal is internally generated by the LF genera-
tor.
*RST: LREXt

Example: See Example "Activating stereo modulation" on page 469.
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Manual operation: See "Audio Source" on page 81

[:SOURce]:STEReo:EXTernal:IMPedance <Impedance>

For [:SOURce]:STEReo:SOURceLREX, selects the input impedance for the external
analog audio signal inputs L and R.

Parameters:
<Impedance> 600 | 600Ohm | 100000 | 100kOhm | 100000Ohm

*RST: 100000

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "External R/L Impedance" on page 81

[:SOURce]:STEReo:MMF <Mmf>

For [:SOURce]:STEReo:SOURceLREX and [:SOURce]:STEReo:AUDio:
PREemphasis:STATe1, sets the maximum modulation frequency. It prevents over
modulation but decreases S/N ratio.

Parameters:
<Mmf> integer

Range: 1000  to  18000
*RST: 1000

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Max Modulation Frequency" on page 82

[:SOURce]:STEReo:AUDio:PREemphasis <PreEmphasis>

If [:SOURce]:STEReo:AUDio:PREemphasis:STATe1, sets the preemphasis used
for signal generation.

Parameters:
<PreEmphasis> OFF | 50 | 75

Range: 50 us  to  75 us

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Preemphasis" on page 81

[:SOURce]:STEReo:AUDio:PREemphasis:STATe <State>

Activates the use of preemphasis for signal generation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.
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Manual operation: See "Preemphasis" on page 81

[:SOURce]:STEReo:PILot:STATe <State>

Activates/deactivates the pilot tone generation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Pilot State" on page 83

[:SOURce]:STEReo:PILot[:DEViation] <Deviation>

Sets the deviation of the pilot tone.

Parameters:
<Deviation> integer

Range: 0  to  10 kHz
*RST: 6.75 kHz

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Pilot Deviation" on page 83

[:SOURce]:STEReo:PILot:PHASe <Phase>

Sets the phase of the pilot tone in degrees, in relation to the 38 kHz carrier signal of
the receiver. For a correct demodulation, the pilot tone must be in phase with the 38
kHz carrier.

Parameters:
<Phase> float

Range: -5  to  5
Increment: 0.1
*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Pilot Phase" on page 83

[:SOURce]:STEReo:ARI:STATe <State>

Activates/deactivates the ARI signal generation. ARI signals can be generated simulta-
neously with MPX and RDS signals.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "ARI State" on page 84

[:SOURce]:STEReo:ARI[:DEViation] <Deviation>

Sets the frequency deviation of the ARI subcarrier signal.

Parameters:
<Deviation> integer

Range: 0  to  10000
*RST: 3500

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "ARI Deviation" on page 84

[:SOURce]:STEReo:ARI:TYPE:STATe <State>

Activates/deactivates the Stereo ARI Identifier. Activating selects the previously
selected identifier type.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "ARI Identification" on page 84

[:SOURce]:STEReo:ARI:TYPE <Type>

Selects the generated identifiers of the ARI signal.

DK and BK are abbreviations of the German words Durchsagekennung and Bereich-
skennung.

Parameters:
<Type> OFF | DK | BK | BKDK

OFF
Only the 57 kHz subcarrier is generated.
DK
The message identification is generated in addition (low-fre-
quency 30% AM).
BK
The area identification is generated in addition (60% AM). The
specific code is selected in [:SOURce]:STEReo:ARI:BK[:
CODE] on page 475.
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BKDK
The area and message identification are generated in addition.
The BK code is selected in [:SOURce]:STEReo:ARI:BK[:
CODE] on page 475.
*RST: OFF

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "ARI Identification" on page 84

[:SOURce]:STEReo:ARI:BK[:CODE] <Code>

Selects the area identification (BK) code of the ARI signal. The code is generated if the
BK or DK+BK identifier of the ARI signal is activated.

Parameters:
<Code> A | B | C | D | E | F

The six letters (six different frequencies) identify a specific
region in each country.
*RST: A

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "ARI BK" on page 84

[:SOURce]:STEReo:RDS:STATe <State>

Activates/deactivates the RDS signal generation. RDS signals can be generated simul-
taneously with MPX (FM stereo multiplex) and ARI signals.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "RDS State" on page 85

[:SOURce]:STEReo:RDS[:DEViation] <Deviation>

Sets the deviation of the RDS subcarrier.

Parameters:
<Deviation> integer

Range: 0  to  10 kHz
*RST: 2 kHz

Example: See Section 13.16.1.6, "SOURce:STEReo subsystem",
on page 468.

Manual operation: See "RDS Deviation" on page 86
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[:SOURce]:STEReo:RDS:DATaset <Dataset>

Selects one of the five data sets provided on the instrument for use in the RDS signal.

Parameters:
<Dataset> DS1 | DS2 | DS3 | DS4 | DS5

*RST: DS1

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "RDS Data Set" on page 86

[:SOURce]:STEReo:RDS:TRAFfic:PROGram[:STATe] <State>

Activates the RDS traffic program. The receiver can recognize a frequency as being
capable of traffic information only if the TP function is active.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Traffic Program" on page 86

[:SOURce]:STEReo:RDS:TRAFfic:ANNouncement[:STATe] <State>

Activates the RDS traffic announcement.

If TP is on, this function switches the receiver from the current status, e.g. playing a
CD, to the receive mode and enables the broadcast of a traffic announcement.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Activating stereo modulation" on page 469.

Manual operation: See "Traffic Announcement" on page 87

13.16.2  SOURce:CORRection subsystem

The SOURce:CORRection subsystem contains the commands for defining correction
values for external test assemblies.

You can acquire the correction values anytime, regardless of the modulation settings of
the generator. During correction, the R&S SMB100B adds the correction values to the
output level of the respective RF frequency.

Determine the correction values in one of the following ways:
● Measure the RF output level at several frequency points and enter the value pairs

manually in a table
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● Connect an R&S NRP to the generator output signal and send the command [:
SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe to
fill the table automatically.

Save correction values to files with file extension *.uco.

Refer to Section 13.5.2, "Handling files in the default or in a specified directory",
on page 383 for general information on file handling in the default and in a specific
directory.

Programming examples

The examples in this section assume that:
● The files are stored in the default directory.
● *RST does not affect data lists.

Example: To create RF level correction values
The following example shows a command sequence to create and activate a list for
assigning level correction values to arbitrary RF frequencies. Further hardware settings
are not considered.

// Reset the instrument to start from an initial state
// Query the available user correction list files in the default
// directory. Select a file or create a file.
// ******************************************************************
*RST; *CLS
:SOURce1:CORRection:CSET:CATalog?
// Response: "ucor1"
// Select the file ucor1.uco.
:SOURce1:CORRection:CSET:SELect "/var/user/ucor1"

// Enter the frequency/level value pairs in the table; existing data
// is overwritten. Query the number of frequency/power entries.
:SOURce1:CORRection:CSET:DATA:FREQuency 100MHz,110MHz,120MHz,130MHz,140MHz,150MHz
:SOURce1:CORRection:CSET:DATA:POWer -10,-7.5,-5.0,-2.5,0,2.5 
:SOURce1:CORRection:CSET:DATA:FREQuency:POINts?
// 6
:SOURce1:CORRection:CSET:DATA:POWer:POINTs?
// 6

// Enable user correction mode and RF output
:SOURce1:CORRection:STATe 1
:OUTPut1:STATe ON

// Query the currently used correction value
:SOURce1:CORRection:VALue?
// -2.5

// Delete a user correction file
:SOURce1:CORRection:CSET:DELEte "/var/user/ucor1.uco"
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Example: To fill user correction data with a sensor
The following example shows a command sequence to fill a user correction list auto-
matically supported by a connected R&S NRP.

// Fill a user correction list with the level values
// measured by an R&S NRP,
// store the data in a file and enable user correction.

*RST; *CLS

:SOURce1:CORRection:CSET:SELect "/var/user/Ucor1_AutoFill.uco"
:SOURce1:CORRection:CSET:DATA:FREQuency 100MHz,110MHz,120MHz,130MHz,140MHz,150MHz
:SOURce1:CORRection:ZERoing:STATe 1
:SOURce1:CORRection:CSET:DATA:SENSor1:POWer:SONCe
// Query the number of automatically filled correction level values
:SOURce1:CORRection:CSET:DATA:POWer:POINTs?
// 6
:SOURce1:CORRection:STATe 1

// Query the correction value at a certain frequency
:FREQ 120000000
:SOURce1:CORRection:VALue?
// -52.13

Example: To export user correction lists
The following example shows a command sequence to export a user correction list
(here the list created with the example before) into an ASCII file. Further hardware set-
tings are not considered.

// Select a user correction file for exporting to file in ASCII format
// Set ASCII data parameters
// Set the ASCII file extension, the decimal separator
// and the column separator for the ASCII data
:SOURce1:CORRection:DEXChange:AFILe:CATalog?
// my_ucor
:SOURce1:CORRection:CSET:CATalog?
// ucor1,Ucor1_AutoFill
:SOURce1:CORRection:CSET:SELect "/var/user/Ucor1_AutoFill.uco"
:SOURce1:CORRection:DEXChange:AFILe:EXTension CSV
:SOURce1:CORRection:DEXChange:AFILe:SEParator:DECimal DOT
:SOURce1:CORRection:DEXChange:AFILe:SEParator:COLumn COMMa 

// Select source and destination 
:SOURce1:CORRection:DEXChange:AFILe:SELect "/var/user/ucor2ASCII"

// Export the user correction data into the ASCII file
:SOURce1:CORRection:DEXChange:MODE EXPort
:SOURce1:CORRection:DEXChange:EXECute
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// Query the available ASCII files with extension .csv
:SOURce1:CORRection:DEXChange:AFILe:CATalog?
// ucor2ASCII,my_ucor

// Import a user correction ASCII file
:SOURce1:CORRection:DEXChange:MODE IMPort
:SOURce1:CORRection:DEXChange:AFILE:SELect "/var/user/my_ucor" 
:SOURce1:CORRection:DEXChange:EXECute

Commands:

● Correction settings................................................................................................ 479
● Correction data exchange.....................................................................................482

13.16.2.1  Correction settings

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency <Frequency>

Enters the frequency value in the table selected with [:SOURce<hw>]:CORRection:
CSET[:SELect].

Parameters:
<Frequency> Frequency#1[, Frequency#2, ...]

String of values with default unit Hz.

Example: See Example "To create RF level correction values"
on page 477 .

Manual operation: See "Frequency (Hz)" on page 183

[:SOURce<hw>]:CORRection:CSET:DATA:POWer <Power>

Enters the level values to the table selected with [:SOURce<hw>]:CORRection:
CSET[:SELect].

Parameters:
<Power> Power#1[, Power#2, ...]

String of values with default unit dB.
*RST: 0

Example: See Example "To create RF level correction values"
on page 477 .

Manual operation: See "Correction Value (dB)" on page 183

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency:POINts?
[:SOURce<hw>]:CORRection:CSET:DATA:POWer:POINts?
Queries the number of frequency/level values in the selected table.

SOURce subsystem



Remote control commandsR&S®SMB100B

480User Manual 1178.3711.02 ─ 11

Return values: 
<Points> integer

Range: 0  to  10000
*RST: 0

Example: See Example "To create RF level correction values"
on page 477 .

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe

Fills the selected user correction table with the level values measured by the power
sensor for the given frequencies.

To select the used power sensor set the suffix in key word SENSe.

Example: See Example "To fill user correction data with a sensor"
on page 478.

Usage: Event

Manual operation: See "Fill User Correction Data with Sensor" on page 185

[:SOURce<hw>]:CORRection:CSET[:SELect] <Filename>

Selects or creates a file for the user correction data.

If the file with the selected name does not exist, a new file is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "To create RF level correction values"
on page 477 .

Manual operation: See "UCOR Data" on page 180
See "Functions for handling of data lists" on page 236

[:SOURce<hw>]:CORRection:VALue?

Queries the current value for user correction.

Return values: 
<Value> float

Range: -100  to  100
Increment: 0.01
*RST: 0

Example: See Example "To create RF level correction values"
on page 477 .

Usage: Query only
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Manual operation: See "User Correction" on page 180

[:SOURce<hw>]:CORRection:ZERoing:STATe <State>

Activates the zeroing procedure before filling the user correction data acquired by a
sensor.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "To fill user correction data with a sensor"
on page 478.

Manual operation: See "Fill User Correction Data with Sensor" on page 185

[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe

Fills the selected user correction list with the level values measured by the power sen-
sor for the given frequencies.

Suffix: 
SENSor<ch>

.
Defines the used power sensor, i.e. the sensor whose values are
used.

Example: See Example "To fill user correction data with a sensor"
on page 478.

Usage: Event

[:SOURce<hw>]:CORRection[:STATe] <State>

Activates user correction with the currently selected table.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To create RF level correction values"
on page 477 .

Manual operation: See "State" on page 180

[:SOURce]:CORRection:CSET:CATalog?

Queries a list of available user correction tables.

Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "To create RF level correction values"
on page 477 .
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Usage: Query only

Manual operation: See "UCOR Data" on page 180
See "Directory, File List and Filename" on page 231

[:SOURce]:CORRection:CSET:DELete <Filename>

Deletes the specified user correction list file.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See Example "To create RF level correction values"
on page 477 .

Usage: Setting only

Manual operation: See "UCOR Data" on page 180

13.16.2.2  Correction data exchange

With the following commands, you can configure user correction lists and export or
import them accordingly.

[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog?

Queries the available ASCII files for export or import of user correction data in the cur-
rent or specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.

Example: See Example "To create RF level correction values"
on page 477 .

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII files for file import or export, or to query existing
files.

Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "ASCII File Settings" on page 96
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[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets the decimal separator used in the ASCII data between '.' (decimal point) and ','
(comma) with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:CORRection:DEXChange:EXECute

Executes the import or export of the selected correction list, according to the previously
set transfer direction with command [:SOURce<hw>]:CORRection:DEXChange:
MODE.

Example: See Example "To export user correction lists" on page 478 .

Usage: Event

Manual operation: See "Import / Export" on page 97

[:SOURce<hw>]:CORRection:DEXChange:MODE <Mode>

Determines import or export of a user correction list.

SOURce subsystem



Remote control commandsR&S®SMB100B

484User Manual 1178.3711.02 ─ 11

Specify the source or destination file with the command [:SOURce<hw>]:
CORRection:DEXChange:SELect.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "Mode" on page 96

[:SOURce<hw>]:CORRection:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a user correction list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "To export user correction lists" on page 478 .

Manual operation: See "Select Source/Select ASCII Destination" on page 97

13.16.3  SOURce:EFRontend subsystem

The SOURce:EFRontend subsystem contains the commands for configuring settings
of an external frontend.

Example: Configuring external frontend frequency bands
SOURce1:EFRontend:FREQuency:IFRequency:VALue?
// Response in Hz: "18750000000" (= 18.75 GHz)

Example: Configuring external frontend connection settings
SOURce1:EFRontend:IDN?
// Response: "Rohde&Schwarz,SZM75,1443.5004K02/100001,1.34.6,1.2.1"

//Query the installed hardware options
SOURce1:EFRontend:OPT?
// Response: "SZM-E,SZM-I"
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Example: Configuring external frontend cable correction
// Query available cable correction files.
SOURce1:EFRontend:ALIGnment:FILE:CATalog?
// Select a cable correction file stored on the instrument.
SOURce1:EFRontend:ALIGnment:FILE:SELect "/var/user/ExtFrontend/CableCorrectionFiles/
if_default_cable_1347_7552_00.s2p"
// Query upper and lower frequency range of the IF correction data.
SOURce1:EFRontend:ALIGnment:FILE:FREquency:RANGe:LOWer?
// Response in Hz: "12000000000" (12 GHz)
SOURce1:EFRontend:ALIGnment:FILE:FREquency:RANGe:UPPer?
// Response in Hz: "19250000000" (19.25 GHz)
SOURce1:EFRontend:ALIGnment:STATe 1

Commands:

[:SOURce<hw>]:EFRontend[:FREQuency]:IFRequency[:VALue]?.......................................485
[:SOURce<hw>]:EFRontend:IDN?................................................................................... 485
[:SOURce<hw>]:EFRontend:OPT?.................................................................................. 486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:LOWer?....................... 486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:UPPer?........................486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:CATalog?....................................................486
[:SOURce<hw>]:EFRontend:ALIGnment:FILE[:SELect]..................................................... 486
[:SOURce<hw>]:EFRontend:ALIGnment[:STATe].............................................................. 487
[:SOURce<hw>]:EFRontend:SCRew:POSition?................................................................ 487

[:SOURce<hw>]:EFRontend[:FREQuency]:IFRequency[:VALue]?

Queries the frequency of the IF signal, that is the frequency at the RF 50 Ω connector.

Return values: 
<IntFrequency> float

Example: See Example "Configuring external frontend frequency bands"
on page 484.

Usage: Query only

Manual operation: See "Intermediate Frequency" on page 128

[:SOURce<hw>]:EFRontend:IDN?

Identification

Returns the IDN string, i.e. the identification of the external frontend.

Return values: 
<IdnString> string

Example: See Example "Configuring external frontend connection set-
tings" on page 484.

Usage: Query only

Manual operation: See "Hardware Config" on page 129
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[:SOURce<hw>]:EFRontend:OPT?

Option identification query

Queries the options included in the external frontend.

For more information, refer to the specifications document.

Return values: 
<OptString> string

The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Example: See Example "Configuring external frontend connection set-
tings" on page 484.

Usage: Query only

Manual operation: See "Options" on page 130

[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:LOWer?
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:UPPer?
Queries the upper/lower frequency range of IF values required at the connected exter-
nal frontend.

We recommend that you cover this range in the cable correction file.

Return values: 
<CableCorrFreqUp> float

Example: See Example "Configuring external frontend cable correction"
on page 485.

Usage: Query only

Manual operation: See "Recommended Frequency Range" on page 132

[:SOURce<hw>]:EFRontend:ALIGnment:FILE:CATalog?

Queries the cable correction files with settings in the default directory.

Listed are cable correction files with extension *.s2p or *.uco.

Example: See Example "Configuring external frontend cable correction"
on page 485.

Usage: Query only

Manual operation: See "Load Cable Correction File" on page 131

[:SOURce<hw>]:EFRontend:ALIGnment:FILE[:SELect] <CableCorrFileNa>

Selects an existing correction file to compensate for cable losses. Selectable files have
file extension *.s2p or *.uco.
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Parameters:
<Filename> string

Example: See Example "Configuring external frontend cable correction"
on page 485.

Manual operation: See "Load Cable Correction File" on page 131

[:SOURce<hw>]:EFRontend:ALIGnment[:STATe] <CableCorrState>

Activates correction of the IF signal for different IF signal frequencies.

Parameters:
<CableCorrState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configuring external frontend cable correction"
on page 485.

Manual operation: See "State" on page 131

[:SOURce<hw>]:EFRontend:SCRew:POSition?

Requires a connected external frequency multiplier with installed mechanically attenua-
tor option.

Queries the value of the screw position required on the connected external frequency
multiplier.

Return values: 
<ScrewPosition> integer

Range: 0  to  150
*RST: 0

Usage: Query only

13.16.4  SOURce:FREQuency subsystem

The SOURce:FREQuency subsystem contains the commands used to define the fre-
quency settings for the RF sources and sweeps.

Example: To configure RF frequency settings
:SOURce1:FREQuency:MODE CW
:SOURce1:FREQuency:CW 6000000000
:SOURce1:FREQuency:OFFSet 2000000000
:SOURce1:FREQuency:MULTiplier 1.5
:SOURce1:FREQuency:CW?
// Response in Hz: 11000000000

// Optionally, configure a user-defined frequency step mode.
:SOURce1:FREQuency:STEP:MODE USER
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:SOURce1:FREQuency:STEP:INCRement 1000000
:SOURce1:FREQuency:CW UP

:SOURce1:PHASe 2
:SOURce1:PHASe:REFerence

[:SOURce<hw>]:FREQuency:MODE................................................................................488
[:SOURce<hw>]:FREQuency[:CW|FIXed].........................................................................489
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL................................................................. 490
[:SOURce<hw>]:FREQuency:MANual..............................................................................490
[:SOURce<hw>]:FREQuency:MULTiplier.......................................................................... 490
[:SOURce<hw>]:FREQuency:OFFSet.............................................................................. 491
[:SOURce<hw>]:FREQuency:CENTer.............................................................................. 491
[:SOURce<hw>]:FREQuency:SPAN.................................................................................492
[:SOURce<hw>]:FREQuency:STARt................................................................................ 492
[:SOURce<hw>]:FREQuency:STOP.................................................................................492
[:SOURce<hw>]:FREQuency:STEP:MODE...................................................................... 493
[:SOURce<hw>]:FREQuency:STEP[:INCRement]............................................................. 493

[:SOURce<hw>]:FREQuency:MODE <Mode>

Sets the frequency mode for generating the RF output signal. The selected mode
determines the parameters to be used for further frequency settings.

Parameters:
<Mode> CW | FIXed | SWEep | LIST | COMBined

CW|FIXed
Sets the fixed frequency mode. CW and FIXed are synonyms.
The instrument operates at a defined frequency, set with com-
mand [:SOURce<hw>]:FREQuency[:CW|FIXed].
SWEep
Sets sweep mode.
The instrument processes frequency (and level) settings in
defined sweep steps.
Set the range and current frequency with the commands:
[:SOURce<hw>]:FREQuency:STARt on page 492 and [:
SOURce<hw>]:FREQuency:STOP on page 492,
[:SOURce<hw>]:FREQuency:CENTer on page 491,
[:SOURce<hw>]:FREQuency:SPAN on page 492,
[:SOURce<hw>]:FREQuency:MANual on page 490
LIST
Sets list mode.
The instrument processes frequency and level settings by
means of values loaded from a list.
To configure list mode settings, use the commands of the Sec-
tion 13.16.7, "SOURce:LIST subsystem", on page 508.
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COMBined
Sets the combined RF frequency / level sweep mode.
The instrument processes frequency and level settings in
defined sweep steps.
Set the range and current frequency with the commands:
[:SOURce<hw>]:COMBined:FREQuency:STARt
on page 552 and [:SOURce<hw>]:COMBined:FREQuency:
STOP on page 552,
[:SOURce<hw>]:COMBined:POWer:STARt on page 552 and
[:SOURce<hw>]:COMBined:POWer:STOP on page 553
*RST: CW

Example: See Example "To configure RF frequency settings" on page 487,

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Manual operation: See "State (RF frequency sweep)" on page 150
See "State (RF frequency / level sweep)" on page 151
See "State" on page 161

[:SOURce<hw>]:FREQuency[:CW|FIXed] <Fixed>

Sets the frequency of the RF output signal in the selected path.

The effect depends on the selected mode:
● In CW mode (FREQ:MODE CW | FIXed), the instrument operates at a fixed fre-

quency.
● In sweep mode (FREQ:MODE SWE), the value applies to the sweep frequency.

The instrument processes the frequency settings in defined sweep steps.
● In user mode (FREQ:STEP:MODE USER), you can vary the current frequency step

by step.

For more information, refer to the specifications document.

Parameters:
<Fixed> float

The following settings influence the value range:
An offset set with the command [:SOURce<hw>]:FREQuency:
OFFSet
Numerical value
Sets the frequency in CW and sweep mode
UP|DOWN
Varies the frequency step by step in user mode.
The frequency is increased or decreased by the value set with
the command [:SOURce<hw>]:FREQuency:STEP[:
INCRement].
Range: (RFmin + OFFSet) to (RFmax + OFFSet)
Increment: depends on options
*RST: depends on options
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Example: See Example "To configure RF frequency settings" on page 487

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Manual operation: See "Frequency" on page 60

[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL <Rcl>

Set whether the RF frequency value is retained or taken from a loaded instrument con-
figuration, when you recall instrument settings with command *RCL.

Parameters:
<Rcl> INCLude | EXCLude

INCLude
Takes the frequency value of the loaded settings.
EXCLude
Retains the current frequency when an instrument configuration
is loaded.
*RST: INCLude

Example: SOURce1:FREQuency:CW:RCL INCLude
Manual operation: See "Exclude Frequency" on page 232

[:SOURce<hw>]:FREQuency:MANual <Manual>

Sets the frequency and triggers a sweep step manually if SWEep:MODE MAN.

Parameters:
<Manual> float

You can select any frequency within the setting range, where:
STARt is set with [:SOURce<hw>]:FREQuency:STARt
STOP is set with [:SOURce<hw>]:FREQuency:STOP
OFFSet is set with [:SOURce<hw>]:FREQuency:OFFSet
Range: (STARt + OFFSet) to (STOP + OFFSet)
Increment: 0.01Hz
*RST: 100 MHz
Default unit: Hz

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Manual operation: See "Current Frequency" on page 151

[:SOURce<hw>]:FREQuency:MULTiplier <Multiplier>

Sets the multiplication factor NFREQ:MULT of a subsequent downstream instrument.

The parameters offset fFREQ:OFFSer and multiplier NFREQ:MULT affect the frequency value
set with the command FREQ.
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The query FREQ? returns the value corresponding to the formula:

fFREQ = fRFout * NFREQ:MULT + fFREQ:OFFSer

See "RF frequency and level display with a downstream instrument" on page 58.

Parameters:
<Multiplier> float

Range: -10000  to  10000
Increment: 0.001
*RST: 1

Example: See Example "To configure RF frequency settings" on page 487

Manual operation: See "Multiplier" on page 61

[:SOURce<hw>]:FREQuency:OFFSet <Offset>

Sets the frequency offset fFREQ:OFFSet of a downstream instrument.

The parameters offset fFREQ:OFFSer and multiplier NFREQ:MULT affect the frequency value
set with the command FREQ.

The query FREQ? returns the value corresponding to the formula:

fFREQ = fRFout * NFREQ:MULT + fFREQ:OFFSer

See "RF frequency and level display with a downstream instrument" on page 58.

Note: The offset also affects RF frequency sweep.

Parameters:
<Offset> float

Increment: 0.01
*RST: 0

Example: See Example "To configure RF frequency settings" on page 487

Manual operation: See "Offset" on page 60

[:SOURce<hw>]:FREQuency:CENTer <Center>

Sets the center frequency of the sweep.

The maximum value depends on the installed hardware options.

For more information, refer to the specifications document.

Parameters:
<Center> float

Range: 300 kHz  to  depends on options
Increment: 0.01 Hz
*RST: 300E6
Default unit: Hz
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Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Center Frequency" on page 156

[:SOURce<hw>]:FREQuency:SPAN <Span>

Sets the span of the frequency sweep range.

Parameters:
<Span> float

Full frequency range
Increment: 0.01
*RST: 400E6

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Span" on page 156

[:SOURce<hw>]:FREQuency:STARt <Start>

Sets the start frequency for the RF sweep.

The maximum value depends on the installed hardware options.

For more information, refer to the specifications document.

Parameters:
<Start> float

Range: 300 kHz  to  depends on options
Increment: 0.01 Hz
*RST: 100 MHz

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Frequency/Stop Frequency" on page 156

[:SOURce<hw>]:FREQuency:STOP <Stop>

Sets the stop frequency range for the RF sweep.

The maximum value depends on the installed hardware options.

For more information, refer to the specifications document.

Parameters:
<Stop> float

Range: 300 kHz  to  depends on options
Increment: 0.01 Hz
*RST: 500 MHz
Default unit: Hz
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Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Frequency/Stop Frequency" on page 156

[:SOURce<hw>]:FREQuency:STEP:MODE <Mode>

Defines the type of step size to vary the RF frequency at discrete steps with the com-
mands FREQ UP or FREQ DOWN.

Parameters:
<Mode> DECimal | USER

DECimal
Increases or decreases the level in steps of ten.
USER
Increases or decreases the level in increments, set with the
command FREQ:STEP[:INCR].
*RST: DECimal

Example: See Example "To configure RF frequency settings" on page 487.

Manual operation: See "Variation Active" on page 61

[:SOURce<hw>]:FREQuency:STEP[:INCRement] <Increment>

Sets the step width.

You can use this value to vary the RF frequency with command FREQ UP or FREQ
DOWN.

If you have activated FREQ:STEP:MODE USER.

Note: This value also applies to the step width of the rotary knob on the instrument
and, in user-defined step mode, increases or decreases the frequency.

Parameters:
<Increment> float

Range: 0 Hz  to  RFmax - 100 kHz
Increment: 0.01 Hz
*RST: 1E6

Example: See Example "To configure RF frequency settings" on page 487

Manual operation: See "Variation Step" on page 61

13.16.5  SOURce:INPut subsystem

The SOURce:INPut subsystem contains the commands for configuring the inputs for
external modulation signals. The instrument trigger setting influences all sweeps and is
effective in the List mode (Instrument Trigger).
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[:SOURce<hw>]:INPut:MODext:COUPling........................................................................494
[:SOURce<hw>]:INPut:MODext:IMPedance<ch>...............................................................494
[:SOURce]:INPut:TRIGger:SLOPe................................................................................... 494

[:SOURce<hw>]:INPut:MODext:COUPling <Coupling>

Selects the coupling mode for an externally applied modulation signal.

Parameters:
<Coupling> AC | DC

AC
Passes the AC signal component of the modulation signal.
DC
Passes the modulation signal with both components, AC and
DC.
*RST: AC

Example: SOURce1:INPut:MODext:COUPling AC
SOURce1:INPut:MODext:IMPedance G50

Manual operation: See "Coupling (AC/DC)" on page 105

[:SOURce<hw>]:INPut:MODext:IMPedance<ch> <Impedance>

Sets the impedance for the externally supplied modulation signal.

Parameters:
<Impedance> G50 | G600 | HIGH

G50 = 50 Ohm to ground
G600 = 600 Ohm to ground
HIGH = 100 kOhm to ground
*RST: HIGH

Example: See [:SOURce<hw>]:INPut:MODext:COUPling
on page 494.

Manual operation: See "Impedance" on page 105

[:SOURce]:INPut:TRIGger:SLOPe <Slope>

Sets the polarity of the active slope of an applied instrument trigger.

Parameters:
<Slope> NEGative | POSitive

*RST: POSitive

Example: INP:TRIG:SLOP NEG
Activates the falling slope of the external trigger signal at the
trigger input.

Manual operation: See "Trigger Slope" on page 154
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13.16.6  SOURce:LFOutput subsystem

The SOURce:LFOutput subsystem contains the commands for setting the LF signal
source in CW and Sweep mode and for analog modulation.

Example: Setting up an LF sweep
The following example shows a command sequence to set up an LF sweep.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the trigger mode, the sweep mode and the sweep range
TRIGger1:LFFSweep:SOURce SINGle
SOURce1:LFOutput1:SWEep:FREQuency:MODE AUTO
SOURce1:LFOutput1:FREQuency:STARt 1 kHz
SOURce1:LFOutput1:FREQuency:STOP 7 kHz

// Select linear spacing
// Select the waveform shape for the frequency sweep cycle
// Set the step width and the dwell time.
SOURce1:LFOutput1:SWEep:FREQuency:SPACing LINear
SOURce1:LFOutput1:SWEep:FREQuency:SHAPe SAWtooth
SOURce1:LFOutput1:SWEep:FREQuency:STEP:LINear 100 Hz
SOURce1:LFOutput1:SWEep:FREQuency:DWELl 150 ms
// Alternatively to the step width set the number of steps
SOURce1:LFOutput1:SWEep:FREQuency:POINts 61

// Activate change to start frequency while waiting for next trigger
// Prerequisites: sweep mode single and sweep waveform sawtooth
SOURce1:LFOutput:SWEep:FREQuency:RETRace 1

// Activate the LF frequency sweep
SOURce1:LFOutput:FREQuency:MODE SWE

// Trigger the sweep(depending on the set mode) and query the status
// Perform a one-off LF sweep
SOURce1:LFOutput1:SWEep:FREQuency:EXECute
SOURce1:LFOutput1:SWEep:FREQuency:RUNNing?
// 1
// the sweep is running

// ***************************************************
// For manual step LF sweep use the following commands 
*RST; *CLS
SOURce1:LFOutput:SWEep:FREQuency:MODE MANual
// Activate the LF frequency sweep
SOURce1:LFOutput:FREQuency:MODE SWEep
// Activate LF Output1.
SOURce1:LFOutput1:STATe 1
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// Input the frequency manually for each step
SOURce1:LFOutput1:FREQuency:MANual 2 kHz
SOURce1:LFOutput1:FREQuency:MANual 2.1 kHz
// Alternatively use UP or DOWN parameter with set step width.
SOURce1:LFOutput1:SWEep:FREQuency:STEP:LINear 60000 Hz
// SOURce1:LFOutput1:SWEep:FREQuency:STEP:LOGarithmic 10 PCT
SOURce1:LFOutput1:FREQuency:MANual UP

Example: Configuring the LF generator
The following is a simple example on how to configure the LF generator and output the
generated signal.

// configure the signal of the LF1 generator
SOURce1:LFOutput1:SHAPe SQU
SOURce1:LFOutput1:SHAPe:PULSe:PERiod 0.001
SOURce1:LFOutput1:SHAPe:PULSe:WIDTh 0.0005
SOURce1:LFOutput1:SHAPe:PULSe:DCYCle 0.5
// configure the signal of the LF1 generator
SOURce1:LFOutput2:SHAPe SINE
SOURce1:LFOutput2:FREQuency 1000000
SOURce1:LFOutput2:PERiod?
// 0.000001

// changing the LF signal shape
// SOURce1:LFOutput2:SHAPe TRAP
// SOURce1:LFOutput2:SHAPe:PULSe:PERiod 0.2
// SOURce1:LFOutput2:SHAPe:TRAPeze:RISE 0.0001
// SOURce1:LFOutput2:SHAPe:TRAPeze:FALL 0.001 
// SOURce1:LFOutput2:SHAPe:TRAPeze:FALL 0.0001
// SOURce1:LFOutput2:SHAPe:TRAPeze:HIGH 0.0005
// SOURce1:LFOutput2:SHAPe TRI
// SOURce1:LFOutput2:SHAPe:PULSe:PERiod 0.1
// SOURce1:LFOutput2:SHAPe:TRIangle:RISE 0.0001

// activate the LF output and select the LF1 as signal source
// configure the LF output signal
SOURce1:LFOutput1:FREQuency:MODE CW
SOURce1:LFOutput1:STATe 1
SOURce1:LFOutput1:SOURce LF1
SOURce1:LFOutput1:VOLTage 1
SOURce1:LFOutput1:OFFSet 0.001

● LF generator settings............................................................................................ 496
● LF sweep settings................................................................................................. 504

13.16.6.1  LF generator settings

With the commands described in this section, you can configure the LF signal source.
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[:SOURce]:LFOutput<ch>:BANDwidth?............................................................................497
[:SOURce]:LFOutput<ch>:FREQuency.............................................................................497
[:SOURce<hw>]:LFOutput<ch>:PERiod?..........................................................................498
[:SOURce<hw>]:LFOutput:FREQuency:MANual............................................................... 498
[:SOURce<hw>]:LFOutput:FREQuency:MODE................................................................. 499
[:SOURce<hw>]:LFOutput:FREQuency:STOP.................................................................. 499
[:SOURce<hw>]:LFOutput:FREQuency:STARt..................................................................499
[:SOURce]:LFOutput<ch>[:STATe]................................................................................... 499
[:SOURce]:LFOutput<ch>:INTernal:VOLTage.................................................................... 500
[:SOURce]:LFOutput:OFFSet.......................................................................................... 500
[:SOURce]:LFOutput<ch>:SOURce................................................................................. 500
[:SOURce]:LFOutput:SIMPedance...................................................................................501
[:SOURce]:LFOutput<ch>:SOURce:PATH........................................................................ 501
[:SOURce]:LFOutput:VOLTage........................................................................................ 501
[:SOURce<hw>]:LFOutput<ch>:SHAPe............................................................................501
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle....................................................502
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod.....................................................502
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh......................................................502
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL.................................................... 502
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH....................................................503
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod................................................. 503
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE.................................................... 503
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod..................................................504
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE..................................................... 504

[:SOURce]:LFOutput<ch>:BANDwidth?

Queries the bandwidth of the external LF signal.

Return values: 
<Bandwidth> BW0M2 | BW10m

*RST: BW10m

Example: LFO:BAND?
// BW10m
// the bandwidth of the externally supplied LF signal is 10 MHz

Usage: Query only

Manual operation: See "Bandwidth" on page 105

[:SOURce]:LFOutput<ch>:FREQuency <Frequency>

Sets the frequency of the LF signal in [:SOURce<hw>]:LFOutput:FREQuency:
MODE CW|FIXed mode.

Note
● If signal source "Internal" is set, the instrument performs the analog modulations

(AM/FM/PhiM/PM) with this frequency.
● In sweep mode ([:SOURce<hw>]:LFOutput:FREQuency:MODE SWE), the fre-

quency is coupled with the sweep frequency.
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Parameters:
<Frequency> float

Range: depends on the installed options
Increment: 0.01
*RST: 1000
Default unit: Hz

Example: SOURce1:LFOutput1:FREQuency 5 kHz
// sets the LF frequency

Manual operation: See "LF Gen Frequency" on page 81
See "Frequency" on page 103

[:SOURce<hw>]:LFOutput<ch>:PERiod?

Queries the repetition frequency of the sine signal.

Return values: 
<LfSinePeriod> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.001
Default unit: s

Example: See Example "Configuring the LF generator" on page 496.

Usage: Query only

[:SOURce<hw>]:LFOutput:FREQuency:MANual <Manual>

Sets the frequency of the subsequent sweep step if LFO:SWE:MODE MAN.

Use a separate command for each sweep step.

Parameters:
<Manual> float

You can select any value within the setting range, where:
STARt is set with [:SOURce<hw>]:LFOutput:FREQuency:
STARt
STOP is set with [:SOURce<hw>]:LFOutput:FREQuency:
STOP
Range: STARt to STOP
Increment: 0.1
*RST: 1000

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Current Frequency" on page 151
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[:SOURce<hw>]:LFOutput:FREQuency:MODE <Mode>

Sets the mode for the output of the LF generator frequency, and determines the com-
mands to be used for frequency settings.

Parameters:
<Mode> CW | FIXed | SWEep

CW|FIXed
Sets the fixed-frequency mode. CW and FIXed are synonyms.
To set the output frequency, use command [:SOURce]:
LFOutput<ch>:FREQuency
SWEep
Sets sweep mode.
To set the frequency, use the commands:
[:SOURce<hw>]:LFOutput:FREQuency:STARt and [:
SOURce<hw>]:LFOutput:FREQuency:STOP
Or [:SOURce<hw>]:LFOutput:FREQuency:MANual
*RST: CW

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "State (LF frequency sweep)" on page 101

[:SOURce<hw>]:LFOutput:FREQuency:STOP <Stop>
[:SOURce<hw>]:LFOutput:FREQuency:STARt <Start>
Sets the start/stop frequency for [:SOURce<hw>]:LFOutput:FREQuency:MODE
 SWEep.

Parameters:
<Start> float

Range: 0.1 Hz  to  1 MHz
Increment: 0.1
*RST: 1 KHz

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Start Frequency/Stop Frequency" on page 156

[:SOURce]:LFOutput<ch>[:STATe] <State>

Activates LF signal output.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "State" on page 107
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[:SOURce]:LFOutput<ch>:INTernal:VOLTage <Voltage>

Sets the output voltage for the LF generators.

The sum of both values must not exceed the overall output voltage, set with command
[:SOURce]:LFOutput:VOLTage.

Suffix: 
<ch>

.
[1]|2
LF1 and LF2

Parameters:
<Voltage> float

Range: 0  to  4
Increment: 0.001
*RST: 1

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Output Voltage" on page 108

[:SOURce]:LFOutput:OFFSet <Offset>

Sets a DC offset at the LF Output.

Parameters:
<Offset> float

Range: depends on lfo voltage
Increment: 0.001
*RST: 0

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "DC-Offset" on page 108

[:SOURce]:LFOutput<ch>:SOURce <Source>

Determines the LF signal to be synchronized, when monitoring is enabled.

Parameters:
<Source> LF1 | LF2 | NOISe | AM | FMPM | EXT1

LF1|LF2
Selects an internally generated LF signal.
NOISe
Selects an internally generated noise signal.
EXT1
Selects an externally supplied LF signal
AM
Selects the AM signal.
FMPM
Selects the signal also used by the frequency or phase modula-
tions.
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*RST: LF1

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Source" on page 108

[:SOURce]:LFOutput:SIMPedance <SImpedance>

Selects the impedance of the LF output.

Parameters:
<SImpedance> G600 | G50

*RST: G50

Example: SOURce:LFOutput:SIMPedance G600
Sets the output impedance of the LF generator to 600 Ohm.

Manual operation: See "Source Impedance" on page 108

[:SOURce]:LFOutput<ch>:SOURce:PATH <SourPath>

Determines the path of the LF output source.

Parameters:
<SourPath> A | B

*RST: A

Example: LFO:SOUR:PATH?
Queries the currently set path for the LF output signal source.

[:SOURce]:LFOutput:VOLTage <Voltage>

Sets the voltage of the LF output.

Parameters:
<Voltage> float

Range: dynamic (see specifications document)
Increment: 0.001
*RST: 1

Example: SOURce:LFOutput:VOLTage 1.5

[:SOURce<hw>]:LFOutput<ch>:SHAPe <Shape>

Selects the waveform shape of the LF signal.

Parameters:
<Shape> SINE | SQUare | PULSe | TRIangle | TRAPeze

*RST: SINE

Example: See Example "Configuring the LF generator" on page 496.

Options: R&S SMBB-K24
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Manual operation: See "LF Gen Shape" on page 81
See "Shape" on page 101

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle <DCycle>

Sets the duty cycle for the shape pulse.

Parameters:
<DCycle> float

Range: 1E-6  to  100
Increment: 1E-6
*RST: 50
Default unit: PCT

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Pulse Duty Cycle" on page 103

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 1E-3

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Period" on page 103

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh <Width>

Sets the pulse width of the generated pulse.

Parameters:
<Width> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 5E-4

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Pulse Width" on page 103

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL <Fall>

Selects the fall time for the trapezoid shape of the LF generator.
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Parameters:
<Fall> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Trapezoid Rise / Fall" on page 104

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH <High>

Sets the high time for the trapezoid signal of the LF generator.

Parameters:
<High> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Trapezoid High" on page 104

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod <Period>

Sets the period of the generated trapezoid shape. The period determines the repetition
frequency of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 1E-3

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Period" on page 103

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE <Rise>

Selects the rise time for the trapezoid shape of the LF generator.

Parameters:
<Rise> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Trapezoid Rise / Fall" on page 104
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[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.001

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Period" on page 103

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE <Rise>

Selects the rise time for the triangle single of the LF generator.

Parameters:
<Rise> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.5E-3

Example: See Example "Configuring the LF generator" on page 496.

Manual operation: See "Triangle Rise" on page 104

13.16.6.2  LF sweep settings

With the commands described in this section, you can configure the sweep of the LF
signal.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl................................................... 504
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute................................................ 505
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE....................................................505
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:POINts...................................................506
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace............................................... 506
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RUNNing?..............................................506
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe...................................................506
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing................................................ 507
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:LOGarithmic..................................507
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:LINear]........................................ 507

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl <Dwell>

Sets the dwell time for each frequency step of the sweep.
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Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01
Default unit: s

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Dwell Time" on page 154

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute

Immediately starts an LF sweep.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE determines which sweep
is executed, e.g. SOURce:LFOutput:SWEep:FREQuency:MODE STEP.

Example: See Example "Setting up an LF sweep" on page 495.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 155

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE <Mode>

Sets the cycle mode of the LF sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Performs a complete sweep cycle from the start to the end value
when a trigger event occurs.
The dwell time determines the time period until the signal
switches to the next step.
MANual
Performs a single sweep step when a manual trigger event
occurs.
The trigger system is not active. To trigger each frequency step
of the sweep individually, use the command [:SOURce<hw>]:
LFOutput:FREQuency:MANual on page 498.
STEP
Each trigger command triggers one sweep step only.
The frequency increases by the value set with the coammnds:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:
LINear] (linear spacing)
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:
LOGarithmic(logarithmic spacing)
*RST: AUTO

Example: See Example "Setting up an LF sweep" on page 495.
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Manual operation: See "Mode" on page 151

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:POINts <Points>

Sets the number of steps in an LF sweep.

For information on how the value is calculated and the interdependency with other
parameters, see Section 7.2.1, "Correlating parameters in sweep mode", on page 143

Parameters:
<Points> integer

Range: 2  to  POINts
*RST: 50

Example: See Example "Setting up an LF sweep" on page 495.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace <State>

Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Retrace" on page 152

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RUNNing?

Queries the current status of the LF frequency sweep mode.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Setting up an LF sweep" on page 495.

Usage: Query only

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe <Shape>

Sets the cycle mode for a sweep sequence (shape).

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Shape" on page 152
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[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing <Spacing>

Selects linear or logarithmic sweep spacing.

Parameters:
<Spacing> LINear | LOGarithmic

*RST: LINear

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Spacing" on page 154

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:LOGarithmic
<Logarithmic>

Sets the step width factor for logarithmic sweeps to calculate the frequencies of the
steps.

For information on how the value is calculated and the interdependency with other
parameters, see Section 7.2.1, "Correlating parameters in sweep mode", on page 143

Parameters:
<Logarithmic> float

The unit is mandatory
Range: 0.01  to  100
Increment: 0.01
*RST: 1
Default unit: PCT

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Step Linear/Step Logarithmic" on page 157

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:LINear] <Linear>

Sets the step width for the linear sweep.

For information on how the value is calculated and the interdependency with other
parameters, see Section 7.2.1, "Correlating parameters in sweep mode", on page 143

Parameters:
<Linear> float

Range: 0.1  to  STOP-STARt
Increment: 0.1
*RST: 1000

Example: See Example "Setting up an LF sweep" on page 495.

Manual operation: See "Step Linear/Step Logarithmic" on page 157
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13.16.7  SOURce:LIST subsystem

The SOURce:LIST subsystem contains all commands for defining lists and for han-
dling of list files.

List files have the predefined file extension *.lsw.

Refer to Section 13.5.2, "Handling files in the default or in a specified directory",
on page 383 for general information on file handling in the default and in a specific
directory.

● *RST does not affect data lists.
● SCPI refers to the individual lists as segments.

Example: Create an RF list and activate the list mode
The following example shows a command sequence to create an RF list and to acti-
vate the list mode. Further hardware settings are not considered.

// Reset the instrument to start from an initial state
// Query the available list files in the default 
// directory /var/user
// Select the list file or create it (if not existing)
*RST; *CLS
:SOURce1:LIST:CAT?
// Response:- shows the name of available list files (if applicable)
:SOURce1:LIST:SEL "/var/user/list1.lsw"

// Write the frequency/level/dwell time values in the selected list file
// existing data is overwritten
// Query the number of frequency/power/dwell time entries in the selected list
// Query the amount of free memory (in bytes) for list mode lists
:SOURce1:LIST:FREQ 58 MHz, 61 MHz, 73 MHz, 86 MHz, 91 MHz, 92 MHz, 98 MHz
:SOURce1:LIST:POW 13 dBm, 12 dBm, 5 dBm, 3 dBm, 0 dBm, 4 dBm, 6 dBm 
:SOURce1:LIST:DWEL:LIST 10000, 100000, 200000, 19000, 10000, 150000, 220000 
:SOURce1:LIST:FREQ:POIN?
// 7 
:SOURce1:LIST:POW:POINT?
// 7
:SOURce1:LIST:DWEL:LIST:POIN?
// 7 
:SOURce1:LIST:FREE?
// 2147483647 (bytes of free memory)

// Use dwell times from list
// Configure the list mode parameters
// Enable RF output
:SOURce1:LIST:MODE AUTO
:SOURce1:LIST:TRIG:SOUR AUTO
:SOURce1:LIST:DWEL:MODE "LIST"
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:OUTPut1:STAT ON

// Use global dwell time
// Set only a part of the list (value pairs 3 to 5) to be processed
// Configure the list mode parameters using global dwell time
// Enable RF output
:SOURce1:LIST:IND:START 2
:SOURce1:LIST:IND:STOP 4
:SOURce1:LIST:MODE AUTO
:SOURce1:LIST:TRIG:SOUR AUTO
:SOURce1:LIST:DWEL:LIST 500 ms
:OUTPut1:STAT ON

// Enable the list mode
// Trigger the list (depending on the mode, not needed with trigger 
// mode AUTO); query the current index 
// Reset the list to the starting point
:SOURce1:FREQ:MODE LIST
:SOURce1:LIST:TRIG:EXEC
:SOURce1:LIST:RUNN?
:SOURce1:LIST:IND?
// 3
// value changes when the value is queried again
:SOURce1:LIST:RES

// For list mode STEP use the following commands 
*RST; *CLS
// Change list mode to STEP
:SOURce1:LIST:MODE STEP
// Activate RF Output1
:OUTPut1:STAT 1
// Activate the list mode
:SOURce1:FREQ:MODE LIST
// For each step: select frequency/powerlevel pair as index from the list 
:SOURce1:LIST:IND 2
:SOURce1:LIST:IND 3
:SOURce1:LIST:IND 4

// Use the selected list for path B (with List Mode B default settings)
:SOURce2:LIST:SEL "/var/user/list1.lsw"
:OUTPut2:STAT ON
:SOURce2:FREQ:MODE LIST
:SOURce2:LIST:IND?
// 2 
// value canges when the value is queried again

// Deactivate the list mode
:SOURce1:FREQ:MODE CW
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Example: List mode data exchange
The following example shows a command sequence to export a list (here the RF list
created with the example before) into an ASCII file. Further hardware settings are not
considered.

*RST; *CLS
LIST:DEXC:MODE EXP

// Set ASCII data parameters
// Set the ASCII file extension, the decimal separator
// and the column separator for the ASCII data
:SOURce1:LIST:DEXC:AFIL:EXT CSV
:SOURce1:LIST:DEXC:AFIL:SEP:DEC DOT
:SOURce1:LIST:DEXC:AFIL:SEP:COL COMM 

// Select source and destination path/directory 
// Query available listfiles in default directory "/var/user"
:SOURce1:LIST:CAT?
// list1
:SOURce1:LIST:DEXC:AFIL:SEL "/var/user/list1ASCII"
:SOURce1:LIST:DEXC:SEL "/var/user/list1" 

// Export the list file data into the ASCII file
:SOURce1:LIST:DEXC:EXEC

// Query the available ASCII files with extension .csv
:SOURce1:LIST:DEXC:AFIL:CAT?
// Response: "list1ASCII"

// Deactivate the list mode
:SOURce1:FREQ:MODE CW

● List mode settings................................................................................................. 510
● List mode file operation.........................................................................................516
● List mode data exchange......................................................................................518

13.16.7.1  List mode settings

With the following commands, you can create list mode data, select the trigger mode
and determine the dwell time.

[:SOURce<hw>]:LIST:DWELl...........................................................................................511
[:SOURce<hw>]:LIST:DWELl:MODE................................................................................ 511
[:SOURce<hw>]:LIST:DWELl:LIST................................................................................... 511
[:SOURce<hw>]:LIST:DWELl:LIST:POINts?......................................................................512
[:SOURce<hw>]:LIST:FREQuency...................................................................................512
[:SOURce<hw>]:LIST:FREQuency:POINts?......................................................................513
[:SOURce<hw>]:LIST:INDex............................................................................................513
[:SOURce<hw>]:LIST:INDex:STARt................................................................................. 513
[:SOURce<hw>]:LIST:INDex:STOP..................................................................................513
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[:SOURce<hw>]:LIST:MODE...........................................................................................513
[:SOURce<hw>]:LIST:POWer.......................................................................................... 514
[:SOURce<hw>]:LIST:POWer:POINts?.............................................................................514
[:SOURce<hw>]:LIST:TRIGger:EXECute..........................................................................515
[:SOURce<hw>]:LIST:TRIGger:SOURce.......................................................................... 515
[:SOURce<hw>]:LIST:RUNNing?..................................................................................... 516

[:SOURce<hw>]:LIST:DWELl <Dwell>

Sets the global dwell time. The instrument generates the signal with the frequency /
power value pairs of each list entry for that particular period.

See also Significant parameters and functions.

Parameters:
<Dwell> float

Range: 1E-3  to  100
Increment: 1E-6
*RST: 0.01

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Global Dwell Time" on page 162

[:SOURce<hw>]:LIST:DWELl:MODE <DwelMode>

Selects the dwell time mode.

Parameters:
<DwelMode> LIST | GLOBal

LIST
Uses the dwell time, specified in the data table for each value
pair individually.
GLOBal
Uses a constant dwell time, set with command [:
SOURce<hw>]:LIST:DWELl.
*RST: GLOBal

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Dwell Time Mode" on page 161

[:SOURce<hw>]:LIST:DWELl:LIST <Dwell>

Enters the dwell time values in the selected list in µs.
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Parameters:
<Dwell> <Dwell#1>{, <Dwell#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data. The list of numbers can be of any length, with the list
entries separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy. See also :
FORMat[:DATA] on page 412 for more details.

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Dwell Time (s)" on page 167

[:SOURce<hw>]:LIST:DWELl:LIST:POINts?

Queries the number (points) of dwell time entries in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Query only

[:SOURce<hw>]:LIST:FREQuency <Frequency>

Enters the frequency values in the selected list.

Parameters:
<Frequency> <Frequency#1>{, <Frequency#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data.
The list of numbers can be of any length, with the list entries
separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See also :FORMat[:DATA].
Range: 300 kHz  to  RFmax (depends on the installed

options)

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Frequency (Hz)" on page 167
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[:SOURce<hw>]:LIST:FREQuency:POINts?

Queries the number (points) of frequency entries in the seleced list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Query only

[:SOURce<hw>]:LIST:INDex <Index>

Sets the list index in LIST:MODE STEP.

After the trigger signal, the instrument processes the frequency and level settings of
the selected index.

Parameters:
<Index> integer

*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Current Index" on page 161

[:SOURce<hw>]:LIST:INDex:STARt <Start>
[:SOURce<hw>]:LIST:INDex:STOP <Stop>
Sets the start and stop index of the index range which defines a subgroup of fre-
quency/level value pairs in the current list.

Parameters:
<Stop> integer

Index range
Only values inside this range are processed in list mode
Range: 0  to  list length
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "List Range from/to" on page 163

[:SOURce<hw>]:LIST:MODE <Mode>

Sets the list mode.
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The instrument processes the list according to the selected mode and trigger source.
See LIST:TRIG:SOUR AUTO, SING or EXT for the description of the trigger
source settings.

Parameters:
<Mode> AUTO | STEP

AUTO
Each trigger event triggers a complete list cycle.
STEP
Each trigger event triggers only one step in the list processing
cycle. The list is processed in ascending order.
*RST: AUTO

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Mode" on page 161

[:SOURce<hw>]:LIST:POWer <Power>

Enters the level values in the selected list. The number of level values must corre-
spond to the number of frequency values. Existing data is overwritten.

Parameters:
<Power> <Power#1>{, <Power#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data.
The list of numbers can be of any length, with the list entries
separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See also :FORMat[:DATA].
Range: depends on the installed options
Default unit: dBm

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Power (dBm)" on page 167

[:SOURce<hw>]:LIST:POWer:POINts?

Queries the number (points) of level entries in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.
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Usage: Query only

[:SOURce<hw>]:LIST:TRIGger:EXECute

Starts the processing of a list in list mode.

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Event

Manual operation: See "Execute Single" on page 162

[:SOURce<hw>]:LIST:TRIGger:SOURce <Source>

Selects the trigger source for processing lists.

The designation of the parameters correspond to those in sweep mode. SCPI standard
uses other designations for the parameters, which are also accepted by the instrument.
The SCPI designation should be used if compatibility is an important consideration. For
an overview, see the following table:

Rohde & Schwarz parameter SCPI parameter Applies to the list mode parameters:

AUTO IMMediate [:SOURce<hw>]:LIST:MODE AUTO

SINGle BUS [:SOURce<hw>]:LIST:MODE AUTO or

[:SOURce<hw>]:LIST:MODE STEP

EXTernal EXTernal [:SOURce<hw>]:LIST:MODE AUTO or

[:SOURce<hw>]:LIST:MODE STEP

Parameters:
<Source> AUTO | IMMediate | SINGle | BUS | EXTernal

AUTO|IMMediate
The trigger is free-running, i.e. the trigger condition is fulfilled
continuously. The selected list is restarted as soon as it is fin-
ished.
SINGle|BUS
The list is triggered by the command [:SOURce<hw>]:LIST:
TRIGger:EXECute. The list is executed once.
EXTernal
The list is triggered externally and executed once.
*RST: AUTO

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "Mode" on page 161
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[:SOURce<hw>]:LIST:RUNNing?

Queries the current state of the list mode.

Return values: 
<State> 1 | ON | 0 | OFF

1
Signal generation based on the list mode is active.

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Query only

13.16.7.2  List mode file operation

The following section covers basic commands to file handling in list mode.

[:SOURce<hw>]:LIST:CATalog?.......................................................................................516
[:SOURce<hw>]:LIST:DELete..........................................................................................516
[:SOURce<hw>]:LIST:DELete:ALL................................................................................... 517
[:SOURce<hw>]:LIST:FREE?.......................................................................................... 517
[:SOURce<hw>]:LIST:RESet........................................................................................... 517
[:SOURce<hw>]:LIST:SELect.......................................................................................... 518

[:SOURce<hw>]:LIST:CATalog?

Queries the available list files in the specified directory.

Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Query only

Manual operation: See "List Mode Data" on page 163

[:SOURce<hw>]:LIST:DELete <Filename>

Deletes the specified list.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See [:SOURce<hw>]:LIST:DELete:ALL on page 517.

Usage: Setting only

Manual operation: See "List Mode Data" on page 163
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[:SOURce<hw>]:LIST:DELete:ALL

Deletes all lists in the set directory.

This command can only be executed, if:
● No list file is selected.
● List mode is disabled.

Example: SOUR1:LIST:CAT?
// list,my_list
SOUR1:LIST:DEL "/var/user/list1"
SOUR1:LIST:CAT?
// my_list
SOUR1:FREQ:MODE?
// LIST
SOUR1:LIST:SEL?
// /var/user/my_list.lsw
//deactivate list mode
SOUR1:FREQ:MODE CW
SOUR1:LIST:DELete:ALL
SOUR1:LIST:CAT?
// -
// all list files are deleted

Usage: Event

Manual operation: See "List Mode Data" on page 163

[:SOURce<hw>]:LIST:FREE?

Queries the amount of free memory (in bytes) for list mode lists.

Return values: 
<Free> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Query only

[:SOURce<hw>]:LIST:RESet

Jumps to the beginning of the list.

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Usage: Event

Manual operation: See "Reset" on page 162
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[:SOURce<hw>]:LIST:SELect <Filename>

Selects or creates a data list in list mode.

If the list with the selected name does not exist, a new list is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "Create an RF list and activate the list mode"
on page 508.

Manual operation: See "List Mode Data" on page 163
See "Functions for handling of data lists" on page 236

13.16.7.3  List mode data exchange

With the following commands, you can configure lists in ASCII format and export or
import them accordingly.

[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog?.......................................................... 518
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension.........................................................518
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect..............................................................519
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn........................................... 519
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal........................................... 519
[:SOURce<hw>]:LIST:DEXChange:EXECute.................................................................... 519
[:SOURce<hw>]:LIST:DEXChange:MODE........................................................................520
[:SOURce<hw>]:LIST:DEXChange:SELect....................................................................... 520

[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog?

Queries the available ASCII files for export or import of list mode data in the current or
specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.

Example: See Example "List mode data exchange" on page 510.

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII file for import or export, or to query existing
files.
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Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 97

[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets "." (decimal point) or "," (comma) as the decimal separator used in the ASCII data
with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "ASCII File Settings" on page 96

[:SOURce<hw>]:LIST:DEXChange:EXECute

Executes the import or export of the selected list file, according to the previously set
transfer direction with command [:SOURce<hw>]:LIST:DEXChange:MODE
Example: See Example "List mode data exchange" on page 510.
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Usage: Event

Manual operation: See "Import / Export" on page 97

[:SOURce<hw>]:LIST:DEXChange:MODE <Mode>

Determines the import or export of a list.

Specify the source or destination file with the command [:SOURce<hw>]:LIST:
DEXChange:SELect.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "Mode" on page 96

[:SOURce<hw>]:LIST:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "List mode data exchange" on page 510.

Manual operation: See "Select Source/Select ASCII Destination" on page 97

13.16.8  SOURce:NOISe subsystem

The SOURce:NOISe subsystem contains the commands for:
● Setting the noise modulation signal. The noise generator is optional.

Example: To configure the noise generator
:SOURce1:NOISe:DISTribution GAUSs
:SOURce1:NOISe:BANDwidth 10000000

:SOURce1:LFOutput1:SOURce NOIS
:SOURce1:LFOutput1:STATe 1

:SOURce1:NOISe:LEVel:RELative?
// Response in dB: -83.86
:SOURce1:NOISe:LEVel:ABSolute?
// Response in dB: -13.86

● Noise generator.....................................................................................................521
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13.16.8.1  Noise generator

[:SOURce<hw>]:NOISe:BANDwidth|BWIDth.....................................................................521
[:SOURce<hw>]:NOISe:DISTribution............................................................................... 521
[:SOURce<hw>]:NOISe:LEVel:RELative?......................................................................... 521
[:SOURce<hw>]:NOISe:LEVel[:ABSolute]?.......................................................................521

[:SOURce<hw>]:NOISe:BANDwidth|BWIDth <BWidth>

Sets the noise level in the system bandwidth when bandwidth limitation is enabled.

Parameters:
<BWidth> float

Range: 100E3  to  10E6
Increment: 100E3
*RST: 100E3

Example: See Example "To configure the noise generator" on page 520.

Manual operation: See "Bandwidth" on page 106

[:SOURce<hw>]:NOISe:DISTribution <Distribution>

Sets the distribution of the noise power density.

Parameters:
<Distribution> GAUSs | EQUal

*RST: GAUSs

Example: See Example "To configure the noise generator" on page 520.

Manual operation: See "Distribution" on page 106

[:SOURce<hw>]:NOISe:LEVel:RELative?

Queries the level of the noise signal per Hz in the total bandwidth.

Return values: 
<Relative> float

Range: -149.18  to  -52.67
Increment: 0.1
*RST: -69.84

Example: See Example "To configure the noise generator" on page 520.

Usage: Query only

Manual operation: See "Noise Density" on page 109

[:SOURce<hw>]:NOISe:LEVel[:ABSolute]?

Queries the level of the noise signal in the system bandwidth within the enabled band-
width limitation.
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Return values: 
<Absolute> float

Noise level within the bandwidth limitation
*RST: 3.84 MHz

Example: See Example "To configure the noise generator" on page 520.

Usage: Query only

Manual operation: See "Noise Level" on page 109

13.16.9  SOURce:PGEN subsystem

The PGEN subsystem contains the commands for setting output of the pulse modula-
tion signal.

Example: Using pulse generator as source for pulse modulation
// select pulse generator as source for pulse modulation
// enable pulse modulation
SOURce1:PULM:SOURce INT
SOURce1:PULM:STATe 1
// pulse generator and signal output are also activated
SOURce1:PGENerator:STATe?
// 1
SOURce1:PGENerator:OUTPut:STATe?
// 1
PGENerator:OUTPut:POLarity NORMal
// to disable pulse generator
SOURce1:PGENerator:STATe 0
// activate the pulse modulation of the RF carrier
SOURce1:PULM:STATe 1

[:SOURce<hw>]:PGENerator:OUTPut:POLarity................................................................ 522
[:SOURce<hw>]:PGENerator:OUTPut[:STATe]..................................................................523
[:SOURce<hw>]:PGENerator:STATe................................................................................ 523

[:SOURce<hw>]:PGENerator:OUTPut:POLarity <Polarity>

Sets the polarity of the pulse output signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
Outputs the pulse signal during the pulse width, that means dur-
ing the high state.
INVerted
Inverts the pulse output signal polarity. The pulse output signal is
suppressed during the pulse width, but provided during the low
state.
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*RST: NORMal

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 522.

Manual operation: See "Pulse Output Polarity" on page 91

[:SOURce<hw>]:PGENerator:OUTPut[:STATe] <State>

Activates the output of the pulse modulation signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 522.

Manual operation: See "Pulse Output State" on page 90

[:SOURce<hw>]:PGENerator:STATe <State>

Enables the output of the video/sync signal.

If the pulse generator is the current modulation source, activating the pulse modulation
automatically activates the signal output and the pulse generator.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 522.

13.16.10  SOURce:PHASe subsystem

This subsystem contains the commands for adjusting the phase of the RF output signal
relative to a reference signal of the same frequency.

Example: Programming Example
// change the phase relative to the current phase
SOURce1:PHASe 2 DEG
// adopt the setting as the current phase
SOURce1:PHASe:REFerence

The following commands are available:

[:SOURce<hw>]:PHASe................................................................................................. 524
[:SOURce<hw>]:PHASe:REFerence................................................................................ 524
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[:SOURce<hw>]:PHASe <Phase>

Sets the phase variation relative to the current phase.

Parameters:
<Phase> float

Range: -36000 to 36000
Increment: 0.001
*RST: 0
Default unit: DEG

Example: See Example "Programming Example" on page 523.

Manual operation: See "Delta Phase" on page 66

[:SOURce<hw>]:PHASe:REFerence

Assigns the value set with command [:SOURce<hw>]:PHASe as the reference
phase.

Example: See Example "Programming Example" on page 523.

Usage: Event

Manual operation: See "Reset Delta Phase Display" on page 66

13.16.11  SOURce:POWer subsystem

The SOURce:POWer subsystem contains the commands for setting the output level,
level control and level correction of the RF signal.

The default units are dBm. To change the units, perform one of the following:
● Enter the unit after the numerical value

Example: :POW 0.5V
● Set the unit with the command :UNIT:POWer.

Example: Configuring the RF output power

:SOURce1:POWer;CW? 
// Response -30
:SOURce1:POWer:CW -25
:SOURce1:POWer:OFFSet?
// Response 0
:SOURce1:POWer:OFFSet 2

:SOURce1:POWer:STEP:MODE?
// Response: DEC
:SOURce1:POWer:STEP:MODE USER
:SOURce1:POWer:STEP:INCRement 2
:SOURce1:POWer:LEVel:IMMediate:AMPLitude UP
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Example: Configure the settings for NRP power control
The example shows a command sequence to configure a closed loop power control
setup.
It is assumed that you have set up the measurement with the amplifier, external cou-
pler, the power sensor and the R&S SMB100B as described in Section 8.4.4, "NRP
power control", on page 193.
// Reset the instrument to start from an initial state
*RST; *CLS

// Select the sensor used for nrp power control
// that is e.g., connected to a second USB interface

:SOURce1:POWer:SPC:SELect SENS2

// Configure the nrp power control settings 
// use the measured peak power for power control
// set the unit dBm for the target level value
// set the target level, e.g. - 10 dBmM
// use the measured target level as reference level
// select single measurement mode to acquire one level value
// set the capture range for the control loop, e.g.  +/- 15 dB 
// set a time delay between the sensor readings, e.g. 2 ms

:SOURce1:POWer:SPC:PEAK ON
:SENSe1:UNIT:POWer DMB
:SOURce1:POWer:SPC:TARGet -10
:SOURce1:POWer:SPC:MEASure
:SOURce1:POWer:SPC:MODE SINGle
:SOURce1:POWer:SPC:CRANge 15
:SOURce1:POWer:SPC:DELay 2 ms

// Enable NRP power control measurement
// switch on RF output
// start the single measurement manually

:Output1:STATe 1
:SOURce1:POWer:SPC:STATe ON
:SOURce1:POWer:SPC:SINGle

// Query if the power control works properly
:SOURce1:POWer:SPC:WARNing?
// Response: 1 -> power conrol doew not work as expected

SOURce subsystem



Remote control commandsR&S®SMB100B

526User Manual 1178.3711.02 ─ 11

Example: Configuring level attenuator

SOURce1:POWer:ATTenuation 20dB
// set the level attenuation manually

SOURce1:POWer:ATTuation:RFOF:MODE FATTenuation
// set maximum attenuation when the RF output is turned off

SOURce:POWer:ATTenuation:VSWR?
// query the level value of the VSWR output

SOURce1:POWer:AATTenuation?
// query the currently active attenuation
// Response: 100

SOURce1:POWer:ATTenuation:DIGital 7.2

Example: Setting a digital attenuation

SOURce1:POWer:ATTenuation:DIGital 7.2
// set an attenuation for the baseband signal.

[:SOURce<hw>]:POWer:ALC[:STATe].............................................................................. 527
[:SOURce<hw>]:POWer:ALC:DSENsitivity....................................................................... 527
[:SOURce<hw>]:POWer:ALC:SONCe.............................................................................. 528
[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE......................................................... 528
[:SOURce<hw>]:POWer:EMF:STATe................................................................................528
[:SOURce<hw>]:POWer:LBEHaviour............................................................................... 529
[:SOURce<hw>]:POWer:LIMit[:AMPLitude].......................................................................529
[:SOURce<hw>]:POWer:MANual.....................................................................................529
[:SOURce<hw>]:POWer:MODE.......................................................................................530
[:SOURce<hw>]:POWer:POWer......................................................................................530
[:SOURce<hw>]:POWer:STARt....................................................................................... 531
[:SOURce<hw>]:POWer:STOP........................................................................................531
[:SOURce<hw>]:POWer:SPC:CRANge............................................................................ 531
[:SOURce<hw>]:POWer:SPC:DELay............................................................................... 531
[:SOURce<hw>]:POWer:SPC:MEASure........................................................................... 532
[:SOURce<hw>]:POWer:SPC:MODE............................................................................... 532
[:SOURce<hw>]:POWer:SPC:PEAK................................................................................ 532
[:SOURce<hw>]:POWer:SPC:SELect.............................................................................. 532
[:SOURce<hw>]:POWer:SPC:SINGle.............................................................................. 533
[:SOURce<hw>]:POWer:SPC:STATe................................................................................533
[:SOURce<hw>]:POWer:SPC:TARGet............................................................................. 533
[:SOURce<hw>]:POWer:SPC:WARNing?......................................................................... 533
[:SOURce<hw>]:POWer:STEP:MODE............................................................................. 534
[:SOURce<hw>]:POWer:STEP[:INCRement].................................................................... 534
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet........................................................ 535
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[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL............................................................. 535
[:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude]..................................................535
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:REFLevel..................................................... 536
[:SOURce<hw>]:POWer:RANGe:LOWer?........................................................................ 536
[:SOURce<hw>]:POWer:RANGe:UPPer?......................................................................... 536
[:SOURce]:POWer:WIGNore...........................................................................................537

[:SOURce<hw>]:POWer:ALC[:STATe] <State>

Parameters:
<State> 0 | OFF | AUTO | 1 | ON | ONTable | PRESet | OFFTable

AUTO
Adjusts the output level to the operating conditions automati-
cally.
1|ON
Activates internal level control permanently.
OFFTable
Controls the level using attenuation values of the internal ALC
table.
0|OFF
R&S SMB100B RF instruments only
Deactivates the ALC, but allows you to recalibrate the level at
each frequency and level change. The value remains up to the
next change.
ONTable
Starts with the attenuation setting from the table and continues
with automatic level control.
*RST: AUTO

Example: POW:ALC ON
Activates internal level control.

Manual operation: See "State" on page 175

[:SOURce<hw>]:POWer:ALC:DSENsitivity <Sensitivity>

Sets the sensitivity of the ALC detector.

Parameters:
<Sensitivity> AUTO | FIXed | LOW | MEDium | HIGH

AUTO
Selects the optimum sensitivity automatically.
LOW|MEDium|HIGH
Sets either low, medium or high sensitivity.
FIXed
Fixes the internal level detector.
*RST: AUTO

Example: POW:ALC:DSEN FIX

SOURce subsystem



Remote control commandsR&S®SMB100B

528User Manual 1178.3711.02 ─ 11

Manual operation: See "Detector Sensitivity" on page 176

[:SOURce<hw>]:POWer:ALC:SONCe

Activates level control for correction purposes temporarily.

Example: POW:ALC OFF
Deactivates automatic level control at the RF output.
POW:ALC:SONC
Executes level control (once).

Usage: Event

Manual operation: See "Readjust" on page 65

[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE <Mode>

Selects the state the attenuator is to assume if the RF signal is switched off.

Parameters:
<Mode> UNCHanged | FATTenuation

FATTenuation
The step attenuator switches to maximum attenuation
UNCHanged
Retains the current setting and keeps the output impedance
constant during RF off.
*RST: n.a. (factory preset: FATTenuation)

Example: SOURce1:POWer:ATTenuation:RFOFf:MODE
FATTenuation
uses maximum attenuation when the RF output is turned off.

Manual operation: See "RF OFF Mode" on page 173

[:SOURce<hw>]:POWer:EMF:STATe <State>

Displays the signal level as voltage of the EMF. The displayed value represents the
voltage over a 50 Ohm load.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: POW:EMF:STAT 1
Activates voltage level display.

Manual operation: See "Display Level as Voltage of EMF" on page 258
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[:SOURce<hw>]:POWer:LBEHaviour <Behaviour>

Selects the level behavior at the RF output over time.

Parameters:
<Behaviour> AUTO | UNINterrupted | MONotone | CVSWr | USER | CPHase

UNINterrupted|MONotone
Uninterrupted level settings and strictly monotone modes.
CWSWr
Constant VSWR
*RST: AUTO

Example: SOURce1:POWer:LBEHaviour AUTO

Manual operation: See "Setting Characteristics" on page 64

[:SOURce<hw>]:POWer:LIMit[:AMPLitude] <Amplitude>

Limits the maximum RF output level in CW and sweep mode.

It does not influence the "Level" display or the response to the query [:
SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude].

Parameters:
<Amplitude> float

Range: depends on the installed options
Increment: 0.01
*RST: n.a. (factory preset: 30)

Example: SOURce1:POWer:LIMit:AMPLitude 10

Manual operation: See "Limit" on page 63

[:SOURce<hw>]:POWer:MANual <Manual>

Sets the level for the subsequent sweep step if SWE:POW:MODE MAN.

Use a separate command for each sweep step.

Parameters:
<Manual> float

You can select any level within the setting range, where:
STARt is set with [:SOURce<hw>]:POWer:STARt
STOP is set with [:SOURce<hw>]:POWer:STOP
OFFSet is set with [:SOURce<hw>]:POWer[:LEVel][:
IMMediate]:OFFSet
Range: (STARt + OFFSet) to (STOP + OFFSet)
Increment: 0.01
Default unit: dBm

Example: See Example "Setting up an RF frequency or power sweep"
on page 544
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Manual operation: See "Current Level" on page 151

[:SOURce<hw>]:POWer:MODE <Mode>

Selects the operating mode of the instrument to set the output level.

Parameters:
<Mode> CW | FIXed | SWEep

CW|FIXed
Operates at a constant level.
CW and FIXed are synonyms.
To set the output level value, use the command [:
SOURce<hw>]:POWer[:LEVel][:IMMediate][:
AMPLitude].
SWEep
Sets sweep mode.
Set the range and current level with the commands:
[:SOURce<hw>]:POWer:STARt and [:SOURce<hw>]:
POWer:STOP,
[:SOURce<hw>]:POWer:MANual.
*RST: CW

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Manual operation: See "State (RF level sweep)" on page 150
See "State (RF frequency / level sweep)" on page 151

[:SOURce<hw>]:POWer:POWer <Power>

Sets the level at the RF output connector.

This value does not consider a specified offset.

The command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude]
sets the level of the "Level" display, that means the level containing offset.

See "RF frequency and level display with a downstream instrument" on page 58.

Parameters:
<Power> float

Level at the RF output, without level offset
Range: See specifications document.
Increment: 0.01
Default unit: dBm

Example: SOURce1:POWer:POWer 15
// sets the level at the RF output.

Manual operation: See "Amplitude" on page 63
See "Generator Settings used for Measurement" on page 186
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[:SOURce<hw>]:POWer:STARt <Start>
[:SOURce<hw>]:POWer:STOP <Stop>
Sets the RF start/stop level in sweep mode.

Parameters:
<Stop> float

Sets the setting range calculated as follows:
(Level_min + OFFSet) to (Level_max + OFFSet)
Where the values are set with the commands:
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet
[:SOURce<hw>]:POWer:STARt
[:SOURce<hw>]:POWer:STOP
Range: Minimum level to maximum level
*RST: -30 (Start)/ -10 (Stop)
Default unit: dBm

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Manual operation: See "Start Level / Stop Level" on page 158

[:SOURce<hw>]:POWer:SPC:CRANge <PowCntrlCRange>

Defines the capture range of the power control system.

Within the range:

Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the
range are not considered.

Parameters:
<PowCntrlCRange> float

Range: 0  to  50
Increment: 0.01
*RST: 30

Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "Catch Range +/-" on page 197

[:SOURce<hw>]:POWer:SPC:DELay <PowCntrlDelay>

Sets a waiting time for the generator to adjust the output level. After the delay time has
elapsed, the power sensor measures the next value.

Parameters:
<PowCntrlDelay> integer

Range: 0  to  1000
*RST: 0
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Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "Delay Time" on page 197

[:SOURce<hw>]:POWer:SPC:MEASure

Sets the measured power value as reference level.

Example: See Example "Configure the settings for NRP power control"
on page 525

Usage: Event

Manual operation: See "Take Measurement as Target Level" on page 196

[:SOURce<hw>]:POWer:SPC:MODE <ControlMode>

Selects the measurement mode for the power sensor.

Parameters:
<ControlMode> AUTO | SINGle

AUTO
Measures the level values continuously.
SINGle
Executes one measurement, triggered by the command [:
SOURce<hw>]:POWer:SPC:SINGle on page 533.
*RST: AUTO

Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "Mode" on page 196

[:SOURce<hw>]:POWer:SPC:PEAK <PowCntrlPeak>

Activates power control by means of the peak power values, provided the power sen-
sor supports this function.

Parameters:
<PowCntrlPeak> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure the settings for NRP power control"
on page 525

[:SOURce<hw>]:POWer:SPC:SELect <PowCntrlSelect>

Selects the power sensor used for power control.
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Parameters:
<PowCntrlSelect> SENS1 | SENS2 | SENS3 | SENS4 | SENSor1 | SENSor2 |

SENSor3 | SENSor4
*RST: SENS1

Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "Sensor" on page 196

[:SOURce<hw>]:POWer:SPC:SINGle

Triggers the power sensor to measure the power value once.

Usage: Event

Manual operation: See "Execute Single" on page 196

[:SOURce<hw>]:POWer:SPC:STATe <PowCntrlState>

Starts power control using the selected sensor. The control loop periodically adjusts
the output level of the signal generator. After switching off, the running loop is comple-
ted.

Parameters:
<PowCntrlState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "State" on page 195

[:SOURce<hw>]:POWer:SPC:TARGet <PowCntrlTarget>

Sets the target level required at the DUT. To define the unit of the power value, use
command :UNIT:POWer on page 596.

Parameters:
<PowCntrlTarget> float

Range: -50  to  30
Increment: 0.01
*RST: -10

Example: See Example "Configure the settings for NRP power control"
on page 525

Manual operation: See "Target Level" on page 196

[:SOURce<hw>]:POWer:SPC:WARNing?

Queries if the activated power control works properly.
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If the power control does not work, the query returns warning state 1. On the screen,
the R&S SMB100B indicates a warning icon.

Return values: 
<WarningState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure the settings for NRP power control"
on page 525.

Usage: Query only

[:SOURce<hw>]:POWer:STEP:MODE <Mode>

Defines the type of step width to vary the RF output power step-by-step with the com-
mands POW UP or POW DOWN.

Parameters:
<Mode> DECimal | USER

DECimal
Increases or decreases the level in steps of ten.
USER
Increases or decreases the level in increments, determined with
the command [:SOURce<hw>]:POWer:STEP[:INCRement].
*RST: DECimal

Example: See Example "Configuring the RF output power" on page 524.

Manual operation: See "Variation Active" on page 61

[:SOURce<hw>]:POWer:STEP[:INCRement] <Increment>

Specifies the step width in the appropriate path for POW:STEP:MODE USER.

To adjust the level step-by-step with this increment value, use the command POW UP,
or POW DOWN.

Note: The command also sets "Variation Step" in the manual control, that means the
user-defined step width for setting the level with the rotary knob or the [Up/Down]
arrow keys.

Parameters:
<Increment> float

Range: 0  to  200
Increment: 0.01
*RST: 1
Default unit: dB

Example: See Example "Configuring the RF output power" on page 524.

Manual operation: See "Variation Step" on page 61
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[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet <Offset>

Sets the level offset of a downstream instrument.

The level at the RF output is not changed.

To query the resulting level, as it is at the output of the downstream instrument, use the
command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude].

See "RF frequency and level display with a downstream instrument" on page 58.

Note: The level offset also affects the RF level sweep.

Parameters:
<Offset> float

Range: -100 to 100
Increment: 0.01
*RST: 0
Default unit: dB
Level offset is always expreced in dB; linear units (V, W, etc.) are
not supported

Example: POWer:OFFSet 10
Sets the RF level offset to 10 dB

Manual operation: See "Offset" on page 64
See "Generator Settings used for Measurement" on page 186

[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL <Rcl>

Determines whether the current level is retained or if the stored level setting is adopted
when an instrument configuration is loaded.

Parameters:
<Rcl> INCLude | EXCLude

INCLude
Takes the current level when an instrument configuration is loa-
ded.
EXCLude
Retains the current level when an instrument configuration is
loaded.
*RST: INCLude

Example: POW:RCL INCL
Takes the level value from an instrument configuration loaded
with command *RCL.

Manual operation: See "Exclude Level" on page 232

[:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude] <Amplitude>

Sets the RF level applied to the DUT.
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To activate the RF output use command :OUTPut<hw>[:STATe] ("RF On"/"RF Off").

The following applies POWer = RF output level + OFFSet, where:
● POWer is the values set with [:SOURce<hw>]:POWer[:LEVel][:

IMMediate][:AMPLitude]
● RF output level is set with [:SOURce<hw>]:POWer:POWer on page 530
● OFFSet is set with [:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet
Parameters:
<Amplitude> float

The following settings influence the value range:
OFFSet set with the command [:SOURce<hw>]:POWer[:
LEVel][:IMMediate]:OFFSet
Numerical value
Sets the level
UP|DOWN
Varies the level step by step.
The level is increased or decreased by the value set with the
command [:SOURce<hw>]:POWer:STEP[:INCRement].
Range: (Level_min + OFFSet) to (Level_max + OFFStet)
*RST: -30
Default unit: dBm

Example: POWer -30
Sets the RF level

Example: See also [:SOURce<hw>]:POWer:STEP:MODE on page 534.

Manual operation: See "Amplitude" on page 63

[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:REFLevel <ReferenceLevel>

Queries the reference level of the user correction.

The reference level is the sum of the amplitude and the level offset, set with the com-
mands [:SOURce<hw>]:POWer:POWer [:SOURce<hw>]:POWer[:LEVel][:
IMMediate]:OFFSet.

Parameters:
<ReferenceLevel> float

Range: -245  to  120
Increment: 0.01
*RST: -30

Manual operation: See "Generator Settings used for Measurement" on page 186

[:SOURce<hw>]:POWer:RANGe:LOWer?
[:SOURce<hw>]:POWer:RANGe:UPPer?
Queries the current interruption-free range of the level.
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Return values: 
<Upper> float

Increment: 0.01
Default unit: dBm

Example: SOURce1:POWer:RANGe:UPPer?
// -15
SOURce1:POWer:RANGe:LOW?
// -50

Usage: Query only

Manual operation: See "Level Range" on page 65

[:SOURce]:POWer:WIGNore <State>

Ignores level range warnings.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SOURce:POWer:WIGNore 1

13.16.12  SOURce:ROSCillator subsystem

The SOURce:ROSCillator subsystem contains the commands for setting the exter-
nal and internal reference frequency.
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Example: Configuring the reference oscillator
// Using 100 MHz external reference source
SOURce:ROSCillator:PRESet 
SOURce:ROSCillator:SOURce EXT
SOURce:ROSCillator:EXTernal:RFOFf:STATe 1
SOURce:ROSCillator:EXTernal:FREQuency 100MHZ
SOURce:ROSCillator:EXTernal:SBANdwidth WIDE
// 100 MHz (loop through) and 1 GHz output
SOURce:ROSCillator:OUTPut:FREQuency:MODE LOOP
SOURce:ROSCillator:OUTPut:ALTernate:FREQuency:MODE DER1G
SOURce:ROSCillator:INTernal:ADJust:STATe 0

// Variable external reference frequency
// SOURce:ROSCillator:EXTernal:FREQuency VAR
// SOURce:ROSCillator:EXTernal:FREQuency:VARiable 100000000

// Using the internal reference frequency
SOURce:ROSCillator:SOURce INT
SOURce:ROSCillator:INTernal:TUNing:STATe 1
SOURce:ROSCillator:INTernal:TUNing:SLOPe LOW
// 10 MHz and 1 GHz output
SOURce:ROSCillator:OUTPut:FREQuency:MODE DER10M
SOURce:ROSCillator:OUTPut:ALTernate:FREQuency:MODE DER1G

// Query calibration value
CALibration:ROSCillator?
// 32767
// Set an internal source 
// Activate user-defined adjustment value of 1000
SOURce:ROSCillator:SOURce INT
SOURce:ROSCillator:INTernal:ADJust:STATe 1
SOURce:ROSCillator:INTernal:ADJust:VALue 1000

// query calibration value
CALibration:ROSCillator:DATA?
// 32767
// change the calibration value
CALibration:ROSCillator:DATA 20000
SOURce:ROSCillator:INTernal:ADJust:VALue?
// 13767
// i.e. CalValue_Def - CalValue_User = 32767 - 20000 = 13767

SOURce:ROSCillator:INTernal:ADJust:VALue 0
CALibration:ROSCillator:DATA?
// 20000
// user-defined adjustment value is 0
// i.e. user-defined adjustment is acivated 
// but the calibration value is used
// and the calibration value is the user-defined value
*RST
SOURce:ROSCillator:INTernal:ADJust:VALue?
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// -12767
// user-defined adjustment value is not affected by preset
// the adjustment value is calculated as 
// - (CalValue_Def - CalValue_User - AdjValue_User)
CALibration:ROSCillator:DATA?
// 32767
// calibration value is preset

// to resume calibrated state
SOURce:ROSCillator:INTernal:ADJust:VALue 0
SOURce:ROSCillator:INTernal:ADJust:STATe 0
// or 
// SYSTem:FPRest

[:SOURce]:ROSCillator:PRESet...................................................................................... 539
[:SOURce]:ROSCillator:SOURce..................................................................................... 539
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe].............................................................. 540
[:SOURce]:ROSCillator:EXTernal:FREQuency.................................................................. 540
[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable.................................................... 540
[:SOURce]:ROSCillator:EXTernal:SBANdwidth..................................................................540
[:SOURce]:ROSCillator:EXTernal:MLRange?....................................................................541
[:SOURce]:ROSCillator:EXTernal:NSBandwidth?.............................................................. 541
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE......................................................... 541
[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE..........................................542
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue.............................................................. 542
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe].............................................................543

[:SOURce]:ROSCillator:PRESet

Resets the reference oscillator settings.

Example: See Example "Configuring the reference oscillator" on page 538.

Usage: Event

Manual operation: See "Set to Default" on page 213

[:SOURce]:ROSCillator:SOURce <Source>

Selects between internal or external reference frequency.

Parameters:
<Source> INTernal | EXTernal

*RST: n.a. (factory preset: INTernal)

Example: See Example "Configuring the reference oscillator" on page 538.

Manual operation: See "Source" on page 213
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[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] <State>

Determines that the RF output is turned off when the external reference signal is
selected, but missing.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example "Configuring the reference oscillator" on page 538.

Manual operation: See "Deactivate RF Output (if external reference is missing)"
on page 213

[:SOURce]:ROSCillator:EXTernal:FREQuency <Frequency>

Sets the frequency of the external reference.

Parameters:
<Frequency> 100MHZ | 1GHZ | VARiable | 10MHZ

*RST: n.a. (factory preset: 10MHZ)

Example: See Example "Configuring the reference oscillator" on page 538.

Options: VARiable requires R&S SMBB-K704
1GHZ requires R&S SMBB-B3

Manual operation: See "External Reference Frequency" on page 213

[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable <Frequency>

Specifies the user-defined external reference frequency.

Parameters:
<Frequency> float

Range: 1E6  to  100E6
Increment: 0.1
*RST: n.a. (factory preset: 1E7)
Default unit: Hz

Example: See Example "Configuring the reference oscillator" on page 538.

Options: R&S SMBB-K704

Manual operation: See "Variable Reference Frequency" on page 214

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <SBandwidth>

Selects the synchronization bandwidth for the external reference signal.

Depending on the RF hardware version and the installed options, the synchronization
bandwidth varies.
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For more information, refer to the specifications document.

Parameters:
<SBandwidth> WIDE | NARRow

NARRow
The synchronization bandwidth is a few Hz.
WIDE
Uses the widest possible synchronization bandwidth.
*RST: n.a. (factory preset: WIDE)

Example: See Example "Configuring the reference oscillator" on page 538.

Manual operation: See "Synchronization Bandwidth" on page 214

[:SOURce]:ROSCillator:EXTernal:MLRange?

Queries the minimum locking range for the selected external reference frequency.

Depending on the RF hardware version, and the installed options, the minimum locking
range vaies.

For more information, refer to the specifications document.

Return values: 
<MinLockRange> string

Example: SOUR:ROSC:EXT:MLR?
Usage: Query only

Manual operation: See "Minimum Locking Range" on page 214

[:SOURce]:ROSCillator:EXTernal:NSBandwidth?

Queries the nominal synchronization bandwidth for the selected external reference fre-
quency and synchronization bandwidth.

Return values: 
<NomBandwidth> string

Example: SOUR:ROSC:EXT:NSB?
Usage: Query only

Manual operation: See "Nominal Synchronization Bandwidth" on page 214

[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE <OutpFreqMode>

Selects the mode for the output reference frequency.

Parameters:
<OutpFreqMode> DER10M | OFF | LOOPthrough

OFF
Disables the output.
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DER10M
Sets the output reference frequency to 10 MHz.
The reference frequency is derived from the internal reference
frequency.
LOOPthrough
This setting is unavailable for
ROSCillator:EXTernal:FREQuency 1GHZ.
Forwards the input reference frequency to the reference fre-
quency output.
*RST: n.a. (factory preset: DER10M)

Example: See Example "Configuring the reference oscillator" on page 538.

Manual operation: See "Reference Output/1 GHz Reference Output" on page 215

[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE <OutpFreqMode>

Sets the output reference frequency.

Parameters:
<OutpFreqMode> LOOPthrough | DER1G | OFF

OFF
Disables the output.
DER1G
Sets the output reference frequency to 1 GHz.
The reference frequency is derived from the internal reference
frequency.
LOOPthrough
If [:SOURce]:ROSCillator:EXTernal:FREQuency 1GHZ,
forwards the input reference frequency to the reference fre-
quency output.
*RST: n.a. (factory preset: OFF)

Example: See Example "Configuring the reference oscillator" on page 538.

Options: DER1G requires R&S SMBB-B3

Manual operation: See "Reference Output/1 GHz Reference Output" on page 215

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Specifies the frequency correction value (adjustment value).

Parameters:
<Value> integer

*RST: 0

Example: See [:SOURce]:ROSCillator[:INTernal]:ADJust[:
STATe] on page 543

Manual operation: See "Adjustment Value" on page 216
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[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

Determines whether the calibrated (off) or a user-defined (on) adjustment value is
used for fine adjustment of the frequency.

Parameters:
<State> 1 | ON | 0 | OFF

0
Fine adjustment with the calibrated frequency value
1
User-defined adjustment value.
The instrument is no longer in the calibrated state.
The calibration value is, however, not changed. The instrument
resumes the calibrated state if you send
SOURce:ROSCillator:INTernal:ADJust:STATe 0.
*RST: n.a. (factory preset: 0)

Example: See Example "Configuring the reference oscillator" on page 538.

Manual operation: See "Adjustment Active" on page 216

13.16.13  SOURce:SWEep subsystem

The SOURce:SWEep subsystem contains the commands for configuring RF sweep sig-
nals.

● The keyword [:FREQuency] can be omitted, then the commands are SCPI-com-
pliant.

● To activate an RF sweep mode, use the following commands:
– RF frequency sweep: SOURce:FREQuency:MODE SWEep

(SOURce:FREQuency:MODE CW (off))
– RF level sweep:SOURce:POWer:MODE SWEep (SOURce:POWer:MODE CW

(off))
– RF combined sweep: SOURce:FREQuency:MODE SWEep

(SOURce:FREQuency:MODE CW (off)
● All sweeps, including the LF sweep, can be set independently of each other.
● All sweeps can be set independently of each other.

See Section 7.1, "Signal generation and triggering in the sweep and list modes",
on page 135.
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Example: Setting up an RF frequency or power sweep
The following example shows a command sequence to set up an RF frequency sweep,
triggered by the execute command. For an RF power sweep, replace FREQuency in
the SWEep commands with POWer.
Exceptions are the power spacing (defined with LINear only) and the power step
width (defined with LOGarithmic only).
// Reset the instrument to start from an initial state
// Switch off display update to improve performance
// (especially with short dwell times)
// Set the sweep mode (first two commands) and the sweep range
// Select linear spacing
// Select the waveform shape for the frequency sweep
*RST; *CLS
SYSTem:DISPlay:UPDate OFF
// Select sweep mode
SOURce:FREquency:MODe SWEep

TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:FREQuency:MODE AUTO  
SOURce1:FREQuency:SPAN 300 MHz
SOURce1:FREQuency:CENTer 200 MHz
// Alternatively use 
// SOURce1:FREQuency:STARt 50 MHz
// SOURce1:FREQuency:STOP 350 MHz
SOURce1:SWEep:FREQuency:SPACing LINear
SOURce1:SWEep:FREQuency:SHAPe SAWTooth

// Initiate an LF frequency sweep
TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:FREQuency:MODE AUTO
TRIGger:LFFSweep

// Activate change to start frequency while waiting for next trigger
// Prerequisites: sweep mode single and sweep waveform sawtooth
SOURce1:SWEep:FREQuency:RETRace 1
// Alternatively reset all sweeps to their initial value 
SOURce1:SWEep:RESet:ALL

// Set the step width and dwell time
SOURce1:SWEep:FREQuency:STEP:LINear 1 MHz
// Alternatively set the number of steps, then the sweep step width is 
// set automatically
SOURce1:SWEep:FREQuency:POINts 301
SOURce1:SWEep:FREQuency:DWELl 500 ms
// With logarithmic spacing select the step width as follows
// (steps of 10 percent of the previous frequency in each instance)  
SOURce1:SWEep:FREQuency:SPACing LOG 
SOURce1:SWEep:FREQuency:STEP:LOGarithmic 10PCT
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// Activate the sweep
// Trigger the sweep (depending on the set mode) and query the status
SOURce1:FREQuency:MODE SWEep
// Perform a one-off RF frequency sweep 
SOURce1:SWEep:FREQuency:EXECute
SOURce1:SWEep:FREQuency:RUNNing?
// 1
// the frequency sweep is running

// For manual step RF sweep use the following commands 
*RST; *CLS
// Set the frequency range 
SOURce1:FREQuency:STARt 50 MHz
SOURce1:FREQuency:STOP 350 MHz
SOURce1:FREQuency:MANual 30 MHz
// Activate manual step RF sweep
SOURce1:SWEep:FREQuency:MODE MANual
// Activate the RF frequency sweep.
SOURce1:FREQuency:MODE SWEep
// Activate RF Output1.
Output1:STATe 1
// Set the frequency manually for each step
SOURce1:FREQuency:MANual 200 MHz
SOURce1:FREQuency:MANual 201 MHz
// Alternatively use the UP or DOWN commands with the set step width.
SOURce1:SWEep:FREQuency:STEP:LINear 1 MHz
SOURce1:FREQuency:MANual UP

// Trigger an enabled sweep immediately
TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:FREQuency:MODE AUTO
TRIGger<hw>[:SWEep][:IMMediate]

// Query the interruption-free level range
SOURce1:POWer:RANGe:LOWer?
// Response: -50
SOURce1:POWer:RANGe:UPPer?
// Response: -15

// Activate a combined RF frequency / level sweep 
*RST; *CLS
*RST; *CLS
SYSTem:DISPlay:UPDate OFF
TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:COMBined:MODE AUTO
SOURce1:SWEep:COMBined:COUNt 200
SOURce1:FREQuency:STARt 1000000000 Hz
SOURce1:FREQuency:STOP 5000000000 Hz
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SOURce1:POWer:STARt -30 dBm
SOURce1:POWer:STOP -10 dBm
SOURce1:SWEep:COMBined:RETRace 1
SOURce1:SWEep:COMBined:SHAPe SAWT
SOURce1:SWEep:COMBined:DWELl 0.01
// Activate combined RF frequency/level sweep
SOURce1:FREQuency:MODe COMB
// Activate RF Output1.
Output1:STATe 1
// Execute combined frequency / level sweep 
SOURce1:SWEep:COMBined:EXECute

[:SOURce<hw>]:SWEep:POWer:DWELl...........................................................................546
[:SOURce<hw>]:SWEep:POWer:MODE...........................................................................547
[:SOURce<hw>]:SWEep:POWer:POINts.......................................................................... 547
[:SOURce<hw>]:SWEep:POWer:SPACing:MODE?........................................................... 548
[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic]....................................................... 548
[:SOURce<hw>]:SWEep[:FREQuency]:DWELl..................................................................548
[:SOURce<hw>]:SWEep[:FREQuency]:MODE.................................................................. 549
[:SOURce<hw>]:SWEep[:FREQuency]:POINts................................................................. 549
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing...............................................................549
[:SOURce<hw>]:SWEep:POWer:SHAPe..........................................................................550
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe................................................................. 550
[:SOURce<hw>]:SWEep:POWer:EXECute....................................................................... 550
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute.............................................................. 550
[:SOURce<hw>]:SWEep:POWer:RETRace.......................................................................550
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace..............................................................550
[:SOURce<hw>]:SWEep:POWer:RUNNing?..................................................................... 551
[:SOURce<hw>]:SWEep[:FREQuency]:RUNNing?............................................................ 551
[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic................................................ 551
[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear].......................................................551
[:SOURce<hw>]:COMBined:FREQuency:STARt............................................................... 552
[:SOURce<hw>]:COMBined:FREQuency:STOP................................................................552
[:SOURce<hw>]:COMBined:POWer:STARt...................................................................... 552
[:SOURce<hw>]:COMBined:POWer:STOP.......................................................................553
[:SOURce<hw>]:SWEep:COMBined:COUNt.....................................................................553
[:SOURce<hw>]:SWEep:COMBined:DWELl..................................................................... 553
[:SOURce<hw>]:SWEep:COMBined:EXECute.................................................................. 553
[:SOURce<hw>]:SWEep:COMBined:MODE......................................................................554
[:SOURce<hw>]:SWEep:COMBined:RETRace................................................................. 554
[:SOURce<hw>]:SWEep:COMBined:SHAPe.....................................................................555
[:SOURce<hw>]:SWEep:RESet[:ALL].............................................................................. 555

[:SOURce<hw>]:SWEep:POWer:DWELl <Dwell>

Sets the dwell time for a level sweep step.
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Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Dwell Time" on page 154

[:SOURce<hw>]:SWEep:POWer:MODE <Mode>

Sets the cycle mode for the level sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Each trigger triggers exactly one complete sweep.
MANual
The trigger system is not active. You can trigger every step indi-
vidually with the command [:SOURce<hw>]:POWer:MANual.
The level value increases at each step by the value that you
define with [:SOURce<hw>]:POWer:STEP[:INCRement].
Values directly entered with the command [:SOURce<hw>]:
POWer:MANual are not taken into account.
STEP
Each trigger triggers one sweep step only. The level increases
by the value entered with [:SOURce<hw>]:POWer:STEP[:
INCRement].
*RST: AUTO

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Mode" on page 151

[:SOURce<hw>]:SWEep:POWer:POINts <Points>

Sets the number of steps within the RF level sweep range.

Parameters:
<Points> integer

Range: 2  to  Max

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.
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[:SOURce<hw>]:SWEep:POWer:SPACing:MODE?

Queries the level sweep spacing. The sweep spacing for level sweeps is always linear.

Return values: 
<Mode> LINear

*RST: LINear

Example: SWE:POW:SPAC:MODE?
queries the sweep spacing for a level sweep at RF output.
Result: "LIN"
linear spacing

Usage: Query only

[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic] <Logarithmic>

Sets a logarithmically determined step size for the RF level sweep. The level is
increased by a logarithmically calculated fraction of the current level.

Parameters:
<Logarithmic> float

The unit dB is mandatory.
Range: 0.01  to  139
Increment: 0.01
*RST: 1
Default unit: dB

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Step" on page 158

[:SOURce<hw>]:SWEep[:FREQuency]:DWELl <Dwell>

Sets the dwell time for a frequency sweep step.

Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Dwell Time" on page 154
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[:SOURce<hw>]:SWEep[:FREQuency]:MODE <Mode>

Sets the cycle mode for the frequency sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Each trigger event triggers exactly one complete sweep.
MANual
The trigger system is not active. You can trigger every step indi-
vidually by input of the frequencies with the command [:
SOURce<hw>]:FREQuency:MANual.
STEP
Each trigger event triggers one sweep step. The frequency
increases by the value entered with [:SOURce<hw>]:SWEep[:
FREQuency]:STEP[:LINear] (linear spacing) or [:
SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic
(logarithmic spacing).
*RST: AUTO

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Mode" on page 151

[:SOURce<hw>]:SWEep[:FREQuency]:POINts <Points>

Sets the number of steps within the RF frequency sweep range.

Two separate POINts values are used for linear or logarithmic sweep spacing. This
command always affects the currently set sweep spacing that you can set via the fol-
lowing command:

:SOURce<hw>:SWEep:FREQuency:SPACing LINear|LOGarithmic
Parameters:
<Points> integer

Range: 2  to  Max

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

[:SOURce<hw>]:SWEep[:FREQuency]:SPACing <Spacing>

Selects the mode for the calculation of the frequency intervals, with which the current
frequency at each step is increased or decreased.

The keyword [:FREQuency] can be omitted; then the command is SCPI-compliant.

Parameters:
<Spacing> LINear | LOGarithmic
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LINear
Sets a fixed frequency value as step width and adds it to the cur-
rent frequency.
The linear step width is entered in Hz, see [:SOURce<hw>]:
SWEep[:FREQuency]:STEP[:LINear].
LOGarithmic
Sets a constant fraction of the current frequency as step width
and adds it to the current frequency.
The logarithmic step width is entered in %, see [:
SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic.
*RST: LINear

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Spacing" on page 154

[:SOURce<hw>]:SWEep:POWer:SHAPe <Shape>
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe <Shape>
Determines the waveform shape for a frequency sweep sequence.

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Shape" on page 152

[:SOURce<hw>]:SWEep:POWer:EXECute
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute
Executes an RF frequency sweep.

The command performs a single sweep and is therefore only effective in manual
sweep mode.

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 155

[:SOURce<hw>]:SWEep:POWer:RETRace <State>
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace <State>
Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.
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You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Retrace" on page 152

[:SOURce<hw>]:SWEep:POWer:RUNNing?
[:SOURce<hw>]:SWEep[:FREQuency]:RUNNing?
Queries the current sweep state.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Usage: Query only

[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic <Logarithmic>

Sets a logarithmically determined step width for the RF frequency sweep. The value is
added at each sweep step to the current frequency.

Parameters:
<Logarithmic> float

The unit is mandatory.
Range: 0.01  to  100
Increment: 1E-3
*RST: 1
Default unit: PCT

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Step Linear/Step Logarithmic" on page 157

[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear] <Linear>

Sets the step width for linear sweeps.

Parameters:
<Linear> float

Range: 0.001 Hz  to  (STOP - STARt)
Increment: 0.01
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Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Step Linear/Step Logarithmic" on page 157

[:SOURce<hw>]:COMBined:FREQuency:STARt <CombFreqStart>

Sets the start frequency of the combined RF sweep.

Parameters:
<CombFreqStart> float

Range: -59999E5  to  12E9
Increment: 0.01
*RST: 100E6

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Frequency/Stop Frequency" on page 156

[:SOURce<hw>]:COMBined:FREQuency:STOP <CombFreqStop>

Sets the end frequency of the combined RF frequency / level sweep.

Parameters:
<CombFreqStop> float

Range: -59999E5  to  12E9
Increment: 0.01
*RST: 500E6

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Frequency/Stop Frequency" on page 156

[:SOURce<hw>]:COMBined:POWer:STARt <CombPowStart>

Sets the start level value of the combined RF sweep.

Parameters:
<CombPowStart> float

Range: -245  to  120
Increment: 0.01
*RST: -30

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Level / Stop Level" on page 158
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[:SOURce<hw>]:COMBined:POWer:STOP <CombPowStop>

Sets the stop level value of the combined RF frequency / level sweep.

Parameters:
<CombPowStop> float

Range: -245  to  120
Increment: 0.01
*RST: -10

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Start Level / Stop Level" on page 158

[:SOURce<hw>]:SWEep:COMBined:COUNt <StepCount>

Defines the number of sweeps you want to execute.

This parameter applies to [:SOURce<hw>]:SWEep:COMBined:MODE > SINGle. To
start the sweep signal generation, use the command [:SOURce<hw>]:SWEep:
COMBined:EXECute on page 553.

Parameters:
<StepCount> integer

Range: 1  to  SeMAX_INT_STEP-1
*RST: 501

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Step Count" on page 158

[:SOURce<hw>]:SWEep:COMBined:DWELl <Dwell>

Sets the dwell time for the combined frequency / level sweep.

Parameters:
<Dwell> float

Range: 0.01  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Dwell Time" on page 154

[:SOURce<hw>]:SWEep:COMBined:EXECute

Executes an RF frequency / level sweep cycle.
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The command triggers one single sweep manually. Therefore, you can use it in manual
sweep mode, selected with the command [:SOURce<hw>]:SWEep:COMBined:MODE
> MANual.

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 155

[:SOURce<hw>]:SWEep:COMBined:MODE <SweepCombMode>

Sets the cycle mode for the combined frequency / level sweep.

Parameters:
<SweepCombMode> AUTO | MANual | STEP

AUTO
Each trigger event triggers exactly one complete sweep.
MANual
The trigger system is not active. You can trigger every step indi-
vidually by input of the frequencies with the commands [:
SOURce<hw>]:FREQuency:MANual and [:SOURce<hw>]:
POWer:MANual.
STEP
Each trigger event triggers one sweep step.
*RST: AUTO

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Mode" on page 151

[:SOURce<hw>]:SWEep:COMBined:RETRace <RetraceState>

Activates that the signal changes to the start level value while it is waiting for the next
trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<RetraceState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Retrace" on page 152
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[:SOURce<hw>]:SWEep:COMBined:SHAPe <Shape>

Selects the waveform shape for the combined frequency / level sweep sequence.

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setting up an RF frequency or power sweep"
on page 544.

Manual operation: See "Shape" on page 152

[:SOURce<hw>]:SWEep:RESet[:ALL]

Resets all active sweeps to the starting point.

Usage: Event

Manual operation: See "Reset Sweep" on page 155

13.17  SYSTem subsystem

The SYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.

Example: To check the instrument specifications
// Check information on specifications document versions.
// Query all versions saved on the instrument:
:SYSTem:SPECification:VERSion:CATalog?
"04.03,04.02,04.01,04.00,03.04,03.03,03.02,03.01,03.00,02.96,02.95,02.94,
02.02,02.01,02.00,01.03,01.02,01.01,01.00"

// Query the initial version of your delivery.
:SYSTem:SPECification:VERSion:FACTory?
// Response: "04.00"

// Select a specific version:
:SYSTem:SPECification:VERSion "04.01"

// Check information of a particular specifications document.
// Query the IDs of all parameters listed in the selected version:
:SYSTem:SPECification:VERSion "04.03"
:SYSTem:SPECification:IDENtification:CATalog?
"ID_RF_FREQ_SETTING_TIME_ALC_ON_MS,ID_RF_FREQ_SETTING_TIME_MS,..."

// Query specification information on a specific parameter by its ID.
:SYSTem:SPECification? "ID_RF_FREQ_SETTING_TIME_ALC_ON_MS"
// Returns the specified value of the parameter.
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Example: To check network-related settings
:SYSTem:COMMunicate:NETWork:STATus?
// Response: "1"
:SYSTem:PROTection1:STATe 0,123456

:SYSTem:COMMunicate:NETWork:IPADdress:MODE STAT
:SYSTem:COMMunicate:NETWork:IPADdress "10.113.0.104"
:SYSTem:COMMunicate:NETWork:IPADdress:DNS "10.0.2.166"
:SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// Response: "SMB100B-102030"
:SYSTem:COMMunicate:NETWork:COMMon:WORKgroup "instrument"
:SYSTem:COMMunicate:NETWork:COMMon:DOMain "rsint.net"
:SYSTem:COMMunicate:NETWork:IPADdress:GATeway "10.113.0.1"
:SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK "255.255.252.0"
:SYSTem:COMMunicate:NETWork:MACaddress "08 00 27 a3 a1 70"
:SYSTem:PROTection1:STATe 1

Example: To restart the network
:SYSTem:COMMunicate:NETWork:RESTart
// terminates the network connection and sets it up again

Example: To find out VISA resource strings
:SYSTem:COMMunicate:NETWork:RESource?
// Response: "TCPIP::10.113.0.104::inst0::INSTR"

:SYSTem:COMMunicate:HISLip:RESource?
// Response: "TCPIP::10.113.0.104::hislip0::INSTR"

:SYSTem:COMMunicate:SOCKet:RESource?
// Response: "TCPIP::10.113.0.104::5025::SOCKET"

:SYSTem:COMMunicate:USB:RESource?
// "USB::0x0AAD::0x01DE::100001::INSTR"

:SYSTem:COMMunicate:GPIB:RESource?
// Response: "GPIB::28::INSTR"
:SYSTem:COMMunicate:GPIB:SELF:ADDRess?
// Response: 28
:SYSTem:COMMunicate:GPIB:LTERminator?
// Response: STAN

:SYSTem:COMMunicate:SERial:RESource?
// Response: "ASRL1::INSTR"
:SYSTem:COMMunicate:SERial:SBITs?
// Response: 1
:SYSTem:COMMunicate:SERial:BAUD?
// Response: 115200
:SYSTem:COMMunicate:SERial:PARity?
// Response: NONE
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Disabling LAN services

► NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or the com-
mon services "LAN", "SCPI over LAN", "VNC" and "HTTP" locks the remote access
to the instrument.
Use the commands in Example "To disable the LAN interface and LAN services"
on page 557 to disable or enable the LAN interface and LAN interface services
individually.

a) For the first parameter of the command, enter the security password of your
instrument.
The default password is 123456.

b) For the second parameter of the command, enter the state: 1 (ON), 0 (OFF)

Example: To disable the LAN interface and LAN services
// *****************************************************************************
// Disable the LAN interface.
// *****************************************************************************
SYSTem:SECurity:NETWork:STATe "<password>", 0

// *****************************************************************************
// Disable the LAN services individually.
// *****************************************************************************
SYSTem:SECurity:NETWork:RAW:STATe "<password>", 0
// Disables remote access over raw socket. 
SYSTem:SECurity:NETWork:SOE:STATe "<password>", 0
// Disables SCPI over Ethernet/LAN communication.
SYSTem:SECurity:NETWork:VNC:STATe "<password>", 0
// Disables remote access over VNC.
SYSTem:SECurity:NETWork:HTTP:STATe "<password>", 0
// Disables remote access over HTTP.
SYSTem:SECurity:NETWork:RPC:STATe "<password>", 0
// Disables remote access over remote procedure call (RPC).
SYSTem:SECurity:NETWork:SSH:STATe "<password>", 0
// Disables SSH network protocol that is used for service purposes.
SYSTem:SECurity:NETWork:FTP:STATe "<password>", 0
//    Disables FTP for file transfer.
SYSTem:SECurity:NETWork:SMB:STATe "<password>", 0
// Disables shared access over SMB.
SYSTem:SECurity:NETWork:AVAHi:STATe "<password>", 0
// Disables Avahi service for automatic instrument configuration in the network.
SYSTem:SECurity:NETWork:SWUPdate:STATe "<password>", 0
// Disables software updates over LAN.
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Example: To query the error queue
:SYSTem:ERRor:STATic?
// Response: -221,"Settings conflict", 153,"Input voltage out of range", ...
// Returns all static errors that are collected in the error queue.

:SYSTem:ERRor:HISTory:ClEar
// Deletes the history entries.

Example: To configure date and time
// Query the date and time settings of the instrument.
:SYSTem:DATE?
// Response: 2023,1,16;1
:SYSTem:TIME?
// Response: 18,15,17;1
:SYSTem:TIME:ZONE?
// Response: "";1  //default UTC setting
:SYSTem:TIME:PROTocol?
// Response: "OFF";1
// No protocol selected.
:SYSTem:NTP:STATe?
// Response: 0;1
// NTP is disabled.

// Setting the timezone and NTP time protocol
:SYSTem:TIME:ZONE:CATalog? 
// Response: "UTC,leap-seconds.list,leapseconds,Africa/Abidjan,..."
:SYSTem:TIME:ZONE "Europe/Berlin"  
// Set the NTP server address.
:SYSTem:NTP:HOST "timesource.net" 
:SYSTem:NTP:STATe?
// Response: "1"
// The NTP time server is enabled.

Commands:

:SYSTem:ERRor:ALL?....................................................................................................560
:SYSTem:ERRor:CODE:ALL?......................................................................................... 561
:SYSTem:ERRor:CODE[:NEXT]?.....................................................................................561
:SYSTem:ERRor:COUNt?...............................................................................................561
:SYSTem:ERRor[:NEXT]?...............................................................................................562
:SYSTem:ERRor:GNEXt?............................................................................................... 562
:SYSTem:ERRor:HISTory:CLEar......................................................................................563
:SYSTem:ERRor:STATic?............................................................................................... 563
:SYSTem:DLOCk........................................................................................................... 563
:SYSTem:KLOCk........................................................................................................... 563
:SYSTem:NINFormation?................................................................................................564
:SYSTem:ULOCk........................................................................................................... 564
:SYSTem:LOCK:OWNer?................................................................................................565
:SYSTem:LOCK:RELease:ALL........................................................................................ 565
:SYSTem:LOCK:REQuest[:EXCLusive]?.......................................................................... 565
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:SYSTem:SAV................................................................................................................565
:SYSTem:RCL............................................................................................................... 566
:SYSTem:PROTect<ch>[:STATe]......................................................................................566
:SYSTem:COMMunicate:GPIB:LTERminator.....................................................................567
:SYSTem:COMMunicate:GPIB:RESource?....................................................................... 567
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess...............................................................567
:SYSTem:COMMunicate:HISLip:RESource?..................................................................... 567
:SYSTem:COMMunicate:NETWork:IPADdress.................................................................. 568
:SYSTem:COMMunicate:NETWork:IPADdress:MODE........................................................568
:SYSTem:COMMunicate:NETWork:MACaddress...............................................................568
:SYSTem:COMMunicate:NETWork:RESource?.................................................................568
:SYSTem:COMMunicate:NETWork:RESTart..................................................................... 569
:SYSTem:COMMunicate:NETWork:STATus?.................................................................... 569
:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain.....................................................569
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname................................................569
:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup.............................................. 570
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS.........................................................570
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway..................................................570
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK..........................................570
:SYSTem:COMMunicate:SERial:BAUD............................................................................ 570
:SYSTem:COMMunicate:SERial:PARity............................................................................571
:SYSTem:COMMunicate:SERial:RESource?.....................................................................571
:SYSTem:COMMunicate:SERial:SBITs.............................................................................571
:SYSTem:COMMunicate:SOCKet:RESource?...................................................................571
:SYSTem:COMMunicate:USB:RESource?........................................................................ 572
:SYSTem:HELP:EXPort.................................................................................................. 572
:SYSTem:IDENtification.................................................................................................. 572
:SYSTem:IDENtification:PRESet......................................................................................572
:SYSTem:IRESponse..................................................................................................... 573
:SYSTem:ORESponse....................................................................................................573
:SYSTem:LANGuage......................................................................................................573
:SYSTem:INFormation:SCPI............................................................................................574
:SYSTem:SECurity:NETWork:AVAHi[:STATe].................................................................... 574
:SYSTem:SECurity:NETWork:FTP[:STATe]....................................................................... 574
:SYSTem:SECurity:NETWork:HTTP[:STATe].....................................................................574
:SYSTem:SECurity:NETWork:RAW[:STATe]......................................................................575
:SYSTem:SECurity:NETWork:REMSupport[:STATe]...........................................................575
:SYSTem:SECurity:NETWork:RPC[:STATe].......................................................................575
:SYSTem:SECurity:NETWork:SMB[:STATe]...................................................................... 576
:SYSTem:SECurity:NETWork:SOE[:STATe].......................................................................576
:SYSTem:SECurity:NETWork:SSH[:STATe].......................................................................576
:SYSTem:SECurity:NETWork:SWUPdate[:STATe]............................................................. 576
:SYSTem:SECurity:NETWork:VNC[:STATe].......................................................................577
:SYSTem:SECurity:NETWork[:STATe].............................................................................. 577
:SYSTem:SECurity:SANitize[:STATe]................................................................................577
:SYSTem:SECurity:VOLMode[:STATe]..............................................................................578
:SYSTem:SPECification?................................................................................................ 578
:SYSTem:SPECification:VERSion....................................................................................578
:SYSTem:SPECification:IDENtification:CATalog?...............................................................579
:SYSTem:SPECification:PARameter?...............................................................................579
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:SYSTem:SPECification:VERSion:CATalog?..................................................................... 579
:SYSTem:SPECification:VERSion:FACTory?.....................................................................580
:SYSTem:SRData?.........................................................................................................580
:SYSTem:STARtup:COMPlete?....................................................................................... 580
:SYSTem:DATE............................................................................................................. 581
:SYSTem:NTP:HOSTname............................................................................................. 581
:SYSTem:NTP:STATe..................................................................................................... 581
:SYSTem:TIME.............................................................................................................. 581
:SYSTem:TIME:ZONE.................................................................................................... 582
:SYSTem:TIME:ZONE:CATalog?......................................................................................582
:SYSTem:TIME:PROTocol...............................................................................................582
:SYSTem:UPTime?........................................................................................................ 583
:SYSTem:BIOS:VERSion?.............................................................................................. 583
:SYSTem:VERSion?.......................................................................................................583
:SYSTem:OSYStem?......................................................................................................583
:SYSTem:MMEMory:PATH:USER?.................................................................................. 584
:SYSTem:DFPRint..........................................................................................................584
:SYSTem:REBoot...........................................................................................................584
:SYSTem:RESTart..........................................................................................................585
:SYSTem:SHUTdown..................................................................................................... 585
:SYSTem:WAIT..............................................................................................................585
:SYSTem:FILes:TEMPorary:DELete.................................................................................585

:SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.

Return values: 
<All> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
A comma separated list of error number and a short description
of the error in FIFO order.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:ALL? 
// queries all entries in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Clear History" on page 622
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:SYSTem:ERRor:CODE:ALL?

Queries the error numbers of all entries in the error queue and then deletes them.

Return values: 
<All> string

Returns the error numbers. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:ALL? 
// queries all entries in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:CODE[:NEXT]?

Queries the error number of the oldest entry in the error queue and then deletes it.

Return values: 
<Next> string

Returns the error number. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:COUNt?

Queries the number of entries in the error queue.
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Return values: 
<Count> integer

0
The error queue is empty.

Example: SYSTem:ERRor:COUNt? 
// queries the number of entries in the error queue. 
Response: 1 
// one error has occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor[:NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue.

Return values: 
<Next> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
Error number and a short description of the error.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Static Notifications/History" on page 621

:SYSTem:ERRor:GNEXt?

Similar to :SYSTem:ERRor[:NEXT]?, but queries the next entry from the global per-
sistant error/event queue.

Return values: 
<NextGlobalError> string

Error/event number, "Error/event description> [;Device depend-
ent info]"
An error number and a short description of the error.
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
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Example: SYSTem:ERRor:GNEXt?
// queries the next error message from the global error queue.

Usage: Query only

:SYSTem:ERRor:HISTory:CLEar

Clears the error history.

Example: See Example "To query the error queue" on page 558

Usage: Event

Manual operation: See "Clear History" on page 622

:SYSTem:ERRor:STATic?

Returns a list of all errors existing at the time when the query is started. This list corre-
sponds to the display on the info page under manual control.

Return values: 
<StaticErrors> string

Example: See Example "To query the error queue" on page 558

Usage: Query only

Manual operation: See "Static Notifications/History" on page 621

:SYSTem:DLOCk <DispLockStat>

Disables the manual operation over the display, including the front panel keyboard of
the instrument.

Parameters:
<DispLockStat> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYST:DLOC ON
Activates the display lock. The instrument cannot be operated
via the display until it has been enabled with SYST:DLOC OFF.

Manual operation: See "User Interface" on page 281
See "Enabling a locked user interface for manual operation"
on page 282

:SYSTem:KLOCk <State>

Disables the front panel keyboard of the instrument.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)
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Example: SYST:KLOC ON
Locks the front panel and external controls.
To enable the controls, send SYST:KLOC OFF.

Manual operation: See "User Interface" on page 281
See "Enabling a locked user interface for manual operation"
on page 282

:SYSTem:NINFormation?

Queries the oldest information message ("Error History > Level > Info") in the error/
event queue.

Return values: 
<NextInfo> string

Example: :SYSTem:NINFormation?
Queries the oldest entry in the info message queue.
Response: 90,"Info;=== Instrument startup...
==="
Information message containing error number 90, that states,
that the instrument startup is complete.

Usage: Query only

:SYSTem:ULOCk <SecPassWord>, <Mode>

Locks or unlocks the user interface of the instrument.

Parameters:
<Mode> ENABled | DONLy | DISabled | TOFF | VNConly

ENABled
Unlocks the display, the touchscreen and all controls for the
manual operation.
DONLy
Locks the touchscreen and controls for the manual operation of
the instrument. The display shows the current settings.
VNConly
Locks the touchscreen and controls for the manual operation,
and enables remote operation over VNC. The display shows the
current settings.
TOFF
Locks the touchscreen for the manual operation of the instru-
ment. The display shows the current settings.
DISabled
Locks the display, the touchscreen and all controls for the man-
ual operation.
*RST: n.a. (factory preset: ENABled)
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Setting parameters: 
<SecPassWord> string

Example: :SYST:ULOC "<password>", DIS
Activates the user interface lock, including display and controls.

Manual operation: See "User Interface" on page 281
See "Enabling a locked user interface for manual operation"
on page 282

:SYSTem:LOCK:OWNer?

Queries the sessions that have locked the instrument currently.

If an exclusive lock is set, the query returns the owner of this exclusive lock, otherwise
it returns NONE.

Return values: 
<Owner> string

Example: SYST:LOCK:OWN?
Returns the owner of locking.
Response: NONE
The instrument is not locked.

Usage: Query only

:SYSTem:LOCK:RELease:ALL

Revokes the exclusive access to the instrument.

Usage: Setting only

:SYSTem:LOCK:REQuest[:EXCLusive]?

Queries whether a lock for exclusive access to the instrument via ethernet exists. If
successful, the query returns a 1, otherwise 0.

Return values: 
<Success> integer

Example: SYST:LOCK:REQ?
Queries the state of exclusive locking.
Response: 1
The exclusive locking is active.

Usage: Query only

:SYSTem:SAV <Pathname>

Saves the current R&S SMB100B settings in a file. To deteremine the file name and
storage location, enter the directory and file name with the command. According to the
file type, the R&S SMB100B assigns the extension (*.savrcltxt) automatically.
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Setting parameters: 
<Pathname> string

Example: SYSTem:SAV "/var/user/temp/Test" 
// saves the file "Test.savrcltxt" in the directory /var/user/temp/.

Usage: Setting only

:SYSTem:RCL <Pathname>

Selects and uploads a *.savrcltxt file with previously saved R&S SMB100B set-
tings from the default or a specified directory.

Setting parameters: 
<Pathname> string

Example: SYSTem:RCL "/var/user/temp/Test" 
// loads the "Test.savrcltxt" file from the directory /var/user/temp/.

Usage: Setting only

:SYSTem:PROTect<ch>[:STATe] <State>[, <Key>]

Activates and deactivates the specified protection level.

Suffix: 
<ch>

.
Indicates the protection level.
See also "Protection" on page 277

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Setting parameters: 
<Key> integer

The respective functions are disabled when the protection level
is activated. No password is required for activation of a level.
A password must be entered to deactivate the protection level.
The default password for the first level is 123456.
This protection level is required to unlock internal adjustments
for example.

Example: To activate protection level:
SYSTem:PROTect1:STATe 1
Internal adjustments or hostname cannot be changed.
To unlock protection level 1:
SYSTem:PROTect1:STATe 0,123456
Internal adjustments are accessible.

Manual operation: See "Protection Level/Password" on page 283
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:SYSTem:COMMunicate:GPIB:LTERminator <LTerminator>

Sets the terminator recognition for remote control via GPIB interface.

Parameters:
<LTerminator> STANdard | EOI

EOI
Recognizes an LF (Line Feed) as the terminator only when it is
sent with the line message EOI (End of Line). This setting is rec-
ommended particularly for binary block transmissions, as binary
blocks may coincidentally contain a characater with value LF
(Line Feed), although it is not determined as a terminator.
STANdard
Recognizes an LF (Line Feed) as the terminator regardless of
whether it is sent with or without EOI.
*RST: n.a. (factory preset: STANdard)

Example: See Example "To find out VISA resource strings" on page 556.

:SYSTem:COMMunicate:GPIB:RESource?

Queries the visa resource string for remote control via the GPIB interface.

To change the GPIB address, use the command :SYSTem:COMMunicate:GPIB[:
SELF]:ADDRess.

Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.

Usage: Query only

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess <Address>

Sets the GPIB address.

Parameters:
<Address> integer

Range: 0  to  30
*RST: n.a. (factory preset: 28)

Example: See Example "To find out VISA resource strings" on page 556.

Manual operation: See "GPIB Channel Address" on page 315

:SYSTem:COMMunicate:HISLip:RESource?

Queries the VISA resource string. This string is used for remote control of the instru-
ment with HiSLIP protocol.
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Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.

Usage: Query only

Manual operation: See "HISLIP" on page 313
See "GPIB" on page 314

:SYSTem:COMMunicate:NETWork:IPADdress <IpAddress>

Sets the IP address.

Parameters:
<IpAddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "IP Address" on page 311

:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

Selects manual or automatic setting of the IP address.

Parameters:
<Mode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "Address Mode" on page 311

:SYSTem:COMMunicate:NETWork:MACaddress <MacAddress>

Queries the MAC address of the network adapter.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<MacAddress> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "MAC Address" on page 312

:SYSTem:COMMunicate:NETWork:RESource?

Queries the visa resource string for Ethernet instruments.

Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.
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Usage: Query only

Manual operation: See "VXI11" on page 313

:SYSTem:COMMunicate:NETWork:RESTart

Restarts the network.

Example: See Example "To restart the network" on page 556.

Usage: Event

Manual operation: See "Restart Network" on page 310

:SYSTem:COMMunicate:NETWork:STATus?

Queries the network configuration state.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "To check network-related settings" on page 556.

Usage: Query only

Manual operation: See "Network Status" on page 310

:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain <Domain>

Determines the primary suffix of the network domain.

Parameters:
<Domain> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "DNS Suffix" on page 312

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>

Sets an individual hostname for the R&S SMB100B.

Note:We recommend that you do not change the hostname to avoid problems with the
network connection. If you change the hostname, be sure to use a unique name.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hostname> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "Hostname" on page 311
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:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup <Workgroup>

Sets an individual workgroup name for the instrument.

Parameters:
<Workgroup> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "Workgroup" on page 311

:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS <DNS>

Determines or queries the network DNS server to resolve the name.

Parameters:
<DNS> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "DNS Server" on page 312

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>

Sets the IP address of the default gateway.

Parameters:
<Gateway> string

Range: 0.0.0.0  to  ff.ff.ff.ff

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "Default Gateway" on page 312

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

Sets the subnet mask.

Parameters:
<Mask> string

Example: See Example "To check network-related settings" on page 556.

Manual operation: See "Subnet Mask" on page 311

:SYSTem:COMMunicate:SERial:BAUD <Baud>

Defines the baudrate for the serial remote control interface.

Parameters:
<Baud> 2400 | 4800 | 9600 | 19200 | 38400 | 57600 | 115200

*RST: n.a. (factory preset: 115200)

Example: See Example "To find out VISA resource strings" on page 556.
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Manual operation: See "Baud Rate" on page 315

:SYSTem:COMMunicate:SERial:PARity <Parity>

Enters the parity for the serial remote control interface.

Parameters:
<Parity> NONE | ODD | EVEN

*RST: n.a. (factory preset: NONE)

Example: See Example "To find out VISA resource strings" on page 556.

Manual operation: See "Parity" on page 315

:SYSTem:COMMunicate:SERial:RESource?

Queries the visa resource string for the serial remote control interface. This string is
used for remote control of the instrument.

Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.

Usage: Query only

Manual operation: See "SERIAL" on page 314

:SYSTem:COMMunicate:SERial:SBITs <SBits>

Defines the number of stop bits for the serial remote control interface.

Parameters:
<SBits> 1 | 2

*RST: n.a. (factory preset: 1)

Example: See Example "To find out VISA resource strings" on page 556.

Manual operation: See "Stop Bits" on page 316

:SYSTem:COMMunicate:SOCKet:RESource?

Queries the visa resource string for remote control via LAN interface, using TCP/IP
socket protocol.

Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.

Usage: Query only

Manual operation: See "Socket" on page 314
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:SYSTem:COMMunicate:USB:RESource?

Queries the visa resource string for remote control via the USB interface.

Return values: 
<Resource> string

Example: See Example "To find out VISA resource strings" on page 556.

Usage: Query only

Manual operation: See "USB" on page 314

:SYSTem:HELP:EXPort

Saves the online help as zip archive in the user directory.

Example: :SYSTem:HELP:EXPort
MMEM:CDIR?
// "/var/user"
MMEM:CAT?
// ..,"Log,DIR,4096","help.tgz,BIN,69836600"
// confirms that help zip archive is saved.

Usage: Event

Manual operation:: "Setup > Help > Export Help to User Path"

:SYSTem:IDENtification <Identification>

Selects the mode to determine the "IDN String" and the "OPT String" for the instru-
ment, selected with command :SYSTem:LANGuage.

Note: While working in an emulation mode, the R&S SMB100B specific command set
is disabled, that is, the SCPI command SYST:IDEN is discarded.

Parameters:
<Identification> AUTO | USER

AUTO
Automatically determines the strings.
USER
User-defined strings can be selected.
*RST: n.a. (factory preset: AUTO)

Example: SYST:IDEN AUTO
Automatically assigns the OPT and IDN strings according to the
selected instrument language.

Manual operation: See "Mode" on page 317

:SYSTem:IDENtification:PRESet

Sets the *IDN and *OPT strings in user defined mode to default values.
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Example: SYST:IDEN USER
SYST:IDEN:PRES

Usage: Event

Manual operation: See "Set to Default" on page 317

:SYSTem:IRESponse <IdnResponse>

Defines the user defined identification string for *IDN.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:IRES is discarded.

Parameters:
<IdnResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:IRES "Test Device"
// Defines identification string 'test device'
*IDN?
// Response: 'test device'

Manual operation: See "IDN String" on page 317

:SYSTem:ORESponse <OResponse>

Defines the user defined response string for *OPT.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:ORES is discarded.

Parameters:
<OResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:ORES "Test Option"
// Defines the OPT string 'test option'
*OPT?
// Response: 'test option'

Manual operation: See "OPT String" on page 318

:SYSTem:LANGuage <Language>

Sets the remote control command set.

Parameters:
<Language> string

Example: SYSTem:LANGuage "SCPI"
// selects SCPI command set
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Manual operation: See "Language" on page 317

:SYSTem:INFormation:SCPI <InfoString>

Inserts system information in recorded SCPI command lists, for example information
on a missing command.

Parameters:
<InfoString> string

Example: SYST:INF:SCPI "missing command"
enters the information into a recorded SCPI command list.

:SYSTem:SECurity:NETWork:AVAHi[:STATe] <SecPassWord>, <AvahiState>

Disables the Avahi service for automatic configuration of the instrument in a network.

Parameters:
<AvahiState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:FTP[:STATe] <SecPassWord>, <FtpState>

Disables FTP protocol for file transfer between the instrument and host.

Parameters:
<FtpState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:HTTP[:STATe] <SecPassWord>, <HttpState>

Disables control of the instrument over HTTP, the protocol for hypermedia information
systems.

Parameters:
<HttpState> 1 | ON | 0 | OFF
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Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:RAW[:STATe] <SecPassWord>, <RawState>

Disables the LAN interface for remote control of the instrument over raw socket port.

Parameters:
<RawState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

:SYSTem:SECurity:NETWork:REMSupport[:STATe] <NetRemSupport>

Disables communication over SSH (SCP) for service purposes.

Parameters:
<NetRemSupport> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:RPC[:STATe] <SecPassWord>, <RpcState>

Enables the LAN interface for remote control of the instrument via remote procedure
calls (RPC).

Parameters:
<RpcState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

SYSTem subsystem



Remote control commandsR&S®SMB100B

576User Manual 1178.3711.02 ─ 11

:SYSTem:SECurity:NETWork:SMB[:STATe] <SecPassWord>, <SmbState>

Disables access to the file system, printers and serial ports in a network over SMB.

Parameters:
<SmbState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:SOE[:STATe] <SecPassWord>, <SoeState>

Disables control of the instrument over LAN using SCPI commands.

Parameters:
<SoeState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:SSH[:STATe] <SecPassWord>, <SshState>

Disables control of the instrument over LAN using the SSH network protocol.

Parameters:
<SshState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:SWUPdate[:STATe] <SecPassWord>,
<SwUpdateState>

Disables software update over LAN.
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Parameters:
<SwUpdateState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork:VNC[:STATe] <SecPassWord>, <VncState>

Disables the VNC interface for remote control of the instrument.

Parameters:
<VncState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example "To disable the LAN interface and LAN services"
on page 557.

Manual operation: See "LAN Services" on page 285

:SYSTem:SECurity:NETWork[:STATe] <SecPassWord>, <LanStorState>

Disables the LAN interface in general, including all services.

Parameters:
<LanStorState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.
The default password is 123456.

Example: See Example "To disable the LAN interface and LAN services"
on page 557

Manual operation: See "LAN" on page 285

:SYSTem:SECurity:SANitize[:STATe] <SecPassWord>, <MmemProtState>

Sanitizes the internal memory.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

SYSTem subsystem



Remote control commandsR&S®SMB100B

578User Manual 1178.3711.02 ─ 11

Setting parameters: 
<SecPassWord> string

Example: SYSTem:SECurity:SANitize[:STATe] 1

Manual operation: See "Sanitize" on page 280

:SYSTem:SECurity:VOLMode[:STATe] <SecPassWord>, <MmemProtState>

Activates volatile mode, so that no user data can be written to the internal memory per-
manently.

To enable volatile mode, reboot the instrument. Otherwise the change has no effect.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Current security password
The default password is 123456.

Example: SYSTem:SECurity:VOLMode:STATe "123456", 1
SYSTem:REBoot

Manual operation: See "Volatile Mode" on page 279

:SYSTem:SPECification? <Id>

Retrieves data sheet information for a specific parameter.

Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet, as queried
with the command :SYSTem:SPECification:
IDENtification:CATalog? on page 579

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.
See also Section 12.7.4, "Datasheet", on page 339.

Example: See Example "To check the instrument specifications"
on page 555.

Usage: Query only

:SYSTem:SPECification:VERSion <Version>

Selects a data sheet version from the data sheets saved on the instrument.
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Further queries regarding the data sheet parameters (<Id>) and their values refer to
the selected data sheet.

To query the list of data sheet versions, use the command :SYSTem:
SPECification:VERSion:CATalog? on page 579.

Parameters:
<Version> string

Example: See :SYSTem:SPECification? on page 578.

:SYSTem:SPECification:IDENtification:CATalog?

Queries the parameter identifiers (<Id>) available in the data sheet.

Return values: 
<IdList> string

Comma-separated string of the parameter identifiers (<Id>)

Example: See :SYSTem:SPECification? on page 578.

Usage: Query only

:SYSTem:SPECification:PARameter? <Id>[, <Parameter>]

Retrieves data sheet information for a specific parameter.

Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet.
Query the data sheet parameters with the command :SYSTem:
SPECification:IDENtification:CATalog?.

<Parameter> float
An additional value the result (ValList) depends on.

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.

Example: Note: The following values are merely an example. Your instru-
ment may not support the same parameters.
SYST:SPEC:PAR? "ID_RF_FREQ_SETTING_TIME_MS",0.1
SYST:SPEC:PAR? "ID_RF_LEVEL_MAX_GENERAL_DBM",
0.1

Usage: Query only

:SYSTem:SPECification:VERSion:CATalog?

Queries all data sheet versions stored in the instrument.
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Return values: 
<VersCatalog> string

Example: See :SYSTem:SPECification? on page 578.

Usage: Query only

:SYSTem:SPECification:VERSion:FACTory?

Queries the data sheet version of the factory setting.

Return values: 
<Version> string

Example: See :SYSTem:SPECification? on page 578.

Usage: Query only

Manual operation: See "Versions" on page 628

:SYSTem:SRData?

Queris the SCPI recording data from the internal file.

This feature enables you to transfer an instrument configuration to other test environ-
ments, as e.g. laboratory virtual instruments.

Return values: 
<FileData> block data

Example: SYSTem:SRData? 
// #3118:SOURce1:ROSCillator:SOURce EXT
// :SOURce1:FREQuency:CW 4000000000
// :SOURce1:FREQuency:OFFSet 1000000
// :SOURce1:AM1:STATe 1
// :OUTPut1:STATe 1

Usage: Query only

:SYSTem:STARtup:COMPlete?

Queries if the startup of the instrument is completed.

Return values: 
<Complete> 1 | ON | 0 | OFF

*RST: 0

Example: SYSTem:STARtup:COMPlete? 
Response: 1 
// the instrument has started and is ready for operation.

Usage: Query only
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:SYSTem:DATE <Year>, <Month>, <Day>

Queries or sets the date for the instrument-internal calendar.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Year> integer

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example "To configure date and time" on page 558.

Manual operation: See "Date" on page 638

:SYSTem:NTP:HOSTname <NTPName>

Sets the address of the NTP server. You can enter the IP address, or the hostname of
the time server, or even set up an own vendor zone. See the Internet for more informa-
tion on NTP.

Parameters:
<NTPName> string

Manual operation: See "NTP Address" on page 639

:SYSTem:NTP:STATe <UseNtpState>

Activates clock synchronization via NTP.

Parameters:
<UseNtpState> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example "To configure date and time" on page 558.

Manual operation: See "NTP Address" on page 639

:SYSTem:TIME <Hour>, <Minute>, <Second>

Queries or sets the time for the instrument-internal clock.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59
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<Second> integer
Range: 0  to  59

Example: See Example "To configure date and time" on page 558.

Manual operation: See "Time" on page 638

:SYSTem:TIME:ZONE <TimeZone>

Sets the timezone. You can query the list of the available timezones with :SYSTem:
TIME:ZONE:CATalog?.

Parameters:
<TimeZone> string

Example: See Example "To configure date and time" on page 558.

Manual operation: See "Timezone" on page 639

:SYSTem:TIME:ZONE:CATalog?

Querys the list of available timezones.

Return values: 
<Catalog>

Example: See Example "To configure date and time" on page 558.

Usage: Query only

Manual operation: See "Timezone" on page 639

:SYSTem:TIME:PROTocol <TimeProtocol>

Sets the date and time of the operating system.

Parameters:
<TimeProtocol> OFF | NONE | 0 | NTP | ON | 1

NONE
Sets the date and time according to the selected timezone,
see :SYSTem:TIME:ZONE:CATalog? on page 582 and :
SYSTem:TIME:ZONE on page 582.
NTP
Sets the date and time derived from the network time protocol.
To select the NTP time server, use the commands :SYSTem:
NTP:HOSTname on page 581 and :SYSTem:NTP:STATe
on page 581.
*RST: n.a. (factory preset: NONE)

Example: See Example "To configure date and time" on page 558.

Manual operation: See "Time Protocol" on page 639
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:SYSTem:UPTime?

Queries the up time of the operating system.

Return values: 
<UpTime> "<ddd.hh:mm:ss>"

Example: SYSTem:UPTime?
Response: "0.08:11:00"

Usage: Query only

:SYSTem:BIOS:VERSion?

Queries the BIOS version of the instrument.

Return values: 
<Version> string

Example: SYST:BIOS:VERS?
queries the BIOS version.
Response: 123456

Usage: Query only

:SYSTem:VERSion?

Queries the SCPI version the instrument's command set complies with.

Return values: 
<Version> string

Example: SYSTem:VERSion 
// queries the SCPI version. 
Response: "1996" 
// the instrument complies with the SCPI version from 1996.

Usage: Query only

:SYSTem:OSYStem?

Queries the operating system of the instrument.

Return values: 
<OperSystem> string

Example: SYSTem:OSYStem?
Response: "Linux"

Usage: Query only
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:SYSTem:MMEMory:PATH:USER?

Queries the user directory, that means the directory the R&S SMB100B stores user
files on.

Return values: 
<PathUser> string

Example: SYSTem:MMEMory:PATH:USER? 
Response: "'/var/user/"

Usage: Query only

:SYSTem:DFPRint <Directory>

Creates a file with the device footprint of the product.

The content is formatted in machine-readable form, suitable for automatic further pro-
cessing.

The generic file name is composed of
DeviceFootprint_<SerialNumber>_<Date>_<Time>.xml. R&S SMB100B
saves the file in the definable directory. If the directory is not specified, it saves the
footprint file in the internal default directory (/var/lib/Rohde-Schwarz/
DeviceFootprint).

You can download the file by using the SCPI commands of the MMEMory subsystem.

Setting parameters: 
<Directory> string

Path to the directory for saving the device footprint file.
Ensure that you have the permission to write into the directory.

Return values: 
<DeviceFootprint> string

Information on the product type, identification and the installed
hardware, software and further service-related information on
the product's configuration.

Example: SYSTem:DFPRint “/var/user/devicefootprint”

SYSTem:DFPRint?
// MMEM:DATA?
// returns the device footprint information saved with SYST:DFPRint

:SYSTem:REBoot

Reboots the instrument including the operating system.

Usage: Event
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:SYSTem:RESTart

Restarts the instrument without restarting the operating system.

Usage: Event

:SYSTem:SHUTdown

Shuts down the instrument.

Usage: Event

Manual operation: See "Shut down" on page 646

:SYSTem:WAIT <TimeMs>

Delays the execution of the subsequent remote command by the specified time.

This function is useful, for example to execute an SCPI sequence automatically but
with a defined time delay between some commands.

See Section 11.2.2, "How to assign actions to the [★ (User)] key", on page 264.

Setting parameters: 
<TimeMs> integer

Wait time in ms
Range: 0  to  10000
*RST: 0

Example: SYSTem:WAIT 10000
// Waits 10s before resetting the instrument.
*RST

Usage: Setting only

:SYSTem:FILes:TEMPorary:DELete

Deletes the temporary files from the internal memory.

Example: :SYSTem:FILes:TEMPorary:DELete
// temporary files are removed

Usage: Event

13.18  STATus subsystem

This system contains the commands for the status reporting system. See also Sec-
tion 12.4, "Status reporting system", on page 306 for detailed information.

*RST on page 378 has no effect on the status registers.
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Value ranges

● Queries return the current value of the respective register, which permits a check of
the device status.
Return values: A decimal value in the range 0 to 32767 (=215-1)

● The configuration commands set the respective register thus determining which
status changes of the R&S SMB100B cause the status registers to be changed.
Setting values: A decimal value in the range 0 to 32767 (=215-1)

:STATus:OPERation:CONDition?.....................................................................................586
:STATus:OPERation:ENABle...........................................................................................586
:STATus:OPERation[:EVENt]...........................................................................................587
:STATus:OPERation:NTRansition.................................................................................... 587
:STATus:OPERation:PTRansition.....................................................................................587
:STATus:PRESet............................................................................................................587
:STATus:QUEStionable:CONDition.................................................................................. 588
:STATus:QUEStionable:ENABle.......................................................................................588
:STATus:QUEStionable[:EVENt]...................................................................................... 588
:STATus:QUEStionable:NTRansition................................................................................ 588
:STATus:QUEStionable:PTRansition................................................................................ 589
:STATus:QUEue[:NEXT]?................................................................................................589

:STATus:OPERation:CONDition?

Quieries the content of the CONDition part of the STATus:OPERation register.

This part contains information on the action currently being performed in the instru-
ment. The content is not deleted after being read out because it indicates the current
hardware status.

Return values: 
<Condition> string

Example: :STATus:OPERation:CONDition?

Usage: Query only

:STATus:OPERation:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:OPERation register. This setting deter-
mines which events of the Status-Event part are forwarded to the sum bit in the status
byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: :STAT:OPER:ENAB 32767
all events are forwarded to the sum bit of the status byte.
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:STATus:OPERation[:EVENt] < >

Queries the content of the EVENt part of the STATus:OPERation register. This part
contains information on the actions performed in the instrument since the last readout.
The content of the EVENt part is deleted after being read out.

Parameters:
< > string

Example: :STAT:OPER:EVEN?
queries the STATus:OPERation:EVENt register.

:STATus:OPERation:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 1 to 0 in the condition part causes an entry to be made in the EVENt
part of the register. The disappearance of an event in the hardware is thus registered,
for example the end of an adjustment.

Parameters:
<Ntransition> string

Example: :STAT:OPER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Opera-
tion register does not cause an entry to be made in the EVENt
part.

:STATus:OPERation:PTRansition <Ptransition>

Sets the bits of the PTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 0 to 1 in the condition part causes an entry to be made in the EVENt
part of the register. A new event in the hardware is thus registered, for example the
start of an adjustment.

Parameters:
<Ptransition> string

Example: :STAT:OPER:PTR 32767
all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVENt part.

:STATus:PRESet <Preset>

Resets the status registers. All PTRansition parts are set to FFFFh (32767), i.e. all
transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a transition
from 1 to 0 in a CONDition bit is not detected. The ENABle parts of STATus:OPERation
and STATus:QUEStionable are set to 0, i.e. all events in these registers are not passed
on.

Parameters:
<Preset> string
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Example: STAT:PRES
resets the status registers.

:STATus:QUEStionable:CONDition <Condition>

Queries the content of the CONDition part of the STATus:QUEStionable register. This
part contains information on the action currently being performed in the instrument.
The content is not deleted after being read out since it indicates the current hardware
status.

Parameters:
<Condition> string

Example: :STATus:QUEStionable:CONDition?
queries the Status:Questionable:Condition register.

:STATus:QUEStionable:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:QUEStionable register. The enable part
determines which events of the STATus:EVENt part are enabled for the summary bit in
the status byte. These events can be used for a service request.

If a bit in the ENABle part is 1, and the correesponding EVENt bit is true, a positive
transition occurs in the summary bit. This transition is reportet to the next higher level.

Parameters:
<Enable> string

Example: STAT:QUES:ENAB 1
Problems when performing an adjustment cause an entry to be
made in the sum bit.

:STATus:QUEStionable[:EVENt] < >

Queries the content of the EVENt part of the STATus:QUEStionable register. This
part contains information on the actions performed in the instrument since the last
readout. The content of the EVENt part is deleted after being read out.

Parameters:
< > string

Example: STAT:QUES:EVEN?
queries the Status:Questionable:Event register.

:STATus:QUEStionable:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<Ntransition> string
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Example: STAT:QUES:NTR 0
a transition from 1 to 0 in the condition part of the STA-
Tus:QUEStionable register does not cause an entry to be made
in the EVENt part

:STATus:QUEStionable:PTRansition <PTransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<PTransition> string

Example: STAT:QUES:PTR 32767
all transitions from 0 to 1 in the condition part of the STA-
Tus:QUEStionable register cause an entry to be made in the
EVENt part

:STATus:QUEue[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Positive error numbers
denote device-specific errors, and negative error numbers denote error messages
defined by SCPI. If the error queue is empty, 0 ("No error") is returned.

The command is identical to :SYSTem:ERRor[:NEXT]? on page 562.

Return values: 
<Next> string

Example: :STATus:QUEue?
queries the oldest entry in the error queue.
Response: 0, 'no error'
no errors have occurred since the error queue was last read out

Usage: Query only

13.19  TEST subsystem

The TEST subsystem contains the commands for performing test routines directly at
the hardware assemblies.

The selftetst responses with a 0 if the test is performed successfully, otherwise a value
other than 0 is returned. None of the commands of this system has a *RST value.
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Example: Testing the screen display

// show the check screen
:TEST:PIXel:WINdow 1
// selct the color for the display, e.g. blue
TEST:PIXel:COLor BLUE
// select the sequence for changing the color automatically
TEST:PIXel:COLor AUTO //(~3s per color)
// select a specific RGB color, e.g. black
TEST:PIXel:RGBA 0,0,0,255
// turn on the gradient
TEST:PIXel:GRADient 1
// switch to text mode
 :TEST:PIXel:TEXT 1
// set the point size of the text
:TEST:PIXel:POINtsize 600 
// exit the check screen 
:TEST:PIXel:WINdow 0

:TEST<hw>:ALL:STARt.................................................................................................. 590
:TEST<hw>:ALL:RESult?................................................................................................590
:TEST:PIXel:COLor........................................................................................................ 590
:TEST:PIXel:GRADient................................................................................................... 591
:TEST:PIXel:POINtsize................................................................................................... 591
:TEST:PIXel:RGBA.........................................................................................................591
:TEST:PIXel:TEXT..........................................................................................................591
:TEST:PIXel:WINDow..................................................................................................... 592

:TEST<hw>:ALL:STARt

Starts the selftest. Use the command :TEST<hw>:ALL:RESult? to query the pro-
gress of the test.

Usage: Event

:TEST<hw>:ALL:RESult?

Queries the progress of the performed selftest. Start the selftest with :TEST<hw>:
ALL:STARt.

Return values: 
<Result> 0 | 1 | RUNning | STOPped

*RST: STOPped

Usage: Query only

:TEST:PIXel:COLor <PixTestColor>

Selects the color of the screen.
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"AUTO" switches from one color to the next in tme intervals of approximately 3 s per
color.

Setting parameters: 
<PixTestColor> RED | BLUE | WHITe | GREen | AUTO | GR25 | GR50 | GR75 |

BLACk
*RST: RED

Example: See Example "Testing the screen display" on page 590.

Usage: Setting only

Manual operation: See "Check Display Screen" on page 644

:TEST:PIXel:GRADient <PixTestGradStat>

Activates the gradient for display screen test.

Parameters:
<PixTestGradStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Testing the screen display" on page 590.

Manual operation: See "Check Display Screen" on page 644

:TEST:PIXel:POINtsize <PixTestGradStat>

Sets the point size of the test text.

Parameters:
<PixTestGradStat> integer

Range: 0  to  999
*RST: n.a. (no preset. default: 0)

Example: See Example "Testing the screen display" on page 590.

Manual operation: See "Check Display Screen" on page 644

:TEST:PIXel:RGBA

Sets a specific RGBA color for the screen.

Example: See Example "Testing the screen display" on page 590.

Manual operation: See "Check Display Screen" on page 644

:TEST:PIXel:TEXT <PixTestGradStat>

Activats the test text mode.
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Parameters:
<PixTestGradStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Testing the screen display" on page 590.

Manual operation: See "Check Display Screen" on page 644

:TEST:PIXel:WINDow <PixTestWindow>

Activates the check display screen.

Setting parameters: 
<PixTestWindow> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Testing the screen display" on page 590.

Usage: Setting only

Manual operation: See "Check Display Screen" on page 644

13.20  TRIGger subsystem

The TRIGger system contains the commands for selecting the trigger source for the
RF and LF sweep.

You can work with an internal or with an externally applied trigger signal. In this case,
use the commands in the SOURce:INPut subsystem to configure the signal.

The trigger system of the R&S SMB100B is a simplified implementation of the SCPI
trigger system. The TRIGger system differs from the SCPI system as follows:
● No INITiate command; the instrument behaves as if INITiate:CONTinuous

ON were set.
● Under TRIGger several sweep subsystems exist.
● The trigger source names correspond directly to the various settings of manual

control. SCPI uses different names which are also accepted by the instrument. The
SCPI names should be used if compatibility is an important consideration.

In addition to these commands, see more trigger-related commands in the modulation
and RF signal subsystems.
Table 13-1: Cross-reference between the manual and remote control

R&S proprietary value name SCPI conform value name Parameter in manual control

AUTO IMMediate "Auto" mode

SINGle BUS "Single" mode.
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R&S proprietary value name SCPI conform value name Parameter in manual control

EXTernal EXTernal "Ext Single" and "Ext Step" mode.

Use command LFO:SWEep:MODE
to select between the two sweep
modes.

EAUTo - "Ext Start/Stop" mode.

:TRIGger<hw>:FSWeep:SOURce....................................................................................593
:TRIGger<hw>:LFFSweep:SOURce.................................................................................593
:TRIGger<hw>:PSWeep:SOURce....................................................................................593
:TRIGger<hw>[:SWEep]:SOURce....................................................................................593
:TRIGger<hw>:FPSWeep:SOURce..................................................................................594
:TRIGger<hw>:FSWeep[:IMMediate]................................................................................595
:TRIGger<hw>:LFFSweep:IMMediate.............................................................................. 595
:TRIGger<hw>:PSWeep[:IMMediate]................................................................................595
:TRIGger<hw>[:SWEep][:IMMediate]................................................................................595
:TRIGger<hw>:LFFSweep.............................................................................................. 595

:TRIGger<hw>:FSWeep:SOURce <Source>
:TRIGger<hw>:LFFSweep:SOURce <Source>
:TRIGger<hw>:PSWeep:SOURce <Source>
:TRIGger<hw>[:SWEep]:SOURce <Source>
Selects the trigger source for the corresponding sweeps:
● FSWeep - RF frequency
● LFFSweep - LF frequency
● PSWeep - RF level
● SWEep - all sweeps

The source names of the parameters correspond to the values provided in manual
control of the instrument. They differ from the SCPI-compliant names, but the instru-
ment accepts both variants.

Use the SCPI name, if compatibility is an important issue. Find the corresponding
SCPI-compliant commands in Cross-reference between the manual and remote con-
trol.

Setting parameters: 
<Source> AUTO | IMMediate | SINGle | BUS | EXTernal | EAUTo

AUTO [IMMediate]
Executes a sweep automatically.
In this free-running mode, the trigger condition is met continu-
ously. I.e. when a sweep is completed, the next one starts imme-
diately.
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SINGle [BUS]
Executes one complete sweep cycle.
The following commands initiate a trigger event:
*TRG on page 379
[:SOURce<hw>]:SWEep:POWer:EXECute
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute
:TRIGger<hw>[:SWEep][:IMMediate], :TRIGger<hw>:
PSWeep[:IMMediate] and :TRIGger<hw>:FSWeep[:
IMMediate].
Set the sweep mode with the commands:
[:SOURce<hw>]:SWEep:POWer:MODEAUTO|STEP
[:SOURce<hw>]:SWEep[:FREQuency]:MODEAUTO|STEP
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE
AUTO|STEP
In step mode (STEP), the instrument executes only one step.
EXTernal
An external signal triggers the sweep.
EAUTo
An external signal triggers the sweep. When one sweep is fin-
ished, the next sweep starts.
A second trigger event stops the sweep at the current frequency,
a third trigger event starts the trigger at the start frequency, and
so on.
*RST: AUTO

Example: See Example "Setting up an RF frequency or power sweep"
on page 544

Usage: Setting only

:TRIGger<hw>:FPSWeep:SOURce <FpTrigSource>

Selects the trigger source for the combined RF frequency / level sweep.

The parameter names correspond to the manual control. If needed, see table
Table 13-1 for selecting the trigger source with SCPI compliant parameter names.

Parameters:
<FpTrigSource> AUTO | IMMediate | SINGle | BUS | EXTernal | EAUTo

AUTO|IMMediate
Executes the combined RF sweep automatically. In this free-run-
ning mode, the trigger condition is met continuously. I.e. as soon
as a sweep is completed, the next one starts immediately.
SINGle|BUS
Executes one complete sweep cycle triggered by the GPIB com-
mands [:SOURce<hw>]:SWEep:COMBined:EXECute or
*TRG. The mode has to be set to [:SOURce<hw>]:SWEep:
COMBined:MODE > AUTO.
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EXTernal
An external signal triggers the sweep.
EAUTo
An external signal triggers the sweep. As soon as one sweep is
finished, the next sweep starts. A second trigger event stops the
sweep at the current frequency and level value pairs, a third trig-
ger event starts the trigger at the start values, and so on.
*RST: No enum range assigned!

Manual operation: See "Mode" on page 151

:TRIGger<hw>:FSWeep[:IMMediate]
:TRIGger<hw>:LFFSweep:IMMediate
:TRIGger<hw>:PSWeep[:IMMediate]
:TRIGger<hw>[:SWEep][:IMMediate]
Performs a single sweep and immediately starts the activated, corresponding sweep:
● FSWeep - RF frequency
● PSWeep - RF level
● LFFSweep - LF frequency
● SWEep - all sweeps

Effective in the following configuration:
● TRIG:FSW|LFFS|PSW|[:SWE]:SOUR SING
● SOUR:SWE:FREQ|POW:MODE AUTO or SOUR:LFO:SWE:[FREQ:]MODE AUTO
Alternatively, you can use the IMMediate command instead of the respective SWEep:
[FREQ:]|POW:EXECute command.

Example: TRIG
Starts all active sweeps.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 155

:TRIGger<hw>:LFFSweep

Executes an LF frequency sweep in the following configuration:
● TRIG:LFFS:SOUR SING
● LFO:SWE:MODE AUTO
Example: LFO:SWE:MODE AUTO

TRIG:LFFS:SOUR SING
TRIG:LFFSweep

Usage: Event

TRIGger subsystem



Remote control commandsR&S®SMB100B

596User Manual 1178.3711.02 ─ 11

13.21  UNIT subsystem

The UNIT subsystem is used to set default units for parameters if no unit is indicated in
a command. These settings are valid for the entire instrument.

Example: Setting default units for remote control
UNIT:POW V
UNIT:ANGL DEG

Sets V (volts) as unit of all power parameters, DEG (degrees) for the phase modulation
angle and KMH for the speed.

:UNIT:ANGLe.................................................................................................................596
:UNIT:POWer.................................................................................................................596

:UNIT:ANGLe <Angle>

Sets the default unit for phase modulation angle. The command affects no other
parameters, such as RF phase, or the manual control or display.

Parameters:
<Angle> DEGree | DEGRee | RADian

*RST: RADian

:UNIT:POWer <Power>

Sets the default unit for all power parameters. This setting affects the GUI, as well as
all remote control commands that determine power values.

Parameters:
<Power> V | DBUV | DBM

*RST: DBM

13.22  Direct commands for the stereo/rds coder option
R&S SMBB-B5

The direct commands allow you the access to all functions of the stereo coder option
R&S SMBB-B5.

Some of the functions are also available via SCPI commands. In this case, we recom-
mend that you use the SCPI commands to keep the settings of the R&S SMB100B and
the stereo coder synchronized. Direct commands for which an SCPI command is avail-
able are marked with “for documentation reasons only” and the SCPI command is
given.

To send the direct commands, use the command [:SOURce]:STEReo:DIRect
"command string".
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To retrieve information, send the query [:SOURce]:STEReo:DIRect? "command
string".

All parameters are string parameters. Send them in quotation marks ("). These charac-
ters are part of the full direct command.

Before using the stereo coder, activate stereo modulation of the R&S SMB100B with
the command SOURce:STEReo:STATe ON. The SCPI command
SOURce:STEReo:AUDio:FREQuency sets the LF-Generator frequency.
SOURce:STEReo:MMF limits the modulation frequency. These commands have no
counterpart in the direct commands.

13.22.1  Programming examples

Example: Alternative frequency lists (AF)
Alternative frequency lists can be transmitted in two ways.
● Method A:

Set the frequencies of an AF list one after the other; the frequency currently trans-
mitted has to be specified as the first frequency.

● Method B:
Set the frequencies of an AF list in pairs, where each pair contains the frequency
currently transmitted and an alternative frequency.
Enter the frequency pairs in ascending order.
Choose descending order only if the alternative frequencies belong to different
regions or are used to broadcast different programs at different times.

A maximum of five AF lists can be generated. For type A lists, max. 25 frequencies per
list can be specified, for type B lists, max. 12 frequencies per list.

Consider the following:
● Do not combine method A and B.
● You can generate a maximum of five AF lists.

For type A lists, you can specify up to 25 frequencies per list; for type B - up to 12.
● There is no validity check for the frequency lists. Make sure that the syntax is cor-

rect.

// Method A
// Generate a new alternative frequency list
STEReo:DIRect "AF=N,87.6,87.7,87.8"
// Set the group sequence
STEReo:DIRect "GS=0A,14A"
// The group sequence must contain group 0A
// The alternative frequencies are now transmitted in group 0A

// Add another alternative frequency list
STEReo:DIRect "AF=+,88.6,88.7,88.8"
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// Method B
// Generate a new alternative frequency list
STEReo:DIRect "AF=N,87.6,90.2,87.6,90.2"
// Set the group sequence
STEReo:DIRect "GS=0A,14A"
// The group sequence must contain group 0A
// The alternative frequencies are now transmitted in group 0A

// Add another alternative frequency list
STEReo:DIRect "AF=+,88.6,91.2,88.6,91.2"

Example: Creating an EON (Enhanced Other Networks) data set
// Query the list of existing EON data sets
STEReo:DIRect? "EON-PI"
// the list shows the EON PI codes already used and codes remaining for new data sets

// Create an EON data set
STEReo:DIRect "EON-PI=1234"
// Set the program service (PS) name for the EON data set
STEReo:DIRect "EON-PS=1234,TEST EON"
// Set the group sequence, e.g. group 14A with variants 0 to 3
STEReo:DIRect "GS=0A,14A"

// Create an AF list for the EON
// Method A
STEReo:DIRect "EON-AFA=1234,N,87.6,87.7,87.8"
// Add further AF lists for the EON
STEReo:DIRect "EON-AFA=1234,+,88.6,88.7,88.8"
// Query the  first AF list of the EON
STEReo:DIRect? "EON-AFA,1234,1"

// Create an AF list for the EON
// Method B
STEReo:DIRect "EON-AFB=1234,N,87.6,87.7,87.8"
// 87.6 = tuned frequency, 87.7 = mapped frequency 1 (variant 5),
// 87.8 = mapped frequency 2 (variant 6)

Example: Free Format Groups (FFGs)
In the user-definable groups 1A, 3A, 5A, 6A, 7A, 8A, 9A, 10A, 11A, 12A and 13A, any
desired data can be transmitted. Five bits of this data are transmitted in block B and 16
bits each in blocks C and D of the specified group.
You can define up to 20 different data sequences.

// Define the transmitted data in group 1A
STEReo:DIRect "1A=05,0000000000,1FFFFFFFFF"
// Group 1A  transmitts 5 times "0000000000" followed by 5 times "1FFFFFFFFF"

// Set the group sequence, e.g. transmit the defined data in group 1A
STEReo:DIRect "GS=0A,1A"
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Example: Transparent Mode
The transparent mode allows you to transmit user-defined binary data instead of the
standard RDS data. The transparent mode uses blocks A to D of the RDS groups.
Standard RDS data is suppressed and not transmitted.
You can define up to 20 different data sequences.
The binary data is sent even if it constitutes no valid or meaningful RDS data. Always
delete the transparent data first, before you resume the transmission of standard RDS
data.

// Transmit the alternating sequences '0123456789ABCDEF' and 
// 'ABCDEF0123456789' instead of the RDS data

// Delete the transparent data
// Enable standard RDS data transmission
STEReo:DIRect "TRANS=0"

13.22.2  Remote-control commands

STEReo:DIRect "<FFG>=<RetrNumb>,<DataSeq#1>,<DataSeq#2>,..."
STEReo:DIRect? "<FFG>"

Transmits data via free format groups (FFGs). A free format group can be filled with
any desired data. (5 bits in block B and 16 bits each in blocks C and D of the group).

Note: This command causes that a queue is filled with data for a specific group. Sends
the data only if the group in question is added to the group sequence with the com-
mand STEReo:DIRect.

Setting parameters: 
<RetrNumb> Number of retransmissions

<DataSeq> You can define up to 20 different data sequences.
Specify at least 10 characters per <DataSeq>. Add leading
zeros, if any.
00 Erases the data.
Range: 0000000000  to  1FFFFFFFFF (10 ASCII coded

hexadecimal characters each)

Parameters for setting and query: 
<FFG> 1A | 3A | 5A | 6A | 7A | 8A | 9A | 10A | 11A | 12A | 13A

Determines the free format group.
To transmit the FFGs of the B group, use same commands.
Replace the A groups are by the B groups in the group
sequence. If B groups are transmitted, block C is overwritten
with the PI code.
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Example: STEReo:DIRect "1A=01,0123456789,1FFFFFFFFF"
Fills a queue with the data "0123456789,1FFFFFFFFF". The
data is sent in consecutive order in group 1A after group 1A is
added to the group sequence.
Query the data of group 1A
STEReo:DIRect? "1A"
Response: "01,0123456789,1FFFFFFFFF"

STEReo:DIRect "AF=<A>,<Freq#1>,<Freq#2>,..."
STEReo:DIRect? "AF<z>"

Defines an alternative frequency list.

A maximum of five AF lists with max. 25 frequencies per list can be created.

Parameters:
<Freq> xxx.x

Sets the alternative frequencies as ASCII coded decimal num-
bers.
If list <z> is not available, the response is ().
Range: 87.6  to  107.9

Setting parameters: 
<A> N

New AF list
+
AF list to be added.

Query parameters: 
<z> AF list to be read.

Range: 1  to  5

Example: STEReo:DIRect "AF=N,97.4,98.3"
Defines an alternative frequency list, the alternative frequencies
97.4 and 98.3 are inserted.
STEReo:DIRect? "AF1"
Response: "97.4,98.3"
STEReo:DIRect "AF=N"
Deletes all frequency lists.

STEReo:DIRect "ARI=<State>"
STEReo:DIRect? "ARI"

(for documentation reasons only)

Activates ARI signal transmission.

Use the command [:SOURce]:STEReo:ARI:STATe instead.

Setting parameters: 
<State> 0 | 1
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Example: STEReo:DIRect "ARI=0"
Deactivates ARI signal transmission.
STEReo:DIRect? "ARI"
Response: "0"

STEReo:DIRect "ARI-DEV=<Deviation>"
STEReo:DIRect? "ARI-DEV"

(for documentation reasons only)

Sets the frequency deviation of the ARI signal (max. deviation).

Use the command [:SOURce]:STEReo:ARI[:DEViation] instead.

Setting parameters: 
<Deviation> Sets the frequency deviation.

Note: Always set a four-digit value. Specify leading zeros, if any.
Range: 0000  to  1000 (ASCII coded decimal numbers),

corresponding to 0 Hz to 10 kHz

Example: STEReo:DIRect "ARI-DEV=1000
Sets the ARI frequency deviation to 10 kHz.
STEReo:DIRect? "ARI"
Response: "1000"

STEReo:DIRect "ARI-ID=<Id>"
STEReo:DIRect? "ARI-ID"

(for documentation reasons only)

Selects the ARI identification.

Use the command [:SOURce]:STEReo:ARI:TYPE instead.

Parameters:
<Id> 0 | 1 | 2 | 3

0
Off
1
DK (traffic announcement identification)
2
BK (area identification)
3
DK and BK (traffic announcement identification and area identifi-
cation)

Example: STEReo:DIRect "ARI-ID=0"
Deactivates the ARI identification.
STEReo:DIRect? "ARI-ID"
Response: "0"
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STEReo:DIRect "BIN=<x>"

Defines and sends, or queries, binary test patterns. The BIN command causes the
Stereo/RDS Coder to send periodic binary bit patterns instead of RDS data.

Parameters:
<x> 0

Binary mode OFF
1
00000000...,
2
11111111...,
3
01010101...,
4
11001100...

Example: STEReo:DIRect "BIN=2"
The binary test pattern is set to "2" so that only "1s" are transmit-
ted.

STEReo:DIRect "BK=<Code>"
STEReo:DIRect? "BK"

(for documentation reasons only)

Sets the ARI area identification.

Use the command [:SOURce]:STEReo:ARI:BK[:CODE] instead.

Parameters:
<Code> A | B | C | D | E | F

Example: STEReo:DIRect "BK=E"
The ARI area identification is set to "E".
STEReo:DIRect? "BK"
Response: "E"

STEReo:DIRect "CT= <Hour>:<Min>:<Sec>,<Day>.<Month>.<Year>"
STEReo:DIRect? "CT"

Sets and activates transmission of the real-time clock.

Note: The CT data is transmitted in group 4A. Setting the real-time clock (CT com-
mand) automatically adds group 4A to the group sequence.

Do not manually add group 4A to, or remove group 4A from, the group sequence.

To remove group 4A from the group sequence, use the command STEReo:DIRect.

Setting parameters: 
<Hour>:<Min>:<Sec> Range: 00:00:00  to  23:59:59
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<Day>.<Month>.<Year>Range: 01.01.00  to  31.12.85

Example: STEReo:DIRect "CT=20:30:59,01.08.03"
The real-time clock is set.
STEReo:DIRect? "CT"
Response: "20:31:06,01.08.03"

STEReo:DIRect "CT=off"

Deactivates transmission of the real-time clock signal in the RDS signal.

Note: This command is used to remove group 4A from the group sequence. Do not
manually remove group 4A from the group sequence.

Example: STEReo:DIRect "CT=off"
The real-time clock signal is no longer transmitted in the RDS
signal.

Usage: Setting only

STEReo:DIRect "DI=<x>"
STEReo:DIRect? "DI"

Sets or reads the decoder information (DI).

This command reads, and if necessary changes, the current decoder operating mode
(mono, stereo, etc.).

Parameters:
<x> Range: 0  to  F (ASCII coded hexadecimal numbers)

Example: STEReo:DIRect "DI=4"

STEReo:DIRect "DS=<x>"
STEReo:DIRect? "DS"

(for documentation reasons only)

Selects/activates a storage area in the Stereo/RDS Coder.

If activated, the settings stored in the selected area can be loaded.

Use the command [:SOURce]:STEReo:RDS:DATaset instead.

Parameters:
<x> Range: 1  to  5

Example: STEReo:DIRect "DS=2"
Storage area 2 is activated.
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STEReo:DIRect "EON-AFA= <PI>,<A>,<Freq#1>,<Freq#2>,..."
STEReo:DIRect? "EON-AFA,<PI>,<z>"

Enhanced Other Networks: Defines type A alternative frequencies for the EON with the
selected PI.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

<Freq> xxx.x
Sets the alternative frequencies as ASCII coded decimal num-
bers.
If list <z> is not available, the response is ().
Note: For each Enhanced Other Network (EON), a maximum of
five type A alternative frequency lists can be created.
Range: 87.6  to  107.9

Setting parameters: 
<A> N

New AF list
+
AF list to be added.

Query parameters: 
<z> AF list to be read.

Range: 1  to  5

Example: STEReo:DIRect "EON-AFA=1000,N,97.4,98.3"
Creates a type A alternative frequency list for the EON with
PI=1000. The new list contains the alternative frequencies 97.4
MHz and 98.3 MHz.
STEReo:DIRect? "EON-AFA,1000,1"
Queries the first type A alternative frequency list of the EON with
PI=1000.
Response: "97.4,98.3"

STEReo:DIRect "EON-AFB= <PI>,<A>,<Freq#1>,<Freq#2>,..."
STEReo:DIRect? "EON-AFB,<PI>,<z>"

Enhanced Other Networks: Defines type B alternative frequencies for the EON with the
selected PI.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)
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<Freq> xxx.x
Sets the alternative frequencies as ASCII coded decimal num-
bers.
If list <z> is not available, the response is ().
Note: For each Enhanced Other Network (EON), a maximum of
five type B alternative frequency lists can be created. Each list
contains a maximum of five frequencies, where <Freq#1> is
Tuned Frequency (TF) and <Freq#2..5> are the Mapped Fre-
quencies (MF). A minimum of two frequencies per EON is
required.
Range: 87.6  to  107.9

Setting parameters: 
<A> N

New AF list
+
AF list to be added.

Query parameters: 
<z> AF list to be read.

Range: 1  to  5

Example: See STEReo:DIRect.

STEReo:DIRect "EON-DEL=<PI>"

Enhanced Other Networks: Deletes the complete EON with selected <PI>.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

Example: STEReo:DIRect "EON-DEL=1000"
Deletes the EON with PI=1000.

Usage: Setting only

STEReo:DIRect "EON-PI=<PI>"
STEReo:DIRect? "EON-PI"

Enhanced Other Networks: Creates an EON or reads the list of the program identifica-
tion (PI) codes of all EONs created so far.

Note: A maximum of eight EONs can be created.

Parameters:
<PI> Note: Always set a four-digit value. Leading zeros, if any, must

also be specified.
Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)
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Example: STEReo:DIRect "EON-PI=1000"
Creates an EON with PI=1000.

STEReo:DIRect "EON-PS=<PI>,<PS>"
STEReo:DIRect? "EON-PS,<PI>"

Enhanced Other Networks: Sets the program service (PS) name for the EON with the
selected <PI>.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

Setting parameters: 
<PS> 8 ASCII characters

Note: Always set an eight-digit value. Blank spaces, if any, must
also be entered.

Example: STEReo:DIRect "EON-PS=1000,Test 123"
Sets the program service name for the EON with PI=1000 to
"Test 123".

STEReo:DIRect "EON-PTY=<PI>,<PTY>"
STEReo:DIRect? "EON-PTY,<PI>"

Enhanced Other Networks: Sets the program type (PTY) for the EON with the selected
<PI>.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

Setting parameters: 
<PTY> Range: 00  to  31 (ASCII coded decimal numbers)

Example: STEReo:DIRect "EON-PTY=1000,10"
Sets the program type for the EON with PI=1000 to "10".

STEReo:DIRect "EON-TA=<PI>,<TA>"
STEReo:DIRect? "EON-TA,<PI>"

Enhanced Other Networks: Sets the TA flag for the EON with the selected <PI>.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

Setting parameters: 
<TA> 0 | 1

Example: STEReo:DIRect "EON-TA=1000,1"
Sets the TA flag for the EON with PI=1000 to "1".
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STEReo:DIRect "EON-TP=<PI>,<TP>"
STEReo:DIRect? "EON-TP,<PI>"

Enhanced Other Networks: Sets the TP flag for the EON with the selected <PI>.

Parameters:
<PI> Range: 0000  to  FFFF (ASCII coded hexadecimal num-

bers)

Setting parameters: 
<TP> 0 | 1

Example: STEReo:DIRect "EON-TP=1000,1"
Sets the TP flag for the EON with PI=1000 to "1".

STEReo:DIRect "GS=<Group#1>,<Group#2>,...<Grpup#36>"
STEReo:DIRect? "GS"

Sets or reads the group sequence.

Note: Sends only group A or group B data at a time. Transmits only groups that con-
tain data. The groups 4A, 14B and 15B are automatically added to the group sequence
and must not be added or removed manually.

Setting parameters: 
<Group> 0A,1A,2A, … to 15B

Example: STEReo:DIRect "GS=0A,1B,10A,15A"
The groups 0A, 1B, 10A and 15A are transmitted.

STEReo:DIRect "IMP=<x>"
STEReo:DIRect? "IMP"

(for documentation reasons only)

Sets external L, R impedances.

Use the SCPI command [:SOURce]:STEReo:EXTernal:IMPedance instead.

Setting parameters: 
<x> 1 | 2

1
600 Ohms
2
100 kOhm

Example: STEReo:DIRect "IMP=1"
Sets the external impedance to 600 Ohms.
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STEReo:DIRect
"MASK=<NumbGroups>,<ErrFreeGroups>,<BitMaskBlcA>,<BitMaskBlcB>,<Bit
MaskBlcC>,<BitMaskBlcD>"

STEReo:DIRect? "MASK"

Sets a bit mask to generate defined bit errors in the RDS data stream.

Setting parameters: 
<NumbGroups> Number of groups to be masked.

If <NumbGroups> = 0, the RDS groups are continuously linked
to the error mask.
If <NumbGroups> ≠ 0, this value is decremented after each
errored group transmitted. When zero count is reached, no fur-
ther errored groups are transmitted, and STEReo:DIRect is set
to "0".
Range: 00  to  FF (hexadecimal values)

<ErrFreeGroups> Number of error-free groups to be inserted after each errored
group.
Range: 00  to  FF (hexadecimal values)

<BitMaskBlc> <BitMaskBlcA>,<BitMaskBlcB>,<BitMaskBlcC>,<BitMaskBlcD>
Hexadecimal bit mask for blocks A, B, C and D of the RDS
groups. For each block, 26 bits (16 data bits and 10 CRC bits)
have to be entered in hexadecimal code.
Range: 0000000  to  3FFFFFFF

Example: STEReo:DIRect
"MASK=09,01,0000001,0000000,0000000,0000000"
In nine RDS groups, the least significant bit of the CRC code of
block A is inverted, i.e. an errored bit is sent. After each errored
group, one error-free group is inserted. After transmission of the
complete sequence, MASK_STATE is set to "0".
With the command MASK_STATE=1, the above sequence (9
errored groups with one error-free group inserted after each
errored group) is retransmitted once.
Then, MASK_STATE is again set to "0".

STEReo:DIRect "MASK_STATE=<State>"
STEReo:DIRect? "MASK_STATE"

Switches on or off the transmission of defined bit errors in the RDS data stream.

Setting parameters: 
<State> 0 | 1
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Example: STEReo:DIRect "MASK_STATE=1"
With the command MASK_STATE=1, a sequence of errored
groups as defined by the MASK command is retransmitted once
if the number of groups to be masked is other than zero. Then,
MASK_STATE is automatically set to "0".
If the number of groups to be masked is equal to zero in the
MASK command (which means continuous error transmission),
the masking function can be switched off with MASK_STATE=0.

Example: STEReo:DIRect? "MASK_STATE"
Response: "1"
The MASK_STATE query provides information whether the RDS
data stream is linked to an error mask.

STEReo:DIRect "MODE=<EMODE>"
STEReo:DIRect? "MODE"

(for documentation reasons only)

Sets one of various transmission modes.

Use the command [:SOURce]:STEReo:AUDio:MODE instead.

Setting parameters: 
<EMODE> 1 | 2 | 3 | 4 | 5

1
L: Signal in left channel only
2
R: Signal in right channel only
3
Signal of equal frequency and phase in left and right channel
4
Signal of equal frequency and opposite phase in left and right
channel
5
Different, independent signals in left and right channel
(5 is not possible if the internal LF generator is selected as
source (SRC = LFGen)).

Example: STEReo:DIRect "MODE=1"
Only the signal of the left channel is transmitted.

STEReo:DIRect "MS=<Flag>"
STEReo:DIRect? "MS"

Sets or reads the music/speech flag.

The flag signals whether music or speech is being transmitted.

Setting parameters: 
<Flag> M | S
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Example: STEReo:DIRect "MS=M"
The music/speech flag is set to "M", which signals that music is
transmitted.

STEReo:DIRect "MPX-DEV=<Deviation>"
STEReo:DIRect? "MPX-DEV"

(for documentation reasons only)

Sets the MPX frequency deviation (max. deviation).

Use the the command [:SOURce]:STEReo[:DEViation] instead.

Setting parameters: 
<Deviation> Note: Always set a four-digit value. Leading zeros, if any, must

also be specified.
Range: 00000  to  10000 (ASCII coded decimal numbers),

corresponding to 0 Hz to 100 kHz

Example: STEReo:DIRect "MPX-DEV=00201"
Sets the MPX frequency deviation to 2.01 kHz.

STEReo:DIRect "PI=<PI>"
STEReo:DIRect? "PI"

Sets or reads the RDS program identification (PI) code.

Setting parameters: 
<PI> Note: Always set a four-digit value. Add leading zeros, if any.

Range: 0000  to  FFFF (ASCII coded hexadecimal num-
bers)

Example: STEReo:DIRect "PI=1234"
The program identification code to be transmitted is set to
"1234".

STEReo:DIRect "PIL=<State>"
STEReo:DIRect? "PIL"

(for documentation reasons only)

Activates/deactivates the pilot tone.

Use the command [:SOURce]:STEReo:PILot:STATe instead.

Setting parameters: 
<State> 0 | 1

Example: STEReo:DIRect "PIL=1"
The pilot tone is activated.
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STEReo:DIRect "PIL-DEV=<Deviation>"
STEReo:DIRect? "PIL-DEV"

(for documentation reasons only)

Sets the pilot tone frequency deviation (max. deviation).

Use the command [:SOURce]:STEReo:PILot[:DEViation] instead.

Setting parameters: 
<Deviation> Note: Always set a four-digit value. Add leading zeros, if any.

Range: 0000  to  1000 (ASCII coded decimal numbers),
corresponding to 0 Hz to 10 kHz

Example: STEReo:DIRect "PIL-DEV=1000"
Sets the frequency deviation of the pilot tone to 10 kHz.

STEReo:DIRect "PIL-PH=<Phase>"
STEReo:DIRect? "PIL-PH"

(for documentation reasons only)

Sets the pilot tone phase.

Use the command [:SOURce]:STEReo:PILot:PHASe instead.

Setting parameters: 
<Phase> Note: Always set a two-digit value with a sign ("+" or "-") in front

of it. Add leading zeros, if any.
Range: -5.0  to  +5.0 (ASCII coded decimal numbers), cor-

responding to ±5.0

Example: STEReo:DIRect "PIL-PH=-33"
Sets the pilot tone phase.

STEReo:DIRect "PRE=<Preemphasis>"
STEReo:DIRect? "PRE"

(for documentation reasons only)

Sets one of various preemphasis options.

Use the commands [:SOURce]:STEReo:AUDio:PREemphasis:STATe and [:
SOURce]:STEReo:AUDio:PREemphasis instead.

Setting parameters: 
<Preemphasis> 0 | 1 | 2

0
Off
1
50 us
2
75 us
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Example: STEReo:DIRect "PRE=1"
The preemphasis is set to 50 us.

STEReo:DIRect "PRESET"

Sets the default settings in accordance with specifications.

Example: STEReo:DIRect "PRESET"
Usage: Event

STEReo:DIRect "PS=<PS>"
STEReo:DIRect? "PS"

Sets or reads the RDS program service (PS) name.

Setting parameters: 
<PS> 8 ASCII characters

Note: Always set an eight-digit value. Blank spaces, if any, must
also be entered.
Special characters in the program service name are entered with
a leading back slash (\) followed by the decimal code of the spe-
cial character according to table E1 of CENELEC.

Example: STEReo:DIRect "RT=02,0,test text with \217"
Sets the program service name. 217 denotes the German letter
ü.

STEReo:DIRect "PS-TABLE=<Table>"
STEReo:DIRect? "PS-TABLE"

Selects the character set table used for the display of the RDS program service (PS)
name in the receiver.

The information concerning the character set is transmitted in segment 0 of the PS.
Segment 0 is repeatedly transmitted if the value for PS-TABLE > 0. For PS-TABLE = 0
no information concerning the character set is transmitted.

Setting parameters: 
<Table> 0 | 1 | 2 | 3

0
No information concerning the character set table in the PS
1
Table E.1 is used.
2
Table E.2 is used.
3
Table E.3 is used.
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Example: STEReo:DIRect "PS-TABLE=2"
The information concerning the character set is transmitted in
segment 0 of the PS in group 0A. To this end, segment 0 is
transmitted repeatedly. At the first transmission segment 0 con-
tains the information about the character set, at the second
transmission segment 0 contains the first two characters of the
PS.

STEReo:DIRect "PTY=<PTY>"
STEReo:DIRect? "PTY"

Sets or reads the program type (PTY).

Setting parameters: 
<PTY> Note: Always set a two-digit value. Add leading zero, if any.

Range: 00  to  31 (ASCII coded decimal numbers)

Example: STEReo:DIRect "PTY=08"
Sets the program type.

STEReo:DIRect "PTYN=<PTYN>"
STEReo:DIRect? "PTYN"

Sets or reads the RDS program type (PTY) name.

Setting parameters: 
<PTYN> 8 ASCII characters

Note: Always set an eight-digit value. Add blank spaces, if any.

Example: STEReo:DIRect "PTYN=Football"
Sets the program type name.
STEReo:DIRect "GS=0A,10A”
Group 10A is activated in addition to group 0A.
The specified program type name is transmitted.

STEReo:DIRect "RDS=<State>"
STEReo:DIRect? "RDS"

(for documentation reasons only)

Switches RDS on or off.

Use the command [:SOURce]:STEReo:RDS:STATe instead.

Setting parameters: 
<State> 0 | 1

Example: STEReo:DIRect "RDS=1"
Activates RDS.
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STEReo:DIRect "RDS-PH=<Phase>"
STEReo:DIRect? "PDS-PH"

Sets the RDS phase.

Setting parameters: 
<Phase> Range: 000  to  359 (ASCII coded decimal numbers)

Example: STEReo:DIRect "RDS-PH=100"
Sets the RDS phase.

STEReo:DIRect "RDS-DEV=<Deviation>"
STEReo:DIRect? "RDS-DEV"

(for documentation reasons only)

Sets the RDS frequency deviation (max. deviation).

Use the command [:SOURce]:STEReo:PILot[:DEViation] instead.

Setting parameters: 
<Deviation> Note: Always set a four-digit value. Add leading zeros, if any.

Range: 0000  to  1000 (ASCII coded decimal numbers),
corresponding to 0 Hz to 10.00 kHz)

Example: STEReo:DIRect "RDS-DEV=0201"
Sets the RDS frequency deviation to 2.01 kHz.

STEReo:DIRect "RDS-PRESET"

All RDS-specific parameters are deleted or set to default values.

Example: STEReo:DIRect "RDS-PRESET"
Sets all RDS parameter to their preset values.

Usage: Event

STEReo:DIRect "RT=<RetranNumber>,<A/
BFlag>,<RadioTextMsg#1>,<RadioTextMsg#2>"

STEReo:DIRect? "RT"

Sets a flag signaling the transmission of new radio text and the message of the radio
text.

Setting parameters: 
<RetranNumber> Range: 00  to  15 (ASCII coded decimal numbers), number

of retransmissions of radio text message

<A/BFlag> 0 | 1
If the A/B flag is set, the A/B bit in group 2A is toggled to signal
that a new radio text message is transmitted.
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<RadioTextMsg> Max. 64 characters
Two texts of 64 characters each can be transmitted in a radio
text message.
Note: For group B, the length of a radio text is limited to 32 char-
acters. Special characters in the radio text are entered with a
leading back slash (\) followed by the decimal code of the spe-
cial character according to table E1 of CENELEC.

Example: STEReo:DIRect "RT=02,0,test text with \217"
Sets the radio text message. 217 denotes the German letter ü.

STEReo:DIRect "SPS=<Time>,<PSN#1>,<PSN#2>,...<PSN#20>"
STEReo:DIRect? "SPS"

Switches program service names (PSN). The program service name automatically
changes after the set time interval.

Parameters:
<PSN> 8 ASCII characters

Max. 20 program service names of eight characters each can be
entered.
Note: Enter the program service names as 8-digit texts. Add
blank spaces, if any.
STEReo:DIRect “SPS=0” stops the transmission of the scroll-
ing PS and starts the transmission of the standard PS.

Setting parameters: 
<Time> Time interval in seconds

Range: 00  to  59 s

Example: STEReo:DIRect "SPS=05,TEST0123,TEST4567"
Transmitts the program service names "TEST0123" and
"TEST4567" alternately, each 5 seconds.

STEReo:DIRect "SRC=<SigSource>"
STEReo:DIRect? "SRC"

(for documentation reasons only)

Selects the signal source.

Use the command [:SOURce]:STEReo:SOURce instead.

Setting parameters: 
<SigSource> 0 | 1 | 2 | 3

0
Off
1
External analog (via L and R inputs)
2
External digital

Direct commands for the stereo/rds coder option R&S SMBB-B5
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3
Internal with LF generator

Example: STEReo:DIRect "SRC=1"
Selects the external analog L and R inputs as source.

STEReo:DIRect? "STATUS"

Status request whether the encoder or the update loader program is being executed.

Return values: 
<Status> ENC

Encoder program is running.
UPL
Update loader program is running.

Example: STEReo:DIRect? "STATUS"
Response: "ENC"

Usage: Query only

STEReo:DIRect "STORE=<DataSet#>"

Saves data in the flash memory. All RDS-specific settings are stored in data set <Data-
Set#> of the flash memory.

Setting parameters: 
<DataSet#> Range: 1  to  5

Example: STEReo:DIRect "STORE=1"
Current setting are saved as data set 1.

Usage: Setting only

STEReo:DIRect "TA=<State>"
STEReo:DIRect? "TA"

(for documentation reasons only)

Sets or reads the traffic announcement flag.

This flag signals whether traffic information is being broadcast.

Use the command [:SOURce]:STEReo:RDS:TRAFfic:ANNouncement[:STATe]
instead.

Setting parameters: 
<State> 0 | 1

Example: STEReo:DIRect "TA=1"

Direct commands for the stereo/rds coder option R&S SMBB-B5
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STEReo:DIRect "TP=<State>"
STEReo:DIRect? "TP"

(for documentation reasons only)

Sets or reads the traffic program flag. This flag signals whether traffic information is
transmitted.

Use the command [:SOURce]:STEReo:RDS:TRAFfic:PROGram[:STATe]
instead.

Setting parameters: 
<State> 0 | 1

Example: STEReo:DIRect "TP=1"

STEReo:DIRect "TRANS<DataNumber>=<DataStream>"
STEReo:DIRect? "TRANS<DataNumber>"

Transparent mode.

An RDS data stream of binary data is generated. If transparent data is selected, all
other RDS data is ignored.

Parameters:
<DataNumber> Max. 20 different data sequences can be defined.

Range: 0  to  13

<DataStream> 16 ASCII coded hexadecimal characters (blocks A to D of the
RDS groups)
TRANS=0 deletes all transparent data and switches back to nor-
mal RDS data transmission.
Note: 16 characters must be specified for each data sequence.
Leading zeros, if any, must also be specified. Transmitts the
data even if it constitutes no meaningful RDS data.

Example: STEReo:DIRect "TRANS1=0123456789ABCDEF"
Sends the data "0123456789ABCDEF" instead of the RDS data.

Direct commands for the stereo/rds coder option R&S SMBB-B5
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14  Troubleshooting and notifications
Handling R&S SMB100B start-up issues

If the product does not start, a blown fuse in the power supply can be the cause. Con-
tact the Rohde & Schwarz customer service to confirm the fault symptoms. If the power
supply has a blown fuse, you must return the product to the Rohde & Schwarz cus-
tomer service to have the power supply replaced. Follow the instructions from the
Rohde & Schwarz customer service.

If you need to transport or ship the instrument, see Section 15, "Transporting",
on page 632.

Understanding R&S SMB100B notifications

The R&S SMB100B distinguishes between various notifications caused by events or
functions. It displays a notification in the "Info" line on the screen temporarily, and
saves all notifications in a history list. In addition, an event initiates an entry in the
event/error queue of the status reporting system.

See:
● Section 12.4, "Status reporting system", on page 306
● Section 14.4, "Querying notifications", on page 620

14.1  Notifications

Notifications inform about operation states of the instrument, and point out deviations,
deficiencies or imperfection of functions that initiate an event in the instrument. The
instrument distinguishes the notifications according to the significance of the events by
different icons.

Some events require that you eliminate the deviation to make sure that the instrument
operates correctly.

To access the notifications and history list dialog, see Section 14.4, "Querying notifica-
tions", on page 620. In remote control mode, you can query the notifications using the
command :SYSTem:ERRor:ALL? on page 560.

14.1.1  Volatile notifications

Volatile notifications report automatic settings in the instrument (e.g. switching off
incompatible types of modulation) or on entries that are not accepted by the instrument
(e.g. range violations).

Volatile notifications do not normally demand user actions and disappear automatically
after a short period of time. They are saved in the history list, however.

Notifications
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Remote command:

:SYSTem:ERRor:ALL? or

:SYSTem:ERRor:CODE[:NEXT]?

14.1.2  Permanent notifications

Permanent notifications are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent notification must
be eliminated before correct instrument operation can be continued.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

Remote command:

:SYSTem:ERRor:STATic?

14.2  SCPI notifications

The SCPI notifications are similar for all SCPI instruments. Detailed information and an
overview of all notifications as defined in the SCPI standard can be found in the corre-
sponding documentation.

SCPI notifications have negative codes (numbers). The error text being entered into
the error/event queue or being displayed is printed in bold face on the left together with
the error code. Below the error text, there is an explanation to the respective error.

14.3  Device-specific notifications

The following table contains all error messages specific for the instrument, marked by
positive error codes in numerical order and an explanation of the error situation.

The device-specific error messages set bit 3 in the ESR register.

The index provides a list of the error messages sorted according to their error codes.

Error
code

Error Description Remedy

50 External reference out of
range or disconnected

The configured reference frequency source is
external but there is no physical external signal or
this signal is out of range.

In the "RF Frequency" > "Reference Fre-
quency" dialog, set the correct reference
signal source.

140 This modulation forces
other modulations off

The instrument disables a modulation because
you enabled another modulation.

 

Device-specific notifications
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Error
code

Error Description Remedy

180 Adjustment failed The instrument cannot execute an adjustment. Generate the adjustment data and load
it into the device.

182 Adjustment data missing Adjustment data is missing. Generate the adjustment data and load
it into the device.

183 Adjustment data invalid Adjustment data is invalid. Generate the adjustment data and load
it into the device.

200 Cannot access hardware The data transmission to a module was unsuc-
cessful.

The module is not installed, not properly
installed or missing.

201 Hardware revision out of
date

You cannot execute a specific function because of
a too old hardware version.

The driver does not support the installed version
of a hardware module.

Consider installing a newer hardware
module or downgrading the driver ver-
sion

202 Cannot access the
EEPROM

An error occurs when writing or reading a
EEPROM.

The EEPROM is possibly defective.
Replace it.

203 Invalid EEPROM data Reading a EEPROM is possible, however the
data are inconsistent.

 

204 Driver initialization failed Initialization of a driver fails when booting the
instrument firmware.

The driver is not compatible with the
hardware or software configuration of
the instrument.

241 No current list There is no list file selected to execute the
required operation.

Select a list file with the correct file
extension. If no list files is available, cre-
ate a list file.

242 Unknown list type speci-
fied

The list type selected is not valid for the required
operation.

Check the selected list type.

460 Cannot open file You or the application cannot open the selected
file.

Check the file path and filename.

461 Cannot write file You or the application cannot edit or write the
selected file.

Check if the file is read-only.

462 Cannot read file You or the application cannot read the selected
file.

Check if the file contents are compatible
with the file type.

463 Filename missing You cannot execute a task because the filename
is missing.

Enter the filename.

464 Invalid filename extension The file extension is not valid for the required
operation.

Check the file extension.

465 File contains invalid data The file with its file extension contains invalid
data. The file extension is wrong for the expected
data.

Check the file extension.

14.4  Querying notifications

The R&S SMB100B monitors the functions performed and automatically detects irregu-
larities. The instrument displays corresponding notifications in the "Info" line and col-
lects all notifications in a history with a detailed description.

Querying notifications
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Find details to the system notifications in Section 14, "Troubleshooting and notifica-
tions", on page 618.

To monitor static notifications and history

► In the taskbar, select the "Info" icon.

● The "Static Notifications" dialog lists the recently monitored notifications chro-
nologically and displays additional information on the highlighted message.

● The "History" dialog lists the accumulated messages with a short description.
The software reports volatile notifications once. The "Info" line displays identi-
cal errors repeatedly only if the original error disappeared. Selecting this info
line also opens the "Static Notifications" dialog.

Handling permanent notifications
If any critical error occurs, the R&S SMB100B automatically shows the warning icon 
in the taskbar. Select the icon to obtain information on the error and the number of
occurrences.
The icon is assigned to permanent notifications. The notification and icon are displayed
until the error is eliminated.

Static Notifications/History
Toggles between "Static Notifications" and the "History" tab in the info dialog.
Remote command: 
:SYSTem:ERRor[:NEXT]? on page 562
Each time a SYST:ERR:NEXT? query is sent, the eldest entry in the error queue is
returned and at the same time cleared in the list.
:SYSTem:ERRor:STATic? on page 563
Queries the list of all errors.

Querying notifications
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Clear History
Clears all messages in the "History" tab.
Remote command: 
:SYSTem:ERRor:ALL? on page 560
Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the
same time cleared.
:SYSTem:ERRor:HISTory:CLEar on page 563
Clears the messages in the "History" view.

14.5  Resolving network connection failures

Several issues may cause failures in the network connection to the instrument. This
section lists the most likely reasons and the recommended solutions.

Common reasons for network connection failures

● Network connecting cables and cable connectors of poor quality
● Incompatibility between the network interface of the R&S SMB100B and certain

switches or routers available on the market
● An invalid IP address assigned to the instrument

Possible solutions to network connection failures

1. NOTICE! Risk of network failure. Connecting to the network can cause network
failure. Errors can affect the entire network.
Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

2. Try out the following to resolve network connection failures:

● Exchange connecting cables, if obvious damage is visible.
See also "Cable selection to minimize electromagnetic interference"
on page 24.

● Observe the link status LED on the R&S SMB100B or the connected network
device. The link status LED is located next to the LAN connector.
If a link failure is detected, connect the instrument to a different device port or
to a different network device.

● Check whether the LAN interface and the required LAN services are enabled.
See Section 11.4.4, "Configuring LAN services", on page 283.

● If the IP address is set manually (no DHCP) or obtained with the Zeroconf
(Avahi) protocol:
– Check whether the IP address of the instrument is within the network's

address range.
– Check whether the IP address is valid.

Resolving network connection failures



Troubleshooting and notificationsR&S®SMB100B

623User Manual 1178.3711.02 ─ 11

See also "IP Address" on page 311.

14.6  Resolving errors during internal adjustments

Internal adjustments can fail for various reasons, e.g. if the adjustment data is invalid
or missing, or if any error causes process to abort.

To resolve a failed adjustment process, you have the following options:
● Abort on error (default setting), see "To resolve aborted internal adjustments"

on page 623
● Continue on error, see "To continue internal adjustments on error" on page 623

To resolve aborted internal adjustments

If an error occurs, the R&S SMB100B displays a notification in the "Information" field
and saves the notification in the history list.

1. Select "Info".

2. Look up the error code of the notification in the overview of device-specific notifica-
tions.
See Section 14.3, "Device-specific notifications", on page 619.

The overview provides a brief explanation of all notifications and information on
how to fix an error.

3. To resolve an adjustment failure, generate adjustment data and load it into the
instrument.

4. Restart internal adjustments as described in "Running internal adjustments"
on page 637

If the error persists:
Contact the Rohde & Schwarz customer support, see Section 14.9, "Collecting
information for technical support", on page 629.

To continue internal adjustments on error

If the failed internal adjustments has no significant effect on your application, you can
skip it and continue the calibration despite the error message. This function is pass-
word-protected.

1. Select "System Config > Setup > Security > Protection".

2. Unlock protection level 1, see"Protection Level/Password" on page 283.

3. Select "System Config > Setup > Internal Adjustment > Configuration > Continue
Adjustment on Error > On".

4. Proceed as described in "Running internal adjustments" on page 637.

Resolving errors during internal adjustments
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14.7  Measuring USB cable quality

To check the quality of the USB cable, see the service manual of the R&S SMB100B.

14.8  Checking the instrument configuration

The R&S SMB100B uses various hardware and software components. To get an over-
view, you can check the instrument assemblies, hardware options, software options
and the firmware version. The "Hardware Config" and "Versions/Options" dialogs list all
components according to their hardware configuration, software options and connected
Rohde & Schwarz equipment, like R&S NRP power sensors.

Installing software and hardware options

Activate newly purchased software options with a keycode. After purchase, the key-
code is part of the delivery of the software option. See also Section 11.3, "Managing
licenses and license keys", on page 268.

For installing newly purchased hardware options, contact Rohde & Schwarz customer
support.

Checking the installed hardware options

To find out the installed options:

1. Select "System Config" > "Setup" > "Instrument Assembly" > "Versions / Options".

2. Select "Hardware Options".

The dialog lists installed hardware options on the R&S SMB100B.

Proceed the same way to get information on the firmware or the installed software
options in the corresponding tab.

Checking the instrument configuration
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Checking the RF hardware assembly

To find out the installed RF hardware:

1. Select "System Config" > "Setup" > "Instrument Assembly" > "Hardware Config".

2. Select "RF Assembly".

The dialog lists the installed RF hardware components installed on the
R&S SMB100B.

Proceed the same way to get information on general or baseband hardware modules
or on the operating times of the R&S SMB100B in the corresponding tab.

Checking the instrument configuration
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14.8.1  Hardware configuration settings

Access:

► Select "System Config" > "Setup" > "Instrument Assembly" > "Hardware Config".

The "Hardware Config" dialog lists all installed assemblies and connected external
instruments with information on their part and serial numbers, and revision states.
Also, it lists the BIOS version. A firmware update does not update the BIOS ver-
sion. The "Counter" tab provides information on the operation time, the number of
times that the instrument was powered on and the last factory calibration of the
instrument.

The remote commands required to query the hardware configuration are described in
Section 13.7, "DIAGnostic subsystem", on page 396.

Assembly
The tables in the tabs show characteristics of the installed assemblies.
"Assembly" Assembly designation.
"Part Number" Part number of the assembly.
"Serial Number"

Serial number of the assembly.
"Revision" Revision state of the assembly.
"Slot" Indicates whether the assembly is connected to the serial bus or PCI

bus.
Remote command: 
:DIAGnostic<hw>:BGINfo? on page 397

Checking the instrument configuration
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Counter
Displays information on the operation times of the R&S SMB100B.

Operation Time / h ← Counter
Displays the operation time in hours so far.
Remote command: 
:DIAGnostic:INFO:OTIMe? on page 397

Power On Count ← Counter
Displays the number the instrument has been turned on.
Remote command: 
:DIAGnostic:INFO:POCount? on page 398

Last Full Factory Adjustment ← Counter
Displays the date of the last factory calibration.
Remote command: 
:CALibration:DATA:FACTory:DATE? on page 394

14.8.2  Versions and options settings

Access:

► Select "System Config" > "Setup" > "Instrument Assembly" > "Versions / Options".

The "Versions / Options" dialog shows the version of the installed instrument firm-
ware, the hardware and software options, the data sheet and the software compo-
nents of the firmware. The BIOS version is also listed; firmware updates do not
update the BIOS version.

The remote commands required to query the hardware configuration are described in
Section 13.7, "DIAGnostic subsystem", on page 396.

Checking the instrument configuration
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Firmware
Shows the firmware version and the version of the software platform.
Note: Your instrument is delivered with the latest firmware version available.
You can download firmware updates and the "Release Notes" that describe the modifi-
cations and the firmware update procedure.
See www.rohde-schwarz.com/firmware/smb100b
Remote command: 
n.a.

Downgrade Info
Shows downgrade information, like factory firmware version and minimum firmware
version to that the instrument can be downgraded.
Remote command: 
n.a.

Show Open Source Acknowledgments
Accesses the list of the used open-source software packages and the corresponding
verbatim license texts.

LucasFonts RSCorpid EULA
Accesses copyright information on LucasFonts font type RSCorpid EULA.

Hardware Options/Software Options
The tables in the "Hardware" and "Software" tabs list the installed hardware and soft-
ware options.
"Option" Short name of option
"Designation" Name of option
"Expiration Date"

For regular options, "Permanent" is indicated in this column.
Remote command: 
*OPT? on page 377
*IDN? on page 377

Versions
The "Versions" tab shows the versions of the technical specification of the
R&S SMB100B and of the software components that comprise the firmware.

"Package" Name of the component.
"Version" Current issue of the component.

E.g. the data sheet covers the technical data of the hardware compo-
nents of the factory settings.
See also Section 12.7.4, "Datasheet", on page 339.

Remote command: 
:SYSTem:SPECification:VERSion:FACTory? on page 580

Checking the instrument configuration
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14.9  Collecting information for technical support

If you encounter problems that you cannot solve yourself, contact your
Rohde & Schwarz support center at www.rohde-schwarz.com/support. Our support
center staff is optimally trained to assist you in solving problems.

The support center finds solutions more quickly and efficiently if you provide them with
information on the instrument and an error description.
● The following dialog boxes in the "Setup > Instrument Assembly" menu provide

useful information:
– Hardware Configuration: hardware assemblies
– Software and Options: the status of all software and hardware options instal-

led on your instrument
● System Messages: displayed in the "Info" line and provide information on any

errors that have occurred
● Support file: a special file (*.tar.gz file) with important support information that

can be created automatically.
The support *.tar.gz file has a user-definable name and contains the following
files and information:
– SgErrors.txt: chronological record of errors
– SystemRestaurationSMBB.savrcltxt: instrument settings at the last cor-

rect shutdown of the instrument
– UndoHistSuppInfo.xml: list of the last user interactions
– DeviceFootprint_<SerialNumber>_<Date>_<Time>.xml: service-rela-

ted information on the instrument's configuration.
– crashlog.txt, coredump: Postmortem debug info
– Several files with information on the last performed adjustment and self-test.

See also the description of error messages Section 14.1, "Notifications", on page 618.

To collect error information in a support file

1. Connect a USB device to the R&S SMB100B.

2. Select "System Config > Setup > Maintenance > Create R&S Support Information".

3. In the "Create R&S Support Information" dialog, navigate to the /usb directory.
Enter the support filename, for example RSSupport_DeviceInfo.

Collecting information for technical support

https://www.rohde-schwarz.com/support


Troubleshooting and notificationsR&S®SMB100B

630User Manual 1178.3711.02 ─ 11

The error information and further required data are collected automatically.
The support file RSSupport_DeviceInfo.tar.gz is created and stored in the /
usb directory.
Collect the error information and attach it to an email in which you describe the
problem. Send the email to the customer support address as listed on the Internet
(www.rohde-schwarz.com/support).

To remove sensitive data

► For information on how to handle or remove the sensitive data from your instru-
ment, refer to the description "R&S SMB100B Instrument Security Procedures".

To pack and transport the instrument

► If you need to transport or ship the instrument, see Section 15, "Transporting",
on page 632.

14.10  Contacting customer support

Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Contacting customer support

https://www.rohde-schwarz.com/support
https://www.rohde-schwarz.com/support
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Figure 14-1: QR code to the Rohde & Schwarz support page

Contacting customer support
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15  Transporting
Lifting and carrying

For safety information, see:
● "Lifting and carrying the product" on page 14
● Section 3.1.1, "Lifting and carrying", on page 21

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection. You can also contact your local Rohde & Schwarz service center for
advice.

Securing

When moving the R&S SMB100B in a vehicle or using transporting equipment, make
sure that the R&S SMB100B is properly secured. Only use items intended for securing
objects.

Transport altitude

The maximum transport altitude without pressure compensation is specified in the spe-
cifications document.
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16  Maintenance, storage and disposal
We advise to check the nominal data from time to time.

16.1  Cleaning

How to clean the product is described in "Cleaning the product" on page 15.

Do not use any liquids for cleaning. Cleaning agents, solvents, acids and bases can
damage the front panel labeling, plastic parts and display.

16.2  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the specifications docu-
ment.

16.3  Performing maintenance tasks

The R&S SMB100B is accurate due to integrated adjustment procedures and addi-
tional test functions that assure correct functioning.

Internal adjustments are integrated self-calibration routines, which you can execute
directly on the instrument.

How to: See Section 16.3.1.3, "How to use the internal adjustments", on page 636.

Self-calibration routines that require additional equipment are performed at an author-
ized Rohde & Schwarz service center. For description, see the R&S SMB100B service
manual.

16.3.1  Internal adjustments

Using the integrated adjustment procedures, you can start the calibration directly on
the instrument.

Minimum power rating required for internal adjustments

Depending on the instrument configuration, it can be required that you have to replace
the DUT by an external 50 Ω termination at the RF output. The following tables show
the minimum required power rating of the terminating resistor regarding the output
power and frequency options. The termination must be specified for the entire fre-
quency range of the instrument.

Performing maintenance tasks
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Table 16-1: Standard (no option) or high output power (R&S SMBB-K33/-K35)

Frequency option R&S SMBB-B112/-B120 R&S SMBB-B131/-B140(N)

Min. power rating 2 W (33 dBm) No termination required

16.3.1.1  Internal adjustment settings

Access:

► Select "System Config > Setup > General > Internal Adjustments".

In this dialog, you can perform internal calibration routines, and get information on
the last performed calibration.
The "Temperature Offset" indicates the deviation of the current temperature of the
instrument, compared to the temperature of the last adjustment.

The remote commands required to define these settings are described in Section 13.6,
"CALibration subsystem", on page 392.

How to: See Section 16.3.1.3, "How to use the internal adjustments", on page 636.

Settings

Adjust All
Executes all available internal calibration routines of the instrument.
Note: Before you start the internal adjustment, make sure that you have connected a
termination resistor, if necessary.
Remote command: 
:CALibration:ALL[:MEASure]? on page 392

Last Full Adjustment
Displays the date of the last fully performed adjustment.

Performing maintenance tasks
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Remote command: 
:CALibration<hw>:ALL:DATE? on page 393

Time
Displays the elapsed time since the last full adjustment.
Remote command: 
:CALibration<hw>:ALL:TIME? on page 394

Temperature Offset
Displays the temperature difference, comparing the temperature of the last adjustment
to the current instrument temperature.
A green checkmark indícates that the offset is within the permitted range. If the temper-
ature deviates more than ±5 K, the instrument indicates a warning icon.
Remote command: 
:CALibration<hw>:ALL:TEMP? on page 393

Information
Displays information to the current adjustment state.
Remote command: 
:CALibration<hw>:ALL:INFormation? on page 393

Continue Adjustment on Error
Continues the calibration even though an error was detected. By default adjustments
are aborted on error.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:CALibration<hw>:CONTinueonerror on page 394

16.3.1.2  Delayed adjustment settings

Access:

► Select "System Config > Setup > General > Delayed Adjustment".

Performing maintenance tasks
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In this dialog, you can set the internal adjustments to start automatically after the
selected warm up time and to switch off the instrument after calibration.

The remote commands required to define these settings are described in Section 13.6,
"CALibration subsystem", on page 392.

Settings

Adjust All Delayed....................................................................................................... 636
Warm Up Time............................................................................................................ 636
Shutdown After Adjustment.........................................................................................636

Adjust All Delayed
Performs all available internal calibration routines of the instrument.
How to: See Starting internal adjustments automatically.
Remote command: 
:CALibration:DELay[:MEASure]? on page 395

Warm Up Time
Sets the time for warming up the instrument before the calibration starts automatically.
How to: See Starting internal adjustments automatically.
Remote command: 
:CALibration:DELay:MINutes on page 395

Shutdown After Adjustment
Enables the automatic shutdown after internal adjustments.
How to: See Starting internal adjustments automatically.
Remote command: 
:CALibration:DELay:SHUTdown[:STATe] on page 395

16.3.1.3  How to use the internal adjustments

Deciding whether to run internal adjustments

1. Select "System Config > Setup > Internal Adjustment".

2. Check the status and color indication in the section "Since Last Full Adjustment".

Green: internal adjustments are not required.
Red: internal adjustments are required. Observe also the indication in the "Informa-
tion" field.

3. We recommend that you run internal adjustments in the following cases:
● Before starting any application that requires a maximum of level accuracy.
● When a long period of time has passed since the last adjustments.
● If the ambient temperature of the instrument significantly differs from the one of

the last adjustments.

4. Proceed as described in "Running internal adjustments" on page 637.
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Running internal adjustments

1. After switching on, the R&S SMB100B requires up to 30 minutes to warm up.
Wait until the instrument has reached operating temperature to achieve accurate
adjustments.

2. Select "System Config > Setup > Internal Adjustment > Adjust All".

3. Confirm with "Ok".

The adjustment process starts.

The adjustment process takes some time depending on the equipment of the
instrument.
If any error occurs, the process aborts. To resolve adjustment issues, see Sec-
tion 14.6, "Resolving errors during internal adjustments", on page 623.

Starting internal adjustments automatically

The delayed adjustment function executes the adjustments automatically. You can set
the warm-up time and shut down after the adjustment process finishes. Using this func-
tion, you can execute adjustments without being on-site and start measurements
directly when back.

1. If necessary, terminate the RF 50 Ω output. See "Running internal adjustments"
on page 637.

2. Select "System Config > Setup > General > Internal Adjustment".

3. Select "Delayed Adjustment".

4. Set the "Warm Up Time", e.g. 40 min.

The R&S SMB100B requires a warm-up time of at least 30 min.

5. Enable "Shut Down After Adjustment"

6. Select "Adjust All Delayed".

The process starts with warming up the instrument, indicating the progress in a sta-
tus dialog. In this dialog, you can abort the process again, if necessary.
After warming up, the R&S SMB100B executes the internal adjustments and shuts
down when finished.

16.3.2  Date and time

The R&S SMB100B uses an internal real-time clock to determine the date and time. It
adjusts the time and date to the timezone of your location automatically, by providing a
selection list of continents and cities.

The instrument records the time whenever you create or modify files on your instru-
ment or you use timed licenses. By default, the instrument is set to the UTC timezone,
but you can select the timezone according to your location.

Moreover, the instrument supports NTP protocol for synchronizing all connected instru-
ments and computer systems to minimize time delays in the network.
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16.3.2.1  Date and time settings

Access:

► Select "System Config" > "Setup" > "Maintenance" > "Date / Time".

The "Date / Time" dialog contains the time and data settings of the operating sys-
tem.
This function is password-protected. Unlock the protection level 1 to access it.
You can also set the time zone for your location, and select a time protocol control-
led by a time server for synchronization.

The required remote commands are described in Section 13.17, "SYSTem subsystem",
on page 555.

Settings:

Date.............................................................................................................................638
Time............................................................................................................................ 638
Timezone.....................................................................................................................639
Time Protocol.............................................................................................................. 639
NTP Address...............................................................................................................639

Date
Displays the date set in the operating system in the format [yyyy.mm.dd].
Remote command: 
:SYSTem:DATE on page 581

Time
Displays the time set in the operating system in the format [hh.mm.ss].
The time setting corresponds to the selected Timezone.
Remote command: 
:SYSTem:TIME on page 581
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Timezone
Selects the timezone in the date and time settings of the operating system.
You can select the timezone according to the major cities on the respective continents.
Tip: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.
Remote command: 
:SYSTem:TIME:ZONE on page 582
:SYSTem:TIME:ZONE:CATalog? on page 582

Time Protocol
Enables the instrument to refer to a network time protocol.
A network time protocol synchronizes the system clocks of all participating devices in a
computer network (Ethernet). A time server in the network provides the time base for
the connected devices that refer to this time to synchronize events.
You can select a high-precision time protocol to achieve high clock accuracy and thus
reduce the impact of varying network delays.
"None" Refers to the selected timezone, see "Timezone" on page 639.
"NTP" Uses the network time protocol (NTP).
Remote command: 
:SYSTem:TIME:PROTocol on page 582

NTP Address
Sets the IP address or host name of the NTP server.
When the server is detected and verified, the instrument enables the connection auto-
matically.
Remote command: 
:SYSTem:NTP:HOSTname on page 581
:SYSTem:NTP:STATe on page 581

16.3.2.2  How to set date and time

To select the timezone

1. Press the [Setup] key.

2. Select "Maintenance > Date /Time > Timezone".

3. Select continent and city of your location.
Tip: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.

4. Close the dialogs.

The instrument adjusts the time according to the selected location.

Performing maintenance tasks



Maintenance, storage and disposalR&S®SMB100B

640User Manual 1178.3711.02 ─ 11

To set the date and time

1. NOTICE!
This function is password-protected. Unlock the protection level 1 to access it.
Since the date and time settings affect time-based options, changing the date and
time can therefore lead to loss of access to the function of the options. We recom-
mend that you only change the system time in urgent cases.
If the time is not displayed correctly, the internal CMOS battery can be discharged.
To change the battery, contact your Rohde & Schwarz support center at
www.rohde-schwarz.com/support.
Press the [Setup] key.

2. Select "Security > Protection".

3. Enable the "Protection Level 1".
The default password is 123456.

4. Select "Setup > Maintenance > Date / Time".

5. Adjust the settings.

6. Close the dialogs.

The instrument sets the new date and time.

16.3.3  Check front panel

Within this dialog, you can verify the functionality of the control keys.

How To: See Section 16.3.3.2, "How to test the front panel", on page 641

16.3.3.1  Check front panel settings

Access:

► Select "System Config > Setup > Maintenance > Check Front Panel".

Performing maintenance tasks
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Reflecting the front panel, the "Check Front Panel" dialog contains all functions to
test the operating elements of the instrument.

16.3.3.2  How to test the front panel

See:
● "Testing the key panel" on page 641
● "Testing the touchscreen" on page 642
● "Terminating the test" on page 643
● "Debugging" on page 643

Testing the key panel

To perform the key panel test, you operate the keys at the front panel, and check the
response of the instrument in the "Check Front Panel" dialog. To perform this test prop-
erly, check each key of the front panel. The test is only completed, when you have veri-
fied all keys.

During the test, the actual functions of the keys are disabled.

1. Press the [Setup] key.

2. Select "Maintenance > Check Front Panel"
The "Check Front Panel" dialog opens.

3. Press a key on the front panel.
Check if the corresponding key in the "Check Front Panel" dialog turns green.

4. Press the same key a second time.
Check that the key in the dialog turns red.
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Note: Pressing the same key again has no further effect, except for the [Esc] key.
Pressing this key a third time, terminates the test procedure.

5. Continue with the next key on the front panel and repeat step 3 to  step 5 until all
keys are tested.

The test is completed, when each key is verified successfully, confirmed by a "Test
passed" message.

Testing the touchscreen

1. Press the [Setup] key.

2. Select "Maintenance > Check Touch Panel"
The "Finger Paint" test window opens.

3. Drag with your finger one or more lines, for example diagonally across the screen.
The test traces the movements of your finger on the screen.

The following results are expected:
● If the lines are uninterrupted, the touchscreen works properly.

● If there are any gaps, the touch-sensitive functionality is damaged.
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● To return to the "Check Front Panel" dialog, press [Esc].

Terminating the test

► Press the [Esc] key.

Exits the "Check Front Panel" dialog.

Debugging

1. If you detect a malfunction, for example, when you press the front panel key for the
first time, and the color of the button in the dialog turns red (instead of green), the
front panel key has probably stuck.

2. Contact the Rohde & Schwarz customer support, see Section 14.9, "Collecting
information for technical support", on page 629.

16.3.4  Check display screen

Using this function, you can verify the color depth and gradient, pixels and the text dis-
play of the screen.

Access:

► Select "System Config > Setup > Maintenance > Check Display Screen".

The R&S SMB100B fades out the current display and indicates the screen in red.
Short instructions on the screen explain how to execute the test.

The remote commands required to define these settings are described in Sec-
tion 13.19, "TEST subsystem", on page 589.

Testing the display screen

1. Press the [Setup] key.

2. Select "Maintenance > Check Display Screen"

Performing maintenance tasks



Maintenance, storage and disposalR&S®SMB100B

644User Manual 1178.3711.02 ─ 11

The "Check Display Screen" window opens.

3. Test the color and gradient of the display screen:

a) Use the [Help] key to hide the indicated text.
b) To toggle between the provided colors manually, use the navigation controls

[Left/Right] or the rotary knob.
The R&S SMB100B provides the colors red, green, blue, white, three levels of
gray shades and black.

c) To switch between the screen colors automatically, use the [Up] key.
d) To toggle the gradient, use the [Down] key.

4. Check if the R&S SMB100B indicates the text correctly:

a) Press [1] on the numeric keypad.
The R&S SMB100B displays a test text over the entire screen.

b) To inspect the text in detail, you can use the rotary knob to zoom it out.

5. To exit the test, press the [Esc] key.

Check Display Screen.................................................................................................644

Check Display Screen
Opens the test window with instructions on how to perform the test.
Remote command: 
:TEST:PIXel:WINDow on page 592
:TEST:PIXel:COLor on page 590
:TEST:PIXel:RGBA on page 591
:TEST:PIXel:GRADient on page 591
:TEST:PIXel:TEXT on page 591
:TEST:PIXel:POINtsize on page 591

16.3.5  FPGA/uC update settings

Access:

► Select "System Config > Setup > Maintenance > FPGA/µC Update".
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This dialog enables you to check for internal assembly updates and perform
updates.

Settings:

Check For Updates..................................................................................................... 645
Assembly.....................................................................................................................645
Install...........................................................................................................................645
Shut down................................................................................................................... 646
Update External Devices.............................................................................................646

└ Check For Updates.......................................................................................646

Check For Updates
Check for updates of the FPGA/µC.
Remote command: 
n.a.

Assembly
The table shows the installed assemblies and their states.
"Assembly" Assembly designation.
"State" Indicates the current state of installed assemblies.

Install
Install all available updates for the FPGA/µC.
Remote command: 
n.a.
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Shut down
For at least one assembly "State = Done" and no pending assemblies, shuts the instru-
ment down to applies installed updates.
Remote command: 
:SYSTem:SHUTdown on page 585

Update External Devices
This dialog shows the update options of external devices connected to the instrument.

Check For Updates ← Update External Devices
Check for updates of external devices.
Remote command: 
n.a.

16.3.6  Delete temporary files

During signal processing, the R&S SMB100B creates and saves various temporary
files in a predefined directory on its non-volatile memory. This predefined directory is a
protected system directory you cannot access in the "File Manager", but you can
delete all temporary files saved there.

To achieve more free disc space on the internal memory

1. Select "System Config > Setup > Maintenance > Delete Temporary Files".

2. Select "Delete Temporary Files".

Deletes the content of the predefined directory.

Another way to achieve more free disc space on the internal memory is to use the Exe-
cute Factory Preset.
This function removes all temporary files, too, but also resets several parameters to
their factory preset values.

Remote command:

:SYSTem:FILes:TEMPorary:DELete on page 585
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16.4  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposing of electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its life. Even disposal via the municipal collection points
for waste electrical and electronic equipment is not permitted.

Figure 16-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its
obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal
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Annex
A  Reference information for remote control

A.1  Telnet program examples

The following program example shows a simple TcpClient class that is intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SMB100B and opens a simple
user interface, very similar to the telnet, which allows input of commands. To enable
real automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>

Telnet program examples
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using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient()
: currentHostName( "" )
, currentPort( 0 )
, currentSocketDescr( 0 )
, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )
, receiveBufferSize( 1024 )
{
}
TcpClient::~TcpClient()
{
  currentHostInfo = NULL;
}

void TcpClient::connectToServer( string &hostname, int port )
{
  currentHostInfo = gethostbyname( hostname.c_str( ) );
  if( currentHostInfo == NULL )
  {
    currentHostName   = "";
    currentPort       = 0;
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    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("error connecting host\n" );
  }
  currentHostName = hostname;
  currentPort     = port;
  currentSocketDescr = socket(AF_INET, SOCK_STREAM, 0);
  if( currentSocketDescr == 0 )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("can't create socket\n" );
  }
  serverAddress.sin_family = currentHostInfo->h_addrtype;
  serverAddress.sin_port   = htons( currentPort );
  memcpy( (char *) &serverAddress.sin_addr.s_addr, 
  currentHostInfo->h_addr_list[0], currentHostInfo->h_length );
  if( connect( currentSocketDescr, ( struct sockaddr *) &serverAddress, 
  sizeof( serverAddress ) ) < 0 )
  {
   throw string("can't connect server\n" );
  }
  clientIsConnected = true;
}
void TcpClient::disconnect( )
{
  if( clientIsConnected )
  {
    close( currentSocketDescr );
  }
  currentSocketDescr = 0;
  currentHostName    = "";
  currentPort        = 0;
  currentHostInfo    = NULL;
  clientIsConnected  = false;
}
void TcpClient::transmit( string &txString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be sent\n");
  }
  char * transmitBuffer = new char[txString.length() +1];
  memcpy( transmitBuffer, txString.c_str(), txString.length() );
  transmitBuffer[txString.length()] = '\n'; //newline is needed!
  if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
  {
    throw string("can't transmit data\n");
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  }
  delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be received\n");
  }
  char * receiveBuffer = new char[receiveBufferSize];
  memset( receiveBuffer, 0, receiveBufferSize );
  bool receiving = true;
  while( receiving )
  {
    int receivedByteCount = recv( currentSocketDescr, 
    receiveBuffer, receiveBufferSize, 0 );
    if( receivedByteCount < 0 )
    {
      throw string("error while receiving data\n");
    }
    rxString += string( receiveBuffer );
    receiving = ( receivedByteCount == receiveBufferSize );
  }
  delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const
{
  return currentHostName;
}
int TcpClient::getCurrentPort( ) const
{
  return currentPort;
}

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage()
{
  cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
  int errorCode         = 0; //no error
  bool useSingleCommand = false;
  string singleCommand  = "";
  string hostname       = "";
  int    port           = 5025;
  string input          = "";
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  TcpClient client;
  switch( argc )
  {
    case 3:
      useSingleCommand = true;
      singleCommand    = argv[2];
    case 2:
      hostname         = argv[1];
      break;
    default:
        printUsage();
        return(-1);
  }
  try
  {
    client.connectToServer( hostname, port );
    bool terminate = false;
    while( !terminate )
    {
      char buffer[1024];
      if( useSingleCommand )
      {
        input =  singleCommand; //send string
      }
      else
      {
        cin.getline( buffer, 1024 );
        input = buffer;
        if( input == "end" )
        {
          terminate = true;
        }
      }
      if( !terminate)
      {
        client.transmit( input ); //send string
        int qPos = input.find( "?", 0 );
        //receive string only when needed
        if( qPos > 0 )
        {
          string rcStr = "";
          client.receive( rcStr );
          cout << rcStr << endl;
        }
      }
      if( useSingleCommand )
      {
        terminate = true;
      }
    }

Telnet program examples
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  }catch( const string errorString )
  {
    cout<<errorString<<endl;
  }
  client.disconnect( );
  return errorCode;
}

A.2  Available user files and file extensions

The table Table A-1 lists available file extensions for user files on the instrument. Some
files depend on the installed options.

For more information, refer to the specifications document.
Table A-1: User files and file extensions on the instrument

Context or function Content type File contents File extension

Instrument state Settings Instrument settings *.savrcltxt

User menu Settings User-defined favorite settings *.user_menu

License key License License key *.xml

User correction List User-defined level correction values *.uco

List Mode List User-defined frequency/level value pairs *.lsw

Pulse train Settings Pulse train data *.pulstrn

Power sensing Settings R&S NRP settings *.nrp, *.rsu

SCPI command list List Export file containing list of SCPIs *.iec

SCPI command script Command script SCPI script file formats: Plain SCPI, MATLAB, NICVI,
Python3

*.txt, *.m, *.c,
*.py

R&S support information Support file Automatically collected support information *.tar.gz

Tutorials Tutorial files Lists containing SCPIs and explanations *.tut

Available user files and file extensions
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B  Unit shortcuts
When specifying units or quantities during data entry, the R&S SMB100B provides the
following shortcuts for simplified input.

Shortcut Designation Context Unit

a, A ampere Current A

 atto- Area, surface am2

c, C centi- Distance, length cm

d, D deci- Distance, length dm

  Level, power dB, dBFS, dBm, dBU, dBW

 degree Phase, polar/spherical coordinates deg

e, E exa- Area, surface em2

f, F femto- Area, surface fm2

g, G giga- Area, surface Gm2

  Data rate, sample rate, symbol rate Gbit/s, Gsample/s, Gsymbol/s, Gchip/s

  Frequency GHz

  Impedance, resistance GΩ

h, H hertz Frequency Hz

k, K kilo- Area, surface km2

  Data rate, sample rate, symbol rate kbit/s, ksample/s, ksymbol/s, kchip/s

  Distance, length km

  Frequency kHz

  Impedance, resistance kΩ

  Velocity km/h

m, M milli- Area, surface mm2

  Current mA

  Distance, length mm

  Electromagnetic force, level mV

  Power mW

  Time, period, etc. ms

 mega- Area, surface Mm2

  Data rate, sample rate, symbol rate Mbit/s, Msample/s, Msym/s, Mchip/s

  Frequency MHz

  Impedance, resistance MΩ
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Shortcut Designation Context Unit

n, N nano- Area, surface nm2

  Current nA

  Distance, length nm

  Electromagnetic force, level nV

  Power nW

  Time, period, etc. ns

o, O ohm Impedance, resistance Ω

p, P peta- Area, surface pm2

 percent Level, ratio %

 pico- Area, surface pm2

  Current pA

  Electromagnetic force, level pV

  Power pW

  Time, period, etc. ps

r, R radiant Phase, polar/spherical coordinates rad

s, S second Time, period, etc. s

t, T terra- Area, surface Tm2

  Data rate, sample rate, symbol rate Tbit/s, Tsample/s, Tsym/s, Tchip/s

  Frequency THz

  Impedance, resistance TΩ

u, U micro- Current µA

  Distance, length µm

  Electromagnetic force, level µV

  Power µW

  Time, period, etc. µs

v, V volt Level, voltage V

w, W watt Level, power W
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C  GPIB interface
Option: R&S SMBB-B86.

This section provides detailed information on the general-purpose interface bus (GPIB)
interface "IEC 625/IEEE 488" for remote control of the instrument. It covers the follow-
ing topics:

● "Pin assignment" on page 656
● "Bus lines" on page 656
● "Interface functions" on page 657

For other remote control interfaces, see Section 12, "Network operation and remote
control", on page 296.

Pin assignment

Figure C-1: Pin assignment of the GPIB interface

Bus lines

● Data bus with eight lines D0 to D7:
The transmission is bit-parallel and byte-serial in the ASCII/ISO code. D0 is the
least significant bit, D7 the most significant bit.

● Control bus with five lines:
IFC (Interface Clear): active LOW resets the interfaces of the instruments connec-
ted to the default setting.
ATN (Attention): active LOW signals the transmission of interface messages, inac-
tive HIGH signals the transmission of device messages.
SRQ (Service Request): active LOW enables the connected device to send a ser-
vice request to the controller.
REN (Remote Enable): active LOW permits switchover to remote control.
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EOI (End or Identify): two functions in connection with ATN:
– ATN=HIGH active LOW marks the end of data transmission.
– ATN=LOW active LOW triggers a parallel poll.

● Handshake bus with three lines:
DAV (Data Valid): active LOW signals a valid data byte on the data bus.
NRFD (Not Ready For Data): active LOW signals that one of the connected devi-
ces is not ready for data transfer.
NDAC (Not Data Accepted): active LOW signals that the instrument connected is
accepting the data on the data bus.

Interface functions

You can use different interface functions to control the instrument via the GPIB inter-
face. Table C-1 lists the interface functions for the R&S SMB100B.

Table C-1: GPIB interface functions

Control character Interface function

SH1 Handshake source function (source handshake), full capability

AH1 Handshake sink function (acceptor handshake), full capability

L4 Listener function, full capability, de-addressed by MTA.

T6 Talker function, full capability, ability to respond to serial poll, deaddressed
by MLA

SR1 Service request function (Service Request), full capability

PP1 Parallel poll function, full capability

RL1 Remote/Local switch-over function, full capability

DC1 Reset function (Device Clear), full capability

DT1 Trigger function (Device Trigger), full capability

For more information, refer to the specifications document.
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Glossary: Terms and abbreviations
A

Avahi: A licensed Zeroconf networking feature, including DNS service. The feature
enables a device to self-configure an IP address and subnet mask automatically, when
a DHCP server in the LAN is not available.

C
Clock: A mandatory internal or an external reference clock signal for generating the
timing pulse in the instrument.

Complete file path: The complete file path specifies the root directory and all subdir-
ectories that contain a file or folder.
Synonyms to this expression are "full file path" and "absolute file path".
See also Section 13.5.2, "Handling files in the default or in a specified directory",
on page 383.

Computer name: Hostname

D
daisy chain: A connection scheme in which instruments are connected together in
sequence, i.e. an output of the first one is connected to an input of the second one, etc.

DHCP: Dynamic host configuration protocol

DNS: Domain name system server

E
e.g.: For example

External mass memory: External memory, connected to the instrument via USB con-
nector (Type A female). It can hold stored files with user data.
See also System drive

F
File transfer: The transmission of files from or to the instrument by a remote client.
The instrument supports the standard methods FTP and file sharing according to
SAMBA/SMB.

FTP: File transfer protocol

G
Glossary: List of the often used terms and abbreviations

GUI: Graphical user interface
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H
Hostname: An unambiguous indication of the instrument in a LAN that uses a DNS
server.
The default hostname follows the syntax SMBB-<serial number>, e.g.
SMB100B-102030.
See Serial number.
Synonym: Computer name

HUMS: Health and utilization monitoring system.

I
i.e.: That is

L
LF: Low frequency

LSB: Least significant bit

M
MIMO: Multiple input multiple outputs

MSB: Most significant bit

N
NTP: Network Time Protocol synchronizes all connected instruments and computer
systems to minimize time delays in the network.

P
PC: Personal computer

Power: A term describing the signal level of the RF signal

product page: A designation of the R&S SMB100B product page www.rohde-
schwarz.com/product/SMA100B.html

R
Remote access: Remote operation

Remote control: The operation of the R&S SMB100B by remote control commands or
programs to perform automated tests.
The instrument is connected to a system controller via LAN/VXI-11, GPIB or USB using
VISA. The instrument is controlled directly or supported by instrument drivers.

Remote device: External device controls the R&S SMB100B in remote operation
mode, see Remote operation.
Synonyms: External controller, client device

https://www.rohde-schwarz.com/product/SMA100B.html
https://www.rohde-schwarz.com/product/SMA100B.html
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Remote operation: Allows you to operate the R&S SMB100B from a remote device
via VNC.
Both the R&S SMB100B and the remote device are connected in a LAN.
Synonym: Remote access

Removable memory: General term describing mass memory that can be unmounted
from the instrument.

RF: Radio frequency

S
SAMBA/SMB: Server message protocol

Serial number: Unique instrument identification, provided on the rear panel of the
instrument and required to build the Computer name.
The serial number are the last 6 digits in the string <stock no.>-<serial
number>, e.g. SMB100B-102030

Smart device: A mobile, cordless device, such as a smartphone or tablet, capable of
Internet browsing.
Synonyms: Smartphone, tablet

System drive: The system drive is a built-in internal memory that holds the operating
system, the firmware, and the stored user data.
Throughout this description, the system drive is referred as an internal memory.
See also Removable memory

T
Trigger: Internally generated or externally supplied signal which starts signal genera-
tion at a particular point in time.

Trigger event: A trigger event is caused by the received trigger signal or executed
manual trigger.

U
UE: User equipment

USBTMC: (USB test & measurement class)
A protocol built on top of USB for communication with USB devices. Using VISA library,
it supports service request, triggers, and other specific operations, similar to GPIB.

User directory: Describes the default file storage location for user data.
Depending on the installed options, the user directory is physically located on the Sys-
tem drive or on the Removable memory
In the file system, user directory is always indicated as /var/user
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V
VISA: Virtual instrument software architecture

Z
Zeroconf: Zero-configuration, see Avahi.
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:CALibration:ALL[:MEASure]?....................................................................................................................... 392
:CALibration:DATA:EXPort.............................................................................................................................394
:CALibration:DATA:FACTory:DATE?..............................................................................................................394
:CALibration:DELay:MINutes.........................................................................................................................395
:CALibration:DELay:SHUTdown[:STATe].......................................................................................................395
:CALibration:DELay[:MEASure]?...................................................................................................................395
:CALibration<hw>:ALL:DATE?.......................................................................................................................393
:CALibration<hw>:ALL:INFormation?............................................................................................................ 393
:CALibration<hw>:ALL:TEMP?......................................................................................................................393
:CALibration<hw>:ALL:TIME?....................................................................................................................... 394
:CALibration<hw>:CONTinueonerror.............................................................................................................394
:DEVice:PRESet............................................................................................................................................ 381
:DIAGnostic:INFO:OTIMe?............................................................................................................................ 397
:DIAGnostic:INFO:POCount?........................................................................................................................ 398
:DIAGnostic<hw>:BGINfo:CATalog?..............................................................................................................397
:DIAGnostic<hw>:BGINfo?............................................................................................................................ 397
:DIAGnostic<hw>:POINt:CATalog?................................................................................................................398
:DIAGnostic<hw>[:MEASure]:POINt?............................................................................................................398
:DISPlay:ANNotation:AMPLitude...................................................................................................................408
:DISPlay:ANNotation:FREQuency.................................................................................................................409
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:DISPlay:BRIGhtness.....................................................................................................................................408
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:DISPlay:DIALog:CLOSe............................................................................................................................... 410
:DISPlay:DIALog:CLOSe:ALL........................................................................................................................411
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:DISPlay:PSAVe:HOLDoff..............................................................................................................................407
:DISPlay:PSAVe[:STATe]................................................................................................................................407
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:FORMat:BORDer..........................................................................................................................................411
:FORMat:SREGister...................................................................................................................................... 412
:FORMat[:DATA]............................................................................................................................................ 412
:FPANel:KEYBoard:LAYout............................................................................................................................418
:HCOPy:DATA?..............................................................................................................................................414
:HCOPy:DEVice:LANGuage..........................................................................................................................414
:HCOPy:FILE[:NAME]....................................................................................................................................414
:HCOPy:FILE[:NAME]:AUTO:DIRectory........................................................................................................415
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar.............................................................................................416
:HCOPy:FILE[:NAME]:AUTO:FILE?.............................................................................................................. 416
:HCOPy:FILE[:NAME]:AUTO:STATe..............................................................................................................416
:HCOPy:FILE[:NAME]:AUTO?.......................................................................................................................415
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe..................................................................................... 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?............................................................................................. 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix................................................................................................. 417
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe......................................................................................417
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe........................................................................................ 417
:HCOPy:IMAGe:FORMat...............................................................................................................................414
:HCOPy:REGion............................................................................................................................................ 414
:HCOPy[:EXECute]........................................................................................................................................415
:INITiate<hw>[:POWer]:CONTinuous............................................................................................................ 428
:KBOard:LAYout.............................................................................................................................................418
:MEMory:HFRee?.......................................................................................................................................... 391
:MMEMory:CATalog:LENGth?....................................................................................................................... 387
:MMEMory:CATalog?..................................................................................................................................... 386
:MMEMory:CDIRectory..................................................................................................................................387
:MMEMory:COPY.......................................................................................................................................... 387
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:MMEMory:RDIRectory..................................................................................................................................390
:MMEMory:RDIRectory:RECursive................................................................................................................391
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:OUTPut:ALL[:STATe].................................................................................................................................... 419
:OUTPut<hw>:AFIXed:RANGe:LOWer?....................................................................................................... 421
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:OUTPut<hw>:PROTection:CLEar.................................................................................................................421
:OUTPut<hw>:PROTection:TRIPped?...........................................................................................................421
:OUTPut<hw>[:STATe]...................................................................................................................................419
:OUTPut<hw>[:STATe]:PON.......................................................................................................................... 419
:READ<ch>[:POWer]?................................................................................................................................... 428
:SCONfiguration:EXTernal:ACONnect...........................................................................................................438
:SCONfiguration:EXTernal:PBEHaviour.........................................................................................................438
:SCONfiguration:EXTernal:REMote:CLEan................................................................................................... 441
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:SENSe<ch>:UNIT[:POWer]..........................................................................................................................429
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:SENSe<ch>[:POWer]:APERture:TIMe......................................................................................................... 429
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:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?...................................................................................430
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.................................................................................430
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:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority................................................................................... 430
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:SENSe<ch>[:POWer]:FILTer:TYPE.............................................................................................................. 433
:SENSe<ch>[:POWer]:FREQuency...............................................................................................................433
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